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1 Getting Started with Light-O-Rama

Welcome to Light-O-Rama

Light-O-Rama is a computerized lighting system designed to control elaborate or simple lighting
displays.  The Light-O-Rama system can be applied to almost any lighting situation, from stand-alone
controllers to synchronizing hundreds of controllers.

This page gives a high-level overview of how to start controlling your lights using Light-O-Rama:

Getting Help about Light-O-Rama
Important Terms and Information
Connecting the Lights Using Light-O-Rama Controllers
Creating a Show

For more detailed information, please see Light-O-Rama Concepts and the Light-O-Rama Software
Package.

Experienced users may wish to see  what's new in the latest version of Light-O-Rama.

Getting Help about Light-O-Rama

This help file contains a lot of information about the Light-O-Rama Software Suite. If you need more
help, please visit the Light-O-Rama website. Click the word "Support" at the top of the page to find
links to more resources, including tutorials, Frequently Asked Questions, our User Forum, and our
Help Desk.

Important Terms and Information

Companion Unit

A companion unit is a Light-O-Rama controller that receives lighting commands from another
source - either a PC running Light-O-Rama software, or from another controller known as a director
unit.

Control Panel

The Light-O-Rama Control Panel is a program that can be used to manage the Light-O-Rama
system on your PC.  The Control Panel runs in the system tray (where the PC's clock is displayed).
 Light-O-Rama is made up of a number of different programs, and the Control Panel is a convenient
way of accessing them.  The Control Panel must be running in order to control shows from your PC.

Daisy Chain

This is the term generally used to describe the manner in which Light-O-Rama light controllers are
connected.  A wire goes from the source (a PC running Light-O-Rama software or a director unit) to
a companion unit.  Another wire goes from that companion unit to another companion unit, and so
on, until all companion units are "chained" together.

http://lightorama.com/
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Do not put "Y"s or forks in the data cable.  Only connect the units in this daisy chain configuration.

Data Cable

Light-O-Rama controllers can be connected using both data cables and phone cables, but you must
know which type of cable it is (for the purposes of Light-O-Rama, a cable is considered a data
cable if its wires are connected straight through).

How do you know if it is a data cable? Well, most likely the only cable that you will see that is not a
data cable is a wire that is intended specifically for phones.  If you go to your local hardware store
and purchase a phone extension cable, then that wire is not a data cable.  The distinction between
data cables and phone cables is important, because the wires are swapped around.  There are
selectors or jumpers on most Light-O-Rama controllers that allow you to specify which wire type you
are using.

Only the wire coming into a controller (from the previous controller or from a PC running Light-O-
Rama software) should be used to determine which selector setting to use.  The wire leaving a
controller (if there is one) can be of any type, and has no bearing on which selector setting should
be used.  For example, if a controller has a phone cable coming in from the previous controller, and
a data cable leaving to the next controller, the selector should be set for "phone cable".

Director Unit

A director unit is a Light-O-Rama controller that sends lighting commands to other controllers
(known as companion units).  Controllers can run individually in standalone mode, but to
synchronize multiple controllers together, they must be directed either by a PC running Light-O-
Rama software, or by a director unit.

Standalone sequences may contain lighting commands for a number of different units.  A director
unit is a unit that is running standalone - i.e. not connected to a PC - that contains lighting
commands for other units cabled to it (the companion units).  The director unit can also control its
own lights, simultaneously.

There is no difference in the hardware of a director unit and a companion unit - the only difference is
the mode that they are in.

A PC running Light-O-Rama software can also be thought of as a director unit, in that it can send
lighting commands to Light-O-Rama controllers.  There must be one and only one director unit (or
PC running Light-O-Rama software) on a daisy chained group of controllers.

Hardware Utility

The Light-O-Rama Hardware Utility is a program that can be used to set up and test the hardware
used to control lights, as well as download sequences to standalone controllers or director units.

Phone Cable

Light-O-Rama controllers can be connected using either data cables or phone cables, but you
must know which type of cable you are using.  See data cables for details.

Preview
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A preview is a representation of your light display. It defines the lighting elements, how they are
arranged, and what channels they use. Creating a preview is required before you can create a
sequence. One preview can be associated with multiple sequences. Update the preview once, and
the next time you open any sequence associated with that preview, the update will automatically be
applied. The display elements in a preview are referred to as 'props'. You must add a prop to the
preview for every display element that you want to control. A prop could be a single string of lights, a
wireframe, an arch, a wreath, or a tree. In fact you can model just about any lighting element in a
preview.

The Sequencer program is used to create and modify previews.

Schedule

A schedule is a list of shows and the times at which those shows are to be played.

If the Light-O-Rama Control Panel is running on a PC, and its "Enable Schedule" option is turned on,
then the schedule will be monitored, and its shows will be started and stopped at the appropriate
times.

The Schedule Editor program is used to create and modify schedules.

Sequence

A sequence is a file that contains a set of lighting commands to be sent to Light-O-Rama
controllers.  There are two types of sequences: musical sequences, which have an associated
music or video file that is to be played at the same time, and animation sequences, which do not.

Before creating a sequence, you must create a preview. The lights you can control in the sequence
are defined by the props in the preview.

Sequences can be grouped together into shows.

The Sequencer program is used to create and modify sequences.

Show

A show is a file that contains a number of sequences, and the order in which they should be played.

A schedule can be created to specify the times at which various shows should be played.

The Show Editor program is used to create and modify shows.

Standalone

A Light-O-Rama controller can be controlled by another controller (or a PC running Light-O-Rama
software), or it can control itself and/or other controllers, in standalone mode.  A sequence,
created using the Sequencer, can be downloaded to a standalone controller using the Hardware
Utility.  The controller can then be set up to run this sequence whenever it has power, or, if the unit
is a model with an internal clock, it can be instructed to run the sequence during a particular time.

A standalone controller whose sequence contains lighting commands for other controllers will
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transmit those commands to the other controllers.  In this case, the controller is known as a director
unit.

Unit

A unit is another term for a Light-O-Rama controller.  Each unit has a number of circuits, each of
which can be used to control lights independently of each other.  Each unit is identified by a unit ID.

Unit ID

Each unit has an identifier assigned to it, known as a unit ID.  When a lighting command is sent to
a unit, all of the units that are daisy chained together can see that command.  However, the
command contains a unit ID; only the units having that unit ID will act upon that command.

For Light-O-Rama controllers, the unit ID is a two characters, each of which can have any of the
values 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, and F.  For example, "01", "25", "37", "5C", "BD", or
"E2".  However, not all possible combinations are allowed: "00" and "F1" through "FF" are
disallowed.

Controllers other than Light-O-Rama controllers use different formats for their unit IDs.

Connecting the Lights Using Light-O-Rama Controllers

To connect lights using Light-O-Rama controllers, take the following three steps:

1. Determine the serial port and hook up a controller.
2. Select a unit ID.
3. Test the lights.

Step 1. Determine the Serial Port and Hook Up a Controller

Insert an SC485 converter into your PC's DB9 serial connector which you plan on using for the Light-
O-Rama network.  If you are using a USB/RS-232 converter, then make sure that it is properly
installed, and that the SC485 converter is connected.  If you're not sure what all this is about, simply
try to find a connector on the back of your PC that has nine pins and which will accept the SC485
adaptor.

Using a cable, connect a Light-O-Rama controller to the SC485 adaptor.  Make sure that the LOR
controller is powered on.  The LED in the controller should be blinking.

Using the Light-O-Rama Control Panel, start the Hardware Utility program.  In the Hardware Utility's
Setup Comm Port section, use the Auto Configure button.  This will cause the Hardware Utility to
look for the attached controller and determine which comm port is being used.

Step 2. Select a Unit ID

If your controller has unit ID selection switches, you can select its ID by adjusting the selectors to
the desired ID.  If your controller does not have these unit ID selection switches, then you will need
to set its unit ID by using the Hardware Utility:

To set the unit ID using the Hardware Utility, connect one and only one unit to the PC using the
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SC485 adaptor and a cable.  In the Set Unit IDs section, go to Set New Unit ID, select the ID that
you wish to use for the controller, and click the Set Unit ID button.  This button will only work on
new units that have never been assigned a unit ID (to change the unit ID of a unit that already has
one assigned, use the Change Existing ID section instead).

TIP: Assign unit IDs sequentially, starting at 01.  This will make maintenance of the units faster.

Step 3. Test the Lights

With the unit connected to the PC, attach lights and power the unit on.  In the Hardware Utility, click
the Refresh button in the top center of the screen.  After a short time, your unit should appear in the
dropdown list to the right of the Refresh button.  Select the unit, and you can then test the lights
using the various controls in the Test Unit's Operation section of the Hardware Utility.

TIP: Before clicking Refresh, set the Hardware Utility's Max Unit ID to as low a value as possible. 
This is the maximum unit ID of controllers that you plan on using (you can always change it to a
higher value if you add more controllers later).  Setting it to a low value makes the Hardware Utility
run faster (though it will not find any connected units with higher unit IDs).

Creating a Scheduled Lights Display

To create a lights display and have it run at certain times, take the following steps:

1. Make your sequences.
2. Make a show.
3. Make a schedule.
4. Turn on the Control Panel's "Enable Schedule".

Step 1. Make Your Sequences

Using the Sequencer, create the sequences that will be used in your show.

You can test how the lights will look for a sequence while in the Sequencer: Make sure Control
Lights is enabled, and that you have assigned the channels in the sequence to a controller that is
hooked up to your PC.  Then, click the play button (which is the green arrow in the toolbar).

Step 2. Make a Show

A show is a collection of sequences.  A show can be created using the Show Editor program.

Shows have several sections, each of which can have sequences:

Background: Sequences listed in the "background" section will be played for the entire
duration of the show.
Startup: Sequences listed in the "startup" section will be played when the show first begins.
Animation and Musical: After the "startup" sequences have completed, sequences in both of
these sections will run, until it is time for the show to stop.
Shutdown: When it is time for the show to stop, the "animation" and "musical" sequences
will stop running, and the sequences in the "shutdown" section will start.  Only after the
"shutdown" sequences are finished will the show truly end.
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In the Show Editor, you can add sequences to any of these sections by selecting the appropriate
section's tab, and hitting the big PLUS button.  

After you have created your show, you should save it using the "Save" or "Save As" button.  Assign
the show a meaningful name - this is the file name that you will be using in the next step.

Step 3. Make a Schedule

Unlike sequences, you cannot run a show interactively.  Instead, to test a show, put that show into
a schedule, using the Schedule Editor program:

In the Schedule Editor, click the Add button, and select the show file with the name that you
created in the previous step.  Select a start and end time that will allow the show to start at a
convenient time for you to view it.  Then click Save to save your schedule.

Step 4. Turn On the Control Panel's "Enable Schedule"

To view the scheduled show, turn on the "Enable Schedule" option in the Light-O-Rama Control
Panel.  Doing this will cause the Control Panel to monitor your schedule, and start and stop your
show at the appropriate times.

2 What's New?

What's New in the Latest Version

What's New in Version 5.2.4
What's New in Version 5.2.2
What's New in Version 5.2.0
What's New in Version 5.1.4
What's New in Version 5.1.2
What's New in Version 5.1.0

What's New in Version 5.2.4

LOR Hub now supports all SD card options
LOR Hub can now turn off SD card schedule days if desired
Improvements in LOR Hub for creating SD cards with PC configuration
Simple Show Builder is being removed with the next release
Superstar Improvements
Sequencer Improvements
Sequencer Bug Fixes
Bug Fixes

LOR Hub now supports all SD card options
The LOR Hub program can now create SD cards with a full range of options, including triggers, filler
sequences, starter sequences, etc.  In a future release, SD card building will be removed from the
Hardware Utility and the Simple Show Builder will be removed from the suite.  
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LOR Hub can now turn off SD card schedule days if desired
Previously there was no way to stop an SD card show from running on a particular day, except by
using a workaround of setting the start and end times for a particular day the same.  LOR Hub can
now properly turn OFF a schedule for a particular day.

Improvements in LOR Hub for creating SD cards with PC configuration
When creating an SD card in Advanced mode in Hub, a new option has been added to configure the
MP3 Director's ports the same way as those ports are defined on the computer.  This can help with
ease of setup of MP3 directors.

Simple Show Builder is being removed with the next release
LOR Hub has taken over all functions of the old Simple Show Builder program.  In the next release
this program will be removed from the suite.  Instead, use LOR Hub to create your shows.

Superstar Improvements

Added support for group modify of "average time length of effects" and "skip inactive grid squares"
Added the "Do Scene Thinning" option in the "Move or Scale Selected Effects" dialog box
Added "Orientation" setting in the Preferences dialog box
Added support to convert 6 channel star effects to white effects on RGB stars from other vendors
(previously it only worked for the standard 200 pixel RGB star)

Sequencer Improvements

All 3 windows on the Motion Effect Generator now update simultaneously, which is also a
performance improvement. Previously they could update slightly out of sync for very large props.
Requested by Light-O-Rama.

If the user selects Create Playback Files from the menu and the sequence hasn't been saved, the
user is now offered a chance to save it (without having to cancel, save the sequence, then try and
create playback files again).  Requested by user ndutton.
http://forums.lightorama.com/topic/48065-reduce-the-clicks/

Enhancement: when opening a sequence, archived props will automatically be un-archived if a prop
with the same name has been added back to the sequence's preview since the sequence was last
opened. Same logic will also apply when you change the preview assigned to a sequence.
Requested by Light-O-Rama.

Enhancement: more accurate conversion when assigning a different preview to an existing
sequence. Requested by Light-O-Rama.

Performance improvements to the Picture motion effect. Requested by user jamills706.
http://forums.lightorama.com/topic/48263-spinning-orange-circle-forever/

In the New Animation Sequence dialog, show the sequence length as words, and give a warning
when OK is clicked and the length is more than an hour. Requested by user Rabeiler.
http://forums.lightorama.com/topic/48288-animation-sequence-will-not-preview/

In the sequence grid, the drop-down list of grid views would previously display views in the order they
were created. Now, the system grid view (Show All Items) is listed first, and then user-created grid
views are listed in alphabetical order. Requested by user Jade Rymkos.
http://forums.lightorama.com/topic/48687-is-there-a-way-to-reorder-grid-views/

http://forums.lightorama.com/topic/48065-reduce-the-clicks/
http://forums.lightorama.com/topic/48263-spinning-orange-circle-forever/
http://forums.lightorama.com/topic/48288-animation-sequence-will-not-preview/
http://forums.lightorama.com/topic/48687-is-there-a-way-to-reorder-grid-views/
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Increased the maximum number of bulbs in a bulb shape to 999. Requested by users dibblejr and
gsmith37064.
http://forums.lightorama.com/topic/48682-moving-s4-to-s5/

In the Paste Special dialog, you can now specify the spacing between horizontal copies. A negative
value yields an overlap, a positive value leaves a blank space between each copy. 0 is always the
default value (it is not remembered between uses). Requested by user spascall.

Added new "hold" effect, which freezes the state of the prior effect. For example, you can freeze and
unfreeze a spiral effect to the beat of the music by alternating spiral and hold effects on the same
motion effect row. The hold effect must be touching the prior effect to work. Requested by Light-O-
Rama.

In Prop Definition, added "Arm Thickness" parameter to the Star shape. A value of 1.0 is the normal
thickness. Smaller values make the arms thinner. Requested by Light-O-Rama.

New tab on Sequencer Preferences that allows the user to choose among 3 edit cursors. Previously,
only the yellow pencil was available. Requested by user bdwillie.
http://forums.lightorama.com/topic/48787-sequencer-pencil-pointer/

"Custom Chase" options are now available on the toolbar via a new drop-down arrow next to the
chase button. The chase options will also get saved with the sequence, and recalled the next time
the sequence is opened. Requested by Jack Richter via help desk.

Add the "+" shortcut key for the Repeat function (to match SE).  Requested by Light-O-Rama.

Added the Enter shortcut key to place an effect in the grid (to match SE). Requested by Light-O-
Rama.

Added option in preferences (Channel Effects tab) to view fades as ramps. Requested by multiple
users.

Added option in preferences (Channel Effects tab) to adjust background color of channel rows in the
grid. Requested at Christmas Expo.

In Prop Defintion's layout tool for custom and advanced shapes, there is a new "Crop" function that
removes extra rows and columns. Requested by Light-O-Rama.

Added Help buttons ("?" icon) to Preview Design, Prop Definition, Group Definition, and Custom Grid
screens. Requested by Light-O-Rama.

Increased the max width and height on the SimpleShape effect to 1000% in order to allow shapes to
expand beyond the prop boundaries. Requested by user Mike Baldwin.

Sequencer Bug Fixes

Bug fix: in the sequence grid, right-clicking on a "member props" or "member groups" node and
selecting "Hide Group Members" from the pop-up menu disabled further highlighting of prop names
as the mouse pointer was moved. Reported by John Johnson Jr via help desk.

Bug fix: in rare cases the Sequencer could crash if 1) the LOR Control Panel was running when the
Sequencer started, and 2) a Schedule was enabled or Show on Demand was running, and 3) the

http://forums.lightorama.com/topic/48682-moving-s4-to-s5/
http://forums.lightorama.com/topic/48787-sequencer-pencil-pointer/
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option to Control Lights when the Sequencer started was enabled. Reported by Jim Wright via help
desk.

Bug fix: S5 Verifier checked for application files that don't exist in S5, which resulted in "Message
Number 7" errors that were not really errors. Reported by stevehoyt, TitusCarnathan, richmuller and
others.
http://forums.lightorama.com/topic/47959-tc-72-verifier-losing-its-mind/
http://forums.lightorama.com/topic/47777-52-verifier-errors/

Bug fix: when using music to control a slider in the Motion Effect Generator, the audio data was
being pulled from the wrong part of the sequence. The effect used the correct audio data when
placed in the sequence grid -- the error was only when the effect was displayed in the Motion Effect
Generator. Reported by Light-O-Rama.

Bug fix: when you imported an S5 prop file in Preview Design, clicked the "Set Channels" button,
then changed the name of the prop while setting channels, the resulting list of props and groups to
lthe left of the design canvas would no longer be in alphabetical order. Reported by user ndutton.
http://forums.lightorama.com/topic/48041-preview-design-bugs-and-suggestions/

Bug fix: if a sequence gets moved to another folder or to another computer and the media file is in
the same folder as the sequence, then playback files created from the new location could point to
the wrong folder for the media file.  Reported by user ndutton.
http://forums.lightorama.com/topic/48059-missing-files-bugs-and-suggestions/

Bug fix: when the sequence length was changed, the sequence was not marked as containing
unsaved changes. Reported by Light-O-Rama.

Bug fix: in rare cases, effects could exist in sequences past the end of the sequence. When using
playback files for such sequences, the Show Player would refuse to play the song with the message
"ERROR STARTING SEQUENCE (Invalid end centisecond for last replacement event: 78195;
channel is 55210 centiseconds)". Reported by NJ Malenke and stevehoyt.

Bug fix: if Holiday Lights Designer was enabled in S4 and then the user upgraded to S5, the Show
Player would display errors in the log like "ERROR PLAYING SEQUENCE (Address in use Trace:
UDP SetIntensity Trace: HandleIO)". Reported by Derek Flint via help desk.

Bug fix: certain combinations of removing and renaming props in a preview could leave a sequence
unable to be opened (error message "An entry with the same key already exists"). Reported by
Michelle Lovering via help desk.

Fix crash when Windows policy "System cryptography: Use FIPS compliant algorithms for
encryption, hashing, and signing" is enabled. Reported by Dave Webb via help desk
https://support.microsoft.com/en-us/help/811833/system-cryptography-use-fips-compliant-
algorithms-for-encryption-hashi

The LOR SC485 serial port adapter (not USB) now works with the S5 Sequencer. Reported by
several users via the help desk.

Fixed the online import of "Boscoyo ChromaStar 36 3 ring".  Reported by Mike Baldwin via help
desk.

Bug fix: in the Motion Effect Generator, double-clicking on a slider did not fully unlock it. Reported
by Light-O-Rama.

http://forums.lightorama.com/topic/47959-tc-72-verifier-losing-its-mind/
http://forums.lightorama.com/topic/47777-52-verifier-errors/
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http://forums.lightorama.com/topic/48059-missing-files-bugs-and-suggestions/
https://support.microsoft.com/en-us/help/811833/system-cryptography-use-fips-compliant-algorithms-for-encryption-hashi
https://support.microsoft.com/en-us/help/811833/system-cryptography-use-fips-compliant-algorithms-for-encryption-hashi
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Bug fix: in the Motion Effect Generator, effects with alpha transparency were not displayed correctly
in the left and right windows. The combined window was correct. Reported by Light-O-Rama.

Bug fix: if the user right-clicked on a cell in the sequence grid, and then right-clicked on another cell
in a different row, several cells in the clicked column would be selected. Reported by Light-O-Rama.

Bug fix: when doing Repeat, then Undo, then Redo, the Redo was done in the wrong place.
Reported by Light-O-Rama.

Fixed a bug with clipboard files, where files created as part of the "Papagayo to LOR" process could
not be pasted. Reported by Dennis Holliday via the help desk.

Bug fix: in the Control Lights window, unchecking a box for an enhanced LOR network or for DMX,
did not actually stop output from going to those networks. Reported by Light-O-Rama.

Other Bug Fixes

In LOR Hub and Hardware Utility, sequences with DMX Fades when written to the SD card could
cause the MP3 director to go out of sync.
LOR Hub was not able to properly create an SD Card schedule.  The schedule would always
revert back to the defaults instead of what the user specified.
LOR Hub would crash if the user attempted to create an SD card show with no sequences in the
create list.
During installation, the Post Install process was not creating 3 new superstar visualization
samples.
In Superstar, text masks were not working in visualizations where some of the mask is outside of
the matrix.
In Superstar, fixed a bug where the white color control was not appearing if the only white that
existed was in images.
In Superstar, changed it so you can do "merge intensity data files" even in the demo version
In Superstar, fixed a bug where scene pixels were getting clipped out if the clip region was on the
right half of the wrap around screen

What's New in Version 5.2.2

Updates to the Sequencer
Superstar 'Add +' button
Bug Fixes

Updates to the Sequencer

A "Where Used" function has been added to the File References dialog, so you can find the effect
that uses a missing reference. Requested by Michael Lenbom via help desk.

In the Prop Definition screen, when defining a "Tree 360 Up & Over" shape using pixels, the shape
diagram will now indicate the location of the first pixel on each string. Requested by Light-O-Rama.

The user now has control over how "smooth to fades" is applied with a new sub-menu: Sequence >
Smooth To Fade Level. This setting controls whether adjacent effects are merged together or not.
Previously, the level was fixed at the "mild" setting; however, with the mild setting it is impossible to
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create DMX intensities that are 2 steps apart (for example: 65, 63, 61). Requested by Drew
Hickman.

Updated the pencil icon to be more visible, and moved the tip to the upper left. Requested by Ernie
McAnally via help desk.

If the user had a Pro license, when they created Playback Files an intensity data file (.LID
extension) was always created. Now an intensity data file is only created if the sequence has props
that use DMX or Enhanced LOR networks. Requested by Light-O-Rama.

Added a "How Do I Get Started?" link at the top of the "Start Page". Requested by Light-O-Rama.

Superstar 'Add +' button

In the "Image Setup" dialog box, a new button was added called "Add +".  The "Add+" button adds
the current image to the image action, selects the next image, and bumps the time ruler selection
forward. This makes it easy to add a series of images for an animation.

Bug Fixes

In certain circumstances, LOR Hub could create a computer show with incorrect sequence
entries.  When enabling the show, LOR Show Player would not be able to find the correct
sequence.
In certain circumstances, LOR Hub could create an SD card with sequences that in the future
could not be edited.  The SD card would however work.
If a MotionPak in LOR Hub did not have the same upper/lowercase as the base sequence, LOR
Hub would not be able to find it.

What's New in Version 5.2.0

New Program:  LOR Hub
Updates to the Sequencer
Bug Fixes

New Program LOR Hub

A new program for the Showtime Suite has been added called 'Hub'.  Hub currently has 2 main
functions.   

1. It enables our new MotionPak technology which allows you to modify LOR Sequence Store
sequences for use with props the LOR Hardware Store will sell.  The first props will be 'Singing
Faces'

2. It is the replacement for Simple Show Builder.  Simple Show Builder is still available in this
release, however it will be removed in a future release.  If you previously used Simple Show
Builder you should move to Hub.  
Hub can create both simple computer shows, as well as SD card shows for MP3 directors.

In future releases, Hub will continue to grow and will be taking over all 'show' type functionality
including things like the Show Editor, Show Scheduler, and Building advanced SD cards for MP3
Directors from the Hardware Utility.  

Updates to the Sequencer
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If the content of the Start Page extends beyond the bottom of the window, the vertical scrollbar that
is displayed now spans the entire right edge of the window - making it easier to scroll. Reported by
Light-O-Rama.

Bug fix: if the user made the Start Page a floating window, then selecting Window > Reset Window
Layout would close the Start Page. Reported by Light-O-Rama.

The first 4 items on the Windows menu have been renamed: "View Playback Window", "Viiew
Motion Effects Window", "View Previews Window", and "View Control Lights Window". Also these
items will only be shown if the respective window is currently hidden ("X" in the upper right corner of
the window has been clicked). This should make it clearer what these menu items do, particularly
the Control Lights item. Reported by Light-O-Rama.

If the content of the Control Lights window extends beyond the bottom of the window, a vertical
scrollbar is now displayed. Reported by Light-O-Rama.

The Start Page can now be hidden, unhidden, and floated just like the Previews and Control Lights
windows. Reported by Light-O-Rama.

Bug fix: the TextPE effect did not display the text specified by the user. Reported by user Dave
Trollope via help desk.

Bug fix: if a sequence used video media and Loop At End was enabled for playback and video
playback was set for full screen, the video window would often get resized instead of remaining full
screen. Reported by user Bry.
http://forums.lightorama.com/topic/47295-video-playback-issue-in-shows/

When you right click on the sequence grid, there is a new sub-menu under Timing Marks > Insert
Timing at Selection, with options for Left, Right, and Both. This will insert timing marks at the left
and/or right edge of the grid selection. Reported by user Luke Kamp via help desk.

Bug fix: on Preview Design's Channel Conflict tab, clicking a column heading in the conflict list
would crash the program. Now clicking a column heading sorts the table according to the values in
that column. Reported by Light-O-Rama.

On Preview Design's Channel Conflict tab, there are now fields for the user to enter text to filter the
list by name or by channel. A "Select All" checkbox was also added. Reported by Light-O-Rama.

When dragging a favorite or subfolder in the Motion Effect Generator, the favorites tree will now auto-
scroll when the cursor nears the top or bottom edge. Reported by user NJ Malenke via help desk.

Bug fix: when moving a timing mark with "Drag events with timings" enabled, the Sequencer could
crash in some cases. Reported by user Peter Dusaitis via help desk.

Bug fix: the "Create an empty freeform timing grid" check box on the New Animation Sequence
dialog did not actually create a freeform timing grid. Reported by Light-O-Rama.

You can now right-click on the Playback Window and change the brightness of the background
image (if there is one). Reported by Light-O-Rama.

RGB aggregates with one or more sub-channels (red, green, or blue) left undefined, could cause the
Sequencer to crash when modifying effects. Reported by user Keith Henrickson via help desk.

http://forums.lightorama.com/topic/47295-video-playback-issue-in-shows/
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Added new dimming curves to the Prop Definition screen: Linear_30pct, Linear_40pct,
PixelCurve_30pct, PixelCurve_40pct. Reported by user jamills706.
http://forums.lightorama.com/topic/47355-dimming-curves-question/

Windows Shell Commands get shared between sequences if you use File > Save As to create a
new sequence. Specifying a new command from the revised screen will only affect the sequence
that is open. Reported by user k6ccc.
http://forums.lightorama.com/topic/47372-windows-command-changes-affects-multiple-sequences/

In rare cases where 2 props in a preview have the same name, the entire preview file would not load
at startup. Now the preview is loaded and a warning about duplicate names is shown on the "Other
Warnings" tab of Preview Design. Reported by Light-O-Rama.

Fixed playback issues when sequences are arranged side-by-side. Reported by user NJ Malenke via
help desk.

A "Copy to Clipboard" function has been added to the File References dialog. For sequences with
many motion effect file references, this can allow you to paste the list of files into a spreadsheet or
word processor for further analysis. Reported by user Stephen Chapman via help desk.

Bug fix: title bar of Playback Window was not showing the name of the current motion effect when
one was clicked on in the sequence grid. Reported by Light-O-Rama.

During sequence playback, the Color Fade tool is now grayed out like the rest of the toolbar.
Reported by Light-O-Rama.

If a comm port is unable to be opened, added a tip to the error message: "Make sure shows are
disabled and the Hardware Utility is closed". Reported by user stevehoyt.
http://forums.lightorama.com/topic/47470-problem-enabling-comm-port/

Added new menu items when right-clicking on the Preview Design canvas: Add, Modify, Copy, and
Delete. Reported by Light-O-Rama.

Improvements when upgrading Pixel Editor previews and sequences to S5 for non-US customers --
problem occurred on PC's configured to use a comma as the decimal separator in numbers.
Reported by user Niklas Adolfsson via help desk.

Bug fix: When using the space bar in the Tapper Wizard --  if you go one tap past when the music
ends, the space bar defaults to the “exit” button and closes the wizard (thus erasing all of your
“beats”). Reported by user Steve Warner.

Bug fix: the Sequencer could crash when the toolbar channel effect was set to DMX Intensity and
you tried to add a motion effect. Reported by user Steve Warner.

Bug fix: clicking the Refresh button on the online prop import screen did not display the updated
data correctly. Reported by Light-O-Rama.

In Archived Prop Management, added button to select all props with no effects. Reported by Light-O-
Rama.

Bug Fixes
The Post Install process failed to copy 3 new examples for Superstar.

http://forums.lightorama.com/topic/47355-dimming-curves-question/
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The configuration for PixCon16 MKII devices was incorrectly showing 32 ports.  
In Superstar, if the preview uses horizontal orientation and you go into "floating windows" mode,
the program could crash.
In Superstar, the first time beat marks are created they are created without issue.  Creating beat
marks a second time incorrectly deleted them.
In Superstar, if you changed timings the program may not prompt you to save your work. 
In Superstar, when using Text Masks along with scenes or morphs, it was possible that the mask
was not applied.  
In Superstar, when using a Text Mask or an Image Mask, if Layer Priority was disabled,
foreground effects would be incorrect and background effects would not be rendered.
In Superstar, if the program was launched from S5 changes would not be saved if "Save" or "Save
As" was used to save the sequence as a .sup file.
In Superstar, when using Autosequence effects, the displayed timings may be incorrectly
changed to the most recently used Autosequence settings.
In Superstar, when using Autosequence if "average the time length of effects" was selected then
the last few seconds of an autosequence effect may not generate triggers. 
In Superstar, when using Autosequence if "Burst and Return" was used, there could be a compile
issue. This happens most frequently with low sensitivity settings such as 1 or 2.
In Superstar, when using Autosequence morphs with transparency set to transparent were not
being saved properly.
In Superstar, when shrinking using the pixel extender and smooth effects, the shrink did not occur
properly. 
In Superstar, the "Center X,Y" control in the Smooth Effects dialog box  the buttons were not
oriented properly when creating a horizontal sequencing grid.
In Superstar, if the pixel extender is enabled and a visualization with a sequencing grid was
imported with a "max length" , a crash could occur.
In Superstar, if the pixel extender is enabled and a sequence was being shunk, only half of the
effects would get applied.

What's New in Version 5.1.4

Registry Wipe can now clean Program Files folder
Updates to the Sequencer
Updates to SuperStar

Registry Wipe can now clean Program Files folder

Some versions of the LOR S4/S5 uninstaller can leave behind unwanted programs in the user's
Program Files(x86)\Light-O-Rama folder.  This can lead to installation problems the next time the
user tries to install the software.  Registry Wipe can now clean those entries up.

Updates to the Sequencer

Performance improvements:
1. The Sequencer starts about 20% faster. Reported by Light-O-Rama.
2. Improved the calculation time of Text and Picture effects. Reported by Light-O-Rama.

Countdown effect changes:
1. Added a "MM:SS" display option and allow a max of at least 1 hour. Reported by Light-O-Rama.
2. Text can now be positioned in both the X and Y directions. Forum request.
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Changes to Preview Design:
1. you can now double-click on a prop in the design area to open its Prop Defintion. Reported by

Light-O-Rama.
2. The "Tree 360 Spirals" shape could display an erroneous message regarding the number of folds

when the number of revolutions was set to a large number. This message has been removed and
the revolution limit restored to 25. Reported by Drew Hickman and user ukoberon. http://
forums.lightorama.com/topic/46953-spiral-360-prop-tree-issue-512/

3. Created new "Cylinder Spiral" shape for spiral-wrapped tree trunks and columns. Reported by
user jamills706. http://forums.lightorama.com/topic/46949-wrapped-tree-trunk-propmodel/

4. On the Prop Definition screen, if the diagram area was taller than it was wide, many of the shape
diagrams would overflow. Now they are properly scaled. Reported by Light-O-Rama.

5. Bug fix: a prop made of pixels that uses the "Tree 360 Spiral" shape could crash the Sequencer.
Reported by Light-O-Rama.

6. Bug fix: the Prop Definition window was expecting the "Arial Narrow" font to be installed, but that
font is not on all computers. On some computers this could cause the program to show a
continual stream of error messages. The program will now check if the font is installed before
using it. Reported by user Norm Bowman (via help desk).

7. The "Tree 360 Up & Over" shape now supports folds in the string. When used with pixels, the
layout has been redone to represent pixel strings that go up and over the top of the tree. Reported
by Drew Hickman and Jesse Tryon.

8. If there are any unsaved changes in the Preview Design screen and you click the Cancel button or
click the Windows "X" button to close it, then you will get a message confirming that you want to
continue without saving the changes. Reported by user Gordon Varney (via help desk).

9. You can now delete props from the Channel Conflicts tab in Preview Design. Select Change
Seleced Props > Delete Props. All of the actions on the Change Selected Props menu are also
now available by right-clicking on the selected props in the Channel Conflict list. Reported by
Light-O-Rama.

10.When copying a prop in Preview Design (Item > Copy), channels will no longer be renumbered if
the "Uses the same channels as" field is set on the source prop. Reported by Light-O-Rama.

Changes to freeform play ranges:
1. Bug fix: when you were defining a freeform range for playback and you moved the cursor to the left

- past the left edge of the grid - it cleared the selection. This made it difficult to select 0:00.00 as
the starting point. Reported by Drew Hickman.

2. The following menu items have been added when you right-click on the timeline or the waveform
(reported by user spascall): 

a. Set Play Range Start - if no freeform play range exists, it creates a range from the selected
point to the end of the sequence; otherwise it moves the start point of the existing range. 

b. Set Play Range End - if no freeform play range exists, it creates a range from the beginning of
the sequence to the selected point; otherwise it moves the end point of the existing range. 

c. Clear Freeform Play Range - clears an existing freeform play range.

Do not allow channels to be copied in the "Show All Items" grid view. This grid view is system generated
- items can be moved, but not hidden or copied. Reported by user daughjs.
http://forums.lightorama.com/topic/47021-cant-delete-duplicate-channel-button/

In the sequence grid, when you right click on a channel name for a prop that has multiple strings, a new
"Set Channel Name" option will appear. This capability will primarily help custom props with multiple
strings which get channel names like "Horatio Hornblower: r64 c31". The channel name will be stored
with the preview, so it will apply to all sequences that use that preview. Reported by Robert Brescia.

In the Skew All and Skew Selection commands, the maximum offset has been increased from 10
seconds to 600 seconds. Also, the user will now have the option of skewing the current timing grid or all

http://forums.lightorama.com/topic/46953-spiral-360-prop-tree-issue-512/
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freeform timing grids. Reported by user NJ Malenke.

Bug fix: changes made to the sequence while calculations are occurring (icon in the upper left is
spinning), might not be reflected during preview playback. Reported by user k6ccc.
http://forums.lightorama.com/topic/46930-modifying-motion-effects-sometimes-not-taking-the-change-
until-after-opening-and-saving-the-effect/

After clicking on a slider in the Motion Effects Generator, you can now fine-tune the value using the left
or right arrow keys. If the slider is unlocked, shift-left-arrow and shift-right-arrow can be used to change
the ending value. Reported by Drew Hickman.

When you right-click on the timeline or the waveform and select "Zoom In" from the menu, the zoomed
sequence grid is now centered on where the right-click took place. Reported by Light-O-Rama.

In rare cases, a preview could get saved that had a prop with an invalid circuit number (like 0). In prior
versions, this would result in a popup error message as the Sequencer opened; and if the preview were
subsequently opened in Preview Design could result in a crash. Going forward there is no popup
message when the program is opened. The preview can then be opened in Preview Design and the error
will be reported on the "Channel Conflicts" tab - where it can be corrected. Reported by Light-O-Rama.

Bug fix: you are no longer allowed to drag beat channels into the list of preview props and vice versa.
Reported by Light-O-Rama.

The 3 versions of the chase tool (intelligent, by prop, and by row) have been condensed into 2: regular
chase and custom chase. Regular chase is the same as intelligent chase (chase by prop when the first
row is a motion row, and chase by row for anything else) with the addition that the selected area for the
chase is now cleared. For a custom chase, the user is prompted whether they want to chase by row or
prop, and whether the selected area should be cleared. A new keyboard shortcut shift-H initiates a
custom chase. Custom chase is also accessible from the right-click menu. Reported by user spascall.

When exporting the grid configuration and "Show All Items" is the current grid view, the user will now get
a warning stating that "Show All Items" is a system-generated view and will not be included in the export
file. Reported by Drew Hickman.

In the Paste Special window, the "All the way to the end of" drop-down box now includes the last item in
the selection and the last row in the grid view. The last row in the grid view is now the default. Reported
by user spascall.

Bug fix: motion effects on props should override effects on groups that they are a member of. However,
that was not happening in all cases. Reported by user John Trp (via help desk).

Bug fix: the Fill tool would display the message "Trying to fill between effects, but the row is empty!"
when the sequence row was not empty. Reported by user lkcubsrule.
http://forums.lightorama.com/topic/47070-s5-fill-error/

Bug fix: Ampersands (&) in prop names would not display correctly in the sequence grid. Reported by
Light-O-Rama.

When playing back a sequence to real lights and when saving playback files, the Sequencer now
checks if motion effects have been placed on props connected to an LOR network that is not enhanced.
If so, then the action is cancelled until the condition is fixed. Reported by Light-O-Rama.

The music is only supposed to play one time when you click the play button in the Motion Effect

http://forums.lightorama.com/topic/46930-modifying-motion-effects-sometimes-not-taking-the-change-until-after-opening-and-saving-the-effect/
http://forums.lightorama.com/topic/46930-modifying-motion-effects-sometimes-not-taking-the-change-until-after-opening-and-saving-the-effect/
http://forums.lightorama.com/topic/47070-s5-fill-error/
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Generator. However, due to a bug, if the loop button on the toolbar for the sequence was enabled, it
would cause the music to repeat in the Motion Effect Generator as well. Reported by Light-O-Rama.

The Motion Effect Generator now has a mute button so users can turn off the music while creating their
motion effect. Reported by NJ Malenke.

When using the Max Intensity, Min Intensity, Fade Up, or Fade Down tools, the message "'Motion effect'
is selected on the toolbar, but no motion effect is currently displayed in the playback window. Would you
like to create an effect using the Motion Effect Generator?" will now only get displayed when motion
effect rows are part of the selection. If the effect shown on the toolbar is "motion effect" but only channel
rows are selected, then the toolbar effect is changed to the ON effect. Reported by Drew Hickman.

The checkbox to enable or disable looping of effects in the Motion Effect Generator has been replaced
by a toggle botton (press on, press off). Also, the loop icon shown there and on the sequence toolbar will
now show a red slash through it when disabled. Reported by Light-O-Rama.

Bug fix: when attempting to open a playback file (.play.lms), the program would display an error
message, then go ahead and open the file anyway. Now no attempt is made to open the playback file
after the error is displayed. Reported by Light-O-Rama.

Fixed the File References dialog so that long sequence names, media file names, and preview
background file names wrap if they extend beyond the width of the window. Reported by Light-O-Rama.

Updates to SuperStar

FEATURES:

Several new options and effects have been added to Superstar's Auto Sequence tool including
effects 'Folding Ricochet', 'Snake Up/Down', along with options to 'Skip Inactive Grid Squares' as
well as 'Average the Time Length of Effects'.
The Sequencer now sends the current timing grid to SuperStar when inserting a SuperStar effect.
This allows SuperStar to display the same timings as the Sequencer.

BUG FIXES:

Exporting as intensity data could cause the program to crash
Text masks and image silhouette masks were not keyed on their clip rectangle. Any effects that
fall entirely with in the mask's clip rectangle get applied to the mask.
In the Auto Sequence dialog box if the user did not select one of the 8 custom colors, a message
is now displayed.
When saving in the Demo version, the file added to the recent files dialog was incorrectly specified
as ',supe.sup'.
When saving in the Demo Version, the suggested filename was incorrectly defaulted to
'.supe.sup'.
In some cases, opening a valid .supe file would cause an error stating the file was not created on
this computer.
Improved export speed of sequences that use large Visualizations
Increased the number of images allowed from 1500 to 3000.
When automatic modification of Star Scenes occurred, it was incorrectly changing the archive
status of the file.
Increased the width of every 5th long tick mark on the edge of the sequence grid
In sequences with effect groups, after a 'select all' effect groups could no longer be expanded.
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Increased available memory for both 32 and 64 bit systems.
The number of channel elements has increased from 8 million to 50 million.
When using Single Step, if the stop button was pressed the first selected effect was not made
active.  This could lead to a warning or error.
Writing large images could cause the program to crash.
The number of fonts has been increased to 30 to allow for user created fonts to be used.
While using the Pixel Extender, if the Layer Priority feature was active pixels were extended too
far.
When using the Move or Scale effects tools after selecting effects that have a group in the
selection, the effects would not be applied.
When using the Move or Scale effects tools while in wrap around mode, some effects were not
wrapped properly.

What's New in Version 5.1.2

Updates to the Sequencer
Updates to SuperStar

Updates to the Sequencer

Sequence grid row height:
1. Bug fix: if the user repeatedly shrunk the row height in the sequence grid, they would reach

certain sizes where some prop/channel names did not get displayed. Now names are always
displayed, regardless of the row height. Reported by user ndutton.

2. Enhancement: depending on the row height, the Sequencer would choose one of 3 font sizes to
display prop/channel names with. Now it will choose among 4 font sizes - a new one was added
when the row height is extra tall. Reported by Light-O-Rama.

In Preview Design, renamed "Channel Conflicts" tab to "Channel Conflicts (and bulk change tool)" to
better reflect its functionality. Reported by Light-O-Rama.

Audio wizard changes:
1. Bug fix: when the VU Wizard was set to analyze only part of the song, it would still insert timing

marks and/or channel effects for the entire song. Reported by Light-O-Rama.
2. The default timing grid shown in the Beat, VU, and Tapper wizards is now the one currently

selected in the sequence grid. Reported by Light-O-Rama.
3. Improved performance when the Apply button is clicked in the Beat, VU, and Tapper wizards.

Reported by Light-O-Rama.
4. Bug fix: when clicking the "Start" button on the Tapper wizard, typing the space bar did not

produce taps. Reported by Drew Hickman and NJ Malenke.

Moved menu item Sequence > Audio Wizards > Add Beat Channel to Sequence > Add New > Beat
Channel. On the sequence grid's right-click menu, the Audio Wizards > Add Beat Channel item was
removed. Added item to the Grid View menu: Add New > Beat Channel. Reported by user Drew
Hickman.

Fixed multiple issues with the Renumber Strings dialog (accessed by going to Preview Design, Channel
Conflicts tab, Change Selected Props > Renumber Strings). Also added a "Reverse Order" button to this
dialog. Reported by user k6ccc. http://forums.lightorama.com/topic/46721-editing-channel-assignments-
information/

The "Other Warnings" tab in Preview Design will now display a warning when the channel assignments

http://forums.lightorama.com/topic/46721-editing-channel-assignments-information/
http://forums.lightorama.com/topic/46721-editing-channel-assignments-information/
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for a master prop and sub-prop are out of sync. A sub-prop has the "Uses the same channels as" field
populated in the Prop Definition screen. Reported by user k6ccc. http://forums.lightorama.com/
topic/46721-editing-channel-assignments-information/

Renamed the opening "Sequences" tab page to "Start Page" to better reflect its purpose. Reported by
Light-O-Rama.

Enhancements to the Prop Definition window:
1. All shape parameters are now displayed in a single column list and a scroll bar will be displayed if

the list does not fit in the available space.
2. There are no longer separate tabs for the "Custom" and "Advanced" shapes. The grid to edit those

shapes is now accessed from a button which opens a separate window -- giving the user much
more screen space to edit custom props.

3. A thumbnail view is now displayed for Custom and Advanced props in the lower portion of the
Shape section.

4. The delete key can now be used to clear cells on the grid when editing a Custom or Advanced
shape.

5. The last shape you used to create a new prop is now remembered and set as the default the next
time you create a prop.

6. The Save and Cancel buttons were moved to the upper left corner to be consistent with the
Preview Design window. 

New shapes in Prop Definition:
1. Tree 360 panels. This can model large commercial trees that are assembled by tiers, and those

tiers are broken into panels/branches. The shape assumes each panel has its own set of
channels and that every panel is lit the same way. Requested by user Drew Hickman.

2. Tree 360 tiers. Also known as "Z trees". This shape does not support RGB pixels. Requested by
user spascall.

3. Sphere and Cylinder shapes. These can be configured to display 1, 2, 3, or all 4 quadrants
(vertical sections). The Tree 360 Wedges shape was also updated with a parameter to choose the
number of quadrants it displays. Requested by user stevehoyt and others. http://
forums.lightorama.com/topic/46771-how-to-define-prop-for-tree-shaped-like-a-globe/

If there are no existing previews, the Upgrade Sequence screen now disables the choose existing
preview option. Reported by Light-O-Rama.

The sequence upgrade process now does a better job of handling inconsistent settings on RGB
channels. Previously, some situations could cause the Sequencer to crash. Reported by user Val
Bennett.
http://forums.lightorama.com/topic/46800-upgrading-sequence-error-from-s4-in-s5/

During the sequence upgrade process, warnings about subsequence channels now include the channel
name. Reported by Light-O-Rama.

Adjusted the size and layout of the New Animation Sequence and New Musical Sequence dialogs so
they display correctly when the "Visual Effects" tab of Window's Performance Options dialog is set to
"Adjust for best performance". Reported by user John Hall.

Adjusted the wording of items in Preview Design's "Add New Item" dialog. Reported by Light-O-Rama.

Changes to motion effects:
1. Removed the align left, center, and right buttons for the Text effect -- as they did not have any

effect on actual lights. Reported by user k6ccc. http://forums.lightorama.com/topic/46834-feature-

http://forums.lightorama.com/topic/46721-editing-channel-assignments-information/
http://forums.lightorama.com/topic/46721-editing-channel-assignments-information/
http://forums.lightorama.com/topic/46771-how-to-define-prop-for-tree-shaped-like-a-globe/
http://forums.lightorama.com/topic/46771-how-to-define-prop-for-tree-shaped-like-a-globe/
http://forums.lightorama.com/topic/46800-upgrading-sequence-error-from-s4-in-s5/
http://forums.lightorama.com/topic/46834-feature-request-horizontal-position-offset-in-motion-effects/
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request-horizontal-position-offset-in-motion-effects/
2. Added TextPE effect that exactly replicates theÂ S4Â Pixel Editor's text effect to improve

sequence upgrades. Adjustments to text effects in upgraded sequences are no longer required.
Note there are now 2 text effects in S5: "Text" and "TextPE". Reported by Light-O-Rama.

3. Renamed the "Full Length" option in the Movie effect to "Movie Length Matches Sequence
Length". Reported by Light-O-Rama.

4. Bug fix: when inserting a new motion effect, the Motion Effect Generator window could be
calculating the effect "None" (blank screen) even though the selection in the drop-down box
showed a different effect. This only occurred when Sequencer Preferences > Motion Effects >
"When opening, initialize from the current toolbar effect and color" was unchecked. Reported by
Light-O-Rama.

5. Bug fix: in some cases the bulb size slider control on the Motion Effects Generator could
disappear. Reported by Light-O-Rama.

6. Bug fix: the scanner effect could cause an error during effect calculations and result in the play
buttons not being enabled. Reported by Chris Reynolds and Eric Brown.

7. There is no longer a delay when you first open the Motion Effects panel until thumbnail images
appear. Reported by Light-O-Rama.

On the grid's toolbar, the Motion Effects and SuperStar tools are now only visible when the user has a
PRO level license. Reported by Light-O-Rama.

Added a warning when trying to use the Fill tool on an empty row. Reported by Light-O-Rama.

If the current toolbar effect is set to "Motion Effect" when the Color Fade tool is selected, the toolbar
effect is now automatically changed to "On". Reported by Light-O-Rama.

Updates to SuperStar

FEATURES:

Added "Snake Up" and "Snake Down" as movement options in the Auto Sequence dialog box
Added "skip inactive grid squares" option in Auto Sequence dialog box
Added "Average the Time Length of Effects" option in Auto Sequence dialog box

BUG FIXES:

Fixed a bug where an encrypted file from previous versions would not read in if it has groups or
timings in it.
Added a check for "Full Range" color mode if launched from a SuperStarRequest. If in "Full
Range" mode, SuperStar forces "Balanced" mode and adjusts all the color values to be 100 or
less.
Made it so every 5th long tick mark on the edges of the sequencing grid is thicker.
Fixed a bug where if you had effect groups in a sequence and you did "select all" then you could
no longer expand the effects in the effect groups
Doubled the amount of memory SuperStar can use This prevents memory errors when compiling
large sequences.
Fixed a bug where writing out a large image could cause the program to crash.
Fixed it so the Auto Sequence movement options work properly with pixel speeds other than 1.00

What's New in Version 5.1.0

Initial production release of S5 ShowTime Designer Pixels.

http://forums.lightorama.com/topic/46834-feature-request-horizontal-position-offset-in-motion-effects/
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3 Feature Comparison

The Light-O-Rama software package must be registered, with a valid license, in order to be used to its
full potential.  Each license contains two separate types of license levels: the main license level and the
SuperStar license level.

The main license level covers all of the Light-O-Rama software package except for the Light-O-Rama
SuperStar Sequencer.  Several different main license levels exist, each having different features: Basic,
Basic Plus, Standard, Advanced, and Pro.  Additionally, there is an unlicensed Demo version (which is
the same as the Basic version, except that it cannot be used to actually control lights, and has
encrypted save files).

The SuperStar license level covers the Light-O-Rama SuperStar Sequencer.  Its possible levels have
names such as 2_CCR, 24_CCR, 60_CCR, and the like, indicating the number of Cosmic Color Ribbons
you can use with SuperStar.  Additionally, there is an unlicensed Demo version which does not allow
export to an actual sequence.

Any reference in this help file to a "license level" or "feature level" refers to the main license level, not to
the SuperStar license level, unless specifically noted otherwise.

You will be given a chance to register your Light-O-Rama software at the time that you install it.  To
register after that time, or to upgrade to a higher level license, please see the "Register Light-O-
Rama" (or "Upgrade Light-O-Rama") menu item on the Sequencer's Help menu, or on the Control
Panel's popup menu.

The following chart summarizes what features are available with each license level, with details on each
feature listed below the chart.  

If a feature is listed as "(demo mode)", it means that the feature can be used with this license to see
what it's like, but it won't be fully supported.  For example, if you try one of the Sequencer's demo mode
features while building a sequence, you won't be able to save your changes to that sequence.  Please
see the details for each feature for exactly what "demo mode" means for that feature.

If a feature is listed as "(S4, not S5)", it means that the feature is support in version 4 of the Light-O-
Rama Software Suite, but support has been dropped in version 5.

Any features not listed here are available with all license levels.

FEATURE DEMO BASIC BASIC PLUS STAN
DARD

ADVA
NCED

PRO

Number of LOR
Units Supported

0 2 4 8
UNLIMI

TED
UNLIMI

TED

Number of Grid
Views Supported

2 2 2 4
UNLIMI

TED
UNLIMI

TED

Full Access XML
Data Storage

No YES YES YES YES YES

Beat Wizard (demo mode) (demo mode) YES YES YES YES

VU Wizard (demo mode) (demo mode) YES YES YES YES

Video Playback
(Windowed No No YES YES YES YES
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FEATURE DEMO BASIC BASIC PLUS STAN
DARD

ADVA
NCED

PRO

Mode)

Show On
Demand

No No YES YES YES YES

Schedule Shows
Based on Day of

Year

(demo mode) (demo mode) YES YES YES YES

Startup
Sequences in

Shows

(demo mode) (demo mode) (demo mode) YES YES YES

Shutdown
Sequences in

Shows

(demo mode) (demo mode) (demo mode) YES YES YES

Background
Sequences in

Shows

(demo mode) (demo mode) (demo mode) YES YES YES

Sequence in
Sequence

(demo mode) (demo mode) (demo mode)
(demo
mode)

YES YES

MIDI File Wizard
(demo mode) (demo mode) (demo mode)

(demo
mode)

YES YES

Triggered
Interactive
Sequences

(demo mode) (demo mode) (demo mode)
(demo
mode)

YES YES

Show Startup
Options

No No No No YES YES

Execute Windows
Shell Commands

No No No No YES YES

Full Screen Video
Playback

No No No No YES YES

Multiple Networks No No No No YES YES

Create Protected
Sequences

No No No No YES YES

DMX Intensity No No No No YES YES

Native DMX
Devices

Supported

No No No No YES YES

Dasher
Controllers
Supported

No No No No
(S4,

not S5)
(S4,

not S5)

X10 Controllers
Supported

No No No No
(S4,

not S5)
(S4,

not S5)

Digital IO Cards
Supported

No No No No
(S4,

not S5)
(S4,

not S5)

BSOFT Digital IO
Cards Supported

No No No No
(S4,

not S5)
(S4,

not S5)

Motion Effects Create Favorites Create Favorites Create Favorites Create Create Create
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FEATURE DEMO BASIC BASIC PLUS STAN
DARD

ADVA
NCED

PRO

Favorit
es

Favorit
es

favorite
s and
use in
sequen

ces

Intensity Files
and Enhanced

Networks

No No No No No YES

Number of LOR Units Supported

Except for the Advanced and higher license levels (which support an unlimited number of Light-O-
Rama controllers), each license level will send lighting commands to a limited number of Light-O-
Rama controllers: Basic supports a single controller, Basic Plus supports four, and Standard
supports eight.  

Whether a particular controller is supported or not depends on its unit ID.  For example, the Basic
license level will send lighting commands only to unit ID numbers 1 and 2, while the Standard
license level will send lighting commands to any unit that has a unit ID between 1 and 8.

Regardless of whether a particular unit will be sent lighting commands, you can always use the 
Sequencer to build sequences using that unit; Light-O-Rama simply will not control the lights for that
unit unless you upgrade to a higher license level.

The unlicensed Demo version will not send lighting commands to any controllers, so you cannot use
it to actually control your lights.

Number of Grid Views Supported

A sequence may have multiple grid views; however, certain license levels will only support a limited
number of grid views in any given sequence.  The Demo, Basic, and Basic Plus levels support 2 grid
views per sequence, Standard supports 4, and Advanced and higher support an unlimited number of
grid views per sequence. The system grid view "View All Items" is not counted toward the limit.

You will not be able to add new grid views to a sequence if it already has the maximum supported
number.  However, you can still open sequences that have more grid views (for example, a sequence
that was created by someone who has a higher license level than you do).  In this case, the extra
grid views can be displayed in the Sequencer, but you will not be able to modify them.

Full Access XML Data Storage

When a sequence is saved using a licensed version of Light-O-Rama, its save file uses a standard
XML format, which is designed to be understandable by people.  Technically advanced users may
feel comfortable editing these XML-based sequence files directly with a text editor, or even building
their own tools that can be used with these files (although please be careful when doing so, as it is
not terribly difficult to make a small mistake which may render the sequence file incomprehensible
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to the Light-O-Rama software package).

On the other hand, when a sequence is saved using the unlicensed Demo version, it is saved
encrypted, and so the file itself cannot be easily understood or modified by anyone or anything
except the Light-O-Rama software package.  Additionally, data from an encrypted sequence cannot
be copied and pasted, except on the computer that the sequence was originally encrypted on.

No matter whether a sequence is saved using the open XML format or using encryption, the Light-O-
Rama software itself will still be able to use it.

If you create an encrypted sequence using the unlicensed Demo version, and later purchase a
license, you can unencrypt the sequence by resaving it on the same computer it was originally
encrypted on, using your licensed version of the software.

Beat Wizard

The Beat Wizard can be used to analyze a song to try to determine its tempo, and to automatically
place timings and lighting effects into a sequence based upon that tempo.  It is fully supported in
license levels Basic Plus and higher.

It is not supported in license level Basic (nor in the unlicensed Demo version).  However, you can
still try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be
able to save your changes.  You will be given a warning about this when you try it, along with a
chance to back out before committing to using it.  Additionally, if you do decide to use it, and your
sequence already has unsaved changes, you will be given a chance to save them before you
actually use this feature.

VU Wizard

The VU Wizard can be used to analyze a song to find peaks in the audio - much like a VU meter -
and to automatically place timings and lighting effects into a sequence based upon those peaks.  It
is fully supported in license levels Basic Plus and higher.

It is not supported in license level Basic (nor in the unlicensed Demo version).  However, you can
still try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be
able to save your changes.  You will be given a warning about this when you try it, along with a
chance to back out before committing to using it.  Additionally, if you do decide to use it, and your
sequence already has unsaved changes, you will be given a chance to save them before you
actually use this feature.

Video Playback (Windowed Mode)

You can build musical sequences based on audio files (such as MP3) or on video files (such as
WMV).  When a musical sequence is played, the sound will always play, but the actual video (or
audio visualization) will only be displayed for license levels Basic Plus and higher.  License level
Basic will not display video (or audio visualization).

Additionally, your license level may or may not support video playback in full screen mode; see "Full
Screen Video Playback" for details.
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Show On Demand

Using license level Basic Plus or above, you can cause a show to be played without having
scheduled it.  This is done via the "Show On Demand" menu item of the Light-O-Rama Control
Panel's popup menu.

Schedule Shows Based on Day of Year

The Light-O-Rama Schedule Editor can be used to schedule shows to play in two different ways: by
the day of the week (such as "from 6:00 PM to 9:00 PM on Friday") or by the day of the year (such
as "from 9:00 AM to 9:00 PM on December 25th").  

However, scheduling based on the day of the year is fully supported only in license levels Basic
Plus, Standard, and Advanced.

Using the Basic license level, you will still be able to use the Schedule Editor based on the day of
the year in a sort of "demo mode" to see what it is like, but the Light-O-Rama Show Player will not
actually play shows that are scheduled this way - it will only play shows that were scheduled by the
day of the week.

Startup Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections.  Among
these is the Startup Section.  Sequences in the Startup Section are played immediately upon the
show starting up, one at a time, in order.  After all of them have been played, the main portion of the
show (i.e. the Animation Section and the Musical Section) begins.

However, this section is fully supported only with the Standard or higher license levels.

Using the Basic and Basic Plus license levels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like.  However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Startup section; instead, the show will simply begin
play directly with the Animation Section and the Musical Section.

Shutdown Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections.  Among
these is the Shutdown Section.  When the scheduled end time for the show is reached, the main
portion of the show (the  Animation Section and the Musical Section) stops, and the sequences in
the Shutdown Section are then played, one at a time, in order.  After they have all finished, the show
is truly finished.

However, this section is fully supported only with the Standard or higher license levels.

Using the Basic and Basic Plus license levels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like.  However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Shutdown section; instead, when the scheduled end
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time for the show is reached, the Animation Section and the Musical section will stop, and the show
will be over.

Background Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections.  Among
these is the  Background Section.  All sequences in the Background Section will play
simultaneously, looping back to their starts when they reach their ends, throughout the entire course
of the show.

However, this section is fully supported only with the Standard or higher license levels.

Using the Basic and Basic Plus license levels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like.  However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Background Section.

Sequence in Sequence

Sequences can themselves contain subsequences - a parent sequence containing a child
sequence.  The parent sequence can be set to start or stop the child sequence at any given point
during play.

However, subsequences are only fully supported with the Advanced license level or higher.

Using other license levels, you will still be able to use subsequences in a sort of "demo mode", to
see what they are like, but you will not be able to save changes to your sequence after having done
so.

MIDI File Wizard

The MIDI File Wizard can be used to automatically insert timings and lighting effects into a musical
sequence that is based upon a MIDI song.  For example, it can make your lights chase each other
in time to the music, or turn certain channels on or off based upon what notes are being played.

However, the MIDI File Wizard is fully supported only with the Advanced license level or higher.

Using other license levels, you will still be able to use the MIDI File Wizard in a sort of "demo
mode", to see what it is like, but you will not be able to save changes to your sequence after having
done so.

Execute Windows Shell Commands

Using the Advanced license level or higher, Light-O-Rama can optionally tell Windows to execute
any arbitrary command that you specify when a particular sequence is started.  An example of how
this might be used: If you broadcast the songs playing during your show over the radio, you might
set your sequences up so that they tell Windows to tell your RDS ("Radio Data System") program
to also broadcast the name of the song, allowing people with RDS-enabled radios to see the name
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of the song currently playing in your show.

Triggered Interactive Sequences

In addition to being able to control lights, some Light-O-Rama controllers can also accept input,
acting as triggers to start particular sequences on demand during a show.  For example, as part of
your display, you could have several buttons for people to push, each of which will play a particular
song.

However, this feature is fully supported only with the Advanced license level.

Using other license levels, you will still be able to use this section in the Show Editor in a sort of
"demo mode", to see what it is like.  However, the Light-O-Rama Show Player will not actually play
any sequences which are triggered during your show.

Show Startup Options

Normally, the sequences in a show will start playing immediately at the show's scheduled start
time.  The Advanced license level or higher allows more control over this; for example, you could
hook a big red button labeled "Start the Show" up to one of your Light-O-Rama controllers, and the
show will not start until that button is pushed.

For details, please see "Show Startup Options".

Full Screen Video Playback

When a musical sequence is based upon a video file (such as a WMV file), the Advanced license
level  or highercan show the video in full screen mode (and similarly, it can show full screen audio
visualizations for musical sequences based upon audio files).

Lower license levels cannot show full screen video (or full screen audio visualizations), but they may
still be able to show video and visualizations in a window instead of in full screen.  See Video
Playback (Windowed Mode) for details.

Multiple Networks

The Light-O-Rama Software Package can send lighting commands to Light-O-Rama controllers over
several different Comm ports simultaneously.  This has several potential uses, especially for people
with large numbers of controllers, or lights spread out physically far from each other.

However, this is supported only in the Advanced license level or higher.  Other license levels will
send lighting commands to Light-O-Rama controllers only over a single Comm port.

Create Protected Sequences

The Light-O-Rama Sequencer can be used to create protected sequences, which are sequences



Feature Comparison 35

© 2019 Light-O-Rama, Inc.

which cannot be modified (generally speaking) or viewed in the Sequencer, but which can still be
played, control lights, scheduled in shows, and so forth.

However, this is supported only in the Advanced license level or higher.  Other license levels can use
protected sequences, but cannot create them.

DMX Intensity

Light-O-Rama allows the possible intensity of most lighting effects ranges from 0 to 100, i.e. a
percentage of full intensity.  DMX devices, however, are capable of taking 256 different intensities
(from 0 to 255), rather than 101.  Light-O-Rama supports this possibility via the DMX Intensity tool.

However, this is only supported in the Advanced license leve or higherl.  Other license levels will not
have access to the DMX Intensity tool.

Native DMX Devices Supported

The Advanced license level or higher can send lighting commands to DMX devices, in addition to
Light-O-Rama controllers.  Lower license levels can only send lighting commands to Light-O-Rama
controllers.

Dasher Controllers Supported

These controllers are not supported in the S5 version.

X10 Controllers Supported

These controllers are not supported in the S5 version.

Digital IO Cards Supported

These controllers are not supported in the S5 version.

BSOFT Digital IO Cards Supported

These controllers are not supported in the S5 version.

Motion Effects

Motion Effects can be fully used only with the Pro license level.  Lower license levels can use the 
Motion Effect Generator to test effects and save those effects as favorites, but they cannot be used
in sequences.
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Intensity Files and Enhanced Networks

The Pro license level can use intensity files and enhanced LOR networks.  These can help with
displays involving very large numbers of independent lighting elements.  Lower license levels cannot
use these features.

4 Light-O-Rama Concepts

Light-O-Rama allows your computer to control your lights and other equipment in synchronized displays.
 Such a display is organized into several levels:

At the lowest level, a sequence contains commands to be sent to your Light-O-Rama hardware, which
will actually control your lights.  For example, a sequence might contain a command to turn on one
string of lights while making another string twinkle, and two seconds later, fading the first string down
while fading the second string up.  A sequence can contain commands for many circuits.  

A sequence contains commands to control lights

Typically, people build a sequence per song that they want in their display (known as musical
sequences), each one containing all of the lighting commands for its particular song.  People also build
animation sequences, not associated with any particular song, and often build one for each independent
part of their display - for example, one animation sequence to control a group of snowmen having a
snowball fight, and another to control a tin soldier firing a cannon.

Sequences can be grouped together into shows.  A show allows several sequences to be played at the
same time, or sequentially, or in random order.  A show can contain different sections - for example,
some sequences might be played only at the beginning of a show, others only at the end, others in
between, and still others for the entire duration of the show.



Light-O-Rama Concepts 37

© 2019 Light-O-Rama, Inc.

A show contains sequences to be played together, or in order, or randomly

Finally, shows can be scheduled to be played at certain times.  Only one show (at most) can be playing
at any given time, but any number of shows can be scheduled for different times, and the same show
can be scheduled to play at many different times.

A schedule is used to play shows at specific times

4.1 Sequences

A sequence is a set of commands to be sent to lights - for example, a sequence may command the
lights to turn on when the sequence starts, turn off a second later, stay off for a tenth of a second, start
twinkling for the next two seconds, and then fade up, from completely off to completely on, during the
next three seconds. The Light-O-Rama Sequencer is used to create and modify sequences. 

Key Sequencing Steps
The Sequence Grid
More Information

Key Sequencing Steps

There are several key steps in the sequence process as shown in the flowchart below:

Create a preview
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Create a sequence
Save a sequence
Create playback files

Create a Preview

A sequence can control multiple sets of lights independently of each other.  Each set of lights should be
hooked up to a particular circuit on a particular controller; each such circuit is referred to as a "channel".
 Channels are assigned to props, and props are part of a preview. Every sequence is associated with a
single preview, and that preview determines the set of channels the sequence can control. A preview can
be associated with multiple sequences.

In the example above, the 3 sequences are all assigned to the "Christmas 2018" preview. Each
sequence will have 4 props that can be controlled: Window, Door, Eaves, and Gutter.
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Not only do you assign channels to a prop, but you also assign a shape to each prop. This lets you
draw and arrange your lights in a way that resembles your actual display.  When you play a sequence in
the Sequencer and display its preview, the drawing will behave just like your lights will - the props in your
drawing will turn on and off, fade up and down, and so forth.

A preview with Window, Door, Eaves, and Gutter props

Create a Sequence

There are two types of sequences: animation sequences and musical sequences.  Musical sequences
are associated with songs (or sound effects, videos, etc.); the lights can be made to turn off and on (and
do other effects) in sync with the music.  Animation sequences are not associated with songs.  Many
sequences can be played simultaneously, but at most one musical sequence can be playing at a time -
all others must be animation sequences.  This means that you can control some of your lights in sync
to a song via a musical sequence, while simultaneously controlling other lights independently, via
animation sequences.

You can create a new sequence:

from the File Menu, 
by clicking links on the Start Page, or 
by right-clicking on a preview name in the Previews Window.

You can also create an S5 sequence by upgrading a sequence created in a prior version.

Save Your Sequence

It is important to save your sequence often so you don't lose any work if your computer crashes or you
lose power. It is also a good idea to make backup copies of your sequences to a flash drive or to the
cloud. The Sequencer's Save Copy options can be configured to make time-stamped backup copies
every time you save.

S5 sequence files use a different file extension than prior versions:

S5 Sequences Prior Versions

Musical Sequences LOREDIT LMS

Animation Sequences LOREDIT LAS



Light-O-Rama v5.2.440

© 2019 Light-O-Rama, Inc.

 Sequence File Extensions

S5 sequence files (LOREDIT extension) cannot be written directly to an MP3 Director's SD card or used
to create a show. To do that, you need to create playback files first.

Create Playback Files

When you have finished your sequence, you must create playback files. If you create playback files, but
then go back and make additional edits to your sequence or to your preview, you will need to create
playback files again. Playback files have a ".play.lms" extension for musical sequences, and a
".play.las" extension for animation sequences. Once the playback files are created, you can use them
to:

download an animation sequence to a controller for standalone playback
create an SD card for an LOR MP3 Director, for playback without a computer
package sequences together into a show, using the Show Editor, and then schedule shows to be
played at certain times using the Schedule Editor.  The Show Player (if enabled, via the "Enable
Schedule" on the Light-O-Rama Control Panel) will monitor your schedule and play your shows at
the appropriate times.

The Sequence Grid

Here is an example of a simple sequence containing 4 props, as represented in the Sequencer. The
props are listed down the left side and a timeline is displayed across the top.  As time passes (from left
to right), you can see that the Window prop is turned on, then it is turned off and the Door prop is turned
on, then that is turned off and the Eaves prop is turned on, and so forth, through the 4 channels:

A simple sequence with a fixed timing grid

Timings

The vertical lines in the sequence grid, representing distinct points in time, are known as timings.  These
timings do not have any direct effect on how your lights will look; instead, they allow you to select time
ranges for lighting effects to happen, using various tools in the Sequencer.

Timings are grouped together into timing grids.  There are 2 types of timing grids: fixed and freeform. In a
fixed timing grid, all of the timings are a fixed distance apart and the timings cannot be moved, deleted,
or added to. In a freeform timing grid, timings can be at any location, and can be moved, added, and
deleted. A sequence can have more than one timing grid.  For example, here is the same sequence, but
now with a freeform timing grid displayed:
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A simple sequence with a freeform timing grid

Note that the timings in this freeform grid are not the same distance from each other.  Also note that the
timings and the effects do not line up with each other - there is no reason that they would have to.  This
is so as to allow flexibility in where effects can be applied, without cluttering the display with many
timings.  

For example, perhaps you might want a sequence to have some effects that follow the drum beats in a
song, and other effects that follow the lead guitar.  You could simply add timings representing both the
drum beats and the guitar to a single timing grid, but if you do, it could be difficult to remember which
timing is for which instrument; also, the display might become cluttered with so many timings.  So,
instead, you could put the timings for the drums into one timing grid, and the timings for the guitar in
another timing grid, and use the drop-down box to easily switch between the two timing grids as
appropriate.  The effects that you add using the timing grid for the drums will not necessarily line up with
the timing grid for the guitar, nor the effects added using the timing grid for the guitar with the timing grid
for the drums, but neither should they.

Grid Views

A grid view is the group of props displayed in the sequence grid.  A sequence can contain multiple grid
views.  Each grid view can have its own props, or can share props with other grid views, or both. There is
one system-generated grid view call "Show All Items" - it automatically shows all props in the preview.
You can change the order of the props displayed in the "Show All Items" grid view, but you cannot
remove items from it.

Grid Rows

The sequence grid can display several types of grid rows:

Regular channel rows have a gray background and control a single output channel
RGB channel rows have a black background and are used for props composed of RGB lights that
can display any color
Motion effect rows are only available with a Pro license. They allow you to apply color patterns to
a prop made of RGB pixels. Motion effects can also be applied to groups of pixel props. Motion
effects can be created using the Motion Effect Generator or the SuperStar Sequencer (SuperStar
is licensed separately).
Animation sequences (but not musical sequences) can be set up to use loops.  When playing a
sequence that contains a loop, when the end of the loop is reached, the sequence will jump back
to the beginning of the loop.  It will do this a certain number of times (that you specify), and then
will continue past the end of the loop.  Each time that it jumps back, you can make it go through
the loop faster, slower, or the same speed as before.  There can be many loops in a sequence
(set up for different time ranges), and loops can even contain other loops.
Musical sequences can contain beat channels, which are intended to hold sequence effects
related to the beat of the music. They are merely a sequencing convenience and do not control
lights.
A sequence can also contain another sequence as a subsequence.  The subsequence can be
turned on or off at different points in the main sequence, and its effects will play only when it is
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turned on.
A sequence can contain effects for props that were once part of the preview, but have since been
deleted. These are called archived props.
A sequence can contain RGB aggregates which aid in the conversion of effects from props made
of traditional lights to RGB channels or motion effect rows.

A prefix symbol is added to certain types of grid rows to help identify them. Here is a master list of
symbols used:

More Information

For more detailed information on sequences, please refer to the following sections:

The Sequencer
Previews
Animation Sequences
Musical Sequences
Grid Rows
Channels
Timings
Effects
Archived Props
RGB Aggregates
Freeform Play Range

4.1.1 Previews

A 'Preview' is a representation of your light display. It defines the lighting elements, how they are
arranged, and what channels they use. Creating a preview is required before you can create a
sequence. 

A preview can be a quick rough sketch, or a detailed, highly realistic depiction of your display. It is up to
you to decide how much effort you want to put in to it. In any case, the preview must define every
channel that will be controlled by your sequences.

When you play a sequence using the Sequencer, you can also watch the sequence's preview in the
Playback window.  The drawing will change as if it were the lights that the sequence controls - that is,
parts of the drawing will turn on and off, fade up and down, twinkle, and shimmer, just as the sequence
commands.
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Props

The display elements in a preview are referred to as 'props'. You must add a prop to the preview for every
display element that you want to control. A prop can be as simple as a single channel string of
traditional lights, or as complex as a big pixel tree or matrix. When you create a prop, you define the
type and color of lights that it uses, its shape, and the channels assigned to it. If one of the built-in
shapes doesn't meet your needs, then you can define a custom shape.

A sample of some of the shapes that come built-in to S5

Groups

Props can be grouped together. 
You might do this so that the props appear together in the sequence grid. 
You might also create a group so that you can apply an effect to the group instead of individual
props. This enables things like sweeping a color across your entire display.

Background Image

A preview can be assigned a background image (for example, a photo of your house), which you can
draw the lights on top of. The brightness of the background image can be adjusted from within the 
Sequencer.

One Preview > Many Sequences

One preview can be associated with multiple sequences. Update the preview once, and the next time
you open any sequence associated with that preview, the update will automatically be applied. 
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Importing a Preview

You don't necessarily need to create a preview from scratch. S5 can import an existing display definition
from a variety of sources.

Import an S4 Visualizer
file

You can perform the
import from the Preview
Management window,
when upgrading a
sequence, or from within
Preview Design
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Import a block-style
animation defined in a
legacy sequence

You can perform the
import from the Preview
Management window, or
when upgrading a
sequence

Import an S4 Pixel Editor
preview

Pixel Editor previews are
automatically upgraded to
S5 previews the first time
you run the S5 Sequencer

Import a preview from an
S5 sequence sent to you
from someone else

Each S5 sequence
contains a backup copy
of the preview it uses.
When you open an S5
sequence that has been
sent to you, the copy of
the preview inside the
sequence will
automatically be imported
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Convert any legacy
sequence to an
automatically generated
preview. The preview won’t
look like your house, but
channel information will
be set correctly and it will
allow you to get started
with your sequencing right
away.

You can auto-generate a
preview when upgrading a
legacy sequence, or by
using the Quick Preview
feature when creating a
new S5 sequence.

The Preview Design Window

Previews are modified using the Preview Design window. It can be accessed several ways:

To create a preview, go to the Previews window and click the "+" icon.
To modify a preview, go to the Previews window and double-click on a preview name.
To modify the preview for an open sequence, click the preview name on the sequence's toolbar
and select Preview Design from the drop-down menu; or you can select Preview Design from the
Sequence menu.

For details on how to create and modify previews, please see the Preview Design topic.
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The Preview Design window with lights drawn on top of a background photo of a house

4.1.2 Animation Sequences

An animation sequence is a sequence that is not associated with a song (or video, or other audio file). 
This is as opposed to a musical sequence.

There are some other differences between animation sequences and musical sequences:

Animation sequences can contain loops, which musical sequences cannot;
Various song-related tools such as the Beat Wizard, MIDI File Wizard, VU Wizard and Tapper
Wizard are only available for musical sequences.
Animation sequences cannot contain beat channels.
Generally speaking, only one musical sequence can be played at a time (although there is an
exception to this, described in the help page on musical sequences), whereas many animation
sequences can be played simultaneously.

You can convert an animation sequence to a musical sequence by simply setting the media file via 
Sequence > Media File.

In S5, animation sequences and musical sequences have the same file extension (LOREDIT). This is
different from prior versions, where animation sequences had an LAS extension and musical sequences
had an LMS extension.

To create an animation sequence in the Sequencer, use the New Animation dialog.
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The New Animation dialog

4.1.3 Musical Sequences

A musical sequence is a sequence that is associated with a song (or video, or other audio file), allowing
you to synchronize the song with lighting effects.  This is as opposed to an animation sequence.

There are some other differences between animation sequences and musical sequences:

Animation sequences can contain loops, which musical sequences cannot;
Various song-related tools such as the Beat Wizard, MIDI File Wizard, VU Wizard and Tapper
Wizard are only available for musical sequences.
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Musical sequences can contain beat channels.
Generally speaking, only one musical sequence can be played at a time (although there is an
exception to this, noted below), whereas many animation sequences can be played
simultaneously.

The exception to the rule that "only one musical sequence can be played at a time" is that musical
sequences put into any section of a show other than the musical section are, effectively, treated as
animation sequences.  That is, their associated songs will not be played, and more than one of them
can be played simultaneously.

You can convert a musical sequence to an animation sequence with the Sequence > Convert to
Animation menu item.

In S5, animation sequences and musical sequences have the same file extension (LOREDIT). This is
different from prior versions, where animation sequences had an LAS extension and musical sequences
had an LMS extension.

To create a new musical sequence in the Sequencer, use the New Musical Sequence dialog.
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The New Musical Sequence dialog

4.1.4 Channels

A channel is a particular circuit on a particular controller which can control lights (or servos in the case
of the Servo Dog controller).  The Sequencer can be used to assign effects to channels, to make the
lights turn on and off, fade, shimmer, twinkle, and so forth.
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Regular Channels

Single channels can control a string of traditional incandescent or LED lights, or a single-color flood
light, or perhaps some strobe lights. We will refer to these as "Regular Channels" to distinguish them
from "RGB Channels".

A single channel from an AC controller

RGB Channels

An RGB channel is a group of three channels - a red channel, a green channel, and a blue channel. By
varying the amount of red, green, and blue light, any color can be produced. A device may have a single
RGB channel, like an RGB flood light (sometimes referred to as "dumb RGB"); or it can have many RGB
channels, like a Cosmic Color Ribbon (sometimes referred to as "Smart Pixels").

Mixing red, green, and blue light

Pixels

Pixels are just a collection of RGB channels, 1 RGB channel controls one pixel. So a string with with 50
pixels would have 50 RGB channels. Light-O-Rama Pixie Controllers, as well as the PixCon16 controller,
are used to control pixels.
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Device Type

When defining a channel, you first start with the Device Type. Device type specifies the type of
commands the controller understands (i.e. command protocol). The S5 software can send commands
using the Light-O-Rama protocol and also the DMX protocol.

Light-O-Rama Protocol

When using the Light-O-Rama protocol, a channel has a unique combination of:

Network, which is the COM port that this channel's controller is hooked up to;
Unit, which is the unit ID of the controller, allowing different controllers to be distinguished from
each other;
Circuit, which represents an electrical circuit that can controlled. It could be a single output from
an AC controller, DC controller, or servo controller. Or a group of circuits could be used to control
a string of RGB pixels - one RGB channel per pixel.

DMX Protocol

When using the DMX protocol, a channel has a unique combination of:

DMX Universe, and
DMX Channel. There are 512 available channels in each DMX universe.

Assigning Channels

Channels are assigned to props in the Prop Definition screen within Preview Design. A preview is
assigned to a sequence, and the sequence can only control the channels defined in its assigned
preview.
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Network Preferences

There are 2 variants of the Light-O-Rama protocol: there is the non-enhanced protocol for "Gen 1"
devices and the enhanced protocol (ELOR) for "Gen 3" and later devices. 

There are also 2 variants of the DMX protocol: there is DMX sent over a USB adapter and DMX sent over
Ethernet (also known E1.31 and sACN).

Which variant to use as well as other connection properties are set using the Network Preferences
program.

4.1.5 Effects

The lighting effects available depend on the type channel:

Regular channels
RGB channels
Pixels

Effects for Regular Channels

On 

The "On" effect is just what it says - the light turns on. This could be the light turning on at full (100%)
intensity, or at some other intensity, or fading on, or fading off.

Twinkle 

The "Twinkle" effect causes your lights to quickly vary between on and off. The effect could be twinkling
at full (100%) intensity, or at some other intensity, or fading on, or fading off.

The difference between "Twinkle" and "Shimmer" is that twinkle is more random: Two different strings of
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lights that are both told to shimmer at the same time will quickly turn off and on in sync with each other;
if they are instead told to twinkle, they will still quickly turn off and on, but not in sync with each other.

Shimmer 

The "Shimmer" effect causes your lights to quickly vary between on and off. The effect could be
shimmering at full (100%) intensity, or at some other intensity, or fading on, or fading off.

The difference between "Shimmer" and "Twinkle" is that twinkle is more random: Two different strings of
lights that are both told to shimmer at the same time will quickly turn off and on in sync with each other;
if they are instead told to twinkle, they will still quickly turn off and on, but not in sync with each other.

DMX Intensity 

DMX devices receive values between 0 and 255. Most of the time it is sufficient to specify that a light be
turned on at 50% or 75% brightness - in which case the DMX Intensity effect is not necessary (the Light-
O-Rama software will handle the conversion between percentage and DMX value for you). However, there
are some DMX devices (moving head lights for example) where a precise DMX value is required. In these
cases, the DMX Intensity effect can be used to specify that value.

Effects for RGB Channels (also called dumb RGB)

For RGB channels, the 4 effects for regular channels (on, twinkle, shimmer, and DMX intensity) can be
applied in combination with a color or a color transition.

Effects for Pixels (also called smart pixels)

For pixels you have 3 options for creating effects. The S5 Sequencer allows you to mix and match all 3
approaches.

Assign colors to each pixel individually. This can be tedious work for display elements with more
than a few pixels. However, sequences for sale are sometimes delivered this way.
You can use the SuperStar sequencer (separate license required)
You can use the Motion Effect Generator that is built in to the Sequencer. Pro license required.

4.1.6 Grid Rows

When a sequence grid is displayed on your screen, each row in the grid will be of a certain type.
Different row types can hold different kinds of effects.

Regular channels
RGB channels
Motion Effect Rows
Subsequences
Beat channels
Loop Rows

Some row types are displayed with a symbol as a prefix to help identify the type of grid row. Here is a
summary of the symbols that are used:
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Regular Channels (non-RGB)

A channel is assigned to a prop, which belongs to the preview associated with the sequence. A
sequence can only control the channels defined in its associated preview. In order to add a channel to a
sequence, you must edit the preview using the Preview Design screen. Channel names and colors are
also derived from the preview, so changing the name or color requires a change to the preview.

The Sequencer is used to assign effects to channels, to make the lights turn on and off, fade, shimmer,
twinkle, and so forth.

In the Sequencer, channels are represented as horizontal rows.  On the left side of a row is the channel
name; on the right side is a grid showing what effects are assigned to the channel at what times. The
grid for a regular channel is displayed with a gray background. For example, the following sequence has
4 channels, and they are named "Window", "Door", "Eaves", and "Gutter".  Each one of them has an
"on" effect that turns the respective channel on at 100% intensity for 1/2 of a second.

A sequence with 4 channels
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See the Adding Effects topic for more details. To change an existing effect on a regular channel row, just
double-click on the effect and a pop-up window will prompt for the new effect. For example, you can use
this to change a twinkle to a shimmer.

Double-clicking on a channel's name brings up the Prop Definition dialog (which is part of the preview). 
This allows modifications to various things like the channel's name, color, unit, and circuit:

Prop Definition screen for the Window prop

Right-clicking on a channel's name brings up a popup menu with various channel-related tools:

Right-click menu
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Regular channel rows can be dragged up and down to rearrange their order.  This has no effect on your
lights; it only affects the order that they are displayed in the Sequencer. Each grid view can display
channels in a different order - changing the order in the currently displayed grid view does not change the
order in any other grid view.

When you play a sequence in the Sequencer, the area just to the right of the channel name flashes with
the color that you selected as it turns on and off; it will also fade up and down, shimmer, twinkle, and so
forth, just as your lights will.  You can change the width of the "color sample" area in the Sequence Grid
Preferences dialog.

RGB Channels

An RGB channel is a group of three channels - a red channel, a green channel, and a blue channel -
which can be combined to produce any color. A device may have a single RGB channel, like an RGB
flood light; or it can have many RGB channels, like a Cosmic Color Ribbon.  In the Sequencer, an RGB
channel is displayed with a black background.  Lighting effects on an RGB channel are represented in
the row as colors:

A sequence with an RGB channel followed by several normal channels

It is important to note that the colors displayed on your computer's screen in the Sequencer are not
necessarily the same colors that will appear on your actual lights, and in some cases may actually be
very different.  Different RGB devices may produce different colors when their constituent red, green, and
blue channels are set to the exact same intensities.  So, you may have to experiment a bit to figure out
colors as displayed in the Sequencer that wind up looking the way you want on your actual RGB
devices.

The primary tool for applying colors to an RGB channel is the Color Fade tool. This tool allows you to
specify a start color and an end color; when applied to a time range in the RGB channel, it will cause
that time range to gradually fade from the start color to the end color. 

Another tool which may be particularly useful for RGB channels is the Fill tool, which (on a normal
channel) allows you to click an empty area and cause it to become a fade from the preceding intensity
to the following intensity.  For example, if you have a normal channel which has a fade up from 40 to 60,
followed by the lights being off, followed by a fade down from 80 to 20, then applying the Fill tool to the
area where the lights are off will cause that area to become a fade up from 60 to 80 (because the effect
preceding the empty area ended at intensity 60, and the effect following the empty area started at 80). 
On an RGB channel, the Fill tool will instead cause a color fade from the preceding color to the following
color, allowing you to quickly set up smooth color transitions across several different colors.

The Chase and Repeat tools may also be of particular use on RGB channels.  The Chase tool causes
the lighting effects in a single channel (or RGB channel) to be applied through a range of following
channels (or RGB channels), offset in time a bit with each passing row, so that the effect seems to be
"chasing" through the channels (or RGB channels) as time passes.  The Repeat tool causes one or
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more copies of the lighting effects in your selection to be applied immediately following your selection.

Other tools, such as Max Intensity or Fade Up or Fade Down, can also be applied to RGB channels. 
Doing so will cause the tool to be applied using the current color shown on the toolbar.  For example, if
the toolbar color is solid blue, applying the Fade Up tool, with intensities 0 to 100, to an RGB channel
will cause the toolbar blue to fade up from 0 to 100, thus making the RGB channel itself fade from black
to blue.

To edit an effect on an RGB channel row, just double-click on the effect and a pop-up window will prompt
for the new colors and effect.

Double-clicking on an RGB channel's name brings up the Prop Definition dialog (which is part of the
preview).  This allows modifications to various things like the channel's name, unit, and circuit:

The RGB Channel Settings dialog

Right-clicking on an RGB channel's button will open up a popup menu with various channel and RGB
channel-related tools:
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Right-click menu

RGB channel rows can be dragged up and down to rearrange their order.  This has no effect on your
lights; it only affects the order that they are displayed in the Sequencer. Each grid view can display
channels in a different order - changing the order in the currently displayed grid view does not change the
order in any other grid view.

When you play a sequence in the Sequencer, the area just to the right of the RGB channel name is filled
with the color of the current effect; the same color as your lights will display. You can change the width
of the "color sample" area in the Sequence Grid Preferences dialog.

RGB channels are added to the sequence by adding props to the preview associated with the sequence.

Motion Effect Rows

Motion effect rows contain motion effects, which are moving color patterns applied to props (or groups of
props) built with RGB pixels. For example, there are motion effects for spirals, snowflakes, fireworks,
pictures, text, etc. 

You can only add motion effect rows to a sequence if you have a Pro level license. 

Motion effect on a pixel tree

Motion effects can be created using the Motion Effect Generator or the SuperStar Sequencer. The
SuperStar Sequencer requires a separate license. To edit an existing effect on a motion effect row, just
double-click on the effect -- the Motion Effect Generator or SuperStar Sequencer will open and allow you
to make changes to the effect.
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Motion effects can be displayed on lights connected to Enhanced LOR networks, as well as DMX
networks. They cannot be displayed on LOR networks that are not enhanced. Furthermore, they cannot
be used in a stand-alone sequence that is loaded into a controller.

Motion effect rows are displayed with a black background. The row names have a "∆" prefix. Effects on a
motion row alternate colors in order to show where one effect stops and the next effect starts. By default
the 2 colors are white and gray. So the first effect on a row will be white, the second effect gray, the third
effect white, etc. The colors shown on the grid have nothing to do with the colors that are used in the
effect.

3 motion effect rows

You can customize the alternating colors in the Motion Effect Preferences screen. Also on that
preferences screen, you can enable a feature that displays the first 4 letters of the effect's name on the
sequence grid. This can help identify the effect. Here is the same example with name display enabled.
You can see that the first row contains a series of Colorwash effects, the second contains Bars effects,
and the third row contains Spiral effects.

Motion effects w ith naming enabled

Motion effect rows are created automatically for pixel-based props and groups when you create a
sequence and set the "Default number of motion effect rows for pixel props" field to a number greater
than 0 (see the New Animation Sequence and New Musical Sequence dialogs). You can create them
later (or add more) by right-clicking on a prop, group, motion row, or channel name on the left side of the
sequence grid and selecting "Add/Modify Motion Effect Rows".
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You can remove a motion effect row by right-clicking on the motion effect row name and selecting
"Delete Motion Effect Row". You can do some bulk deletions by selecting Sequence > Delete Grid Rows
from the main menu.

Subsequences

A subsequence is a sequence that is used as a part of another sequence (its "parent sequence", or "the
main sequence").  Subsequences are displayed with a "§" prefix in the sequence grid.

A subsequence

A sequence grid row for a subsequence can be turned on and off, using the Sequencer, in the same
ways that other channels can be.  When the channel in the main sequence is turned on, the
subsequence will begin playing, from its beginning.  It will continue playing for as long as the channel
remains on; if play of the subsequence reaches its end before the channel has been turned off in the
main sequence, the subsequence will simply loop back to its beginning and continue playing.

When the channel in the main sequence is turned off, the subsequence will stop playing.  If the channel
is subsequently turned back on, the subsequence will start playing again, from its beginning (not from
the last point that it left off at).

In S5, the effects contained in a subsequence will be displayed in the playback window while the
sequence is being played. This is different from prior versions.

Tip: Do not set up the same physical unit and circuit to be a channel in a sequence and a channel in a
subsequence of that sequence (or two channels in two different subsequences of a sequence).  Doing so
will likely cause unexpected and undesired results, as the two channels compete for control over the
same physical circuit.

Note: If a sequence with a Windows shell command is used as a subsequence, that command will not
be executed.  Only the shell command associated with the main sequence (if any) will be executed.

A subsequence can be created by selecting "Subsequence" from the "Add New" item on the Sequence
menu or on the Grid View menu.
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Right-click on a subsequence's name and select "Modify Subsequence" to change its name, color, or
referenced sequence file.

Right-click on a subsequence's name and select "Delete Subsequence" to remove it completely from the
sequence.

Beat Channels

Beat channels are intended to hold sequence effects related to the beat of the music; however, you can
put any regular channel effect anywhere you want in a beat channel. Beat channels can only be added
to musical sequences and are shown with a "?" symbol as a prefix. Beat channels are not shown in the
playback window when the sequence is played and they cannot control real lights. Beat channels stay
frozen at the top of the sequence grid so they are always visible. You can add as many beat channels
as you want to a sequence, there are no limits.

If you have many beat channels in a sequence, you might not want to see all of them at one time - as it
could take up a lot of valuable screen space. You can control this by selecting the Beat Channel Row
Count item from the Grid View menu.

2 beat channels at the top of a sequence

Beat channels can be created:

Within any of the 4 audio wizards.
By selecting "Beat Channel" from the "Add New" item on the Sequence menu or on the Grid View
menu.
By right-click on an existing beat channel name and selecting "Add Beat Channel"

Right-click on a beat channel's name and select "Modify Beat Channel" to change its name and/or color.

Right-click on a beat channel's name and select "Delete Beat Channel" to remove it completely from the
sequence.

You can copy sequencing from a beat channel to other areas of your sequence using copy/paste.

Loop Rows

An animation sequence (but not a musical sequence) can contain loops.  When the Show Player or the
Sequencer plays a sequence with loops, when the end of a loop is reached, the sequence will go back
to the beginning of the loop. This will happen a certain number of times (which you specify), after which
the sequence will continue on past the end of the loop.



Light-O-Rama Concepts 63

© 2019 Light-O-Rama, Inc.

Each time through a loop, you can have the sequence speed up, slow down, or remain at the same
speed.

A sequence can contain many loops.  Loops can be nested - that is, a loop can contain other loops.

Loop rows are shown with a white background are fixed to the top of the sequence grid. They do not
scroll away when the rest of the sequence is scrolled vertically. 

For example, the following picture shows a sequence with a loop starting at 1 second and ending at 2
seconds. The number of times the loop will repeat is shown in the middle of loop (1 in this case). If the
loop were to speed up after each pass, then the repeat count would be followed by a "+" symbol.  If the
loop were to slow down after each pass, then the repeat count would be followed by a "-" symbol. In this
case the loop speed is set to stay the same, so no symbol is displayed.

A sequence with a loop starting at 1 second and ending at 2 seconds

See the Loops in Animation Sequences topic for more information.

4.1.7 Timings

Timings are the times in a sequence at which you can command the lights to do various effects - to turn
on, turn off, fade up, fade down, and so forth.  

Timings are represented in the Sequencer by vertical grey lines.  For example, the following sequence
has timings every half a second, at 0.5 seconds, 1 second, 1.5, 2, 2.5, 3, and so forth:

A sequence with timings every half a second

Timings do not have any direct effect themselves on the behavior of your lights; rather, they simply give
you a way to specify a start time and an end time for effects on a grid row.  You can fill the space
between two timings with an effect by selecting the appropriate tool (such as the "Fade Up" tool) and
clicking on a grid cell (see Adding Effects for details). For example, selecting the "Max Intensity" tool
and clicking the cell between 1 second and 1.5 seconds for the "Door" prop results in:
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The Door prop has been turned on, between 1 second and 1.5 seconds

Timings do not have to be equally spaced (as they are in the above example).  For example, the
following sequence has timings at 0.37 seconds, 1 second, and 3.2 seconds:

A sequence with timings at 0.37 seconds, 1 second, and 3.2 seconds

Timing Grids

A set of timings is known as a "timing grid".  A sequence can have more than one timing grid, with one
being shown at a time.  The timing grid that is currently shown can be changed by selecting from the
"Timings" drop-down box on the Toolbar.  There are two types of timing grids: fixed grids and freeform
grids.

Fixed Timing Grids

In a fixed timing grid, each timing is the same length of time from the next timing.  For example, a fixed
timing grid might have a timing every second, or every tenth of a second.

The timings in a fixed timing grid cannot be moved, deleted, or added to.

Freeform Timing Grids

In a freeform timing grid, timings do not have to be equidistant.  For example, a freeform timing grid
might have one timing at time 1.00 (i.e. one second), another half a second later at time 1.50, and
another 2.2 seconds past that at time 3.70.

The timings in a freeform grid can be moved or deleted, and new timings can be added.

Creating, Deleting, and Modifying Timings

Timings can be automatically inserted into a sequence when it is created, in a variety of ways.  For
example, you can tell the Sequencer to insert timings every so often - for example every half second, or,
for a musical sequence, insert timings based on the song itself using various tools like the Beat Wizard,
VU Wizard, Tapper Wizard, and MIDI File Wizard.  If you tell it to insert timings every so often (such as
every half second), it will create them in a fixed timing grid. If you tell it to use one of the audio wizards,
or not to insert timings, it will use a freeform timing grid.  Please see the New Animation dialog and New
Musical Sequence dialog for details. The audio wizards can also be run at any time after sequence
creation.
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The New Musical Sequence dialog

In a freeform timing grid:

Timings can be added during sequence playback by using the "T" shortcut key
Timings can be moved by clicking and dragging them.  This behavior can be turned on or off by
"locking" the timings.
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Timings can also be added, deleted, and resized in a variety of other ways. See these topics for more
information:

The toolbar's timings section
The Timing Mark sub-menu on the grid's right-click menu

4.1.8 Compressed Sequences

The layout of a Light-O-Rama sequence file is somewhat verbose.  This is intended to make it easier for
third party tools which use LOR sequence files to be created.  However, it has a drawback: Large
sequences may be fairly slow to load.  When loading a large sequence in the Sequencer, this may be
an inconvenience.  But the real problem is when loading a large sequence in the Show Player: It may
take several seconds, during which time your show is effectively paused.

To resolve this issue, Light-O-Rama supports the concept of a "compressed sequence".  A compressed
sequence is a separate save file, associated with a sequence but containing only enough information to
play the sequence in the Show Player, and optimized for loading speed.  This can speed up loading
times dramatically - for example, for a certain large sequence that takes eight seconds to load on a
certain computer, the associated compressed sequence only takes a small fraction of a second to load
on that same computer.

Light-O-Rama will automatically create compressed sequences whenever appropriate, and the Show
Player will automatically use them instead of the associated sequence file whenever they are present. 
So, you should not have to take any steps in order to start taking advantage of this feature.  You can,
however, prevent the Show Player from using compressed sequences (for example, if something
unexpected goes wrong with them), in which case it will simply use the sequences instead.  This can be
controlled through the LOR Control Panel's "Use Compressed Sequences" option.

Animation sequences which contain loops cannot be compressed.  All other sequences are eligible for
compression.

It is highly recommended that you manually ensure that each of your sequences has an up-to-date
compressed sequence built before starting your show. You can do this for an entire show or schedule via
the Sequence Compressor program.

Assuming that you do not turn "Use Compressed Sequences" off, the way that the Show Player handles
sequences and compressed sequences is this:

When your show calls for a certain sequence to be loaded, the Show Player will first check to see if
there is a compressed sequence associated with that sequence.  If so, and if the compressed sequence
is more recent than the sequence, it will load the compressed sequence instead of the sequence.

Otherwise, it will load the sequence.  After loading the sequence, it will check whether or not a
compressed sequence can be made for it, and, if so, it will create the compressed sequence.  This is so
that in future runs of the show, it can simply use the compressed sequence instead of the sequence.

4.1.9 Protected Sequences

A protected sequence is a sequence which, generally speaking, cannot be modified, and whose
sequence grid cannot be viewed in the Sequencer.  Protected sequences can, however, be played just
like any other sequence; they can be scheduled in your shows, they can be played in the Sequencer,
they can be downloaded as standalone sequences, and they will control your lights.
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There are some things about a protected sequence which can be modified:

The location of the media file (via Sequence > Media File)
The preview (via Sequence > Assign Different Preview)
The Windows shell command (via Sequencer > Windows Command)

To create a protected sequence, open the sequence which you wish to protect, and then select "Export
as Protected" from the File menu.  It will prompt you to select a file name for the protected sequence. In
S5, protected sequences have a different file extension than regular sequences: .LORPROT versus
.LOREDIT

The ability to create a protected sequence is available only with the Advanced license level or higher.

A protected sequence, as displayed in the Sequencer

4.1.10 Archived Props

What Are Archived Props?

Archived props are an inactive part of the sequence. They contain effects and can be displayed on the
sequence grid (they are shown with an "@" symbol as a prefix). Each archived prop has its own prop
definition that is not part of the preview. Archived props are not shown in the playback window when the
sequence is played and they cannot control real lights.

Archived props are a benefit because the sequencing on old props is preserved, allowing you to decide
what action to take and when.

4 archived props
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How Are They Created?

If an existing sequence is opened and contains information for props that are no longer part of the
preview, those props and their associated sequence are automatically converted to archive props. You
cannot create an archive prop manually. Scenarios where this might occur:

You are upgrading sequences for S4 and you created your preview by importing a Visualizer file.
However, there are some old channels in your sequence that you don't use any and were not in
the Visualizer file - and thus won't be in your S5 preview either. Those old channels in the
sequence will get archived because they are not in the preview.
You created an S5 sequence with a last year's preview (e.g. 2017 Christmas) and now you have
created a new preview for this year (e.g. 2018 Christmas). Your display has changed from last
year and you have retired a few props. If you assign the new 2018 Christmas preview to your 2017
sequences, then the sequencing for the retired props will be archived because they are no longer
in the preview.
You were working on this year's sequence (e.g. Sequence-A), which is currently closed. You edit
the preview and remove a prop because you decide you are not going to use it this year. When
you next open Sequence-A, the sequencing for the prop you removed from the preview will be
archived.

If you delete a group from the preview and your sequence had motion effects on that group, then the
group will be archived.

What Can You Do With Them?

You can do several things with archive props:

You can copy sequencing from the archive prop to other areas of your sequence using copy/
paste.
If the sequence for the archived prop is no longer needed, you can delete it by right-clicking on the
prop’s name and selecting "Delete Archived Prop".

Delete an archived prop directly from the sequence grid

From the Manage Archived Props dialog you can perform bulk deletions, convert archive props to
beat channels, or add them to your preview (making them a full-fledged members of your
sequence, capable of controlling lights).
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4.1.11 RGB Aggregates

What Are RGB Aggregates?

RGB aggregates allow you to combine any 3 existing channels (the channel colors don't need to be red,
green, and blue necessarily), and the combination of the 3 is treated as an RGB channel for sequencing
purposes. This can be useful for people who are converting sequences with traditional strings to RGB.

In rare circumstances the S5 sequence upgrade process may create an RGB aggregate, but generally
they are manually created as needed by the user.

RGB aggregates do not need to have channels assigned to all 3 slots (red, green, and blue). You could
create an RGB aggregate with just the green and blue slots assigned, for example.

In the following example, "Hoop 2" is an RGB aggregate consisting of red, white, and blue traditional
channels. The white channel "Hoop Wh 2" is placed in the aggregate's green slot. "Hoop 2" can be
sequenced as either an RGB channel or as 3 individual channels. Changes made to the RGB Channel
row are immediately reflected on the individual channels, and vice versa.

"Hoop 2" is an RGB Aggregate

How Are They Created?

RGB aggregate channels can be created:

By selecting "RGB aggregate" from the "Add New" item on the Sequence menu or on the Grid
View menu.
By clicking the "+" icon on the Manage RGB Aggregates dialog.

Right-click on a RGB aggregate's name and select "Modify RGB aggregate" to change its name and/or
its assigned channels.

Right-click on a RGB aggregate's name and select "Delete RGB aggregate" to remove it completely from
the sequence.

What Can You Do With Them?

Suppose that in last year's display you used several colors of traditional lights (bundles) on your roof
outline, and that this year you are replacing them with RGB pixels. You need to somehow change the
sequences you used last year to control the new pixels in this year's display. 
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Here are the steps:

1. Copy the preview for last year's display to a new preview.
2. Add the pixels for the roof outline to the new preview, without deleting the strings used the prior year.
3. Open last year's sequence.
4. Assign the new preview to the sequence.
5. Use Save As to give the sequence a new name
6. Create an RGB aggregate for the a bundle in the roof outline
7. Copy the RGB aggregate's RGB channel to the clipboard
8. If you have a Pro license, paste onto the motion effect row for the new pixels. If you have a lower level

license, select all of the RGB pixel rows and paste into the selected area.

4.1.12 Time Format

Whenever the Light-O-Rama Sequencer asks you for a length of time, you can generally specify hours,
minutes, seconds, and hundredths of a second.  You don't have to specify all of them if you don't want
to.

The general format is:

HH:MM:SS.hh

Where HH is hours, MM is minutes, SS is seconds, and hh is hundredths of a second.  You usually do
not have to type all of that in, though; for example, if you are concerned only with seconds, you don't
have to type in anything about hours, minutes, or hundredths of seconds.

The Sequencer also uses this same format whenever it displays a length of time to you.

The following examples show how to specify various lengths of time:

Length of Time Format

Ten seconds 10

Ten and 37/100 seconds 10.37

Three minutes and ten seconds 3:10

Three minutes, ten and 37/100 seconds 3:10.37

Seven hours, three minutes, and ten seconds 7:03:10

Seven hours, three minutes, ten and 37/100 seconds 7:03:10.37
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4.2 Shows

What is a Show?

A show is a collection of sequences, to be played as a set.  After creating sequences with the
Sequencer, you can build a show from them using the Show Editor.  Shows can then be scheduled
to play at certain times, using the Schedule Editor, and are then actually played by the Show
Player.

Assuming that your license level is at least Basic Plus, you can also cause a show to be played on
demand, without scheduling it, via the Light-O-Rama Control Panel.

There are six different parts to a show, each of which consists of sequences:

The Background Section
The Startup Section
The Animation Section
The Musical Section
The Interactive Section
The Shutdown Section

Each of these parts is optional.  For example, a show can be built having only a musical section and
a shutdown section.

By default, when a show is being played in the Show Player, any given sequence in the show will
not be loaded until when it is about to be played for the first time.  Depending upon the size of the
sequence and the power of the computer, it may take a human-noticeable amount of time to load a
sequence; if so, this may cause an undesired delay between sequences, the first time they are
played.  So, optionally, you can choose to preload all sequences before any of them are played.

Additionally, if your Light-O-Rama software license is for the Advanced feature level, you can modify
exactly how your show will start up - for example, immediately at its scheduled start time, or after a
certain circuit on a certain Light-O-Rama controller has been triggered (for example, by someone
hitting a "start" button).  See "Show Startup Options" for details.

Note that the duration of a show is not part of the show itself; rather, it is determined by the
schedule.

4.3 Schedules

What Is a Schedule?

The schedule is at the top of the Light-O-Rama schedule/show/sequence hierarchy:

The schedule is created and modified by the Light-O-Rama Schedule Editor, and played by
the Light-O-Rama Show Player.
It consists of shows, which are created and modified by the Light-O-Rama Show Editor.  The
schedule schedules these shows to be played at certain times.
Shows consist of sequences, which are created and modified by the Light-O-Rama
Sequencer.
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Sequences are composed of commands to be sent to your lights, producing various lighting
effects.

The schedule has two parts: the weekly schedule and the calendar schedule.  The weekly schedule
contains information on shows that should be played on a recurring, weekly basis - for example,
every Wednesday night from 7:00 PM to 10:00 PM.  The calendar schedule contains information on
shows that should be played once, at a specific date and time.

When the Light-O-Rama Show Player looks at the schedule to decide whether a show should be
played, it first checks the calendar schedule to see if it has any shows scheduled for the current
date and time.  If there are, the Show Player will play that show.  Otherwise, the Show Player will
check the weekly schedule.

Example

Suppose you have a single show which you want to play every Friday and Saturday night, from 7:00
PM to 10:00 PM, except for Christmas Eve (when you want it to run from 5:00 PM to 11:00 PM) and
Christmas Day (when you want it to run from 8:00 AM to 2:00 PM).  Then you would put the Friday
and Saturday shows into the weekly schedule, and the Christmas Eve and Christmas Day shows in
the calendar schedule.  The Light-O-Rama Show Player would then follow the weekly schedule on
every day except Christmas Eve and Christmas Day, when it would then follow the calendar
schedule.

Considerations

Unlike the Show Editor, which can be used to create many shows, and the Sequencer, which can
be used to create many sequences, the Schedule Editor only maintains a single schedule, and
the Show Player only uses that single schedule.
The Show Player will not play any scheduled shows unless it is started and scheduled shows are
enabled, via "Enable Schedule" in the Light-O-Rama Control Panel.
After modifying your schedule in the Schedule Editor, make sure to save it.  Changes to your
schedule will not be picked up by the Show Player until the schedule has been changed.

4.4 File Locations

The first time you start the Light-O-Rama software, you will be prompted for the name of the folder where
you want to store sequences and other related files. The default choice is to create a "Light-O-Rama"
sub-folder below your "Documents" folder, as shown below.
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Light-O-Rama Sub-folders

Regardless of where you choose to put the Light-O-Rama data folder, it will contain the following sub-
folders:
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Audio

The "\Light-O-Rama\Audio" folder is where you should store the media files (audio and/or video) that you
will use as the music track for your sequences. The advantage of storing them here, is that Light-O-
Rama programs will look for the media files here by default. If you move your sequences to a different
computer, or share your sequences with another user, as long as you store the media file here, Light-O-
Rama programs will always be able to find the media file without prompting.

Clipboards

The "\Light-O-Rama\Clipboards" folder is where clipboards for the Sequencer are stored when cutting,
copying, or pasting effects. Clipboard files have a ".LCB" file extension. Clipboard files created by third-
party programs should be placed in this folder.

CommonData

The "\Light-O-Rama\CommonData" folder contains a number of important files:
?

??Previews (LORPreviews.xml)
Motion Effect Favorites (LORFavorites.xml)
Color Fade tool favorites (LORGradients.xml)
Motion Effect Generator palettes (LORPalettes.xml)
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?

Hardware

The "\Light-O-Rama\Hardware" folder stores dimming curves that can be loaded into a controller.

ImportExport

The "\Light-O-Rama\ImportExport" folder is the default location for files exported from the Sequencer,
including previews, props, and motion effect favorites.

KeyMaps

The "\Light-O-Rama\KeyMaps" folder is not currently used in S5.

Logs

The "\Light-O-Rama\Logs" folder is not currently used in S5.

LORInternal

The "\Light-O-Rama\LORInternal" folder is used as temporary storage by some Light-O-Rama programs.
You should not make any changes to the items stored in this folder or any of its sub-folders. 

Network

Below "\Light-O-Rama\Network" folder is a sub-folder called "SavedConfigurations", where exports from 
Network Preferences are saved. These files have a ".LIV" extension.

Plugins

The "\Light-O-Rama\Plugins" folder contains sub-folders where files can be added to extend the
functionality of the Sequencer: 

prop shapes (not yet supported)
motion effects (not yet supported)
software dimming curves

Sequences

The "\Light-O-Rama\Sequences" folder is where your sequence files should be stored. S5 Sequence
files have a ".LOREDIT" extension.

SuperStar

The "\Light-O-Rama\SuperStar" folder contains files used by the SuperStar Sequencer.

Moving Files To A New Computer

If you move your Light-O-Rama software to a new computer, you should copy files in all of the sub-
folders noted above, with the exception of Logs and LORInternal.
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4.5 Hardware

Light-O-Rama can control your lights via Light-O-Rama controllers and Native DMX devices. The S5
version has dropped support for: Dasher controllers, Digital IO cards, BSOFT digital IO cards, and X10
controllers.

When a prop is created in a preview using the Sequencer, the kind of controller (known as "device type")
is assigned in the Prop Definition window. It can also be changed on the Channel Conflicts & Bulk
Changes tab of Preview Design.

4.5.1 Light-O-Rama Controllers

Light-O-Rama allows your computer to control your lights via a variety of hardware controllers.  Primary
among these are Light-O-Rama controllers.

Some Light-O-Rama controllers can also act as input triggers, allowing you to start particular sequences
on demand (such as when a person pushes a button).

Unit IDs

Each Light-O-Rama controller is assigned a unit ID.  A unit ID is an identifier for the controller, and is
two characters long, with each character being a digit (0-9) or a letter from A to F.  For example, 37,
25, 4B, C8, and DA are all valid unit IDs.  Some such combinations are reserved, though, and
should not be used for as a unit ID.  Specifically, 00, F1 through F9, and FA through FF are not valid
unit IDs.

Controllers will only react to lighting commands that are intended for their own unit ID; if two
controllers on the same network have the same unit ID, both will react simultaneously to the same
commands.  However, a unit set up to use input triggers must have its own unique unit ID, not
shared with any other unit, and must not be on an LOR Enhanced network.  Also, the Hardware
Utility may react strangely with respect to a unit ID which has more than one unit - for example,
detecting them as a single unit, or misdetecting them as some unknown controller type.

The unit ID of a controller is set in one of two ways, depending upon the type of controller:

Most controllers have physical switches on them that allow you to set the unit ID by moving the
switches.
Otherwise, the Hardware Utility can be used to select a unit ID for controllers without such
switches.

It is generally a good habit to assign your unit IDs sequentially starting at 01.  This is not necessary,
but it will speed up some maintenance such as configuring and testing your controllers in the 
Hardware Utility.

Circuit IDs

Within a controller, each string of lights is assigned a specific circuit ID.  This allows Light-O-Rama
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to make different lights do different effects at the same time, using the same controller.

Standalone Mode and Computer Controlled Mode

Light-O-Rama controllers can be set up in standalone mode, in which a sequence is downloaded to
them in advance via the Hardware Utility, or hooked up to your computer via a COM port, in which
case the Light-O-Rama Show Player will send them lighting commands (during scheduled shows),
or the Light-O-Rama Sequencer will (on demand for a single sequence).

A controller in standalone mode can also send lighting commands to other controllers that are
hooked up to it via phone lines or data lines, similarly to the way that the Show Player or Sequencer
would.  Therefore, in standalone mode, a sequence only needs to be downloaded (via the Hardware
Utility) to a single controller; the other controllers hooked up to it will receive their commands from it.

Only one source of lighting commands should be present in any group of controllers that are hooked
up to each other - either the Show Player, the Sequencer, or a single controller with a downloaded
sequence.  Having more than one source of commands will cause unexpected and undesired
results, as lighting commands will be missed or garbled.

Light-O-Rama Networks

The Show Player and Sequencer can control up to sixteen different networks of Light-O-Rama
controllers, each hooked up over a different COM port.  These networks are referred to as
"Regular" (which is the default), "Aux A", "Aux B", "Aux C", and so on, up to "Aux O".  

One main use of multiple networks is for displays with very large numbers of controllers; they enable
more lighting commands to be sent out at a single time.  They also allow you to set up a sort of star
network centered on your PC, rather than a single long daisy chain of controllers; both of these may
make such sequences perform more smoothly.

Another use is for displays whose controllers are hooked up using wireless communications, via a
Light-O-Rama Easy Light Linker.  Wireless communications has a lower top speed than wired, but
using multiple wireless networks allows commands to be sent over all of them simultaneously.  So,
depending upon how many controllers you have and how many lighting effects you send them during
your show, using multiple wireless networks could make your show perform more smoothly than
using a single wireless network.

It is simplest, though, to just use a single Light-O-Rama network, and in many situations, this is
perfectly sufficient.

Light-O-Rama networks can be either normal or "enhanced".

The COM ports represented by each of the networks can be set via the Light-O-Rama Network
Preferences program. For example, the following picture shows COM3 assigned to the Regular
network, COM12 assigned to auxiliary network Aux O, and the remainder of the networks
unassigned, with Regular (COM3) being an enhanced network:
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Multiple COM ports assigned to various Light-O-Rama networks

Enhanced Light-O-Rama Networks

A Light-O-Rama network can be an "enhanced" network (via the Advanced Mode of the Light-O-
Rama Network Preferences program).  This allows intensity files to be used for controllers on the
network, which can be especially helpful with displays having large numbers of channels and lighting
effects.  Intensity files do not have to be used, though; effects defined in regular sequence files will
still work fine on an enhanced LOR network.  In fact, effects from both a regular sequence and from
its associated intensity file can be used simultaneously.

A Pro level license is required to use this feature, and the Light-O-Rama Comm Listener must be
running in order for the lights to be controlled.  Not all controllers can be used on such a network,
and some controllers may require firmware updates before they are able to be used on an enhanced
network.  Also, input triggers are not supported on LOR Enhanced networks.

Assigning Circuits in a Sequence

When you add a controller to your display, you add the strings of lights attached to that controller as
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props in your preview using the Preview Design window.

4.5.2 Light-O-Rama Pixel Controllers

Light-O-Rama sells several different Pixel Controllers which support multiple different Pixel ICs.  The
Pixie 16, Pixie 8, and Pixie 4 controllers can support up to 100 pixels per port and fully integrate into the
existing Light-O-Rama network.

When you add a pixel controller to your display, you add the strings of pixels attached to that controller
as props in your preview using the Preview Design window.

4.5.3 Light-O-Rama PixCon16 Devices

With the introduction of the PixCon 16 controller, Light-O-Rama is now selling and supporting native
E1.31 devices.  These devices are configured from the Network Preferences program on the advanced
tab.  To start the configuration of LOR E1.31 devices, press the 'Find/Configure E1.31 devices' button.

When you add a PixCon 16 controller to your display, you add the strings of pixels attached to that
controller as props in your preview using the Preview Design window.

4.5.4 Native DMX Devices

In addition to Light-O-Rama controllers and various other types of controllers, Light-O-Rama can control
native DMX devices, either directly over a serial port and adapter or over ethernet via E1.31.

When you add a DMX device to your display, you add the controller's channels as props in your preview
using the Preview Design window.

Several DMX universes can be used, each having a unique universe number from 1 to 999.  Each should
be assigned a separate DMX adapter (such as an ENTTEC Open DMX USB adapter) or else E1.31
settings (such as IP address and port).  You can assign adapters or E1.31 settings to universes via the 
Network Preferences program.

Unlike other protocols (such as LOR), the DMX protocol requires that the LOR Control Panel be running
in order to actually control the devices.  The LOR Control Panel will, in turn, start up the LOR Comm
Listener.  When a program such as the Sequencer or Show Player wants to send a command to a DMX
device, it actually sends the command to the LOR Comm Listener, which in turn sends it out over the
adapter or E1.31 address assigned to the device's specified universe.

Note that you do not have to use the "DMX Intensity" effect on DMX channels.  You can, but you can
also use any other effect (such as Fade Up or Twinkle).  If you use a DMX Intensity effect, it will have a
natural DMX intensity range of 0 to 255.  If you use any other effect, it will have a range of 0 to 100, but
Light-O-Rama will automatically scale it to DMX's 0 to 255 range immediately before sending it out to the
actual DMX device.

4.5.5 LED Pixel and Node Terminology

When discussing individually addressable bulbs, there are many terms that can be used.  In an effort to
standardize these terms when dealing with RGB devices, Light-O-Rama defines the following:

'LED' (or 'Light'):  A single locus (point) of light.  One or more LEDs are part of a NODE.  LEDs (or
LIGHTs) are elemental - they can NOT be broken down further.
'Node':  A single processor for one or more LEDs.  Nodes are PHYSICAL.  Think of them as the
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processor chip on every individual LED/LIGHT.
'Pixel': A pixel is a collection of one or more NODEs.  Pixels are VIRTUAL, and controlled by a
single TRIPLET.  All nodes that are part of a pixel will react in the same way.  Pixels are the 'bridge'
between the physical world and the virtual (sequencing) world.
'Triplet':  A group of 3 CHANNELs that set the color of a PIXEL.  When we speak about a triplet we
do not specify the order of the CHANNELs.  For example, some pixels are in RGB order, while some
others could be in GRB order.   Either of those orders refer to the same triplet.
'Channel': A channel controls a single color of a TRIPLET.  A TRIPLET consists of 3 channels: 
Red, Green, Blue in the order specified by the manufacturer of the string.

The number of TRIPLETs required will always be the same as the number of PIXELs.  When we talk
about something that you can physically touch we use 'Pixel'.  When we are talking about it otherwise,
say in reference to a sequence, we use 'Triplet'.

Here are some examples to help:

A Light-O-Rama Cosmic Color Ribbon has 150 LEDs.  Every 3 LEDs are attached to a single NODE. 
When you set the resolution of the CCR, you control how many consecutive NODES are assigned to a
single PIXEL.  At a resolution of 50, each NODE is controlled by 1 PIXEL for a total of 50 PIXELs.  At a
resolution of 25, every two NODEs are controlled by 1 PIXEL for a total of 25.  In all cases a single
TRIPLET will control a single PIXEL.

You may have a string of 170 RGB LEDs.  Each one of these LEDs is attached to a single NODE.  If
you do not group any of the NODEs together, you will have 170 PIXELs that are controlled by 170
TRIPLETs which consist of 3 CHANNELs each for a total of 510 CHANNELs.

Separating the notion of Nodes from Pixels also allows virtual addressing to make more sense.  For
example, say you have 30 pixels that are arranged as a 10 x 3 matrix.  When you physically construct
this matrix, you will most likely use a snake pattern as that minimizes the amount of wire/etc.  Your
NODES will look like this:

1  2  3  4  5  6  7  8  9  10
20 19 18 17 16 15 14 13 12 11
21 22 23 24 25 26 27 28 29 30

Notice how when we get to the right side, we don't start over at the left, but instead go one line lower and
in reverse order.  While that makes a lot of sense while building the matrix, logically the pixels are not in
the correct order.  Since we read left-to-right, we'd like to see all the pixels ordered from left to right.  If
we were to set the 'Zig-Zag' parameter on a PixCon16 to 3, the physical nodes will still be in the same
order, however the pixels will be numbered:

1  2  3  4  5  6  7  8  9  10
11 12 13 14 15 16 17 18 19 20
21 22 23 24 25 26 27 28 29 30

Since NODE refers to the physical and PIXEL refers to the virtual, we now can state 'Node 18 is Pixel
13', and it makes sense.  

5 The Light-O-Rama Software Package

The Light-O-Rama software package is a suite of programs, each helping with a different portion of
computerized control of your lights to help build a dynamic display:
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The Control Panel runs in your system tray, and gives convenient access to control over your
shows.
The Sequencer is used to create, modify, and test sequences.
The SuperStar Sequencer can be invoked from the Sequencer and used to create unique effects.
It also has auto-sequencing capabilities.
The Show Editor is used to package sequences together into shows.
The Schedule Editor is used to schedule shows to play at certain times.
The Simple Show Builder is an alternative to the Show Editor and the Schedule Editor.  It is
generally simpler to use, but less flexible.
The Show Player monitors the schedule, and plays the scheduled shows at the appropriate times.
The Comm Listener is used by other programs (such as the Sequencer and Show Player) to
communicate with DMX devices.
The Network Preferences program allows you to configure the comm networks that your computer
will use to communicate with your controllers.
The Hardware Utility can be used to test your controllers, and to download sequences to them to
be used in standalone mode.
The ServoDog Utility can be used to configure Light-O-Rama ServoDog controllers.
The Verifier can be used to check for certain types of problems with your Light-O-Rama
configuration, schedule, shows and sequences.
The Sequence Compressor can be used before shows to make sure that your compressed
sequences are up-to-date.
The Diagnostic is a troubleshooting tool that displays various information about your Light-O-Rama
configuration.
The Offline Registration Utility can be used to register Light-O-Rama on a computer that does not
have access to the internet.

Additionally, add-ons can be used with Light-O-Rama (these are not supplied as a part of the Light-O-
Rama software package).

The Light-O-Rama software package must be registered with a valid license in order to use it to its full
potential.  There are several different possible license levels, each having different features available. 
Light-O-Rama can also be used unlicensed, in Demo mode, but you will not be able to actually control
lights while in Demo mode.

Please note that the Light-O-Rama software package must be installed on a local drive; it is not
supported when installed on a network drive.

5.1 Registering Light-O-Rama

The Light-O-Rama Software Package must be registered, with a valid license, before it can be used to
its full potential.  Without a license, Light-O-Rama can be used as a demo, but it will not actually control
your lights.

There are several different license levels, each having different features available; please see the feature
comparison for details.

To register Light-O-Rama first visit the Light-O-Rama website, and purchase a license.  You will then be
able to enter your license information in any of a few different ways:

When you first install the software, or 
By going to the Sequencer's Help menu and selecting Register Or Upgrade Light-O-Rama, or 
By selecting "Register Light-O-Rama" (or "Upgrade Light-O-Rama") on the Control Panel's popup

http://lightorama.com/
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menu

Doing any of these things will open the Registration dialog:

The Registration Dialog

If your computer is connected to the internet, you can register simply by entering the name and license
key from your license information, and clicking "Register" (the license name and key can be copied and
pasted from the email in which they were sent to you).  Light-O-Rama will then automatically verify your
license information, and, if it is valid, register your computer.  

You may then have to close any Light-O-Rama programs that are running, and then restart them, before
all of your newly available features will be available.

If your computer is not connected to the internet, click on the link at the bottom of the Registration
dialog in order to register offline.

5.1.1 Registering Offline

If your computer is connected to the internet, you can register Light-O-Rama directly in the Registration
dialog.  If not, though, you can still register while offline.  Open the Registration dialog and click the link
at its bottom ("Need to register offline? Click here.").

Doing so will open the Offline Registration dialog:
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The Offline Registration Dialog

Once this dialog is opened, follow the instructions on it to register offline.  A brief summary:

First, enter your license name and license key (these can be copied and pasted from the email in which
they are sent to you).

Next,click "Show Offline Registration Key".

At this point, you will need to use your offline registration key to get an offline authorization key.  There
are two ways to do this:

First, if you have another computer, which is connected to the internet and which has Light-O-Rama
installed, you can run the Offline Registration Utility on that computer.  Make sure to have your license
name, license key, and offline registration key available to enter onto that computer; the Offline
Registration Utility will use them to create an offline authorization key.

If you do not have another computer that you can use to run the Offline Registration Utility, then you can
obtain an offline authorization key by calling Light-O-Rama, at the telephone number shown on the form.
 Provide the person you speak to with your license name, license key, and offline registration key, and
they will provide an offline authorization key to you.
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After you have obtained an offline authorization key, type it into the boxes near the bottom of the form,
and click "Register".

After you have successfully registered, you may need to close any Light-O-Rama programs that are
running and restart them before all of your newly available features can be used.

5.2 Control Panel

What is the Light-O-Rama Control Panel?

The Light-O-Rama Control Panel is an application that runs in your system tray, allowing convenient
access to other programs in the Light-O-Rama software package, as well as control over your
displays.

The Light-O-Rama control panel must be running in order for the Show Player to play your scheduled
 shows (additionally, "Enable Schedule" must be turned on).  It also must be running in order to
control lights on LOR Enhanced networks or on DMX networks.

Running the Light-O-Rama Control Panel

To run the Light-O-Rama Control Panel, select it from your computer's Start menu, under All
Programs (or "All apps") / Light-O-Rama / Light-O-Rama Control Panel:
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Run the Light-O-Rama Control Panel from your computer's Start menu

System Tray Icon

Once running, the Control Panel will show up as a Light-O-Rama light bulb icon in your system tray:

The Control Panel, running in the system tray

The color of the light bulb describes the current state of the Show Player: If scheduled shows are
currently enabled, it will be blue; if they are disabled, but shows on demand are enabled, it will be
orange; if shows are disabled entirely, it will be red:
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The different possible colors of the Control Panel

If you wish, you can set it up so that the Control Panel will automatically be run whenever your
computer starts up (and therefore you won't have to start it via the Start menu anymore).  To do this,
select Launch at Startup from the Control Panel's popup menu.

The Status Window

Left-clicking on the Light-O-Rama Control Panel's icon in your computer's system tray opens up the
Light-O-Rama status window.  This window shows whether or not the Light-O-Rama Show Player is
currently monitoring your schedule to play shows at their scheduled times, and, if so, whether a
show is currently running, what show that is, and what the next show will be.  If any sequences are
currently running, it also shows information about all of them.

The Status window also has a "Commands" menu, which has the same menu items as the right-
click popup menu.

It also shows various log messages, indicating such things as that a show or a sequence is starting
or stopping, that an error occurred playing a sequence, or that an interactive trigger was detected. 
The "Clear Log" button will clear out all existing messages from the display, and "Copy Log" will
copy the log messages to your computer's clipboard, so that you can paste them into a file.  Please
note that the log does not retain its messages indefinitely; it will periodically clear earlier messages
out.

If that Status window shows Light-O-Rama's status as "Scheduled Play is Off", your scheduled
shows will not play.  If you wish to enable them, select "Enable Schedule" from its "Commands"
menu or from the Control Panel's right-click popup menu.  Similarly, if the Status window says that
they Light-O-Rama is "enabled", your scheduled shows will play; if you wish to disable them, select
either "Disable Shows Gracefully" or "Disable Shows Immediately".

The Status window can also say that Light-O-Rama is "enabled (only for on demand shows)", in
which case your scheduled shows will not play, but on demand shows will.  In this situation, you will
be able to either enable your scheduled shows or disable shows entirely (either gracefully or
immediately).
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The status w indow, w ith scheduled shows enabled and a show currently playing
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The status w indow, w ith scheduled shows enabled, but no show currently playing
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The status w indow, w ith on demand shows enabled, but not scheduled shows
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The status w indow, w ith shows disabled

The Popup Menu

Right-clicking on the Light-O-Rama Control Panel's icon in the system tray brings up a popup menu
(this same menu is also available as the "Commands" menu in the Status window).  This menu
contains items to quickly launch other programs in the Light-O-Rama software package, and to
control your display in various ways:

Register (or Upgrade) Light-O-Rama
Sequencer
SuperStar Sequencer
Hardware Utility
ServoDog Utility
Network Preferences
Verifier
Sequence Compressor
Show Editor
Schedule Editor
Simple Show Builder
Enable Schedule
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Disable Shows Gracefully
Disable Shows Immediately
Show On Demand
Shut Down Show On Demand
Use Compressed Sequences
Show Player Memory Restarts
Launch at startup
Unload Light-O-Rama
Close Menu
Help

The Control Panel's right-click popup menu

Register (or Upgrade) Light-O-Rama

Selecting "Register Light-O-Rama" (or "Upgrade Light-O-Rama") from the Control Panel's right-click
popup menu allows you to register your Light-O-Rama software, or to upgrade to a higher level
license, unlocking various features.  

This item will show up as "Register Light-O-Rama" if you are using the unlicensed Demo version of
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the software, or "Upgrade" if you are using a license, but it is not the highest possible license level. 
If you are using the highest possible license level, this item will not be displayed at all.

Sequencer

Selecting "Sequencer" from the Control Panel's right-click popup menu launches the Light-O-Rama
Sequencer, used to create, modify, and test sequences.

SuperStar Sequencer

Selecting "SuperStar Sequencer" from the Control Panel's right-click popup menu launches the
Light-O-Rama SuperStar Sequencer. 

Note: it is recommended to access SuperStar via the Sequencer's SuperStar Effect tool
rather than opening SuperStar directly from the Control Panel menu.

Hardware Utility

Selecting "Hardware Utility" from the Control Panel's right-click popup menu launches the Light-O-
Rama Hardware Utility, used for various things such as testing controllers and downloading
sequences to them for use in standalone mode.

ServoDog Utility

Selecting "ServoDog Utility" from the Control Panel's right-click popup menu launches the Light-O-
Rama ServoDog Utility, used to configure Light-O-Rama ServoDog controllers.

Network Preferences

Selecting "Network Preferences" from the Control Panel's right-click popup menu launches the Light-
O-Rama Network Preferences program.

Verifier

Selecting "Verifier" from the Control Panel's right-click popup menu launches the Light-O-Rama
Verifier, used to check for certain problems with Light-O-Rama's configuration, schedule, scheduled
shows, and scheduled sequences.

Sequence Compressor

Selecting "Sequence Compressor" from the  Control Panel's right-click popup menu launches the
Light-O-Rama Sequence Compressor, which can be used before shows to ensure that all
compressed sequences are up-to-date.

Show Editor

Selecting "Show Editor" from the Control Panel's right-click popup menu launches the Light-O-Rama
Show Editor, used to create and modify shows.

Schedule Editor

Selecting "Schedule Editor" from the Control Panel's right-click popup menu launches the Light-O-
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Rama Schedule Editor, used to schedule shows to be played by the Light-O-Rama Show Player.

Simple Show Builder

Selecting "Simple Show Builder" from the Control Panel's right-click popup menu launches the Light-
O-Rama Simple Show Builder, which is intended as an easier to use, but less flexible, alternative to
the Show Editor and the Schedule Editor.

Enable Schedule

Selecting "Enable Schedule" from the Control Panel's right-click popup menu causes the Light-O-
Rama Show Player to monitor your schedule and to play your shows at their scheduled times.

Note that on demand shows can be played regardless of whether your scheduled shows are enabled
or not.

When scheduled shows are enabled, the light bulb icon in the computer's system tray will be blue.

Note: If "Enable Schedule" is greyed out, this means that it has already been selected, and the
Show Player is monitoring your schedule.  To stop the Show Player from monitoring your schedule,
select "Disable Shows Gracefully" or "Disable Shows Immediately".

Disable Shows Gracefully

Selecting "Disable Shows Gracefully" from the Control Panel's right-click popup menu causes the
Light-O-Rama Show Player to put your current show (if one is running) into shutdown mode, and to
stop monitoring your schedule for shows to be played.  When the show goes into shutdown mode,
any song from the Musical section that is currently playing will be allowed to finish, and then the
show's Shutdown section will start.

To instead shut down your show immediately, including abruptly stopping any sequences or song
that might be playing, choose Disable Shows Immediately instead.

When shows are disabled, the light bulb icon in the computer's system tray will be red.

Note: If "Disable Shows Gracefully" is greyed out, this means that the Show Player is not
monitoring your schedule.  To have the Show Player start monitoring your schedule, select "Enable
Schedule".

Disable Shows Immediately

Selecting "Disable Shows Immediately" from the Control Panel's right-click popup menu causes the
Light-O-Rama Show Player to immediately stop your current show (if one is running), and to stop
monitoring your schedule for shows to be played.  

Stopping your show immediately will abruptly stop your sequences, including any song that
happens to be playing.  To have the Show Player stop your show more gracefully, choose Disable
Shows Gracefully instead.

When shows are disabled, the light bulb icon in the computer's system tray will be red.

Note: If "Disable Shows Immediately" is greyed out, this means that the Show Player is not
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monitoring your schedule.  To have the Show Player start monitoring your schedule, select "Enable
Schedule".

Show On Demand

Selecting "Show On Demand" from the Control Panel's right-click popup menu causes the following
dialog to open:

The Show On Demand dialog

Using this dialog, you can choose a show file to play immediately, or at a certain time, without
needing to add it to your schedule.  You can choose to let it play until a certain time, or else
indefinitely, in which case it will not stop until you "shut down show on demand", "disable shows
gracefully", "disable shows immediately", or "unload Light-O-Rama".

If a show is already playing at the time the on demand show is supposed to start, the playing show
will be allowed to stop gracefully before the on demand show will start.  That is, if a sequence from
its Musical Section is currently playing, that sequence will be allowed to continue to play until its
natural end; also, the sequences from its Shutdown Section, if any exist, will be played (after the
current sequence from the Musical Section ends, or immediately if there is no current sequence
from the Musical Section).

If "Show On Demand" is used when scheduled shows are disabled, it will not enable your scheduled
shows; only your on demand show will play (if desired, though, you can enable your scheduled
shows too, simply by clicking "Enable Schedule").  When this is the case, the light bulb icon in the
computer's system tray will be orange.

Please note that the Show On Demand feature is only available for license level Basic Plus and
higher.

Shut Down Show On Demand

If an on demand show is currently playing, selecting "Shut Down Show On Demand" from the
Control Panel's right-click popup menu will cause the on demand show to stop.  It will be allowed to
stop gracefully; that is, if a sequence from its Musical Section is currently playing, that sequence
will be allowed to continue to play until its natural end; also, the sequences from its Shutdown
Section, if any exist, will be played (after the current sequence from the Musical Section ends, or
immediately if there is no current sequence from the Musical Section).

After the on demand show stops, if scheduled shows are enabled, the Show Player will start
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whatever show is scheduled for the current time (if any).

"Shut Down Show On Demand" can also be used to cancel an on demand show that has been
requested, but not yet started (either due to its start time not having been reached, or else due to
another show still being in the process of shutting down).

Use Compressed Sequences

Checking "Use Compressed Sequences" from the Control Panel's right-click popup menu causes
the Light-O-Rama Show Player to create and use compressed sequences if possible, which should
cut down on the time it takes to load.  Unchecking it causes it to ignore compressed sequences,
and instead use the regular sequences.

Show Player Memory Restarts

Checking "Show Player Memory Restarts" from the Control Panel's right-click popup menu causes
the Show Player to automatically restart in certain situations: When no show is playing, and no
show is scheduled to start playing within the next sixty seconds, if the Show Player is using more
than 100 megabytes of memory, it will automatically shut down.  Assuming that the schedule is
enabled, the Light-O-Rama Control Panel will then automatically restart the Show Player.  The
intention of this is a preventive measure to protect against ill effects of possible memory leaks in the
Show Player, which could otherwise build up over time to a point that would cause the Show Player
to crash.

Launch at Startup

Checking "Launch at Startup" from the Control Panel's right-click popup menu causes the Light-O-
Rama Control Panel to automatically run whenever your computer starts up.  Unchecking it causes
it not to run at startup time, in which case you can start it manually whenever you like.

Unload Light-O-Rama

Selecting "Unload Light-O-Rama" from the Control Panel's right-click popup menu will shut down
both the Light-O-Rama Control Panel and the Light-O-Rama Show Player.  Your scheduled shows
will not run while these are shut down.

To start the Light-O-Rama Control Panel again, run it from your computer's Start menu.  Or, if
"Launch at startup" has been enabled, the Control Panel will automatically run the next time that
your computer starts up.

Close Menu

Selecting "Close Menu" from the Control Panel's right-click popup menu will close the popup menu.
 The Light-O-Rama control panel will still remain active.

Help

Selecting "Help" from the Control Panel's right-click popup menu will open up the Light-O-Rama help
files.
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5.3 S5 Sequencer

The Light-O-Rama S5 Sequencer is a tool used to create sequences, which are files that
contain commands to be sent to controllers to produce various lighting effects - to turn lights on
and off, make them twinkle or shimmer, fade up or down, and so forth.

There are several keys steps in the sequence process as shown in the flowchart below:

Create a preview
Create a sequence
Save a sequence
Create playback files

The main S5 Sequencer window is divided into several sub-windows. In the following picture it is shown
with the sub-windows in their default positions; however, the layout of the sub-windows can be easily 
customized. Also, the S5 Sequencer comes with several themes that control the background and text
colors in the main window. In the configuration that is shown, the Playback Window is pinned, meaning
it stays open (notice the pin icon in the upper right corner of the window). The Preview Management
Window, Motion Effects Window, and Control Lights Window on the right side are all unpinned, meaning
you can click on the name of the window to open it temporarily, but once you click on something else
the window will close. To change a window from pinned mode to unpinned mode (or vice versa), just click
the pin icon for that window.

The Start Page gives you links to quickly start a new animation or musical sequence, and to open
sequences that have been recently viewed.
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Sequences are displayed in the S5 Sequencer as a grid.  Rows represent regular channels, RGB
channels, motion effect rows, subsequences, beat channels or loops, and columns represent timings. 
Cells in the grid therefore represent the lighting effects that will happen on props at various points in time
while the sequence is being played. 

Regular channels, RGB channels, and motion effect rows are associated with props in the preview or
with archived props. Motion effect rows can also be used with preview groups.

As an example, the following sequence has four props, each with a single channel.  At the start of the
sequence, the first prop's channel turns on.  It stays on for half a second, then turns off, and the second
prop's channel then turns on.  Then it turns off, and the third turns on, and then the third turns off and the
fourth turns on.  This brings us two seconds into the sequence, at which point all four channels fade
down, for a second.  After that, the first and fourth channels start shimmering, while the second and third
fade up:
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A sequence with four channels, and various lighting effects

Notice that one cell is highlighted with a thick yellow box - the cell of the first channel from 3 seconds to
3.5 seconds.  That is the currently selected cell.  Various tools can be applied to the selected cell (or
cells), for example to change the lighting effect used on that channel at that time.

Before proceeding, you should understand what a sequence is and what a preview is.

For more detailed information about using the S5 Sequencer, please see the following topics:

The Main Menu
The Start Page
The Previews Window
Preview Design
The Sequence Tab (editing a sequence)
Motion Effect Generator
Playback Window
Motion Effects Window
Control Lights Window
Customizing Window Layouts
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The Sequencer w ith an open sequence

5.3.1 Menu Bar

The Light-O-Rama S5 Sequencer’s menu bar gives access to all of the program's major functionality. 
For detailed help, please refer to the help pages for each individual menu on the menu bar:

File Menu
Sequence Menu
Tools Menu
Window Menu
Help Menu

The S5 Sequencer's menu bar

5.3.1.1 File Menu

The Light-O-Rama S5 Sequencer's File menu has menu items related to creating, opening, and saving
sequences, as well as exiting the program.

Several of these menu items operate on the "currently selected sequence".  Many sequences can be
open simultaneously in the S5 Sequencer, but only one is the currently selected sequence.  Each open
sequence has a tab that displays the sequence's name. The currently selected sequence's tab will be
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highlighted (the highlight color depends are which theme you are using). To select a sequence, simply
click on its tab.

New
Open
Recent Files
Save
Save As
Save A Copy
Create Playback Files
Export as Protected
Close
Close All
Exit

The File Menu

New

Selecting "New" on the Sequencer's File menu opens a sub-menu which gives you a choice
between creating a new animation sequence or a new musical sequence. You can also initiate the
creation of a new musical or animation sequence from the Start Page, or by right-clicking on a 
preview in the Previews Window.

"New Musical Sequence" has a
keyboard hotkey:

"New Animation Sequence" has a
keyboard hotkey:

Open
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Selecting "Open" on the Sequencer's File menu opens a dialog that allows you to select a sequence
file. If you select an S5 sequence file (.LOREDIT file extension) it will immediately open on a new tab
within the Sequencer. If you choose a sequence file created in an older version like S4 (.LMS or
.LAS file extension), then the sequence will be upgraded to S5 and you will receive some prompts
during the upgrade process.

"Open" has a keyboard hotkey:

 

Recent Files

Selecting "Recent Files" on the Sequencer's File menu opens a sub-menu which lets you select
from a list of the most recently opened sequences. The list of files on the "Recent Files" sub-menu
are the same ones listed on the Start Page.

Save

Selecting "Save" from the Sequencer's File menu saves the changes that you have made to the
currently  selected sequence.  If the sequence was newly created and has never been saved before,
Save will also prompt you for a file name to use for the new sequence.

The Save function will be followed by a Save A Copy function if specified in Save Copy Preferences.

"Save" has a keyboard hotkey:

Save As

Selecting "Save As" from the Sequencer's File menu saves the current sequence to a new file name.
 The old file will still exist, but will not include any of the changes that you made to the sequence
since the last time that you saved it.

Save A Copy

Selecting "Save A Copy" from the Sequencer's File menu saves the current sequence to a new file
name.  The old file will still exist, but will not include any of the changes that you made to the
sequence since the last time that you saved it. 

This function has a several options that control its behavior. See the Save Copy Preferences topic for
details. In particular, this function can be used to make backup copies of the sequence when the
"Date and Time" suffix is specified.

Create Playback FIles

When you are finished with a sequence, select "Create Playback Files" from the Sequencer's File
menu to save the current sequence in a format that can be used for scheduling a show or writing an
SD card for an LOR Director. If you subsequently make changes to the sequence or to the preview,
you will need to create playback files again.
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If your sequence is named "mysequence.loredit", then the playback file will be named
“mysequence.play.lms” if it is musical sequence, or "“mysequence.play.las” if it is an animation. If
you have a Pro license, a “mysequence.play.lms.pe.lid” intensity data file will be created at the
same time. The playback file(s) will be placed in the same folder as the base sequence
(mysequence.loredit).

Creating playback files is a key step in the sequence process.

Export as Protected

Selecting "Export as Protected" from the Sequencer's File menu can be used to create a protected
sequence based upon the current sequence.

Close

Selecting "Close" from the Sequencer's File menu closes the currently selected sequence.

If the sequence has unsaved changes, you will be prompted on whether you wish to save the
changes or not; if the sequence has never been saved before, and you choose to save it, you will
also be prompted to select a filename for the new sequence.

Close All

Selecting "Close All" from the Sequencer's File menu closes all open sequences.  

If any of the sequences have unsaved changes, you will be prompted on whether you wish to save
them or not; if any of the sequences have never been saved before, and you choose to save them,
you will also be prompted to select filenames for the new sequences.

Exit

Selecting "Exit" from the Sequencer's File menu closes the Sequencer.  If any currently open
sequences have changes that have not yet been saved, you will be prompted for whether or not you
want to save them.

5.3.1.1.1  New  Animation Sequence Dialog

The Sequencer's New Animation dialog is used to create a new animation sequence (a sequence with
no music).  The New Animation dialog can be reached several ways:

Selecting File > New > Animation Sequence from the main menu
Clicking the "New Animation Sequence" link on the Start Page
Right-clicking on a preview in the Previews window and selecting "New Animation Sequence" from
the pop-up menu
Using the keyboard shortcut Alt-N

For detailed help, please refer to the following sections:

Sequence Author
Preview
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Sequence Length
Use Loops
Initial Timing Grids
Number Of Motion Effect Rows For Pixel Props
Save these choices as defaults.

The New Animation Sequence dialog

Sequence Author

If you wish, you can put your name here.  It will be saved with the sequence, and will be displayed
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on the Sequence Information screen. Once set, even if set to a blank value, it cannot be changed.

Preview

A preview is a representation of your light display. It specifies all of the props that you can apply
effects to in your sequence. It also specifies all of the channels your sequence will be able to
control.

Normally, you will select a preview that you have already created on the "Existing Previews" tab.
However, you can use the Quick Preview feature to create a new preview on the fly.

After assigning a preview here, you may continue to update the preview and those updates will be
automatically reflected in the sequence (for example, adding a new prop). You can also later assign
a different preview to the sequence; although if you do that, the new preview should be substantially
similar to the originally assigned preview.

Sequence Length

This allows you to specify the duration of the sequence.  You will be able to change the value later,
using Change Sequence Length in the Sequence menu.

The time can include hours, minutes, seconds, and hundredths of a second.  For details on the
format used to specify various lengths of time, please see Time Format.

Use Loops

If you check the "Use Loops" check box, the newly created sequence will automatically include a
loop level, which can be used to insert loops into the sequence.

If you create an animation sequence without having selected "Use Loops", and you later decide that
you do want loops in the sequence, you can add a loop level by selecting "Loop Level" from the Add
New menu, available on the Sequence menu and the Grid View menu.

Initial Timing Grids

This allows you to tell the Sequencer to automatically insert timings into the new sequence. 
Timings are the spots in time where you can easily place lighting effects - for example, turn a string
of lights on, or have it twinkle, or have it fade down.

If you don't know how far apart you want timings to be, just take a guess.  You can always insert,
delete, or move timings later.  Note that although the New Animation dialog only allows you to set
timings up at equal lengths from each other, timings in general can be any length from each other. 
For example, you could later add a timing three seconds away from another, and a third timing half a
second away from that one.

If you select "Custom Interval", you can enter any length you want, rather than one of the defaults. 
This value must be entered using the standard Time Format.
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Number Of Motion Effect Rows For Pixel Props

If you have a Pro level license, then you can use motion effects to sequence your props that utilize
RGB pixels. You can also have multiple motion effects playing on a prop at the same time. This
setting specifies how many motion effect rows should be created for every pixel-based prop.
Typically 1 or 2 is a good choice to start. And then you can add more rows to specific props as your
sequencing needs dictate. 

Save These Choices As Defaults

If you turn this check box on, your answers to the questions in this dialog will be saved so that
whenever you create a new animation sequence in the future, those answers will automatically show
up in this dialog as the default answers.

5.3.1.1.2  New  Musical Sequence Dialog

The Sequencer's New Musical Sequence dialog is used to create a new musical sequence (a sequence
with an associated audio or video file).  The New Animation dialog can be reached several ways:

Selecting File > New > Musical Sequence from the main menu
Clicking the "New Musical Sequence" link on the Start Page
Right-clicking on a preview in the Previews window and selecting "New Musical Sequence" from
the pop-up menu
Using the keyboard shortcut Ctrl-N

After doing one of these things, but before the New Musical Sequence dialog opens, you will be
prompted to select the audio or video file that will be used to build the new sequence.  After you select
the file, then the New Musical Sequence dialog will open.

Behind the scenes, the Sequencer will open the media file to determine its length. When the new
sequence is created, its length will match that of the media file.

For detailed help, please refer to the following sections:

Sequence Author
Preview
Music Information
Initial Timing Grids
Number Of Motion Effect Rows For Pixel Props
Save These Choices As Defaults
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The New Musical Sequence dialog

Sequence Author

If you wish, you can put your name here.  It will be saved with the sequence, and will be displayed
on the Sequence Information screen. Once set, even if set to a blank value, it cannot be changed.
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Preview

A preview is a representation of your light display. It specifies all of the props that you can apply
effects to in your sequence. It also specifies all of the channels your sequence will be able to
control.

Normally, you will select a preview that you have already created on the "Existing Previews" tab.
However, you can use the Quick Preview feature to create a new preview on the fly.

After assigning a preview here, you may continue to update the preview and those updates will be
automatically reflected in the sequence (for example, adding a new prop). You can also later assign
a different preview to the sequence; although if you do that, the new preview should be substantially
similar to the originally assigned preview.

Music Information

If you wish, you can put the name of the artist, song, and album of the associated song here.  It will
be saved with the sequence, and will be displayed in the Sequence Information dialog.

Some media files have already been tagged with this information. If you utilize such a media file, the
Sequencer will automatically discover those tags and populate the fields in this section (though you
can still change or delete it if you wish).

You can change this information later in the Sequence Information dialog.

Initial Timing Grids

This allows you to tell the Sequencer to automatically insert timings into the new sequence. 
Timings are the spots in time where you can easily place lighting effects - for example, turn a string
of lights on, or have it twinkle, or have it fade down.

In addition to placing timings a certain length of time apart (a tenth of a second, a half second, a
second, or "Custom Interval"), add adding no timings at all ("Don't add any timings"), you can
instruct the Sequencer to use various wizards to insert timings based upon the song itself:

The MIDI File Wizard can insert timings and effects based upon the beat of a MIDI song, as
well as based on the individual notes played by different instruments in the song.
The Tapper Wizard allows you to tap the keyboard or mouse while the song plays, and will
record the times at which you tap.
The Beat Wizard attempts to determine the tempo of the song, and insert timings and effects
based upon it.
The VU Wizard looks for peaks in the song, much like a VU meter, and inserts timings and
effects based upon them.

Not all of these wizards are available for every type of media file; for example, the MIDI File Wizard
can only be used with MIDI files.  Any wizards that cannot be used with the type of media file being
used will be greyed out.
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If you select "Custom Interval", you can enter any length you want, rather than one of the defaults. 
For details on the format used to specify various lengths of time, please see Time Format.

If you choose to have equally spaced timings, then you will be given the option to use a fixed timing
grid or  a freeform timing grid, by checking or unchecking the "Use a fixed timing grid" box. 
Otherwise, a freeform timing grid will be used.

Note that you can always insert, delete or move timings later, in a variety of ways.

Number Of Motion Effect Rows For Pixel Props

If you have a Pro level license, then you can use motion effects to sequence your props that utilize
RGB pixels. You can also have multiple motion effects playing on a prop at the same time. This
setting specifies how many motion effect rows should be created for every pixel-based prop.
Typically 1 or 2 is a good choice to start. And then you can add more rows to specific props as your
sequencing needs dictate. 

Save These Choices As Defaults

If you turn this checkbox on, your answers to most of the questions in this dialog will be saved so
that whenever you create a new musical sequence in the future, those answers will automatically
show up in this dialog as the default answers.

The artist name, album name, and song name will not be saved as defaults (though if you use an
MP3 tagged with this information, it will automatically be placed into that section).

5.3.1.1.3  Quick Preview

When creating a new sequence, you have the option of associating that sequence with an existing
preview, or creating a "Quick Preview". To create a Quick Preview, click on the "Quick Preview" tab in
the New Musical Sequence or New Animation Sequence dialog. It only requires 3 pieces of information:

1. Sequence Name. This defaults to today's date, but you can change it to whatever you want;
however, it cannot be blank.

2. Tell it what kind of devices you are connecting to. This can be either be:
Light-O-Rama devices, or
DMX devices, or
"I do not know what I am connecting to yet". If you choose this option, the sequence you
create will not control any lights; but allows you to defer your decision for later. When you
come to a decision and are ready to control lights, you will need to open this preview in 
Preview Design and change the props to another Device Type.

3. The number of channels the sequence will control.
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The Quick Preview tab

Using the choices shown above would result in the following sequence. The 16 channels are listed down
the left side. The name of the preview is shown to the right of the green check mark.

A sequence grid created using Quick Preview
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Using the choices shown above would result in the preview shown below. The 16 stars represent the 16
channels. If the Playback Window is visible when the sequence is played in the Sequencer, then the
stars will turn on and off according to the effects in your sequence. The preview will be listed on the
Previews Window just like any other the preview. 

A preview created using Quick Preview

5.3.1.2 Sequence Menu

The  Light-O-Rama Sequencer's Sequence Menu gives you access to a set of functions that operate on
the currently selected sequence (the highlighted tab).  If there is not any file open, then the Sequence
Menu is disabled. 

Sequence Information
File References
View Sequence Folder
Media File
Convert Media to WAV file
Convert to Animation
Change Sequence Length
Skew All
Windows Command
Preview Design
Assign Different Preview
Manage Archived Props
Manage RGB Aggregates
Delete Grid Rows
Add New
Audio Wizards
Waveform Area
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Grid Configuration

The Sequence menu

Sequence Information

This menu item opens the Sequence Information dialog, giving you visibility to key information about
the current sequence, This includes who created the sequence and when, as well as information
about the music (artist, title, and album).

File References

This menu item opens the File References dialog, giving you visibility to all files referenced by the
current sequence.

View Sequence Folder

This menu item will open a Windows Explorer window with the current folder set to the folder
containing the current sequence.

This might be of use if you want to see the file size of the current sequence, or to make a copy the
sequence file. If you are going to make a copy, make sure and save it first!
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Media File

This menu item allows you to specify the audio or video file that should be used with the current 
sequence.  This may be useful, for example, if you have changed the directory that you store your
media files in.

When used on an animation sequence, it will convert the animation sequence to a musical
sequence.

Convert Media to WAV file

This menu item converts the media file associated with the sequence to the wave format (which has
a WAV file extension).

Some media file formats do not position accurately when play back is started in the middle of the
file. This can cause inaccuracies in sequencing - your lights would turn on at slightly different times
depending on whether play back was started from the beginning of the sequence or the middle.
MPG video files and variable bit rate MP3 files are most susceptible to this issue. Converting to a
wave file can eliminate this problem.

Convert to Animation

This menu item will convert the current sequence from a musical sequence to an animation
sequence.

Perhaps someone has sent you a sequence, but you don't have the media file to go with it. By
converting the sequence to an animation, you can still play it back and watch the preview.

To convert an animation sequence to a musical sequence, use the Media File menu item.

Change Sequence Length

This menu item allows you to change the duration of the current sequence.

For information on the format used to specify an amount of time, please see the Time Format topic.

The Change Sequence Length dialog
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Skew All

Skewing a sequence will move all of its events, timings, and loops by some specified amount of
time.  A sequence can be skewed either to the left - i.e. shifting its events (and such) earlier in time
- or to the right - i.e. shifting them later in time.

After selecting "Skew All" from the Sequence menu, a window will open up, allowing you to choose
the size and direction of the skewing:

The Skew All dialog

In most cases, you should leave the "Action" section with the default choices. However, if you have
a special situation, you can turn off skewing of effects or timing marks as needed.

After completing this dialog, the sequence will be skewed by the amount, and in the direction, that
you chose.

Here is an example of a simple sequence, before and after skewing to the right by one-quarter
second:
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A simple sequence, before skewing

The same sequence, after skewing to the right by 1/4 second

Windows Command

This menu item will open the Windows Shell Command dialog which allows a command to be
executed whenever the current sequence is run (whether by the Sequencer or by the Show Player). 

Preview Design

This menu item opens the Preview Design window for the current sequence.

Assign Different Preview

This menu item allows you to associate a different preview to the current sequence. This function
works best if the new preview started out as a copy of the original preview. However, the function will
also look for matching prop names between the old preview and the new preview. Effects will be
preserved for props and groups that match. Where there is no match, those items and their effects
will be archived.

Manage Archived Props

This menu item will open the Manage Archived Props dialog which allows you to change archived
props in the current sequence: delete them, turn them into preview props, or turn them into beat
channels. 

Manage RGB Aggregates

This menu item will open the Manage RGB Aggregates dialog which allows you to add, modify, and
delete RGB aggregate channels. RGB aggregates allow you to combine any 3 existing channels
(the colors don't need to be red, green, and blue necessarily), and the combination of the 3 is
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treated as an RGB channel for sequencing purposes. 

Delete Grid Rows

This menu item will open the Delete Grid Rows dialog which allows you to permanently remove
certain types of unused grid rows from the sequence. This menu item is only available to users with
a Pro license.

The Delete Grid Rows dialog

Add New

This menu item opens a sub-menu, allowing you to add a new loop level, beat channel,
subsequence, or RGB aggregate. "Add New" is also available on the Grid View menu.

Audio Wizards

This menu item opens a sub-menu, allowing you to select an audio wizard to run.

Waveform Area

The "Waveform" sub-menu from allows you to set the audio waveform area’s height. Choose “Large”
to see the maximum amount of detail in the waveform. Choose “Small” to see the waveform, but
have more room to display the sequence. Animation sequences are automatically set to hide the
waveform. The height can also be set by right-clicking in the waveform area.

Grid Configuration
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This item opens a sub-menu allowing you import or export the user-defined grid views in the
sequence. For Pro users, it will also import/export the properties of each motion effect row. The
system-generated "Show All Items" grid view is not included in the export. "Grid Configuration" is
also available on the Grid View menu. 

5.3.1.2.1  Sequence Information Dialog

Selecting "Sequence Information" from the Sequencer's Sequence menu opens a dialog that displays
key information about the sequence, allowing you to change some of it:

Created By: The creator of the sequence as specified in the New Animation dialog or the New
Musical Sequence dialog.  This value cannot be edited.
Created At: The date and time at which the sequence was created.  This value cannot be edited.
Modified By: If you modify a file that was created by someone else, you can enter your name
here, if you wish.
Music Artist: For musical sequences, the artist who performed the song.
Music Title: For musical sequences, the name of the song.
Music Album: For musical sequences, the name of the album that the song is from.

The Sequence Information dialog

5.3.1.2.2  File References Dialog

Selecting "File References" from the Sequencer's Sequence menu opens a dialog that lists all files
referenced by the sequence. This includes the media file, the background image for the preview, 
subsequences, and files used by motion effects (e.g. Movie and Picture effects). 

Files that don’t exist at the specified location are listed with a prefix of “*** missing ***”. This is an
indication that the file reference should be fixed.

Subsequence and motion effect references can be fixed with this dialog. The media file can be fixed
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using the Media File item on the Sequence menu. The Preview Background file can be fixed in Preview
Design.

To specify a new location for one or more files, click the check box next to the filename(s), then click
the Change Directory button. You will be prompted for the new location. Note that this function does not
actually move the file(s), rather it updates the effects that reference those file(s). This can be useful if
you move your sequence directory.

The File References dialog

5.3.1.2.3  Window s Shell Command Dialog

When a sequence is started, Light-O-Rama can optionally also execute an arbitrary Windows
command, running any program that you specify.  

For example, some people broadcast the songs that play during their shows over radio, and would like
the name of the song to be broadcast along with it, using the RDS ("Radio Data System") protocol,
allowing people with RDS-enabled radios to see the name of the song that they are listening to.  RDS is
not directly supported by Light-O-Rama, but you could set up your  musical sequences so that,
whenever one of them is played, Light-O-Rama will tell Windows to tell your RDS program to broadcast
the name of the song for that sequence.

To set up a sequence to execute a Windows command, select "Windows Command" from the 
Sequencer's Sequence menu.  After that, whenever that sequence is played (either by the Sequencer or
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the Show Player), the command will be executed.  

Important notes:
the command will not be executed if the sequence it is associated with is used as a subsequence
of another sequence.
if the Show Player is running when you change the command associated with a sequence, you
may have to stop and start the Show Player in order for this change to be picked up.
This feature is available only at the Advanced feature level and higher.

Topics:
Reuse Existing Command
Create New Command
Shell Command Variables
Sharing Sequences between Computers, and Security

The Windows Shell Command dialog

Reuse Existing Command

Select the "Existing Command" radio button and choose a command from the drop-down list to use a
command that was already set up for another sequence. Both sequences will run the same command
when they start.
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The    button copies the selected existing command to the "new command" box so you can
use an existing command as the basis for a new one. 

The    button deletes the selected command. This will affect all sequences that use the same
command; so be very certain that the command is no longer needed before deleting it. If your
intent is that the current sequence no longer run a command, use the "No command" radio button
instead.

Create New Command

Select the "New Command" radio button for creating an entirely new command, not used by any other
sequence. If your command is an executable file or batch file, you can use the "Select" button to select
the desired file and the full path to the file will be placed in the new command text box. Your command
can also include special shell command variables as noted below.

Shell Command Variables

For the most part, a shell command will be executed exactly as you type it.  You can, however,
additionally use certain variables, which will be replaced at run-time with various information, such as the
title of the song associated with the sequence.  The following variables can be used (note: the exact
result of using any of the date/time "DT_" variables may depend upon your computer system, so try
them out if you need to rely upon an exact format):

Variable Meaning

%% A single percent character ("%")

%DT_a% Day of week, abbreviated ("Mon")

%DT_A% Day of week ("Monday")

%DT_b% Month name, abbreviated ("Aug")

%DT_B% Month name ("August")

%DT_c% Date and time ("Sunday, March 09, 2008 4:05:07 PM")

%DT_d% Day of month (01 through 31)

%DT_H% Hour, 24 hour clock (00 through 23)

%DT_I% Hour, 12 hour clock (01 through 12)

%DT_j% Day of year (001 through 366)

%DT_m% Month number (01 through 12)

%DT_M% Minute (00 through 59)

%DT_p% AM or PM

%DT_S% Second (00 through 61)

%DT_w% Day of week, number (0 through 6, Sunday being 0)

%DT_x% Date ("11/29/10")

%DT_X% Time ("16:32:37")
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%DT_y% Year, two digit ("10")

%DT_Y% Year, four digit ("2010")

%ENV_something% The value of your computer's environment variable "something"; for
example, use %ENV_PATH% to get the value of your computer's PATH
environment variable

%MEDIA_ALBUM% The name of the album that this sequence's media file is from (if set in
your sequence)

%MEDIA_ARTIST% The name of the artist that this sequence's media file is by (if set in your
sequence)

%MEDIA_FILENAME% The name of the sequence's media file, without path information

%
MEDIA_FILENAME_FULL
%

The name of the sequence's media file, with path information

%
MEDIA_FILENAME_NO_E
XT%

The name of the sequence's media file, without path information and
without the file extension (such as ".mp3")

%MEDIA_TITLE% The name of the song that this sequence's media file is (if set in your
sequence)

%SEQUENCE_AUTHOR% The author of this sequence (if set in your sequence)

%
SEQUENCE_CREATED_A
T%

The date and time at which the sequence was created

%SEQUENCE_FILENAME
%

The name of the sequence file, without path information

%
SEQUENCE_FILENAME_
FULL%

The name of the sequence file, with path information

%
SEQUENCE_FILENAME_
NO_EXT%

The name of the sequence file, without path information and without the
file extension (such as ".lms")

%
SEQUENCE_MODIFIED_B
Y%

The name of the person who has modified the sequence (if set in your
sequence)

These variables were supported in prior versions, but are no longer supported in S5

Variable Meaning

%DT_U% Week of year, with the first Sunday of the year starting week 01 (00
through 53)

%DT_W% Week of year, with the first Monday of the year starting week 01 (00
through 53)

%DT_Z% Time zone ("EST")
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Sharing Sequences between Computers, and Security

The ability to execute an arbitrary Windows command is very powerful, and even potentially harmful - for
example, you could execute a command which will install spyware on your machine.  Therefore, it would
not be wise to execute whatever Windows command another person chose, unless you are absolutely
sure that the command they chose is safe and harmless.

For this reason, Light-O-Rama imposes a security measure: The command to be executed is not stored
directly in the sequence file itself.  Instead, the sequence file contains a key for an entry in another file
("cmdmap.lcm", located in your Light-O-Rama sequences directory); that entry specifies the Windows
command to be executed.  If that file doesn't contain an entry for that key, Light-O-Rama simply does
not execute any command when the sequence plays.

So, you can use sequences created by other people without fear of spyware or other harmful programs,
as long as you continue to use your own version of cmdmap.lcm, not a copy of the other person's
cmdmap.lcm.

However, this means that if you yourself use Light-O-Rama on two separate machines - for example one
to create your sequences on, and another to run your shows on - you will have to copy your "real"
version of cmdmap.lcm from one machine to the other if you want your sequences to execute Windows
shell commands.  You would typically do this at the same time that you copy your sequences
themselves over from one machine to the other.

5.3.1.2.4  Manage Archived Props Dialog

Selecting "Manage Archived Props" from the Sequencer's Sequence menu opens a dialog where you
can view all of the archived props in a sequence. 
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Check the boxes next to the archived props you want to take action on. You can use the "Select All"
button to set or clear all of the boxes at once.

After you have selected the desired props, take action by clicking one of the 3 big buttons:

"Move to preview" will convert the archived prop to a preview prop (i.e. it adds the prop to the
preview). The prop is no longer archived and its sequencing will appear during preview playback
and will control real lights.
"Move to beats" will convert the archived prop to beat channels. While upgrading a sequence, a
beat channel in the legacy sequence could get archived because it does not exist in the preview.
This command will allow that issue to be corrected.
"Delete" permanently removes the selected archive props from the sequence. A legacy sequence
might contain channels that were no longer used and those channels would get archived because
they don't exist in the preview. There is no reason to keep such channels in an S5 sequence, so
this command gives you an efficient way to remove them.

After you are done, click "Save" to close the dialog and make the actions permanent, or click "Cancel"
to revoke the changes.

5.3.1.2.5  Manage RGB Aggregates Dialog

Selecting "Manage RGB Aggregates" from the Sequencer's Sequence menu opens a dialog where you
can view all of the RGB aggregates in a sequence. From this dialog you can:

Add a new RGB aggregate
Modify an existing RGB aggregate
Delete an RGB aggregate

The Manage RGB Aggregates dialog
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Add a new RGB aggregate

Clicking the "+" icon will open a dialog allowing you to create a new RGB aggregate. 

Enter the name for the new aggregate. 
Use the filter box to narrow done the list of channels to choose from.
Click on a channel name that will occupy the red slot in the aggregate, then click the "Set
Red" button. The name of the selected channel will appear below the button.
Click on a channel name that will occupy the green slot in the aggregate, then click the "Set
Green" button. The name of the selected channel will appear below the button.
Click on a channel name that will occupy the blue slot in the aggregate, then click the "Set
Blue" button. The name of the selected channel will appear below the button.
Click the "Create" button to create the aggregate.

It is not required to set all 3 slots. Setting only 1 or 2 of the slots is fine.

Creating a new RGB Aggregate

Modify an existing RGB aggregate

Double-clicking on an RGB aggregate name (or clicking a name to select it then clicking the pencil
icon) will open a dialog allowing you modify the selected RGB aggregate. Here you can change the
name, or change the channels assigned to any of the 3 slots. To change the channel assigned to a
slot, use the same procedure described in creating an aggregate.
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Modifying an RGB Aggregate

Delete an RGB aggregate

Click on an aggregate name to select it then click the red "X" icon to delete it. You can also use
Shift-click and Ctrl-click to select multiple items before clicking the delete icon.

5.3.1.3 Tools Menu

The Light-O-Rama S5 Sequencer's Tools Menu gives you access to a set of functions that are unrelated
to a specific sequence.

Motion Effect Generator
Sequencer Preferences
Change User Data Directory
Waveform Colors
Theme
Zoom Preferences
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The Tools Menu

Motion Effect Generator

This option on the Tools menu opens the Motion Effect Generator window. This menu item can be
used when no sequences are open to test effects and optionally save the one’s you like as favorites.
You can do this at any license level.

When a sequence is open, this menu item can be used to place motion effects in the active 
sequence See the Sequencing topic for more information on how to use the Motion Effect Generator
when editing your sequences. Placing motion effects in a sequence requires the Pro license level.

Sequencer Preferences

This option on the Tools menu opens the Sequencer Preferences dialog, which allows you to
customize some of the look and behavior of the S5 Sequencer..

Change User Data Directory

This option on the Tools menu allows you to change the default directory where your audio and
sequence files are stored. You should back up your sequence files before initiating this action.

Waveform Colors

This option on the Tools menu allows you to customize the colors of the waveform display.

Theme

This option on the Tools menu allows you to choose among several themes (color schemes) for
displaying the main window of the Light-O-Rama Sequencer

Zoom Preferences

This option on the Tools menu allows you to customize zoom preferences (default row height and
time scale width) for new sequences.
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5.3.1.3.1  Sequencer Preferences

The Sequencer Preferences sub-menu on the Light-O-Rama S5 Sequencer's Tools menu opens a dialog
that allows you to customize the behavior of certain functions in the Sequencer. The dialog has several
tabs:

Tooltips
Playback
Motion Effects
Previews
Save Copy
Video
Cursors
Start Up

The Sequencer Preferences Dialog

5.3.1.3.1.1  Tooltip Preferences

The "Tooltips" tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools menu.
From here you can control how tool-tips are displayed on the sequence grid.

Enable tooltips
Seconds before opening
Seconds before closing automatically
Manually close tooltips on mouseover
Manually close tooltips on click
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Sequencer Preferences - Tooltips Tab

Enable tooltips

If this box is checked, when the mouse is over a sequence grid, a tool-tip displaying information
about the cell being pointed to can be displayed. 

Seconds before opening

If tool-tips are enabled, this text box controls how many seconds it will take before the tool-tip pops
up, when the mouse is kept still over a sequence grid.  

You do not have to specify a whole number; for example, you can set it to six tenths of a second by
entering "0.6".

Seconds before closing automatically

If tool-tips are enabled, this checkbox and text box control whether or not they will automatically
close themselves a certain amount of time after being opened.  If the checkbox is checked, they will
automatically close after the number of seconds specified in the text box.

You do not have to specify a whole number; for example, you can set it to three-quarters of a
second by entering "0.75".
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Manually close tool-tips on mouseover

If tool-tips are enabled, selecting this option will make them close when you roll your mouse over
them.  The other option is to make them close when you click on them.

Manually close tool-tips on click

If tool-tips are enabled, selecting this option will make them close when you click on them.  The
other option is to make them close when you roll your mouse over them.

5.3.1.3.1.2  Playback Preferences

The "Playback" tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools menu.
From here you can control how:

How color samples are displayed during playback
How progress is indicated during playback

Sequencer Preferences - Playback Tab

Color Sample Preferences

This option controls the width of the color sample area (just to the right of the channel names, as
shown in the picture below). Choose "No color sample" to not display color samples at all.
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Playback Progress Preferences

This option controls how the playback marker is displayed. The options are:

Use a moving marker. This displays a marker at the current playback location, regardless of
timing marks.
Highlight the current column. This highlights the timing marks immediately before and after the
current playback location.
Highlight the current timing mark. This highlights a timing mark as the current playback position
reaches it. When the playback position is between timing marks, nothing is highlighted. This
mode is useful for verifying that your timing marks match the music.

Playback in Progress

5.3.1.3.1.3  Motion Effect Preferences

The "Motion Effects" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can control:

How motion effects are displayed in the sequence grid
How the Motion Effect Generator is initialized when it opens
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The Sequencer Preferences - Motion Effects Tab

How motion effects are displayed in the sequence grid

Motion Effect Row Colors

Motion effects on any particular row in the sequence grid alternate colors in order to show where one
effect stops and the next effect starts. The colors shown on the grid have nothing to do with the
colors that are used in the effect. Use "Grid color 1" and "Grid color 2" to set the 2 colors displayed
on the sequence grid for motion effect rows.

The pictures in the next section demonstrate what this actually looks like in the sequence grid.

Motion Effect Names

The first 4 letters of the effect's name can be displayed on the sequencer grid. This can help identify
the effect.

Here is an example with name display disabled. The only ways to identify an effect are to either 1)
double-click on the effect to open it in the Motion Effects Generator, or 2) single-click on the effect
and it will be displayed in the playback window (assuming the playback window is not hidden).
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Motion effects w ith naming disabled

Here is the same example with name display enabled. You can see that the first row contains a
series of Colorwash effects, the second contains Bars effects, and the third row contains Spiral
effects.

Motion effects w ith naming enabled

How the Motion Effect Generator is initialized when it opens

The Motion Effect Generator can be initialized with values from the sequence toolbar when creating a
new effect (it has no impact when modifying an existing effect). If enabled then the first color in the
palette will reflect the value of the Color Fade Tool on the sequence toolbar. Also, the effect will be
initialized based on the current toolbar channel effect: Colorwash motion effect for "on", Twinkle
motion effect for "twinkle", and a flashing Colorwash motion effect for "shimmer".

5.3.1.3.1.4  Channel Effect Preferences

The "Channel Effects" tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools
menu. From here you can control how channel effects are displayed on the sequence grid.
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The Sequencer Preferences - Channel Effects Tab

Fades

When fade or intensity lighting effects are displayed in the Sequencer, they are displayed in one of
two ways: "as ramps" or "as colors".  You can use the "View fades as ramps" check box to control
which is used.

When viewed "as colors", fades and intensities will be displayed as gradually varying shades
between light grey (which indicates that the channel is off, i.e. the intensity is zero) and the color
assigned to the channel (which indicates an intensity of 100%, i.e. full brightness).

When viewed "as ramps", they are instead displayed as partially filling in their cells with the color of
the channel, to a degree based upon the intensity.

Neither of these settings have any effect on the behavior of your actual lights; they only affect how
the Sequencer displays these lighting effects in the sequence grid.

A sequence with fades viewed using colors
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The same sequence, w ith fades viewed as ramps

Channel Background Color

Regular channels and beat channels are displayed with a gray background on the sequence grid.
However, you can control how light or dark you want the gray background to be. Use the slider to
control the lightness. A sample is shown to the right of the slider.

5.3.1.3.1.5  Preview  Preferences

The "Previews" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can control:

How preview background images are handled
The screen drawing quality

The Sequencer Preferences - Previews Tab

How preview background images are handled
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The first check box controls whether the background image is displayed at all. We recommend that
you leave this box checked.

The second part determines whether the background image will be stretched to completely fill the
playback window, or whether the image's aspect ratio (the ratio of the width to the height) will be
maintained. Note that props are drawn in relation to the background image; so if you choose the
option where the aspect ratio is maintained, then it will also be maintained for the all of the props in
the preview. Maintaining the image's aspect ratio is highly recommended.

The screen drawing quality

If you are running the Sequencer on a game-rated computer (one that has a graphics card), then the
Sequencer can take advantage of that hardware in Preview Design and while playing a sequence in
the playback window. This is a performance versus display quality setting. If you choose a higher
quality setting and then notice that playback lags, then you will want to return to this tab and
choose a lower quality setting.

Changing the drawing quality will not take effect until the next time the Sequencer is started.

Hexagon-shaped bulbs at the lowest quality setting (enlarged to show detail):

Hexagon-shaped bulbs at the highest quality setting (enlarged to show detail):

5.3.1.3.1.6  Save Copy Preferences

The "Save Copy" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can customize the behavior of the Save A Copy item on the
File menu. The available options are:

Save A Copy During Regular Save
Save A Copy Location
File Name Suffix
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The Sequencer Preferences - Save Copy Tab

Save A Copy During Regular Save

If this box is checked, then every time the user performs a regular Save operation it will be
automatically followed by a Save A Copy operation. If unchecked, then Save A Copy will only be
performed when the user selects it from the File menu.

Save A Copy Location

This option allows the user to specify the folder for Save A Copy operations.

File Name Suffix

This option allows you to customize the default suffix that is applied. Choosing the “Date and Time”
option is particularly useful for making multiple backup copies of your sequence. 

If you enter custom text, you can only use characters that are valid in Windows file names. These
characters are forbidden: * . " / \ [ ] : ; | = , 

5.3.1.3.1.7  Video Preferences

Musical sequences are associated with a song or other sound effect, from either an audio file (such as
an MP3) or a video file (such as an AVI, WMV, or MP4 file).  If a musical sequence is associated with a
video file, Light-O-Rama can display the video during play. 

The "Video" tab is accessed by selecting Sequencer Preferences from the Sequencer's Tools menu and
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can be used to control whether and how video is displayed during playback.

There are 2 sets of video preferences. The left side controls how videos are displayed during sequencing
(while using the Sequencer). The right side controls how videos are displayed in shows by the Show
Player.

On either side you have the same 3 choices:

Display Videos in a Window 
Display Videos in Full Screen Mode
Use Audio Track Only When Sequencing With Video Media

Not all modes are supported at all license levels. See the Feature Comparison page for more
information.

The Sequencer Preferences - Video Tab

Display Videos in a Window

In this mode, video will be displayed in a window. You can move the window and resize it as needed.

Display Videos in Full Screen Mode

In this mode, video will be displayed full screen. If you have multiple monitors, the method for
choosing the monitor where the video will be display is different for sequencing and show playback:
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For sequencing, first select the Display Vidoes in a Window option. Play a sequence and position
the video window on the desired monitor. Stop playback. Go back into Video Preferences and
change the option to Full Screen Mode.
For show playback, select the desired monitor from the drop-down list.

Use Audio Track Only When Sequencing With Video Media

In this mode, when a musical sequence with a video is played, only the audio track of the video will
be played. There will be no video window.

5.3.1.3.1.8  Cursor Preferences

The "Cursors" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can customize the cursor that is displayed when:

drawing light strings in Preview Design
using effect tools on the toolbar, like "on" or "chase"

Sequencer Preferences - Cursors Tab

You have your choice of:

Yellow pencil (default). Some users say the black tip of the pencil makes the exact location of the
cursor hard to determine. Therefore, you can also choose...
White pencil, or
Up Arrow. This cursor is built into Windows. So if you have custom cursors loaded onto your
system, the arrow may look slightly different than what is shown in the dialog.
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The intent is that the Sequencer uses the default Windows arrow cursor for selection and a different
cursor when drawing.

5.3.1.3.1.9  Start Up Preferences

The "Start Up" tab is accessed by selecting Sequencer Preferences from the Light-O-Rama S5
Sequencer's Tools menu. From here you can control:

Whether Control Lights is automatically enabled if the Comm Listener is already running when the
Sequencer is started.

The Sequencer Preferences - Start Up Tab

5.3.1.3.2  Themes

The Themes menu item on the Light-O-Rama S5 Sequencer's Tools menu opens a dialog that allows
you to select a color scheme for the main Sequencer window. 
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Theme Selection Dialog

There are 3 themes to choose from:
Light
Dark
Blue

After selecting a theme, the Sequencer will need to be restarted in order for the new theme to take
effect.

Light Theme
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The Light Theme

Dark Theme
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The Dark Theme

Blue Theme
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The Blue Theme

5.3.1.3.3  Zoom Preferences

When a sequence is displayed in the Sequencer, it is represented as a grid.  You can zoom in or out of
the grid in either the horizontal and vertical direction at any time. See the Scrolling and Zooming topic for
more information.

Whenever save your sequence the zoom level is saved too. And when you re-open that sequence, the
zoom level will be restored. However, whenever the Sequencer creates a new sequence, it will use some
default zoom level settings.  If you prefer some particular zoom level, you probably do not want to zoom
in or out every time that you create a sequence.  So, the Zoom Preferences sub-menu (of the Tools
menu) allows you to save your current zoom level settings as defaults, by selecting "Save Zoom
Preferences".

Later, when you create a new sequence, it will default to the zoom level settings that you had saved.
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If you change the zoom level on a sequence and want to get back to your saved default zoom level
settings, the Zoom Preferences sub-menu also provides a way to do this: by selecting "Apply Saved
Preferences".

There is also a system default zoom level, and selecting "Apply System Defaults" will apply that to the
active sequence.

Zoom Preferences Sub-menu

5.3.1.4 Window Menu

The Window menu of the Light-O-Rama Sequencer enables you to hide or show certain Sequencer
windows on your screen.  Most importantly, it allows you to reset the position of all windows to their
default locations.

The following menu items are available:

View Start Page
View Playback Window
View Motion Effects Window
View Previews Window
View Control Lights Window
Float Current Window
Reset Window Layout

View Start Page

Selecting this option on the Window menu unhides the Start Page. This menu item is only shown if
the Start Page is currently hidden.

View Playback Window
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Selecting this option on the Window menu unhides the Playback window. This menu item is only
shown if the Playback window is currently hidden.

View Motion Effects Window

Selecting this option on the Window menu unhides the Motion Effects window. This menu item is
only shown if the Motion Effects window is currently hidden and the user has a Pro license.

View Previews Window

Selecting this option on the Window menu unhides the Preview Management window. This menu
item is only shown if the Preview Management window is currently hidden.

View Control Lights Window

Selecting this option on the Window menu unhides the Control Lights window. This menu item is
only shown if the Control Lights window is currently hidden.

Float Current Window

This option on the Window menu floats the current window so that it can be moved and sized
independently of the main Sequencer window. If you have multiple display monitors, you can move a
floating window to a separate monitor. Only the Playback, Preview, Motion Effects, and Control
Lights windows can float. Sequence windows cannot float.

Reset Window Layout

This option on the Window menu resets the position of all windows to their default locations, as
shown below.
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5.3.1.5 Help Menu

The Help menu of the Light-O-Rama Sequencer brings up help and other information about Light-O-
Rama.

The following options are available on the Help menu:

Contents
Index
Search
Shortcut Keys
Welcome
Visit Light-O-Rama on the Web
About the Light-O-Rama Editor
Register or Upgrade Light-O-Rama



Light-O-Rama v5.2.4146

© 2019 Light-O-Rama, Inc.

The Help Menu

Contents

This option on the Help menu opens up the main Sequencer topic in the Light-O-Rama help file.

It has a keyboard hotkey: F1

Index

This option on the Help menu opens up the index of the Light-O-Rama help file.

Search

This option on the Help menu opens up the search menu of the Light-O-Rama help file.

Shortcut Keys

This option on the Help menu opens up the Keyboard Shortcut Summary in the Light-O-Rama help
file.

Welcome

This option on the Help menu displays some introductory information to help you get started using
the Light-O-Rama Sequencer

Visit Light-O-Rama on the Web

This option on the Help menu opens the Light-O-Rama website in your web browser.

About the Light-O-Rama Editor

This option on the Help menu brings up the Sequencer's About box, which displays some
information about the program and your computer.

Register or Upgrade Light-O-Rama

http://lightorama.com/
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Use this item on the Help menu to register your Light-O-Rama software, or to upgrade to a higher
level license, unlocking various features.  

5.3.1.5.1  About

Selecting "About" from the Light-O-Rama Sequencer's Help menu displays the version of the Sequencer
that you are running, your Light-O-Rama license information, and information about your computer.
When contacting Light-O-Rama for help with the Sequencer, being ready with the information displayed
in the “About” window can assist in getting your problem resolved faster.

If you create a ticket with the Light-O-Rama Help Desk, you can use the "Copy to Clipboard" button to
copy the information shown in the window so that your can paste it into your ticket. This will assist in
getting your issue resolved faster.

The S5 Sequencer's About Box

5.3.2 Start Page

The Start Page gives you links to quickly start a new animation or musical sequence, and to open
sequences that have been recently viewed. The list of recent sequences on the Start Page are the same
ones listed on the Files > Recent Files sub-menu. The Start Page can be docked in any location,
floated, or hidden.
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5.3.3 Previews Window

The "Previews" window is normally docked on the right side of the main Light-O-Rama S5 Sequencer. To
keep the window open, click the pin icon in the upper right corner of the window. From the Preview
window you can create, modify, delete, and import/export previews.

From here you can:

Double-click on a preview name to edit it. This will open a Preview
Design window with the selected preview loaded. 

Click the "+" icon to start a new preview. This will open an empty
Preview Design window ready for you to create a preview from
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scratch.

Click on a preview name and then click the pencil icon. This will
open a Preview Design window with the selected preview loaded.

Click on a preview name and then click the red “X” button. You will
be prompted to confirm that you want to proceed with the
deletion. Click “Yes” to delete or click “No” to cancel. If after
deleting it you find that you want to get it back, assuming you
have a sequence associated with that preview you can just open
that sequence and the preview will be imported from it.

Click on a preview name and then click the “Copy” button. You
will be prompted for the name of the new preview. If you keep a
copy of a preview for each year of your display (recommended),
then this is the command you should use to copy one year's
preview to the next (e.g. 2018 to 2019).

Click the Import icon to open a menu that allows you to:

Import a Visualizer (LEE) file. You will prompted to select
an LEE file and it will then be imported into a new preview.
During the import process, Visualizer fixtures will be
converted to props, and Visualizer props will be imported as
preview groups.
Import a Sequence Editor Animation. You will be prompted
to select the LMS or LAS sequence file that contains the
animation.
Export an S5 preview. You will be prompted for the file
name. This creates a file with an LORPREV extension.
Import an S5 preview. You will prompted to a select a file
with an LORPREV extension.

Right-click on a preview name to open a menu that allows you to:

Modify the selected preview in a Preview Design window.
Delete the selected preview. You will be prompted to
confirm that you want to proceed with the deletion.
Copy the selected preview. You will be prompted for the
name of the new preview.
Export the selected preview. You will be prompted for the
file name. This creates a file with an LORPREV extension.
Create a new musical sequence using the selected
preview.
Create a new animation sequence using the selected
preview.

5.3.4 Preview Design

Creating a preview is the first step in using the Light-O-Rama S5 Sequencer. No sequencing can be
done without a preview. While it is possible to create a preview outside of the Preview Design window
(via import, or using the Quick Preview feature when creating a new sequence), any editing of a preview
must be done in Preview Design.
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A preview defines the lighting elements in your display and how they are arranged. It allows your
sequences to be simulated during playback. A preview can be a quick rough sketch, or a detailed, highly
realistic depiction of your display. It is up to you to decide how much effort you want to put in to it. In
any case, the preview must accurately define every channel that will be controlled by your sequences.

You can access the Preview Design window from the Previews Window or from the Preview Menu on
the sequence toolbar.

Props and Groups

The display elements in a preview are referred to as 'props'. You must add a prop to the preview for every
display element that you want to control. A prop can be as simple as a single channel string of
traditional lights, or as complex as a big pixel tree or matrix. When you create a prop, you define the
type and color of lights that it uses, its shape, and the channels assigned to it. If one of the built-in
shapes doesn't meet your needs, then you can define a custom shape.

A sample of some of the shapes that come built-in to S5

Props can be grouped together. 
You might do this so that the props appear together in the sequence grid. 
You might also create a group so that you can apply an effect to the group instead of individual
props. This enables things like sweeping a color across your entire display.

One Preview > Multiple Sequences

One preview can be associated with multiple sequences. Update the preview once, and the next time
you open any sequence associated with that preview, the update will automatically be applied.
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Using Preview Design

At the top of the Preview Design window are:

The Save and Cancel buttons
The Preview Name field. The name must be unique -- having 2 previews with the same name is not
allowed. If a preview is already associated with one or more sequences and you change the
preview name, the association with sequences will be preserved. See the topic on Naming
Strategies for a deeper discussion of how to name previews.

Below this there are 5 tabs:

Design - this is where you will do most of your work, creating props and arranging them so that
they match your display.
Channel Conflicts and bulk change tool - this tab will show a green check mark if everything is
OK, and a warning sign if there are problems with the channels you have assigned to your props.
The tab allows you to quickly identify the issues and resolve them. It can also be used to make
changes that affect multiple props, such as when you change a controller's unit id (e.g. 01 to 11)
or network (e.g. Regular to Aux A).
Other Warnings - this tab will show a green check mark if everything is OK, and a warning sign if
there are problems with prop definitions (e.g. a sub-prop is not assigned the same channels as its
master prop).
String Summary - this tab displays a table of all strings defined by every prop in the preview. If you
want a print-out of your props and channel assignments to carry with you as you wire up your
display, you can use this table, copy it to the clipboard, and paste it into any spreadsheet
program. In the spreadsheet you can sort and filter the data, add and remove columns, and print it
out.
Statistics - this tab gives you statistics about the preview: number of props, groups, pixels,
channels, etc.
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The Preview Design window showing a sample preview

5.3.4.1 Design Tab

The Design tab of the Preview Design window is where you create props (display elements) and arrange
them so that they match your display. 

This is the first of 5 tabs on the Preview Design window. The others are:

Channel Conflicts & Bulk Changes
Other Warnings
String Summary
Statistics
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The Design Tab

The Design Tab is divided into 2 main sections:

The left side contains controls that allow you to create and modify props and groups:

Add Item button
Zoom control
Toolbar
Prop and Group List
Bulb tab
Scale tab
Background tab

The right side is the visual design canvas - a representation of your display that will be used to simulate
your lights during sequence playback.
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Selecting Items

Items in the Prop and Group List can be selected by clicking on them. The prop or group that is selected
will then be displayed in yellow on the design canvas to the right. You can also do the reverse: you can
click on a prop on the design canvas and its name will be highlighted in the Prop and Group List. 

You can also select more than one item at a time. This is often useful for moving several props at the
same time or for creating groups. In the Prop and Group List, Ctrl-click on an item to select it in addition
to items already selected. Use Shift-click to select a range of items in the list. When selecting items
using the mouse on the design canvas, hold the Shift button down on the keyboard while clicking the
mouse and that prop will be added to the ones already selected.

In the picture below, the “Gutter” prop has been selected – it is highlighted in the Prop and Group List
and displayed in yellow on the design canvas.

Keyboard Shortcuts

The following keyboard shortcuts can be used on the design tab:

Shortcut Action

deletes the selected prop or group

  

selects all props

moves the selected props by a small amount
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Makes the selected items larger. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

  

Makes the selected items smaller. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

  

rotates the selected props counterclockwise

  

rotates the selected props clockwise

  

Control-zero resets prop rotation to its default value (fixed prop
shapes only)

  

undo last operation

  

redo last operation

Add Item

Click the Add Item button to add Props and Groups to your preview. After saving the new prop or
group, it will be added to the Prop and Group List and displayed on the design canvas on the right.

Create a new prop using one of the built-in shapes, or define a custom shape

This option opens the Prop Definition window, allowing you to create a prop from scratch. The wide
variety of built-in shapes makes it easy to create many common display elements.
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Some of the shapes that can be selected in the Prop Definition w indow

Create a new group from existing props and groups

This option opens the Group Definition window, allowing to create a new group. Any props and
groups that are currently selected on the Design tab will be preselected on the Group Definition
window as members of new group. Of course you can change the selections once you are in the
Group Definition window.

Add a Light-O-Rama device (AC controller, Cosmic, Pixie, Pixcon, Flood, etc)

This option will create props according to the Light-O-Rama controller and unit id you specify. It is a
good way to quickly create props that have accurate channel assignments. Flood lights created with
this option will look realistic, but you may need to change the shape for props created for other
controllers if you are going for realism in your preview.

Add a DMX device

This option can be used to create a generic DMX device that uses regular (single) or RGB channels.
It is a quick way to create props that have accurate channel assignments; but if you are going for
realism, use "Create a new prop" or one of the "online" options instead.

Add an RGB device (generic)

This option can be used to create RGB floods and "dumb RGB" props attached to Light-O-Rama
controllers. Each prop will be created as single RGB bulb with a star shape. It is a good way to
quickly create RGB props that have accurate channel assignments; but if you are going for realism,
use "Create a new prop" or one of the "online" options instead.

Import an S5 prop file

This option loads props and groups into your preview from a file that had previously been exported.
These files have an “.lpeprop” extension. You should review the channel assignments on any
imported props to make sure they match your controllers – this can be done by double-clicking on
the name of an imported prop to open the Prop Definition window. By default, an imported prop will
be assigned the name that it had when it was exported. However, if that name is already being used
in the preview, then a numeric suffix will be added to the name in order to make it unique.

Import a Visualizer file (fixture, prop, or complete visualization)

This option imports a file created with the S4 Visualizer. You will be prompted to select a Visualizer
fixture file (.LFF extension), prop file (.LPF extension), or complete visualization file (.LEE
extension). All of the fixtures and props defined in the selected file will then be loaded into the
preview. Visualizer fixtures will become S5 props. Visualizer props will become S5 groups. You
should review the channel assignments on any imported props to make sure they match your
controllers.
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Draw a new string

When you select this option, the cursor will change to a pencil shape when moved over the design
canvas. Click on the design canvas to start drawing your string. A single click of the left mouse
button will insert a vertex into the line and allow you to continue drawing the next segment. To stop
drawing, double-click the left mouse button or use the ESC key. When you stop drawing, the Prop
Definition window will open so you can adjust the number of bulbs in the string and also assign a
channel.

This option is also available by right-clicking on the design canvas.

Light-O-Rama props (online)

This option will allow you to import props for items sold in the Light-O-Rama store, such as pixel
trees and singing faces. It is recommended that you have internet access when using this option so
that you see the latest available content (content will likely change over time). You should review the
channel assignments on any imported props to make sure they match your controllers.

SuperStar (online)

This option will allow you to import props that match sequences sold by SuperStar Lights. It is
recommended that you have internet access when using this option so that you see the latest
available content (content will likely change over time). You should review the channel assignments
on any imported props to make sure they match your controllers.

Boscoyo Studio (online)

This option will allow you to import props for items sold by Boscoyo Studio. You will need internet
access when using this option so that you can retrieve the content. You should review the channel
assignments on any imported props to make sure they match your controllers. 

Prop definitions imported from this link were created by Boscoyo Studio. Light-O-Rama provides a
connection to the data in order to make our software easier to use, but is not responsible for the
content.

Generic Props (online)

This option will allow you to import props for some commonly used lights. It is recommended that
you have internet access when using this option so that you see the latest available content
(content will likely change over time). You should review the channel assignments on any imported
props to make sure they match your controllers.

Zoom

You can zoom in on your props to make fine adjustments. The buttons on the left and right will
zoom in or out one step at a time. Or you can use the slider to quickly move to the desired zoom
level. If you are zoomed in, clicking on a prop in the Prop and Group List will cause the canvas to

http://www.superstarlights.com/
https://www.boscoyostudio.com/
https://www.boscoyostudio.com/
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scroll so the selected prop becomes visible.

Toolbar

The toolbar consists of:

Item menu
Format menu

Options menu:   icon
Undo and Redo buttons

Item Menu

Most of the choices on the Item menu are also available when you right-click on the Prop and Group
List and also when you right-click on the design canvas.

Modify - you can double-click on an item’s name, or you can single-click on it and select “Modify”
from the Item Menu. Either method will open the Prop Definition window if a prop is selected, or
the Group Definition window if a group is selected. 
Copy - this command opens the Copy Prop Dialog, which is very helpful in creating a collection of
props that all look the same, such as a series of arches or mini-trees.
Delete - use this command to delete the selected props and groups. You will be asked to confirm
before the delete actually takes place.
Layout - use this command to view a printable layout of the selected prop or group with channel
information for every string or pixel. This can be quite large depending on the number of channels/
pixels involved.
Copy prop to advanced shape - this command is used to copy a pixel-based prop to a new prop
with the same channel assignments and pixel locations but with the Advanced shape so it can be
further customized.
Export selected items - this command exports the selected props and groups to a file. You might
do this so they can be imported into another preview or so they can be shared with other users. 
You will be prompted for a location to save the export file.  Export files have the extension
".lpeprop". To import props, see the Add Item button.

Format Menu
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Format menu with Align submenu open

All items on the Format menu are also available when you right-click on the design canvas.

Align - if multiple props are selected, the items on this sub-menu allow you to align those props in
various ways.
Make same size - if multiple props are selected, the items on this sub-menu allow you to resize
the selected items such that they all have the same width, height, or both.
Horizontal spacing - if multiple props are selected, the items on this sub-menu allow you to make
the horizontal spacing between them equal, or to remove any space between them (so they abut
one another).
Vertical spacing - if multiple props are selected, the items on this sub-menu allow you to make
the vertical spacing between them equal, or to remove any space between them (so they abut one
another).
Rotation - after selecting 1 or more props, the actions listed under the “Rotation” menu allow you
to rotate the selected items back to their default orientation (0 degrees), to 90 degrees right, or 90
degrees left. Selected props and/or groups can be rotated to any angle by dragging the rotation
handle that is displayed when they are selected or using the keyboard shortcuts Ctrl-LeftArrow
and Ctrl-RightArrow. Ctrl-0 (control key + zero key) is a shortcut for resetting rotation back to the
default orientation (0 degrees). Note that freeform prop shapes do not have a default orientation, so
the Rotation > 0 command has no effect on them.
Reset - after selecting 1 or more props, the actions listed under the “Reset” sub-menu allow you
to reset the selected items back to their default position (centered), or default size (1/2 of the
canvas size), or both. Resetting the position is particularly useful because it is possible to drag
items off the edge of the design canvas. When this happens, select the prop from the Prop and
Group List, then choose Format > Reset > Position from the menu.

Options Menu

Show pixel numbers on selected props - this option displays a number next to each pixel in the
selected pixel-based prop. The number indicates the order in which the pixels should be wired;
however, it does not indicate which string the pixel is on. You will need to zoom in to read the
numbers. This option is also available by right-clicking on the design canvas.
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Numbered Pixels

Set color for pixel number labels - this option allows you to change the color used to display pixel
numbers when "Show pixel numbers" is enabled.
New prop defaults - this option allows you to set some defaults when the Prop Definition screen is
used to create new props.

Preview Design Preferences

Undo/Redo

Prop adds, deletes, movement, scaling, and rotation can be undone and redone. Undo/redo does not
apply to modifying props or groups.

 clicking this button undoes the last operation, and has the keyboard shortcut Ctrl-Z.

 clicking this button reapplies an operation that was previously undone, and has the keyboard
shortcut Ctrl-Y.

Prop and Group List

The Prop and Group List is displayed immediately below the toolbar. Every prop and group in your
preview will be listed here in alphabetical order. To help distinguish groups from props, groups will be
listed with blue text. In the picture below, "Arch 2-3", "Arch 4-5", "Arch 6-7", "Arch 1-7" and "Arches
with subgroups" are groups, and the others are props. Props "arch1" through "arch7" are selected.

To select an item in the list, just click on it with the left mouse button. You can use shift-click to
extend the selection, and ctrl-click to select additional items. More information is available in the 
Selecting Items section.
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The Prop and Group List

After selecting 1 or more items in the list, you can use the toolbar to select actions to perform, or
you can right-click on them to view a menu that has many of the same options as the Item menu.

The Prop and Group List w ith right-click menu

displayed

Bulb Tab
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After selecting 1 or more props, you can change the bulb settings for the selected props. The default
bulb shape is square, which uses the least amount of computer resources; however there are a
variety of shapes available.

There are some specialized bulb shapes:
Strobe 1 - a strobe that flashes about once per second
Strobe 3 - a strobe that flashes about 3 times per second
Snowfall Tube - simulates single color snowfall tubes (also known has drip tubes and meteor
tubes).
Flood - use for flood lights, single color or RGB.

Making the bulb size larger can make the prop easier to see on the computer screen. For strobes
and floods you will almost always want to make the bulb size larger than the default in order to
make them look realistic.

For most props, you will want to leave the bulb transparency setting at 0%. For floods, you may
want something more transparent (> 0%). Adjust the transparency slider until you achieve the
desired appearance.

An example of strobes on a megatree along with the associated prop definition:
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Scale Tab

After selecting one or more props or groups, you can use the buttons on this tab to increase or
decrease the size of the selected items. This can be useful for fine-tuning the size of an item. It also
the best way to resize freeform prop shapes, as they do not display resize handles on the design
canvas.

Click a button once to perform a small change, or hold the button down to continuously scale the
selected items.

The "Change height and width" buttons have the following keyboard shortcuts:

Shortcut Action
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Makes the selected items larger. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

  

Makes the selected items smaller. Hold the keys down longer to
engage the keyboard auto-repeat if needed.

Background Tab

Using a background image can be a great help in creating a realistic preview. Click the “Set Image”
button to choose the image file. Clicking the “Clear Image” button will remove the image from the
preview. Move the Brightness slider to the left to dim the background image, simulating the view of
your display during nighttime. Image brightness can also be changed from other areas of the
program.

Note that there are settings that control whether the background image is shown at all and whether
it maintains its aspect ratio.

Design Canvas

In the picture above, there is 1 blue string, 2 red strings, and 5 RGB arches. The second arch is
selected. 
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In the preview design window, traditional strings (incandescents, LEDs, strobes) are displayed with
the color of the string (e.g. a string of red LEDs will show as red). RGB pixels and dumb RGB
strings are displayed in white. Any string that has been selected, traditional or RGB, is shown in
yellow.

The selected item is always shown in yellow and has 4 red scaling “handles” at the corners (lines
just have 2 handles) and a rotation handle to the right. You can select multiple props using Shift-
click on the design canvas, or Ctrl-click or Shift-click in the Prop and Group List. The selected prop
(s) can be dragged around the preview window using the mouse. They can be resized by dragging
any one of the 4 red handles in the corners, or by using the Ctrl-UpArrow and Ctrl-DownArrow
keyboard shortcuts. You can rotate them by dragging the handle on the right side, by using the
Format > Rotation menu, or by using the Ctrl-LeftArrow and Ctrl-RightArrow keyboard shortcuts. If
you have multiple props selected, you can align them in many ways using the Format menu.

You can double-click on a prop to open its Prop Definition.

Any movement, scaling, or rotation action can be undone by clicking the undo button or using the
Ctrl-Z keyboard shortcut.

Right-Click Menu

After right-clicking on the design canvas you can:

Add an item - this has the same effect as clicking the Add Item button.
Draw a new string - this allows you to interactively draw a new light string directly on the design
canvas.
Modify the selected prop
Copy the selected prop
Delete the selected props
Perform any of the operations available on the Format menu
Enable or disable the display of pixel numbers on pixel-based props when they are selected

Right-Click on Lines-Connected Vertex
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5.3.4.2 Channel Conflicts & Bulk Changes Tab

The Channel Conflicts & Bulk Changes tab of the Preview Design window has 2 functions: 

1. It can be used to quickly identify and resolve props with conflicting channel assignments
2. It can be used change the channel assignments for multiple props at once (i.e. bulk change); for

example, moving multiple props from the Aux A network to the Aux B network, or from one DMX
universe to another.

The tab will show a green check mark if everything is OK, and a warning sign if there are channels
conflicts. A filtered list of props is displayed down the left side. Clicking on a prop will list its channel
assignments in the "Channels" area, where they can be changed. When clicking on a prop with a
channel conflict, the list of conflicts will be shown in the "Prop Warnings" area.

This is the second of 5 tabs on the Preview Design window. The others are:

Design
Other Warnings
String Summary
Statistics

The Channel Conflicts & Bulk Changes tab
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Sorting The List

The list of props can be sorted by Name or Start Channel by clicking the column heading. Clicking the
column heading a second time will reverse the direction of the sort.

Filtering The List

There are 3 filters that can be applied to the list of props. By default, the list is filtered to show only
channel conflicts.

The "Show" Filter

From this drop-down box you can choose to display:

All props in the preview
All props with channel conflicts
All props with device type "LOR"  (as shown in the channel section of the Prop Definition window)
All props with device type "DMX"
All props with device type "Undetermined"
Text starts with -- when using the Prop Name or Channel filters, compare the entered text with the
start of the name or channel
Text ends with -- when using the Prop Name or Channel filters, compare the entered text with the
end of the name or channel
Text contains -- when using the Prop Name or Channel filters, select the prop if the entered text
appears anywhere within the name or channel. This is also the text comparison method used
when any of the first 5 drop-down options is selected.

Prop Name Filter

Type some text into the "Name" box to filter the list by prop name. In the example below, only props
with the word "star" in their name are shown. If the "Show" filter is set to "Text starts with" or "Text
ends with", then only that part of the prop name will be matched; otherwise any prop name that
contains the text that was entered will be matched.
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Channel Filter

Type some text into the "Channel" box to filter the list by start channel. In the example below, only
LOR props with the word "aux b" in their channel name are shown. If the "Show" filter is set to "Text
starts with" or "Text ends with", then only that part of the channel name will be matched; otherwise
any channel name that contains the text that was entered will be matched.

Resolving Channel Conflicts
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Steps for resolving a channel conflict

1. Click on a row with a  warning sign.

2. Note that conflict details shown in the "Prop Warnings" area. Multiple conflicts may be listed here
if multiple props all have the same channel assigned, or the prop uses multiple channels and
those channels conflict with other props.

3. Determine the new channel that should be assigned to this prop and make the changes in the
"Channels" area. You might find a quick review of the information shown on the String Summary
tab helpful in determining the correct channel. Alternatively, you could go back to the Design tab,
double click on the prop name, and change the channel information in the Prop Definition screen
(but that would take longer).

4. After changing the assigned channel, click the "Save Update" button to commit the change. If you
go back to step 1 without performing this step, your changes will be lost.

Making Bulk Changes

"Bulk changes" means that you want to modify the channels assignments of many props at once.
To do this, you first need to select all of the props that you are going to change. You could do this
by clicking on the first prop, then Ctrl-Clicking on all of the other props that you want to change.
However, it is often faster to use the Filter Tools to narrow the list of props to just those that need to
change, then clicking the "Select All" check box to select them all.

After selecting the desired props, then you can select an action from the "Change" menu (these
actions can also be accessed by right-clicking on the selected props).
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The Change menu

Renumber Strings

Selecting "Renumber Strings" from the Change menu (or right-clicking on the prop list and selecting
"Renumber Strings") will open a dialog that will allow you to consecutively renumber the selected
props. At the same time, you can change the selected props from LOR to DMX or vice versa. 

When you renumber, the number of channels used by each prop is taken into account. For
example, if you are renumbering 3 props and props 1 and 3 each require 1 channel, but the second
prop requires 6 channels; then if you renumber starting at channel 9, the new channel numbers will
be:

First prop - channel 9
Second prop - channels 10-15
Third prop - channel 16
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Set LOR Network

The selected props will be moved to the LOR network you specify. For example, you could use this
function to move props from the Regular network to Aux A.
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Set LOR Unit Id

The selected props will be moved to the LOR unit id you specify. For example, you could use this
function to move props from unit 10 to unit 11.

Set DMX Universe

The selected props will be moved to the DMX universe you specify. For example, you could use this
function to move props from Universe 2 to Universe 12.

Delete Props

The selected props will be permanently deleted from the preview. This can be useful if a preview
contains items that are no longer needed and should be removed. Sometimes this situation can
even be the source of channel conflicts.

5.3.4.3 Other Warnings Tab

The Other Warnings tab of the Preview Design window displays warnings that are not related to channel
assignments. If there are warnings on this tab, any sequence that uses this preview cannot be played
back while control lights is enabled, and also playback files cannot be created. The tab will show a
green check mark if everything is OK, and a warning sign if there are problems. 

This is the third of 5 tabs on the Preview Design window. The others are:

Design
Channel Conflicts & Bulk Changes
String Summary
Statistics
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The Other Warnings tab

Warning Messages

Possible warnings that can appear on this tab include:

A sub-prop is not assigned the same channels as its master prop. If you change the channels
assigned to a master prop, you will also need to update the channel assigned to its sub-props.
A group has no members. Either add some members, or delete the group.
A group has a circular definition (it includes itself as a member).
Two or more groups share the same name. Each group should have a unique name.
Two or more props share the same name. Each prop should have a unique name.

5.3.4.4 String Summary Tab

The String Summary tab of the Preview Design window displays a table of all strings defined by every
prop in the preview (props with device type "undetermined" are not included). If you want a print-out of
your props and channel assignments to carry with you as you wire up your display, you can use this
table, copy it to the clipboard, and paste it into any spreadsheet program. In the spreadsheet you can
sort and filter the data, add and remove columns, and print it out. 

This is the fourth of 5 tabs on the Preview Design window. The others are:

Design
Channel Conflicts & Bulk Changes
Other Warnings
Statistics
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The String Summary tab

The Toolbar

The drop-down box allows you to filter the list by Device Type, so you can view just the LOR devices or
just the DMX devices.

You can use the copy button  to copy the displayed information to the clipboard so that it can be
pasted into a spreadsheet, where it can be sorted, filtered and printed.

The Grid

You can sort the grid by any column by clicking on the heading for that column. Clicking on a column
heading once will sort it in ascending order; clicking on it again will sort in the reverse order. Particularly
useful is clicking on the Device Type column heading, as this will sort first by Device Type, then by
Network, then by Unit, and then by Start Circuit giving you list ordered by physical connection (which
makes a good reference).

5.3.4.5 Statistics Tab

The Statistics tab of the Preview Design window gives you statistics about the preview: number of props,
groups, pixels, channels, etc. 

This is the fifth of 5 tabs on the Preview Design window. The others are:

Design
Channel Conflicts & Bulk Changes
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Other Warnings
String Summary

The Statistics tab

You can use the copy button  to copy the displayed information to the clipboard so that it can be
pasted into other applications.

5.3.4.6 Prop Definition

A prop in the Sequencer allows you to define a single item that is in your display. This item could be
simple, like a string of lights, or a wreath; or it could be complex, like a pixel tree or matrix. For every
prop, you assign it a name and then define the type of lights that it uses, its shape, and its assigned
channel(s).
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Name

Each prop must have a name. The name must be unique within the preview.

Comment

This is an optional field for you to make notes about this prop.

Lights Section

Use this section to define the types of lights your prop consists of.

Traditional

Choose the “Traditional” tab of the Lights section of the Prop Definition window to model strings of
LEDs or incandescent lights or strobes. Colors for your string are defined on the left. Click the
“Custom” button to choose a custom color. By default, the custom color is close to an incandescent
warm white bulb.
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Set the “Type” drop-down as follows:

Select “Multicolor string 1 ch” for single color strings or single color flood lights or a single
string with various light colors. Choose the colors that make up the string.

Choose “Channel per color” for bundles of single color strings (sometimes referred to as
"superstrings"). Select color(s) for the strings on the left. For each color you choose, that
color will show up in the “Order” list on the right. The Sequencer will assign one channel for
each color that you choose. If the channels for these strings are numbered consecutively, it is
recommended that you use the up and down arrows on the right-hand side to put the colors in
the order that their channels are assigned (click on a color to select it, then use the arrow
buttons to move it into the correct position). This way, the channels will be assigned correctly
without any additional action.

RGB

Choose "RGB Pixels" for LOR Cosmic Color Devices and any other pixel strips, nodes, or bulbs.
Use the "Motion Effects Rows" button to define default motion effect rows that will be incorporated
into new sequences (this setting has no effect on existing sequences). The number in
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parentheses on the button reflects the number of default motion effect rows that have already been
defined for the prop.

Choose "Dumb RGB (3 channel)" for display elements that have a single red, green, and blue
channel. This includes RGB floods and dumb RGB strips and nodes. 

The channel order should be set to reflect the way the red, green, and blue channels are physically
wired. If you are unsure, this may take some experimentation.

Shapes Section

Use this section to define how your prop looks on your computer screen during sequence playback.
Defining the shape accurately is also very important for pixel-based props so that motion effects get
displayed correctly.

In the Prop Definition window, choose a shape that most closely matches your prop. Use "Lines-
Connected", "Lines-Unconnected", "Lines-Closed Shape", or "Custom" to define a shape that isn't
listed. Any shape can be resized and rotated, so you are not limited to the traditional orientation of
the shape.

The description of the numerical entries in the middle of the shape section will change depending on
the shape that is selected and type of lights (traditional, RGB pixels, or dumb RGB). Many shapes
will require you to specify the number of lights in the prop (or in a section of the prop). For props with
traditional or dumb RGB lights, this number can be an approximation -- set it to a value that looks
good on your computer screen. For RGB pixels, the value must be the exact number of physical
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pixels.

At the bottom will be diagram of your shape primarily intended to show channel number orientation
for props with multiple channels.

Channels Section

In the right-most section of the window you define the channels assigned to the prop. This section
should be filled in last because the entries will change automatically based on the values you enter
in the “Lights” and “Shape” sections. Take care to enter this information accurately, or your lights
will not come on.

The Channels section

Uses The Same Channels As

Normally, you can leave this field set to "<none>". However, if you connect more than one set of
lights to the same channel, then you can create a "Master prop" and one or more "sub props" to
model this configuration. For example, if you have several candy canes that are all connected to the
same channel and turn on and off together, then you can create one candy cane as the Master
Prop. The master candy cane will have the "Uses The Same Channels As" field set to "<none>" and
it will appear in the sequence grid (as an example, assume this prop is named "Candy cane
master"). The other candy canes will be "sub props" --  the "Uses The Same Channels As" field will
be set to "Candy cane master" and the props will not appear in the sequence grid. Should you
change the channel(s) assigned to the master prop, it is up to you to also update the related sub-
props. If you fail to keep them synchronized, you will get a warning on the Other Warnings tab in
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Preview Design.

Device Type

Select the device type from the drop-down that matches your hardware. 

Use "LOR" for Light-O-Rama controllers using the Light-O-Rama protocol (or enhanced
protocol). Note that the PixCon16 controller can use the Light-O-Rama protocol or E1.31
(DMX) protocol -- so your Device Type selection on the Prop Definition screen needs to match
the way you have configured the controller..
Select “DMX” for controllers that connect via the E1.31 protocol over Ethernet or connect via a
DMX USB adapter..
A device type of “Undetermined” is available for situations where the device type is not
known. 

Max Circuit (or DMX Channel)

The number box at the top right defines how many channels are in each DMX universe or the
maximum circuit number if LOR is selected. For DMX, you can leave this at the default value of 512,
unless you have a controllers that does not allow an RGB pixel to cross universe boundaries. In this
case, set the DMX universe size to 510 (170 pixels per universe).

Individual Start Channels

For the first string, you must provide the starting Unit ID and circuit (for LOR channels), or universe
number and channel (for DMX channels). Subsequent strings will be calculated automatically. This
works great for many situations, but there are exceptions. For those exceptions, click the “Individual
Start Channels” check box. This will allow you to enter a starting Unit ID and circuit for every string.
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Separate Unit ID (or DMX Universe) for each RGB String

This check box will cause each string to start at circuit 1 of the subsequent Unit ID (or DMX
Universe) from the previous row. If this box is unchecked, then each row starts from the last Unit ID
and circuit from the previous row.

5.3.4.6.1  Prop Shapes

Prop shapes can be separated into 2 categories: freeform shapes which allow you to manipulate the
shape directly; and scalable shapes, where the position of all of the individual light bulbs are fixed in
relationship to one another.

For many shapes, you will specify a "starting location". This is the location of the first string or first pixel.
The starting location may contain the abbreviations "CW" and "CCW". 

CW stands for "clockwise" and means the strings proceed in a clockwise direction when looking
down from the top of the prop. 
CCW stands for "counter-clockwise" and means the strings proceed in a counter-clockwise
direction when looking down from the top of the prop

These are the freeform shapes:

Bulb Shape
Lines-Connected
Lines-Unconnected
Lines-Closed Shape
Matrix-Horizontal-Quad
Matrix-Vertical-Quad
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Advanced Shape

These are the fixed shapes:

Arch
Arch Opposing Strings
Candycane-Left, Candycane-Right
Custom
Cylinder
Cylinder spiral
Fan
Firestick
Globe 8 Rows
Hidden
Matrix-Horizontal-Rectangle
Matrix-Vertical-Rectangle
Sphere
Spokes
Star
Stars Nested
Tree 90, 180, 270
Tree 360 wedges
Tree 360 tiers
Tree 360 panels
Tree 360 up&over
Tree 360 spiral
Window Frame
Wreath

Freeform Shapes

Freeform shapes display handles that allow you to manipulate the shape directly. There are no scaling
handles; if you wish to scale them you must use the Scale Tab or the Ctrl-UpArrow / Ctrl-DownArrow
keyboard shortcuts. Also these shapes can be rotated, but they do not have a natural orientation so
Format > Rotation > 0 has no effect. 

Bulb Shape

In a bulb shape, every light is displayed with a red handle, allowing each one to be moved
independently of one another.

Bulb shape with 3 lights
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Lines-Connected

In a Lines-Connected shape, each vertex can be moved independently of one another. This makes it
great for drawing regular strings of lights. You can draw a Lines-Connected shape interactively by
right-clicking on the design canvas and selecting Draw New String from the pop-up menu.

Lines-Connected

Lines-Unconnected

In a Lines-Unconnected shape, the string is modeled as series of line segments, each of which can
be moved independently of one another.

A Lines-Unconnected shape with 5

segments

Lines-Closed Shape

A Lines-Closed Shape is modeled as a polygon with each vertex movable.
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Lines-Closed Shape

Matrix-Horizontal-Quad

The Matrix-Horizontal-Quad shape is like the Matrix-Horizontal-Rectangle, except that the corners
are movable.

Matrix-Horizontal-Quad shape

Matrix-Vertical-Quad

The Matrix-Vertical-Quad shape is like the Matrix-Vertical-Rectangle, except that the corners are
movable. This shape is useful for creating "CCR Trees" like the one shown below. Two props, each
with a Matrix-Vertical-Quad shape and 6 strings of 50 RGB pixels, are used to represent the
ribbons.
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12 Ribbon CCR Tree

The Matrix-Vertical-Quad shape can also be used to represent icicle lights -- made with either
traditional lights or RGB pixels. The next picture uses 2 Matrix-Vertical-Quad shapes: 1 for the icicle
lights on the left (highlighted in yellow), and another for the ones on the right. In this example, each
quad shape has 1 string of 150 lights with 29 folds.
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Icicle Lights

Advanced Shape

With an advanced shape you can move each individual pixel as needed by dragging them on the
design canvas. When moving pixels you should enable the display of pixel numbers so you know
which pixel you are moving.

You can also change how the pixels are arranged in the effects buffer by clicking the "Edit Advanced
Buffer Layout" button. As the name implies, this is is an advanced function, but can be used to
create pixel props that cannot be represented by other shapes.

In the next picture, a preview has been created with a background image of a snowflake. The pixels
have been arranged (with pixel numbers showing) to match how the prop is wired.
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Snowflake prop with pixel numbers shown

Next, the buffer layout for the snowflake is defined such that each arm of the snowflake is 4 columns
in the grid. Each number in the layout grid corresponds to the pixel number shown above. For help in
using the buffer layout grid, see the Custom Shape Light Placement grid topic (it works the same
way). With this buffer layout, motion effects that move left or right will go around the snowflake.
Motion effects that move up will expand from the center, and effects the move down will go from the
outside of the snowflake inward.

The buffer layout for the snowflake

This preview contains just one prop; but this prop would be one of many in someone's display. So
the final step would be to export this prop from this preview, and then import it into the preview
containing the full display.

Fixed Shapes
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Every shape that is not a "freeform shape" is a "fixed shape" -- the position of all of the individual light
bulbs within the shape are fixed in relationship to one another. Fixed shapes display scaling handles
when selected -- you can drag any of the 4 red handles to make the prop bigger or smaller. These
shapes also have a natural orientation, so you can use Format > Rotation > 0 to reset the prop to that
orientation.

Selected prop showing 4 scaling handles and a rotation

handle

Arch

The arch shape can be used for:

an arch with traditional light strings
a segmented arch with traditional light strings
a pixel-based arch

The arch shape prompts for the number of segments. This value should be set to 1, unless you are
modeling a segmented arch with traditional light strings.

Arch shape

Arch Opposing Strings

The "Arch Opposing Strings" shape is intended for large, pixel-based arches that have controllers on
both sides of the arch. The pixel strings run up both sides and meet at the top of the arch.

Pixel Numbering: Arch vs. Arch Opposing Strings



The Light-O-Rama Software Package 189

© 2019 Light-O-Rama, Inc.

Candycane-Left, Candycane-Right

These shapes can be used to represent candy-canes of various sizes. When used with multiple
columns of pixels, the pixel strings are assumed to be run vertically.

Candy-cane shapes

Custom

A custom shape allows you to define where the lights are using a grid. If you are using traditional
lights, you will have more flexibility defining your prop by using one of the freeform shapes. However,
for pixel-based props, a custom shape can be an easy way to define the arrangement of those
pixels. See the Custom Shape Light Placement topic for more information using the grid to define
your custom prop.

Here is an example of a candy cane defined using a custom shape with traditional strings. 

a "1" in a grid cell identifies lights on the first string
a "2" in a grid cell would identify lights on the second string
a "3" in a grid cell would identify lights on the third string, and so on

Custom Candy

Cane-Traditional Lights

Next is an example of a candy cane defined using a custom shape with pixels. 

"1" in a grid cell identifies the first pixel of the first string
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"2" in a grid cell identifies the second pixel of the first string, and so on up to 999
"1001" in a grid cell identifies the first pixel of the second string
"1002" in a grid cell identifies the second pixel of the second string, and so on up to 1999
"2001" in a grid cell identifies the first pixel of the third string
"2002" in a grid cell identifies the second pixel of the third string, and so on up to 2999

The next example shows 1 string of 12 pixels.

Custom Candy

Cane-Pixels

Cylinder

The cylinder shape allows you to model lights placed on a column. The lights can go completely
around the column, or you can specify 1/4, 1/2, or 3/4 coverage. If you choose partial coverage, be
sure choose the Starting Location entry carefully. When used with pixels, the pixel strings are
assumed to run vertically.  Lights facing away from the viewer are shown at a lower intensity in the
preview; however, this does not affect the actual lights.
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The column shape: 1 full coverage, and 2 half

coverage examples

Cylinder spiral

The Cylinder Spiral shape models one or more strings wrapped around a column.  Lights facing
away from the viewer are shown at a lower intensity in the preview; however, this does not affect the
actual lights.
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Cylinder Sprial Shapes with 1 and 2

strings

Fan

The fan shape models a 180 degree fan.

2 fan shapes with differing numbers of lights

Firestick

The firestick shape models a single vertical column of lights. When used with pixels, the "# of
Sections" parameter should be set to 1.
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Firestick Shape

Globe 8 Rows

The Globe 8 Rows shape models the spherical tree-topper sold by SuperStar lights. However, you
could also use the shape with traditional lights to model a single-color sphere. The number of lights
on this shape is fixed at 200.  Lights facing away from the viewer are shown at a lower intensity in
the preview; however, this does not affect the actual lights.

The Globe 8 Rows shape

Hidden

Use the Hidden shape to model items that are assigned channels but don't have any lights. This
could include macro channels on Light-O-Rama's Cosmic Color Ribbons, or control channels on a
DMX fixture.

Matrix-Horizontal-Rectangle

The Matrix Horizontal Rectangle shape models a set of lights arranged in a rectangle, where the
strings run horizontally. If the matrix needs to be skewed in some way, use the Matrix Horizontal
Quad shape instead. When modeling a pixel string on a gutter or eave, use this shape with the
number of strings set to 1.
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A Matrix Horizontal Rectangle shape with 16 strings

Matrix-Vertical-Rectangle

The Matrix Vertical Rectangle shape models a set of lights arranged in a rectangle, where the
strings run vertically. If the matrix needs to be skewed in some way, use the Matrix Vertical Quad
shape instead.  

A Matrix Vertical Rectangle shape with 16 strings

Sphere

The cylinder shape allows you to model lights placed on a spherical object. The lights can go
completely around the sphere, or you can specify 1/4, 1/2, or 3/4 coverage. If you choose partial
coverage, be sure choose the Starting Location entry carefully. When used with pixels, the pixel
strings are assumed to run vertically.  Lights facing away from the viewer are shown at a lower
intensity in the preview; however, this does not affect the actual lights.
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The sphere shape: 1 full coverage, and 2 half coverage examples

Spokes

The spokes shape models strings radiating from a central point.

The Spokes shape: 6 spokes with pixel numbers on the left, 12 spokes on the right

Star

The Star shape can model a single star with any number of points.
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4, 5, and 6-pointed stars

Stars Nested

The Stars Nested shape models 5-pointed stars that are nested one within the other. Up to 6 nested
stars are supported. It looks best when the number of lights in each star is divisible by 10.

The Stars Nested shape

Tree 90, 180, 270

These shapes model trees that are not a complete circle. Whether you choose 90 degrees, 180
degrees, or 270 degrees is a matter of preference - how it looks on the preview -- it does not change
the effects on the actual lights. Strings are assumed to run vertically up and/or down the tree.
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90, 180, and 270 degree trees

Tree 360 wedges

The Tree 360 Wedges shape models the most common type of lighted tree -- one where all sides of
the tree are lit. Strings are assumed to run vertically up and/or down the tree. Lights facing away
from the viewer are shown at a lower intensity in the preview; however, this does not affect the actual
lights.
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The Tree 360 shape

Tree 360 tiers

The Tree 360 Tiers shape divides the tree into layers and is sometimes referred to as a "z tree".
Each layer is activated by a different channel. This shape does not support pixels.
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Tree 360 Tiers shape parameters and diagram

Tree 360 panels

Commercial trees are often built with panels or branches that are placed around each layer of the
tree. When creating a panel tree you:

1. define the arrangement of lights on a single panel, and then 
2. specify how many panels there are on each layer of the tree.

There is a limit of 999 lights per panel.
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Tree 360 up&over

In a Tree 360 Up & Over shape, a string of lights goes up one side of the tree and down the opposite
side. Lights facing away from the viewer are shown at a lower intensity in the preview; however, this
does not affect the actual lights.
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Tree 360 Up & Over shape parameters and diagram.

The diagram is a view from the top.

Tree 360 spiral

Tree 360 Spiral shapes model a tree where the strings spiral up around the outside of the tree. The
"revolutions" parameter can be positive or negative -- the sign controls the direction of the wrapping.
Lights facing away from the viewer are shown at a lower intensity in the preview; however, this does
not affect the actual lights.
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Spiral Trees: 1 w ith 3 strings, and 2 w ith 1 string

Window Frame

You can use the Window Frame shape to model windows and doors. When modeling a door, set the
"# of lights at the bottom" to 0.

Using the Window Frame shape to model a w indow and a garage door

Wreath

Use the Wreath Shape to model any circular prop. When used with pixels, the pixels are assumed
to be wired outside to inside, and then continuing back to the outside, then inside, etc.

2 Wreaths, one with pixel numbers displayed
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5.3.4.6.2  Custom Grid

When using a Custom shape, Advanced shape, or Tree 360 Panels shape on the Prop Definition window
you will click a button to open the custom grid window:

For a Custom shape, you are using the grid to define the placement of your lights. 
For an Advanced shape, you are using the grid to define the placement of pixels in the effect
buffer.
For a Tree 360 Panels shape, you are defining the location of lights on a single panel.

Custom Grid Window

Entering Grid Data

To define the shape, place a number in each cell where there is a light or pixel:

For traditional strings and dumb RGB, the number you enter in the custom grid is the string
number. 
For RGB pixels, the number you enter is the pixel number. 1-999 are pixels on the first RGB
string. 1001-1999 are pixels on the second RGB string, 2001-2999 are on the third RGB string,
etc.

The picture below shows a candy cane with 12 RGB pixels. 
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Custom Candy

Cane-Pixels

If you were defining a candy cane made using a single incandescent string or a single dumb RGB string,
then all of the numbers in the grid would be “1”, as in the picture below.

Custom Candy

Cane-Traditional Lights

A number can be entered into a cell by:

Clicking on a cell and entering the number using the keyboard
Using the cut, copy, and paste buttons
Using the auto-numbering feature

The Toolbar

Cut, Copy, Paste
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Within the custom grid you can use the cut, copy and paste buttons (or their keyboard shortcuts) to
move blocks of data around the grid. You can also use them to move data to and from an external
spreadsheet (like Microsoft Excel).

Grid Menu

The Custom Grid Menu

From this menu you can:

Select All - selects all grid cells
Add Offset To Selection - prompts for a number (can be positive or negative), and then adds
that number to the selected cells. This can be used to change the string assigned to the
selected cells.
Flip Selection Vertical - flips the selected cells vertically. Using the example at the beginning
of this topic: a right-side-up candy cane will become an upside-down candy cane.
Flip Selection Horizontal - flips the selected cells horizontally. Using the example at the
beginning of this topic: a candy cane facing left will become a candy cane facing right.
Transpose - flips the entire grid so that the rows become columns and the columns become
rows. Here is the original candy cane example transposed:

Crop - deletes any blank rows at the top or bottom, and any blank columns on the left or right

Grid Size

The grid size controls
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Using these controls you can:

Change the width of the grid - adds or removes columns
Change the height of the grid - adds or removes rows
Change the size of the grid cells - make them smaller or larger

Using a Background Image

Using a background image can make placing the numbers in the grid much easier. Simply click the
Load Picture button to load a picture of your prop. The selected picture will be used as the
background of the grid. Acceptable file formats are JPG, PNG, and BMP. Then adjust the
Transparency slider so that the background image and the numbers you type in can both be seen.

A background image made partially transparent, and numbers entered for part of the outline
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Auto-numbering

When auto-numbering is active (i.e. the Active box is checked), you can just click on a cell with the
left mouse button to insert a number. If Auto Increment is checked, then the pixel number will
automatically increment after every mouse click. In general, Auto Increment should be unchecked
when creating a custom grid for traditional lights, and checked when creating a custom grid for pixel-
based props.

Keyboard Shortcuts

Key Action

Use the arrow keys to move one cell in the direction of the
arrow

Move to the first cell in the current row

Move to the last cell in the current row

Move up 1 screen 

Move down 1 screen 

Expand the selection by holding down the shift key while
using any of the keys listed above

Deletes the contents of the selected cells

Selects the entire grid

Cut

Copy
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Paste

5.3.4.7 Group Definition

In Preview Design, you can create groups of props. This enables you to apply effects to the entire group.
For example, if you have 4 arches in row, you could put them in a group. A curtain effect applied to the
group will be different than the same curtain effect applied to each prop individually. 

Preview Group Definition Window

Items In The Group

Place a check mark next to each prop that you want included in the group. You can use the Select All
button to check all of the boxes, and the Clear All button to clear all of the boxes.
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Arrangement

There are different ways to group props. In the arch example above, you would set the arrangement to
“horizontal stack” because arches are usually arranged horizontally. There is also a “use preview”
arrangement setting which applies effects according to the way the props are laid out in the preview. You
can even put all of your RGB elements in a single preview group and then apply effects to that group and
your entire display will appear to move together.

None

The group will only be used to keep items together in the sequence grid. You cannot create motion
effect rows for groups with an arrangement of "none".

Horizontal Stack Align Bottoms

Members of the group are arranged side-by-side. If there are members with varying heights, they will
be arranged using the bottom as a reference.

Horizontal Stack Align Tops

Members of the group are arranged side-by-side. If there are members with varying heights, they will
be arranged using the top as a reference.

Vertical Stack

Members of the group are arranged bottom to top. If there are members with varying widths, they will
be arranged using the left side as a reference.
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Nested

Members of the group are arranged bottom to top. If there are members with varying widths, items
with shorter widths are stretched to match the widest item..

V Stack, H Fill

This is like the "nested" arrangement, except that when items are stretched, pixels are repeated in
the buffer so that there are no gaps.

Use Preview

Pixels are arranged according to their placement in the preview. The slider associated this
arrangement can be used to adjust the granularity of the placement. Coarser granularity results in
faster performance, but might make your effects look "blocky" if you have many pixels. Finer
granularity will eliminate the "blockiness" but takes more memory and takes longer to calculate the
effects.
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Channel Layout

Use the channel layout to view the results of the arrangement setting. This is the pixel configuration that
will be used when motion effects are applied.

Motion Effect Rows

You can define a set of motion effect rows that will be applied when the preview is used during the
creation of a new sequence. Changes made to these motion effect rows do not affect existing
sequences.

5.3.4.8 Copy Prop Dialog

The “Copy” command is very helpful in creating a collection of props that all look the same, such as a
series of arches or mini-trees. This opens a window where you can specify how many copies should be
made. If the source name has a numeric suffix, then that number will be automatically incremented for
each copy. After the “Make Copies” button is pressed the new copies will be displayed

Here is the process for copying a prop:

Select the prop in the item list that will be the source of the copy. For props with a numeric
suffix, this prop’s name should end with “1”, “01”, “001”, “(1)”, “(01)”, or “(001)”. If you have
created 5 arches and then decide you need more, you can select the last one (e.g. “Arch 05”)
and the Copy command will continue your number sequence from there.

Select “Prop”, then “Copy” from the menu. This will open the Copy window. See the picture
below for an example.

The “Base Name” field should already be filled in for you. If you are creating a non-numeric
sequence such as “Left”, “Center”, “Right”, then you might want to edit the base name to
remove the suffix in the source prop’s name.

Select the number of copies to make. The New Names list on the right will automatically
update as this value is changed.

If the source prop’s name has a numeric suffix, then the “Starting Number” field should be set
automatically.

The “Suffix” field should be set automatically, but can be changed if desired. For example, if
your source prop does not have a numeric suffix, but you want the copies to be numbered, then
change this field to the desired number format.

You can change the automatically generated names by double-clicking any entry in the “New
Names” list and making edits as desired.

After making all of your edits, click the “Make Copies” button. This will close the Copy window
and the new copies should appear in the preview design window.

The channel information in the copies will be set automatically -- incremented from the source
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prop. However, after the copy completes, you should double-click on the name of each copied
prop in the list and when the Prop Definition window opens, verify that the channel information
for that prop is correct.

The picture below shows the Copy command being applied to a prop named “Arch 01”. The numeric
suffix is automatically detected and the fields set accordingly. The only action is to set the desired
number of copies (4 in this example). 

Result of making 4 copies

5.3.4.9 Naming Strategies

The Sequencer comes with an empty preview called “Default”. If you want to keep things simple, you can
create all of your props in the Default preview and associate all of your sequences with Default:
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Another approach is to create a preview for each holiday for which you have a light show. For example,
you could have previews called “Valentines”, “Halloween”, and “Christmas”. If your display were to
change from year to year, you would update the props in the preview for the relevant holiday.

Finally, you can create a preview for each display, for each year. So you might start with a preview
called “2018 Christmas” associated with all of your sequences for 2018. Then in 2019, you would archive
your 2018 sequences for reference, and make copies that you would work with for your 2019 show.
Something like this:

Copy all of your 2018 sequences to a new folder for 2019. 
In the Sequencer, copy the “2018 Christmas” preview to “2019 Christmas”. This would make a
copy of the preview’s visual layout as well as make a copy of every prop in the preview. 
Open each sequence in the 2019 folder and change the sequence’s preview to “2019
Christmas” (with the sequence open, select Sequence > Assign Different Preview from the menu).
With that complete, you could proceed with adding and removing props in the “2019 Christmas”
preview and revising the 2019 sequences as desired

The Advantage of this approach is that it gives you a history of your old sequences and those sequences
can be opened in the Sequencer and viewed using the preview in effect for that year.



Light-O-Rama v5.2.4214

© 2019 Light-O-Rama, Inc.

5.3.5 Sequence Tab

This section will describe the various parts of an open sequence tab, and how you go about editing a
sequence. Before proceeding, you should understand what a sequence is and the high-level description
of the S5 Sequencer.

To start sequencing, open an existing sequence or start a new one.

To open an existing sequence: 
o select File > Open or File > Recent Files from the main menu, or 

o click on one of the recent files listed on the Start Page.

To start a new sequence: 
o select File > New from the main menu, or 

o click New Animation Sequence or New Musical Sequence on the Start Page, or 

o right-click on a preview in the Previews Window and select New Animation Sequence or New

Musical Sequence from the pop-up menu.

The sequence will be displayed in its own tab.
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The Sequencer w ith an open musical sequence

The sequence tab has several sections:

The Toolbar
Grid Views and the Grid View Menu
The Timeline and Waveform
Item List
Sequence Grid

Areas within the Sequence Tab

For more information on using the Sequence Tab, please see the following topics:
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Scrolling & Zooming
Item List
Grid Views
Grid View Menu
Selecting Cells
Intensity Range
Adding Effects
Modifying Effects
Deleting Effects
Cut/Copy/Paste/Repeat
Toolbar
Right-Click Context menu
Freeform Play Range
Playback
Audio Waveform
Audio Wizards
Tooltips
Loops in Animation Sequences

5.3.5.1 Scrolling & Zooming

Your sequence grid is often larger than your display. To access all parts of your sequence, you will need
to be able to:

Scroll the grid in any direction
Zoom in and out of the grid both horizontally and vertically

Scrolling

There are several was to scroll the grid.

Scroll Bars

You can click on the scroll bars to scroll the grid. There are 2 vertical scroll bars on the right edge: one
scrolls the beat channels section and the other scrolls the main section. If there are no beat channels
displayed, the beat channel scroll bar will be hidden. Also, the beat channel scroll bar will only need to
be used if you have defined more beat channels than can be displayed at one time. The maximum
number of beat channels displayed at one time defaults to 10, but you can change this value from the 
grid view menu.
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Sequence Grid Scroll Bars

Mouse Wheel

You can scroll the grid vertically using the mouse wheel on your mouse. 

Using a mouse wheel makes it easier to scroll

If you are using a laptop and only have the built-in touch pad available, you can use 2 fingers to scroll
vertically; though this tends to not work as reliably as a mouse with a mouse wheel

Using a touch pad to scroll

Hold the shift key down while using the mouse wheel to scroll horizontally.
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Keyboard

As you move the selected area of the grid using the arrow keys, home, end, page up, or page down, the
grid will scroll so the current cell is always visible.

Zooming

You can zoom in or out in the sequencing grid:

Zoom The Timescale (horizontal)

Click the Zoom Time In button on the toolbar

Click the Zoom Time Out button on the toolbar

Zoom in using Ctrl +

Zoom out using Ctrl -

Hold the Ctrl key down while using the mouse wheel

Zoom in by dragging the mouse pointer across the audio
waveform

Right click on the time scale or on the wave form. 
The first 2 options on the menu allow you to zoom the
time scale in and out.
The next 3 options zoom to a fixed time scale: 5, 10, or
15 seconds wide. These can quickly take you to a
reasonable time scale if you have zoomed in too far.

Zoom The Row Height (vertical)

Click the Zoom Channels In button on the toolbar to make the height of each
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grid row shorter

Click the Zoom Channels Out button on the toolbar to make the height of each
grid row taller

Zoom Preferences

Zoom Preferences (under the Tools menu) allows you to set a preferred horizontal and vertical zoom level
and to restore it when desired.

5.3.5.2 Item List

The "item list" is the list of preview props, preview groups, grid view groups, subsequences, archive
props, RGB aggregates, beat channels (in musical sequences), and loops (in animation sequences)
shown to the left of the sequence grid. For every item in the list, there is a corresponding row
immediately to its right in the sequence grid.

Between the item list and the sequence grid is a thick gray vertical bar.  Dragging the bar left or right
changes the width of the item list.

Areas within the Sequence Tab

The item list and sequence grid are divided into 2 sections:

An upper part for beat channels (in musical sequences), and loops (in animation sequences). This
part is fixed (frozen) at the top of the sequence grid so that loops and beat channels always
remain visible.
A lower part for all other items: preview props, preview groups, grid view groups, subsequences,
archive props, RGB aggregates. You can create subsets of props and groups that you want to
display in this section by using Grid Views.

If there are no beat or loop channels, then the upper part will be hidden. However, if both sections are
shown then each will have its own vertical scroll bar on the far right.
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Subjects covered in this topic:

Row Types
Item List Hierarchy
Condensed Mode
Item List Double-Click
Reordering The Item List
Item List Right-Click Menu

Row Types

When a sequence grid is displayed on your screen, each row in the grid will be of a certain type.
Different row types can hold different kinds of effects.

Regular channels
RGB channels
Motion Effect Rows
Subsequences
Beat channels
Loop Rows

Some row types are displayed with a symbol as a prefix to help identify the type of grid row. Here is a
summary of the symbols that are used:

If a row is displayed with an "X" pattern, it is a placeholder in the item list and cannot have effects
applied to it. This most often occurs when Condensed Mode is off -- the placeholder rows can be hidden
by turning Condensed Mode on.



The Light-O-Rama Software Package 221

© 2019 Light-O-Rama, Inc.

A placeholder row

Item List Hierarchy

The item list is a hierarchical tree where items in the list can have child items, and those children can in
turn have children. Items in the hierarchy with child items below them will be displayed with a "+" or "-"
symbol inside a small box to the left of the name:

a "+" symbol means the children are hidden; clicking on the "+" will expand the tree node and
display the children
a "-" symbol means the children are displayed; clicking on the "-" will collapse the tree node and
hide the children. 

You can right-click on a collapsed item (one with a "+" button next to it) and select "Expand" from
the pop-up menu to display all children at all levels below the item that was clicked.
You can right-click on an expanded item (one with a "-" button next to it) and select "Collapse"
from the pop-up menu to hide all children at all levels below the item that was clicked.
You can select Expand All from the Grid View Menu to display all children for every item in the
item list.
You can select Collapse All from the Grid View Menu to hide all children for every item in the item
list.

Preview Props

Preview props that have a single regular channel, RGB channel, or motion effect row will be
displayed as a single row in the sequence grid.

A prop with a single string of lights (such as a bush):

An RGB flood light:

A pixel-based arch with 1 motion effect row and the channel level disabled (motion effect rows
require a Pro license):

Preview props that have more than one regular channel, RGB channel, or motion effect row will be
displayed as a tree in the item list. The examples below are shown with Condensed Mode off.

A mini-tree with multiple strings of lights, and each string color is assigned to a separate 
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channel:

A megatree built with strings of traditional lights (c01 is the first string, c02 the second, etc):

A pixel-based arch with 3 motion effect rows and the channel level disabled (motion effect rows
require a Pro license):

Preview Groups

Preview groups can generate a hierarchy because they can have motion effect rows (if the group's
arrangement setting is not "none"). Members of the group (props and/or other groups) are also listed
under the group.

Note: motion effects on groups allow you to do some amazing things, like color sweeps across
several props or even your entire display.

As an example, here are 3 pixel arches combined into a group. 



The Light-O-Rama Software Package 223

© 2019 Light-O-Rama, Inc.

Group Definition

The first motion effects row is for group - effects created here will act as if the combined arches are
one big prop. This is followed by motion effect rows for each individual prop.

Group displayed in the sequence grid

Grid View Groups

A grid view group is a set of regular channels or RGB channels or Motion Effect rows or beat
channels (or, conceivably, other grid view groups) that is nested together, so that it can be collapsed
down to a single row in the sequence grid, or expanded to show all of its members.

In this example, the grid view group "Unit ID 06: Strobes" has been expanded. The other grid view
groups are collapsed.
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RGB Aggregates

RGB aggregates have 3 channels that are displayed as children in the hierarchy.

"Hoop 2" is an RGB Aggregate

RGB Channels on Pixel Props

If you have a Pro license, pixel-based props are displayed with motion effect rows by default. You
can display the RGB channels by right-clicking on the prop name and selecting "Enable Channel
Level on Pixel Prop" on the pop-up menu. Later, if you decide that you no longer need the channel
level, you can right-click on the prop name and select "Remove Channel Level on Pixel Prop". If you
don't have a Pro license, then RGB channels are always displayed (motion effect rows are not
available at these license levels).

As an example, here is a pixel-based arch with the channel level enabled (only the first 5 RGB
channels are included in the picture). With these settings, the prop can be sequenced using motion
effects and channel effects interchangeably.
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Condensed Mode

The item list hierarchy can displayed such that all levels of the tree are displayed, or a "condensed"
mode where higher levels of the tree are hidden when lower levels are displayed. 

Turning condensed mode off makes it easier to understand the item list hierarchy, but it leaves
"blank" rows (the ones with X's) in the sequence grid. 

Condensed Mode OFF

Turning condensed mode on mimics the behavior of the Sequence Editor in prior versions, and uses
the screen space more efficiently. This is the same example as above; however, with condensed
mode enabled, the "Roofline ALL", "Motion Effects", and "Member Props" items have been hidden
because their children are visible.
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Condensed Mode ON

You can turn condensed mode on or off via the Grid View Menu.

Item List Double-Click

Double-clicking on an item name brings up the Prop Definition or Group Definition or Beat Channel
Definition, depending on the type of item that was clicked. If a prop or group definition is modified in this
way, the sequence grid will be updated to reflect the changes and the preview will be saved to disk.

Reordering The Item List

You can reorder the list by clicking and dragging items. In the picture below, "01.07-Window C" is being
dragged to a new position.
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You also move items in and out of grid view groups by clicking and dragging them.

Item List Right-Click Menu

Right-clicking on an item name brings up a context menu of actions you can take with that item. The
content of the menu is highly dependent on the type of item that was clicked.

Menus for regular channels, RGB channels, motion effect rows, and preview
groups

Menu for a regular channel or RGB channel in the

"Show All Items" grid view
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Menu for a regular channel or RGB channel in a user

grid view

Menu for a motion effect row

Menu for a preview group
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Menu for a grid view group

As you can see from the examples above, not all menu items are available in every situation.
However, here is a compilation of the menu items you will encounter:

Zoomed Playback - opens the Zoomed Playback sub-menu
Prop Definition - opens the Prop Definition window for the prop
Group Definition - opens the Group Definition window for the group
Use This Prop (or Group) For Thumbnails - by default, effect thumbnails displayed in the
Motion Effects Window use a 50x50 matrix. However, with this command you can have the
thumbnails generated using the selected prop or group.
Expand - expands all levels of the selected prop or group, such that all child items are
displayed.
Collapse - collapses all levels of the selected prop or group, such that all child items are
hidden.
Insert Preview Props and Groups - adds additional props or groups to the current grid view
via the Insert Props And Groups Dialog. This menu item is for user grid views only (not the
"Show All Items" grid view).
Convert to Grid View Group - opens a dialog that allows you to move the clicked item, and
optionally those below it, into a new grid view group.
Duplicate Children to New Group - allows you to copy the children of the current grid view
group into a new group.
Degroup - removes the selected grid view group, but leaves the members of the group in its
place.
Change Grid View Group Name - allows you to change the name of the selected grid view
group.
Hide Item - removes the selected item for the current grid view. The item is not deleted, it is
simply no longer visible in the current view. This menu item is for user grid views only (not the
"Show All Items" grid view).
Copy to Other Grid View - opens a dialog that allows you to copy the selected item to
another grid view (an existing grid view or a new one).
Sort Channels - Sort all of the channels on the same hierarchy level by name, channel color,
row number within the prop layout, column number within the prop layout, or reverse the
current order.
Set Channel Name - sets the channel name. This menu item is only available on props with
multiple strings (e.g. megatrees).
Add/Modify Motion Effect Rows - allows you to add new motion effect rows and/or modify
existing ones via the Motion Effect Rows Dialog.
Delete Motion Effect Row - displays a confirmation message, and then deletes the selected
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motion effect row. If you need to delete multiple rows, see the Sequence > Delete Grid Rows
option on the main menu.
Enable Channel Level on Pixel Prop - enables channel level sequencing on pixel-based
props.

Menu for a beat channel

Options on this menu include:

Add Beat Channel - opens a dialog that allows you to add a new beat channel to the
sequence.
Modify Beat Channel - open a dialog that allows you to change the name and/or color for
the selected beat channel.
Delete Beat Channel - displays a confirmation message, and then deletes the selected beat
channel.
Beat Wizard - opens the Beat Wizard.
Tapper Wizard - opens the Tapper Wizard.
VU Wizard - opens the VU Wizard.

Menu for a loop row

Menu when right-cliicking on a loop name

These items are described in the Loops in Animation Sequences topic.

5.3.5.2.1  Grid View s

A grid view is an ordered collection of grid rows. A grid view can contain any type of grid row except loop
rows and beat channels. Loop rows (in animation sequences) and beat channels (in musical sequences)
are fixed to the top of the sequence grid and do not change when the grid view is changed.
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A sequence can contain multiple grid views, and there is a grid view selector that allows you to quickly
flip between them. To the right of the grid view selector, is a button that opens the grid view menu.

There is a system grid view named "Show All Items" which automatically displays all items in the
sequence. If an item is added to the preview, it is automatically added to the "Show All Items" grid view.
You can change the order of items in the "Show All Items", but you cannot add, remove, or copy items
within it. All other grid views are user created, and you have complete control over their content. You
might have a grid views for lights in your yard and another for lights on your house. Or you might have
one grid view for props with traditional lights and another for ones that have pixels. Creating grid views is
optional; you can stick with the "Show All Items" grid view and leave it at that.

Areas within the Sequence Tab

All sequences are initially created with a "Show All Items" grid view.  There are a few ways to add
another grid view using the Sequencer:

From the Grid View menu:
"Add New View" will add a grid view and let you pick the props and groups that appear in it
"Save View As" will create a new grid view with the same props and groups as the current grid
view. This can also be used to copy the "Show All Items" system grid view to a user grid view,
which you can more extensively customize.

Right-click on a channel, prop, or group name on the left side of the grid and select "Copy to
Other Grid View". This will allow you to add the item to an existing grid view or to a brand new grid
view.

Import/Export

It can make the process of sequencing easier if your props and groups are listed in the same order in
every sequence. You can do this by setting up the desired order in one sequence, and perhaps
categorize the props into several grid views. To make your grid views available in other sequences you
export then from the original sequence and import them into the others. See the "Grid Configuration"
item on the Grid View menu (also available on the Sequence menu).

Note: the "Show All Items" grid view is excluded from the export/import process because it is
system-generated. Use the "Save View As" item on the Grid View menu to copy it to a user
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view, which will be exported.

5.3.5.2.2  Grid View  Menu

The Grid View Menu is opened by clicking the icon just to the right of the Grid View selector. The icon is
marked with a red box in the following picture:

When opened, the menu displays options to control the grid view:

Add New View
Rename View
Save View As
Delete View
Append Items To View
Reset Displayed Props And Groups
Reset Displayed Beat Channels
Add New Sub-menu
Condensed View
Show Tree Lines
Expand All
Collapse All
Beat Channel Row Count
Grid Configuration Sub-menu

Add New View
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This menu item prompts for the name of a new grid view. It then opens the Insert Props And Groups
Dialog so that you can select the items that will be in the grid view.

Rename View

This menu item allows you to enter a new name for the current grid view

Save View As

This menu item prompts for the name of a new grid view. It then copies the current grid view into the
new one.

Delete View

This menu item displays a confirmation message, and then deletes the current grid view. You
cannot delete the "Show All Items" grid view, as it is system-generated.

Append Items To View

This menu item opens the Insert Props And Groups Dialog, and then appends the selected items to
the bottom of the current grid view. Does not apply to the "Show All Items" grid view.

Reset Displayed Props And Groups

This menu item opens the Insert Props And Groups Dialog, and then replaces the items in the
current grid view with the ones selected in the dialog. Does not apply to the "Show All Items" grid
view.

Reset Displayed Beat Channels

This menu item opens a dialog that allows you to select amongst the beat channels defined in the
sequence. The newly selected beat channels replace any that are currently displayed in the grid.

Add New Sub-menu

This menu item opens a sub-menu that allows you to add a new a loop row, subsequence, beat
channel, or RGB aggregate. "Add New" is also available on the main menu at Sequence > Add New.

Condensed View

This menu item toggles the condensed mode on and off.

Show Tree Lines

This menu item toggles the display of tree lines in the item list.

Expand All
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This menu item causes all children for every item in the item list to be displayed.

Collapse All

This menu item causes all children for every item in the item list to be hidden.

Beat Channel Row Count

This menu item opens a dialog that allows you to modify the maximum number of beat channels
that are displayed. The default is 10.

Grid Configuration Sub-menu

This item opens a sub-menu allowing you import or export the user-defined grid views in the
sequence. For Pro users, it will also import/export the properties of each motion effect row. The
system-generated "Show All Items" grid view is not included in the export. "Grid Configuration" is
also available on the main menu at Sequence > Grid Configuration. 

5.3.5.2.3  Grid View  Groups

A grid view group is a set of regular channels or RGB channels or Motion Effect rows or beat channels
(or, conceivably, other grid view groups) that is nested together, so that it can be collapsed down to a
single row in the sequence grid, or expanded to show all of its members.  When a grid view group is first
created, the grid view group is shown as a single row:

Several collapsed grid view groups

Click the "+" button on the left to expand the group, and the "-" button to collapse it.
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The "Strobes" group has been expanded

Notice that the "Unit ID 06: Strobes" row has been hidden in the picture above. This is the sequence
grid's "condensed view".  Sequences often have many rows and it is usually important to display as
many rows as possible to make sequencing go faster. This is the purpose of the condensed view -- to
show as many grid rows as possible. So when a parent (the grid view group) is expanded, the parent
node is hidden and only the child nodes (the channels) are displayed. For new users this can
sometimes be confusing, so S5 allows condensed mode to be turned off. Condensed mode is turned on
or off from the Grid View menu.

Condensed mode off, Show tree lines on

In the picture above, condensed mode has been turned off and now you can see both the parent "Unit ID
06: Strobes" and its 4 children, which makes clear the parent/child relationship. Now you can see that a 
grid view is a hierarchical tree! 

But what happened to the sequence grid on the right -- it is showing an "X" pattern? Well, that is the
other thing that condensed mode does: collapsed parent rows (where a "+" button is at the beginning of
the row) display the effects for their first child in the grid. So in the top picture, the grid row for "Unit ID
06: Strobes" was actually showing the effects for "06.01-Strobes-A". When condensed mode is turned
off, there is nothing to be displayed for the parent, which is what the "X" pattern indicates.
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The rest of this topic will show the sequence grid with condensed mode enabled.

So again, when a grid view group is collapsed, the effects displayed on its row are the events of its first
member (be it a regular channel, RGB channel, or motion effect row).  However, applying a tool to the
row actually applies it to ALL of its members.  For example, with the grid view group collapsed, if you
apply the Fade Up tool to its first cell, the result will look like this:

Fade Up tool applied while group was collapsed

But when you expand the grid view group, it becomes apparent that the Fade Up tool was applied to all
of the grid view group's members:

The same group, expanded

If you then collapse the grid view group, and apply the Chase tool to it while it is collapsed, no change
will be evident from what is displayed:
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After applying the Chase tool, while collapsed

But a change did happen - the Chase tool was applied to the entire grid view group.  The only reason
that no change is evident from what is displayed is because when the grid view group is collapsed, only
the effects of the first channel are displayed, and the Chase tool did not alter the effects of the first
channel.  Expanding the grid view group reveals the change:

Expanded, after a chase

You can convert existing channels (and RGB channels, etc.) so that they become part of a new grid view
group, by right-clicking on a channel, prop, or group name on the left side of the grid and select "Convert
to Grid View Group" on the pop-up menu.  You can also "degroup" a group --  that is, remove the group
node and leave the group's children in its place -- by using "Degroup" on that same pop-up menu.



Light-O-Rama v5.2.4238

© 2019 Light-O-Rama, Inc.

Menu for a grid view group

The complete menu is described in the Item List topic.

5.3.5.2.4  Motion Effect Row s Dialog

This dialog window displays the existing motion effect rows for a preview prop or preview group. The
motion effect rows are listed in the table on the left, and the prop's pixels are shown on the right. 

Motion effect rows do not have to apply to all of the pixels in a prop (or group). Using this dialog, you can
specify that a motion effect row only applies to a rectangular subsection of the prop's pixels.

If you click on a row in the table on the left and the selected motion effect row uses a subsection of
pixels, then the subsection will be graphically represented on the right.

Within this dialog you can:

Add A New Row
Change Row Name
Add Rows By Subdividing
Manually Specify a Subsection
Copy/Paste the Motion Row Configuration
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The Motion Effect Rows Dialog

Add A New Row

Clicking the "Add Row" button will add a new motion effect row to the table. The new row will use all of
the pixels in the prop or group (the Subsection field will be unchecked).

Change Row Name

By default, motion effect rows are named "Effects 01", "Effects 02", etc. You can change the name of a
row by clicking on the name in the table, and then typing the new name.

Add Rows By Subdividing

Using the "Subdivide" button, you can divide the pixels into rows and columns, creating a separate
motion effect row for each section. 

The following picture shows a 12x50 pixel tree subdivided into 2 columns and 2 rows. There will be 4 new
motion effect rows created, with each subsection being 6x25 pixels
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Subdividing a 12x50 pixel tree into 2 columns and 2 rows

After clicking "OK" in the Create Subsections dialog, this is the result. Notice that clicking on a row in
the table graphically displays the subsection on the right.
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Result of subdividing the pixel tree into 4 sections

Manually Specify a Subsection

While the "Subdivide" button is very convenient for creating equally sized subsections, you might have
need to manually specify subsection. You can do this by making sure the "Subsection" box is checked
for the motion effect row, and then manually typing the values for left, top, width, and height.

Copy/Paste the Motion Row Configuration

You can copy the contents of the motion effect row table to the clipboard, and then use the paste button
to append the data into the Motion Effect Row dialog for another prop. This can be useful if you have
several pixel-based props that have the same dimensions.

5.3.5.2.5  Insert Props And Groups Dialog

This dialog allows you to choose preview props, preview groups, and archived props that will be part of a
grid view. Check the boxes next to the items you want. The selected items will appear in the list on the
right. Only items listed on the right side will be applied to the grid view after you click the "OK" button.

You can filter the list on the left by typing some text into the filter box. The list is automatically filtered
as you type each character. For example, to find your arch props, you could enter "arch".
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The Insert Props And Groups Dialog

Clicking the "Select..." button opens the following window:

5.3.5.3 Selecting Cells

A cell, or a range of cells, can be selected in the sequencing grid, allowing you to apply various tools to
it (such as specifying what lighting effects should be placed in that cell).  You can recognize the
currently selected cell (or cells) by a thick dashed yellow border.  For example, in the following 
sequence, a cell on the first row is selected between 3.00 seconds and 3.50 seconds:
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A cell on the first row is selected

In the sequencing grid, you can select cells using the:

mouse
keyboard shortcuts
right-click context menu

Grid Selection Using The Mouse

Click On A Cell

Click on a single cell to select it. If the cell has a motion effect in it, that effect starts
playing in the Playback Window.

Click And Drag

Select multiple cells by clicking on a cell and then dragging the mouse across the range.

If you drag with the left mouse button depressed, what happens after the
button is released depends on which tool is selected on the toolbar. For
example:

 Select – no effect is applied to the selected cells

 Max Intensity – will apply the current effect, as listed on the
toolbar, to the selected cells at the maximum intensity shown on the
toolbar.

 Fade Up – will apply the current effect, as listed below the Effect
Generator button, to the selected cells. The effect is ramped up from
the minimum intensity at the left-most selected cell to the maximum
intensity at the right.
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 Fade Down – will apply the current effect, as listed below the
Effect Generator button, to the selected cells. The effect is ramped
down from the maximum intensity at left-most selected cell to the
minimum intensity at the right.

If you drag with the right mouse button depressed,  after the button is
released the grid's context menu will open

Normally a mouse selection will be bound on the left and right by the 
timing marks in the grid. However, you can make a selection that starts
and ends between timing marks by holding down the Ctrl key as you start
to click and drag. For example, here is a selection from about 0.3 to 1.3
seconds on a fixed timing grid with 1 second spacing:

Expanding the Selection

Expand the selection by shift-clicking on a cell.

Double-Click Selection And Edit

Double-clicking on an effect in the sequencing grid will select all of the cells for that
effect, then open a dialog window that allows the effect to be modified:

Regular Channels - effect can be changed from intensity, shimmer, twinkle,
or DMX intensity
RGB Channels - colors can be modified
SuperStar Effects - SuperStar is opened, allowing the effect to be edited
Other Motion Effects - the Motion Effect Generator is opened
Loops - the repeat count and speed can be modified

If the effect is modified and the user clicks “OK”, then those modifications are
applied to the selected cells. In the following picture, one of the cells in the second
row was double-clicked, causing all of the cells for that effect to be selected
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(including the ramp up and ramp down portions).

Keyboard Selection

Key Effect

Use the arrow keys to move one cell in the direction of the arrow

Move to the first cell in the current row

Move to the last cell in the current row

Move up 1 screen 

Move down 1 screen 

Expand the selection by holding down the shift key while using any of
the keys listed above

If part of an effect is selected, then "E" will expand the selection to
encompass the entire effect

"C" will expand the selection to the entire column

"R" will expand the selection to the entire row

Ctrl-A will select the entire grid.

Right-Click Context Menu, Select sub-menu

Right-clicking in the sequencing grid provides a variety of options, including cell selection:
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Right-click context menu with Select sub-menu shown

5.3.5.4 Intensity Range

Many commands in the Sequencer take into account the intensity range displayed on the toolbar. When
you open a sequence the intensity range will be set at "0" and "100". This means that :

the "Max Intensity" tool will create effects at 100% (maximum brightness)
the "Min Intensity" tool will create effects at 0% (since 0% is completely off, this erases any
effects where it is applied)
the "Fade Down" tool will create effects that go from 100% to 0%
the "Fade Up" tool will create effects that go from 0% to 100%
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A portion of the S5 toolbar

The intensity section of the toolbar consists of 3 parts:

1. The intensity menu, opened by clicking on the word "Intensity"
2. The first intensity value
3. The second intensity value

It doesn't matter which order you enter the 2 intensity values. "100" and "0" is the same as "0" and
"100".

Entering Values

There are 3 ways to change an intensity value on the toolbar:

You can enter numbers for the desired intensity range directly into the number boxes. The
numbers you enter should be between 0 and 100; except if the toolbar effect is DMX Intensity, in
which case the numbers can range from 0 to 255.
You can increment and decrement the intensity values by clicking on the small buttons to the
right of the number.
Clicking the "Intensity" button to the left of the number boxes will open a menu where you can
select from some predefined ranges. You can also create your own ranges from this menu by
choosing Manage Intensity Presets.

Intensity Menu. Upper and

lower half are built-in, the

quarters are presets.
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Managing Presets

Selecting the "Manage Intensity Presets" item from the toolbar's Intensity menu, will open the "Manage
Intensity Presets" dialog:

The Manage Intensity Presets dialog

You can use the arrows keys to navigate around the grid, or left-click on any cell using your mouse
pointer. Click the OK button to save your changes when you are done.

Add a Preset

Start adding your information on the last row of the grid - the one marked with a "*" in the left margin.
As soon as you start typing, a new empty row will be created, but keep entering data on the row you
started. Enter data in all 3 columns. Use the Tab key after finishing the entry in one cell - it will move
you to the next cell. After entering data in the last column, you can you use the Tab or Enter key to
finish the entry for that row.
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Adding a new preset

Modify a Preset

To start editing a cell, left-click on it using the mouse pointer, or use the F2 shortcut key if the
desired cell is already highlighted. To commit the change, type the Enter key. To cancel the
change, use the Esc key.

Delete a Preset

Click in the left margin of the row you want to delete, then use the Delete key.

5.3.5.5 Adding Effects

Light-O-Rama gives you the tools to make your lights do amazing things.  In addition to simply turning
them on and off, you can turn them on to varying levels of brightness, have them fade up or down,
shimmer, or twinkle. You can make RGB lights change to any color. And with motion effects, you can
apply colorful patterns to pixel-based props.

The process involves assigning these effects to grid rows in a sequence using the Sequencer. The
sections below will describe how to create effects using the toolbar. However, most tools also have a
shortcut key, which will be noted below. In addition, most tools can be access using the grid's right-click
context menu. 

To summarize, you can add effects by using any of the following:

the toolbar
keyboard shortcuts
the right-click context menu
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The active tool, intensity range, and current effect are combined to determine how effects are added to the

sequence grid

When using the toolbar, only one tool can be active at a time. Click on the icon for the tool in order to
make it active. The active tool will have a border drawn around it.

When the Select tool is active, the standard mouse pointer is displayed when you move the
mouse over the grid, and the mouse can be used to select grid cells.
When any other tool is active, the mouse pointer specified in Cursor preferences is displayed, and
effects will be placed in cells that are selected.

When using keyboard shortcuts or the right-click context menu to create effects, the tool selected on
the toolbar is ignored.

Basic Operations: Max Intensity, Min Intensity, Fade Up, and Fade
Down

Applying an effect using the toolbar requires 3 steps:

1. Choosing the tool

Tool Button Action

Max Intensity Applies the selected effect at the maximum value in the 
intensity range

Min Intensity Applies the selected effect at the minimum value in the 
intensity range. If the minimum intensity is 0%, this will erase
any existing effects where it is applied.

Fade up Ramps the selected effect from the minimum value in the 
intensity range to the maximum value in the intensity range

Fade down Ramps the selected effect from the maximum value in the 
intensity range to the minimum value in the intensity range

2. Setting the intensity range on the toolbar

3. Choosing the effect that will be applied from the drop-down selection box

Effect Description

  On the light is turned on (no shimmer or twinkle)
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  Shimmer causes your lights to quickly vary between on and off at a constant
high rate.

  Twinkle causes your lights to quickly vary between on and off at a random
rate.

  DMX Intensity this is useful for sending DMX commands to DMX devices that
require specific DMX values (like some moving head lights). The DMX
protocol supports intensities from zero to 255, and so this effect
gives you precise control over the DMX intensities sent to a device. 
Please note that not all Light-O-Rama controllers support this
functionality; DMX intensity events sent to a controller that does not
support them will simply be ignored. To check whether any particular
controller supports it, please refer to that controller's documentation.

  Motion Effect an effect intended for pixel-based display elements created by the 
Motion Effect Generator or the SuperStar Sequencer. The motion
effect that will be applied when drawing on the grid is the one
currently displayed in the Playback Window. Motion Effects can only
be placed on Motion Effect Rows, and require a Pro level license.
Furthermore, motion effects can only be displayed on lights
connected to Enhanced LOR networks, or DMX networks. They
cannot be displayed on LOR networks that are not enhanced. Lastly,
they cannot be used in a stand-alone sequence that is loaded into a
controller.

After making those 3 choices and then moving your cursor over the sequence grid, your cursor will

change to a pencil  indicating that you are in "effect drawing mode". Click the left mouse button
and drag over some cells. When you release the mouse button those cells will be filled with the
effect you chose, at the intensity range you chose, and reflecting the tool type you chose.

In the example above, an effect was applied to a regular channel row. However, this technique applies
equally well to RGB channel rows. The only difference is that RGB channel rows need a color. If the
color fade tool is open, then the color currently shown in the tool is used for the effect. If not, then the
color shown on the toolbar (on the color fade button) is used.
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In the example above, a colorized effect was applied to an RGB Channel Row. This technique applies
equally well to Motion Effect Rows. When you do, it will apply the color to all of the pixels in the prop (a
ColorWash motion effect). The only difference is the way the resulting motion effect is displayed in the
grid. In the picture below, the display of motion effect names option is enabled.

You can even use the same technique to create loops in animation sequences. Loops don't use color,
so it is more like the first example.

Each channel effect (on, shimmer, twinkle, and DMX intensity) has its own pattern when displayed on
the sequence grid. This makes it easy to identify what your sequence is doing without even playing it
back. The patterns are applied to both regular channel rows and RGB channel rows.
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Keyboard Shortcuts for Basic Operations

All of the actions listed above can be performed using keyboard shortcuts. The actions listed below
are also available on the right-click context menu.

Tool Shortcut
Key

Action

Max Intensity applies the selected toolbar effect at the maximum value in the
intensity range

Min Intensity applies the selected toolbar effect at the minimum value in the
intensity range

Fade up ramps the selected toolbar effect from the minimum value in
the intensity range to the maximum value in the intensity
range

Fade down ramps the selected toolbar effect from the maximum value in
the intensity range to the minimum value in the intensity range

On set selected cells to the ON effect at max toolbar intensity
(ignores the toolbar effect selection)

Shimmer set selected cells to the SHIMMER effect at max toolbar
intensity (ignores the toolbar effect selection)

Twinkle set selected cells to the TWINKLE effect at max toolbar
intensity (ignores the toolbar effect selection)

Any Use the currently selected tool (from the toolbar) on the grid
selection

Intelligent Fade Tool  

When using your mouse, the intelligent fade tool will create a:

Fade Up when you use it by clicking and dragging left-to-right
Fade Down when clicking or dragging right-to-left
Fill if you click without dragging

This tool is not available when using the keyboard. Use the shortcuts for fade-up, fade-down, and fill
instead.
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Fill Tool  

Shortcut Key:

 
The Fill tool can be used to create smooth fades from one effect to another.  For example, if a fade
up from 10% to 40% is followed by the lights being off, which is followed by a fade up from 20% to
80%, then applying the Fill tool on the area where the lights are off will make it into a fade down from
40% to 20%:

Before a fill... ... and after a fill

It can also be used in a similar manner on RGB channels to smoothly fade from one color to
another.

Before a fill... ... and after a fill

The Fill tool can also be used on Motion Effect Rows.

Before a fill...

... and after a fill

With motion effects, the Fill tool tries to perform a cross-fade. However, you will achieve better
results by creating the cross-fade yourself (which requires a second motion effects row):

Cross fading the 2 effects using a second motion effect row

The Fill tool does not do anything when used on cells that contain an effect.

The Intelligent Fade tool and the Color Fade tool can also be used to apply fills in certain situations.

Chase Tool  

Shortcut Key:

 
The Chase tool can be used to take a pattern and "chase" it through several channels over a time
range.  For example:
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Before a chase...

... and after a chase

Exactly what is chased, and where it is chased to, depends upon how you click-and-drag (or, if
using the keyboard, how you expanded the selection).  The lighting effects in the corner that you
started dragging from will be chased to the corner that you finished dragging to so that, for example,
you could chase effects "up" or "down" through channels.

The effects that are chased will include everything up to and including the last lighting effect in the
channel that you start dragging from (or, if dragging backwards, everything from the first lighting
effect).

The Chase tool can also be used on RGB channels:

Before an RGB chase...



Light-O-Rama v5.2.4256

© 2019 Light-O-Rama, Inc.

... and after an RGB chase

The Chase tool can also be used on Motion Effect Rows:

Before a motion effect chase...

... and after a motion effect chase

The Chase tool has additional options that can be accessed by clicking on the small down arrow to
the right of the chase button.

The Chase Options menu

Row Mode: 
Auto: chase each prop if the effect being chased is a motion effect and that motion row
applies to the entire prop (not a subsection); otherwise chase each row
Chase Each Row: perform the chase on each row in the selected area 
Chase Each Prop: perform the chase on the first row of each prop in the selected area
(makes a difference on pixel props with multiple motion effect rows)

Clear Selection First: clears the chase area of any existing effects before placing the new
effects that are part of the chase.

For example, consider the following sequence, and imagine that you want to chase the second fade
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up in the first channel:

Before chasing the second fade

If you had "Clear selection first" turned on, the chase would overwrite the ends of the existing fades
in some of the other channels:

After chasing the second fade, w ith "Clear selection first"

enabled

But with "Clear selection first" turned off, the existing effects are kept in place:

After chasing the second fade, w ith "Clear selection

first" disabled  

Motion Effect Tool  

After selecting one or more cells on a motion effect row with this tool active, the Motion Effect
Generator will open. Create your effect and then click the OK button to close the Motion Effect
Generator. The new effect will be placed in the selected cells. This tool requires a Pro level license.

SuperStar Tool  

After selecting one or more cells on a motion effect row with this tool active, the SuperStar
Sequencer will open. After you finish your sequencing in SuperStar, close SuperStar by clicking on
the Red X in the upper right of the program (there is no need to use SuperStar's save function). You
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will then be returned to the S5 Sequencer and your new SuperStar effects will be automatically
saved as part of the S5 Sequencer's sequence. They will be displayed in the selected cells as a
single effect at the maximum value in the toolbar's intensity range, This tool requires a Pro level
license.

Color Fade Tool  

Shortcut Key:

 
Note: the colors displayed on your screen will not necessarily match those shown by your
actual RGB lights; you may have to experiment to determine colors that wind up looking
the way you want, and different RGB devices may show different colors when sent the
same intensities.

The Color Fade tool can be used to apply colors to RGB channels and Motion Effect Rows.  Clicking
the Color Fade tool button on the toolbar opens a floating Color Fade tool window, which enables
you to specify the colors to be used:

The Color Fade tool w indow

Note that the Color Fade Tool button on the toolbar is not only a button, but also displays a color
transition. You can create color fade effects with the floating Color Fade tool window open or
closed. 

If the window is open, then color fade effects will be created using the colors on the window. 
If the window is closed, then color fade effects will be created using the colors display on the
toolbar button. 

You can update the colors on the toolbar button by selecting the desired colors in the Color Fade
tool window and then clicking the "Update Toolbar" button.

With the Color Fade tool selected, clicking and dragging an area of an RGB channel or multiple
RGB channels will cause that area to become those colors:

Applying a color fade to an RGB channel

If you drag backwards, however, the colors will be applied in reverse order (this also happens if you
are using the keyboard, and expand the selection from right to left instead of left to right):
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Applying a color fade to an RGB channel by dragging backwards

If the "Clicking empty cell does matching fill" box is checked in the window and you click on an
empty cell (as opposed to clicking-and-dragging) will cause the Color Fade tool to perform a fill,
smoothly fading from the preceding color to the following color:

Before clicking the empty area... ... and after clicking the empty area

If the "Clicking empty cell does matching fill" box is not checked and you click on an empty cell,
then the color in the tool window will be applied to the cell that was clicked.

The Color Fade tool window gives several ways to select the colors to be used:

The "Choose" buttons on either side will open a color picker dialog to specify the color for that
side
The "Copy" button on either side will copy the color from the opposite side
The "Swap" button will move the two colors to their opposite sides
The "Random" buttons on either side will choose a random color for that side
The "Random button in the middle will choose random colors for both sides

The Color Fade tool takes into account the selected effect on the toolbar.  For example, here is a 
twinkling color fade:

A twinkling color fade

A note regarding DMX color effects: The Color Fade tool allows you to specify that DMX effects
should be used.  However, as of the time of this writing, LOR hardware does not support DMX effects
which change intensity (for example, a fade up), and so unless the underlying DMX effects caused
by using the Color Fade tool stay at a constant intensity, they will be automatically converted to
regular fades when they are sent to the controllers.  That is, for example, a DMX fade from 0 to 255
will be converted to a regular fade from 0% to 100%.  So, the Color Fade tool will not give as fine-
grained control over DMX as you may think.

However, if you make your sequence using DMX fades now, and in the future LOR hardware is
updated to support them, then your sequence will take already be set up to advantage of this.

5.3.5.6 Modifying Effects

This section covers techniques for modifying existing effects. 

One simple way to edit your sequence is to place new effects over the old ones -- if that is what
you want to do, then see the Adding Effects topic. 
You can also use cut, copy, paste, and repeat to modify a sequence -- which is covered in the 
clipboard topic.

Covered in this topic are:
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Double-Click Selection And Edit
Nudge Tools
Changing Colors
Changing Intensity
Prompt For New Effect
Toggle Tool

A condensed list of keyboard shortcuts for modifying a sequence can be found in the Keyboard Shortcut
Summary.

Double-Click Selection And Edit

Double-clicking on an effect in the sequencing grid will select all of the cells for that
effect, then open a dialog window that allows the effect to be modified:

Regular Channels - effect can be changed from intensity, shimmer, twinkle,
or DMX intensity
RGB Channels - colors can be modified
SuperStar Effects - SuperStar is opened, allowing the effect to be edited
Other Motion Effects - the Motion Effect Generator is opened
Loops - the repeat count and speed can be modified

If the effect is modified and the user clicks “OK”, then those modifications are
applied to the selected cells. In the following picture, one of the cells in the second
row was double-clicked, causing all of the cells for that effect to be selected
(including the ramp up and ramp down portions).

Nudge Tools

The nudge tools allow you to make small adjustments to existing effects in the grid. By default, each
click of the button moves effects in 0.05 second increments. However, if you hold the Ctrl key down
while clicking the button, effects will move in 0.25 second increments.

Effects can also be moved left or right by using the Skew Selection command.

Nudge tools on the toolbar

Nudge Effect Left  
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When you click on this button, any effects completely or partially within the selected area will be
moved to the left.

Nudge Effect Right   

When you click on this button, any effects completely or partially within the selected area will be
moved to the right.

Shorten Effect   

When you click on this button, any effects completely or partially within the selected area will be
shortened. The starting time of the effect remains the same.

Lengthen Effect   

When you click on this button, any effects completely or partially within the selected area will be
lengthened. The starting time of the effect remains the same.

Changing Colors

You can change the colors of RGB Channel effects by:

opening the Color Fade tool and select the new color
selecting an area of the grid that contains the effects to be changed. These must be RGB
Channel rows.
right-click on the area, then opening the Existing Effects (foreground) Sub-menu, then
selecting Apply Toolbar Color or Apply Toolbar Hue.

Changing Intensity

Tools to change the intensity of existing effects are accessed by right-clicking on the sequence grid,
then opening the Existing Effects (foreground) Sub-menu.

Prompt For New Effect

You can modify a group of effects to all be a new effect that you choose. First select an area that
contains effects you wish to modify, then either:

right-click on the selection, open the Prompt For New Effect Sub-menu and select Modify
Existing Effects, or
use the Shift-M keyboard shortcut

This works with regular channels, RGB channels, and motion effect rows.

Toggle Tool

This command will toggle the effects in the selected area between on and off.  Any that had been off
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will be turned on; all others will be turned off (note that this includes not just those that had been on,
but also, for example, those that had been shimmers or fades).

You can invoke it by:

Selecting the Toggle tool  on the toolbar, then selecting an area of the grid to toggle.
Selecting an area on the grid, then right-clicking and select "Toggle" on the Advanced Tools
sub-menu.
Selecting an area on the grid, then using the "G" shortcut key

Before Toggle

After Toggle

5.3.5.7 Deleting Effects

To delete existing effects in the grid, select an area, then:

Click the Cut button on the toolbar, or
Use the Delete keyboard shortcut, or
Select Clear from the right-click menu
Use the Min Intensity tool when the minimum intensity is set to 0%

5.3.5.8 Clipboards & Cut/Copy/Paste/Repeat

In the S5 Sequencer, the sequence grid supports cut, copy, and paste operations on 2 types of data:

The copying and pasting of timing marks is covered in the Timing Mark sub-menu topic.
The copying and pasting of lighting effects is covered in this section.

The Sequencer supports basic cut, copy, and paste operations on lighting effects. But it also supports
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more advanced operations. All operations can be accessed from the toolbar.

Clipboard section of the Toolbar

From the toolbar you can:

Select And Manage Clipboards
Choose The Paste Mode
Cut
Copy
Paste
Paste Special
Repeat

Cut, copy, paste, and paste special can also be accessed using keyboard shortcuts or from the right-
click menu.

Select And Manage Clipboards

Clipboards are used to copy (or cut) and paste lighting effects from one area of the sequence grid to
another.  In the Sequencer, you can have multiple different clipboards, allowing you to keep several
different sets of effects available to be pasted. However, only one clipboard can be active at any given
time. 

You can also lock clipboards so that they cannot be copied into (thus preventing accidental overwriting
of their contents):

Unlocked clipboard

Locked clipboard

The default clipboard is named "Std Clipboard" and it cannot be locked. The active clipboard is shown on
the toolbar with an icon to indicate whether it is locked or unlocked.

The active clipboard

Click on the name of the active clipboard to open the Clipboard Management window.

Choose The Paste Mode

When pasting in the sequencing grid, use the paste mode selector on the toolbar to choose the desired
mode before you paste. There are 4 different paste modes:

Paste By Cell
Paste By Time
Stretch to Fit
Repeat to Fit
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Paste Mode selector on the toolbar

Paste By Cell

Paste by Cell pastes effects based upon the relative durations of the copied cells and the cells
where they will be pasted.  

For example, consider timings at 0 seconds, 1 second, and 2 seconds.  Between 0 and 1 is a fade
up, and between 1 and 2 is a fade down:

Effects to be copied

These events will be copied, and pasted to the time starting at 5 seconds.  There are timings at 5
seconds, 7 seconds, and 7.5 seconds:
 

Where they w ill be pasted to

 
If "Paste by Cell" is selected, then there will be a fade up from 5 to 7, and a fade down from 7 to 7.5:
 

After pasting by cell

Paste By Time

Paste by Time pastes effects based upon their durations as they were copied. 

For example, consider timings at 0 seconds, 1 second, and 2 seconds.  Between 0 and 1 is a fade
up, and between 1 and 2 is a fade down:

Effects to be copied

 
These events will be copied, and pasted to the time starting at 5 seconds.  There are timings at 5
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seconds, 7 seconds, and 7.5 seconds:
 

Where they w ill be pasted to

 
If "Paste by Time" is selected, then there will be a fade up from 5 to 6, and a fade down from 6 to 7.
 The timings at 7 and 7.5 are ignored; only the original lengths of the events are used:
 

After pasting by time

Stretch to Fit

Stretch to Fit stretches (or compresses) effects to fit into the area that you have selected, without
regards to any timings within that area.  

For example, consider timings at 0 seconds, 1 second, and 2 seconds.  Between 0 and 1 is a fade
up, and between 1 and 2 is a fade down:

Effects to be copied

 
These events will be copied, and pasted to the time starting at 5 seconds, with the area between 5
seconds and 7.5 seconds selected.  There are timings at 5 seconds, 7 seconds, and 7.5 seconds:
 

Where they w ill be pasted to

 
If "Stretch to Fit" is selected, then since the copied effects totalled two seconds in length, and since
the area being pasted to is two and a half seconds in length, each effect will be stretched to 125% of
its original length (since 2.5 seconds is 125% of 2 seconds).  Therefore, there will be a fade up from
5 seconds to 6.25 seconds, and a fade down from 6.25 seconds to 7.5 seconds:
 

After stretching to fit

Repeat to Fit
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Repeat to Fit repeats (or cuts off) effects to fit into the area that you have selected, without regards
to any timings within that area.  

For example, consider timings at 0 seconds, 1 second, and 2 seconds.  Between 0 and 1 is a fade
up, and between 1 and 2 is a fade down:

Effects to be copied

 
These events will be copied, and pasted to the time starting at 5 seconds, with the area between 5
seconds and 7.5 seconds selected.  There are timings at 5 seconds, 7 seconds, and 7.5 seconds:
 

Where they w ill be pasted to

 
If "Repeat to Fit" is selected, then since the copied effects totalled two seconds in length, and since
the area being pasted to is two and a half seconds in length, there will be one full copy of the copied
effects for the first two seconds, followed by the first half second of a second copy of the effects. 
That is, there will be a fade up from 5 seconds to 6 seconds, a fade down from 6 seconds to 7
seconds, and the first half of a fade up from 7 seconds to 7.5 seconds:
 

After repeating to fit

Cut 

The Cut command removes the selected effects from their original position in the grid and stores
those effects on the current clipboard. If the current clipboard is locked, an error message is
displayed.

"Cut" has a keyboard hotkey:

Copy 

The Copy command copies the selected effects onto the current clipboard. If the current clipboard is
locked, an error message is displayed.

"Copy" has a keyboard hotkey:
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Paste 

The Paste command copies the effects in the current clipboard onto the selected area of the grid,
taking into account the current paste mode. The source row doesn't necessarily need to be of the
same type as the destination row, as shown in the table below.

Copy From:
Paste Into:

Regular Channel or Beat
Channel

RGB Channel Motion Effects Row

Regular Channel
or Beat Channel

Fully supported - no change
to the effect

"on", "twinkle", and
"shimmer" are preserved.
The RGB channel effect
takes on the color of the
source channel.

"on", "twinkle", and
"shimmer" are
recreated as motion
effects. The motion
effect takes on the
color of the source
channel.

RGB Channel "on", "twinkle", and
"shimmer" effects are
created at 100% intensity,
wherever those RGB
channel effects existed in
the source. Color
information is not used in
conversion.

Fully supported - no
change to the effect

"on", "twinkle", and
"shimmer" are
recreated as motion
effects. The motion
effect takes on the
color of the source
effect.

Motion Effects
Row

A twinkle motion effect is
converted to a twinkle
channel effect. All other
motion effects get converted
to the "on" channel effect.
Start and end intensity of
the source motion effect are
preserved in the destination
channel effect.

A twinkle motion effect is
converted to a twinkle
channel effect. All other
motion effects get
converted to the "on"
channel effect. The first
selected color of the
motion effect is used as
the color for the RGB
channel effect. That color is
dimmed according to the
source motion effect's
starting and ending
intensity values.

Fully supported - no
change to the effect

"Paste" has a keyboard hotkey:

Paste Special 

The Paste Special command will open a dialog window, allowing you to specify additional options
when pasting.
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The Paste Special dialog

"Paste Special" has a keyboard
hotkey:

Repeat Across Time (Horizontally)

Specify the number of times the clipboard data should be repeated horizontally. The Spacing entry
can be used to control the spacing between copies as shown in the picture below. If pasting by cell,
then the spacing value is the number of cells. For all other paste modes, the spacing is specified in
seconds and fractions of a second. Every time you open the Paste Special dialog, spacing will
initially be set to 0, regardless of any value you might have entered before.
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Repeat Across Channels (Vertically)

Specify the number of times the clipboard data should be repeated vertically.

Source and Destination

The "Source" box controls which portions of the copied effects will be pasted: 

"Background" means that only areas that are completely off will be pasted; 
"Foreground" means that only effects will be pasted; 
"Both", which is the default, means that off areas as well as effects will be pasted (i.e.
foreground and background).

For example, consider the following portion of a sequence, and imagine that the simple chase on the
left will be copied and pasted on top of the twinkle effects on the right:

Before pasting the chase on top of the tw inkling

For now, assume that the "To" box (which we will discuss momentarily) is set to "Both".  Then if the
"From" box is also set to "Both", then the entire copied area - including the off effects - will be
pasted:

After pasting, from Both to Both

But if "From" is set to "Foreground", then the empty areas are not pasted, leaving some of the cells
twinkling:

After pasting,  from Foreground to Both

Or if "From" is "Background", then only the off areas are pasted:
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After pasting, from Background to Both

The "To" box is similar, but it controls which of the cells in the area being pasted into will actually be
overwritten.  For example, if "From" is set to "Both":

Before pasting

After pasting, from Both to Background

After pasting, from Both to Foreground

After pasting, from Both to Both

You can even combine "From" and "To".  For example:

Before pasting

After pasting, from Foreground to Foreground

Repeat 
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The Repeat tool can be used to automatically place a copy of the selected area immediately after
the selected area.  For example, consider the following:

Before repeating

Then pressing the Repeat button will make the following:

After repeating once

And you can repeat as many times as you like thereafter; for example, pressing Repeat three more
times will make the following:

After repeating four times

"Repeat" has a keyboard hotkey:

5.3.5.8.1  Clipboard Management

Clipboards are used to copy (or cut) and paste lighting effects from one area of the sequence grid to
another.  In the Sequencer, you can have multiple different clipboards, allowing you to keep several
different sets of effects available to be pasted. However, only one clipboard can be active at any given
time. 

You can also lock clipboards so that they cannot be copied into (thus preventing accidental overwriting
of their contents):

Unlocked clipboard

Locked clipboard

The default clipboard is named "Std Clipboard" and it cannot be locked, renamed, or deleted. The active
clipboard is shown on the toolbar with an icon to indicate whether it is locked or unlocked.
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The active clipboard

(enlarged)

Click on the name of the active clipboard on the toolbar to open the Clipboard Management window.

The Clipboard Management Window

Setting the Active Clipboard

To select the active clipboard (the one that will be used for cut, copy, paste, and repeat operations),
simply click on its name in the Clipboard Management window so that the desired row is selected,
then click the OK button to close the window. The toolbar will update to reflect your selected
clipboard.

Adding New Clipboards

By default, the Sequencer has a single clipboard. However, the "Add New" button can be used to
quickly create multiple clipboards. After clicking the button, you will be prompted for the new
clipboard name.

Renaming a Clipboard

Click on a clipboard in the list, then click the Rename button. You will be prompted for the new
name.

Deleting a Clipboard

Click on a clipboard in the list, then click the Delete button. The deletion will happen immediately --
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you will not be prompted to confirm.

Locking and Unlocking Clipboards

A clipboard can be locked or unlocked; a locked clipboard cannot be copied into (though it can still
be pasted from). This prevents accidentally overwriting copied effects that you want to keep
available.  If you attempt to copy to a locked clipboard, you will get a pop-up message:

To lock a clipboard, click on its name to select it, then click the Lock button. To unlock a clipboard,
click on its name to select it, then click the Unlock button.

Adding Clipboard Files Created by External Applications

There are some third-party tools that can create clipboard files (files with an LCB extension). You
can make these available in the Sequencer by moving or copying the file into the Clipboards folder.
Once the file is in that folder, the file name will appear the Clipboard Management window.

5.3.5.9 Toolbar

Each sequence tab in the Light-O-Rama Sequencer has its own toolbar. The toolbar selections on one
tab can be different than the selections on another tab. For example, the current intensity range and
current effect can be set differently for each sequence.

The order of the buttons on the S5 toolbar cannot be changed by the user. This helps Light-O-Rama
customer support help you - if you call in for help, we can easily point you to where the color fade tool is
(as an example).

The buttons on the toolbar will wrap to match the width of the sequence tab. So, while the buttons will
always stay in the same order, you might have 2 rows of buttons, or 3 rows, or more - depending on the
width of the sequence tab.

Here is the comprehensive list of every button on the toolbar, listed in the order in which they appear.

Toolbar Item Description

Calculation Status 

Shows the name of the Preview assigned to the sequence. Click here to open the
toolbar's Preview Menu
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Save Button

  Clipboard Cut / Copy / Paste

Shows the name of the active clipboard (the one that will be used for cut, copy,
paste, and repeat operations). To the left of the clipboard name is an icon that
indicates whether the clipboard is locked or unlocked. Cut and copy operations
can only be performed with an unlocked clipboard. Click the clipboard name to
open the Clipboard Management window.

Shows the current Paste Mode, and allows you to change it.

Cut Button

Copy Button 

Paste Button 

Paste Special Button -- opens a dialog that allows you to specify additional
options when you paste

Repeat Button

  Undo / Redo

Undo Button. This will undo the last modification to the sequence grid.

Redo Button. This re-applies the last action performed by the Undo button.

  Window Toggles

Toggle playback window visibility

Toggle waveform visibility

  Zoom Control

Zoom row height shorter

Zoom row height taller

Zoom time out (total number of visible seconds will increase)

Zoom time in (total number of visible seconds will decrease)

  Playback Control

Play the full sequence

Play from the left edge of the visible sequence grid to the end of the sequence

Play from the beginning of the sequence to the right edge of the visible sequence
grid

Play the visible portion of the sequence

Play the current selection. If there is a freeform play range defined then that is
played; otherwise the current grid selection (dashed yellow outline) is played.

Pause playback. Press again to un-pause

Stop playback

Repeat playback. When enabled, this will cause playback to repeat until the
Stop Playback button is pressed. When disabled, this icon will have a red slash
through it.

Shows the current Playback Speed and allows you to change it. Playback
speeds other than normal may not be supported on some types of media files.

  Effect Tools - only 1 tool can be active at time
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Select tool. If this effect tool is enabled, then clicking on a cell or cells in a
sequence's grid will simply select those cells. No lighting effect will be applied,
nor will any be applied by hitting the enter key.

Toggle tool. If this effect tool is enabled on the Tools menu, then clicking on a
cell or cells in a sequence's grid will turn individual parts of the selection on or off.
Each portion of the selection that had been on will be turned off, and every other
portion will be turned on.  Note that the latter includes not just portions of the
selection that had been off, but also those that had been twinkles, fades,
shimmers, and intensities.

Maximum Intensity. Inserts the current effect (as shown on the toolbar) into the
grid - at the maximum intensity shown on the toolbar.

Minimum Intensity. Inserts the current effect (as shown on the toolbar) into the
grid - at the minimum intensity shown on the toolbar.

Fade Up

Fade Down

Intelligent Fade

Fill

Chase

Motion Effect 

SuperStar Effect

Shows the current color transition. Clicking it opens the Color Fade tool, which
overrides the color transition shown on the toolbar.

  Intensity Range & Current Effect

Click here to open the Intensity Menu, which will allow you to choose from a list
of preset intensity ranges.

Shows the current Intensity Range and allows you to change it by: 1) typing new
numbers into the boxes, or 2) using the up and down arrows to adjust the current
values.

Shows the Current Effect and allows you to change it

  Nudge Tools

Nudge Effect Left

Nudge Effect Right 

Shorten Effect

Lengthen Effect

  Timing Grid

Click here to open the toolbar's Timing Grid Menu

Shows the current Timing Grid and allows you to change it

5.3.5.9.1  Toolbar Preview  Menu

The name of the preview assigned to the sequence is the second item shown on the toolbar. When you
click on the preview name, a menu opens. The items on that menu are described in this topic.
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The Toolbar's Preview Menu

Preview Design

This menu item opens the sequence's preview for editing in the Preview Design window.

Assign Preview

This menu item allows you to associate a different preview to the current sequence. This function
works best if the new preview started out as a copy of the original preview. However, the function will
also look for matching prop names between the old preview and the new preview. Effects will be
preserved for props and groups that match. Where there is no match, those items and their effects
will be archived. This item is also available on the Sequence Menu.

Background Image

This sub-menu can be used to adjust the brightness of the background image in the preview (if the
preview has a background image).

5.3.5.9.2  Toolbar Timing Grid Menu

The Timing Grid menu is the second-to-last item on the toolbar. This menu can be used to create,
rename, and delete timing grids. You can also create timing grids in a Musical Sequence using the
audio wizards. Use the Right-Click Timing Mark Sub-menu to manipulate timing marks within a timing
grid. 

From this menu you can:
Change Timing Grid Name
Add New Fixed Grid
Add New Freeform Grid
Duplicate to New Freeform Grid
Import Timings
Export Timings
Delete Timing Grid
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Lock Timings
Drag Events with Timings

The Toolbar's Timing Grid Menu

Change Timing Grid Name

This menu item can be used to change the name of the current timing grid.  The main purpose of
giving a timing grid a name is to make it easier to distinguish when it is listed on the toolbar.

Add New Fixed Grid

This menu item can be used to add a new fixed timing grid to the sequence.  After you select this
item, you will be asked to specify the length of time between timings - for example, to make the
timings a quarter second apart, enter "0.25".

Add New Freeform Grid

This menu item can be used to add a new freeform timing grid to the sequence.  After you select
this item, you will be prompted to enter a name for the new timing grid.

Duplicate to New Freeform Grid

This menu item can be used to create a new freeform timing grid, initially populating it with the
same timings that are in the current timing grid.

Note that this can be done regardless of whether the current timing grid is a freeform grid or a fixed
grid.

Import Timings
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This menu item opens a dialog that allows you to import timing marks from several sources.

Timing grid import - source selection

S5 Timing File

You can import an S5 timing file which has an LORTIME extension -- one created using Export
Timings.

LMS or LAS Sequence

You can import timings from an LMS or LAS file. Typically you would upgrade one of these
sequences, which would bring in the timings and the effects; but this function is available if you just
need the timing marks.

Audacity Label File

An Audacity label file. Audacity is a free audio editing and analysis program available from https://
www.audacityteam.org/. It has the ability to analyze beats and notes in music. As an example:

1. Start the Audacity program
2. Open your music file in Audacity
3. Open the Analyze menu and choose a tool, for example "Bar and Beat Tracker: Bars". After

the analysis is run, you should see a label track with some markers in it.

https://www.audacityteam.org/
https://www.audacityteam.org/
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Audacity screen with timing labels at the bottom

4. Select File > Export Labels from the Audacity menu. Choose a file name and location. The
file extension will be TXT.

5. In the S5 Sequencer, select Import Timings from the toolbar's Timing Grid menu.
6. Select the "Import from Audacity label file" option
7. Select the timing grids to import, then click the "Import" button

Export Timings

This menu item will open a dialog allowing to choose the freeform timing grids and beat channels to
be included in the export file. After choosing the items to include in the file, click the "Select File"
button. Select a name for the file and click "Save". By default, these files will be saved to the 
ImportExport folder, but you can change the folder if desired. Files created by this method will have
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an LORTIME extension.

The Timing Export dialog

Delete Timing Grid

This menu item can be used to delete the current timing grid from the sequence.

There must be at least one timing grid in a sequence, so this menu item will be unavailable if there
is only one timing grid.

Lock Timings

Each timing in a sequence is a particular point in time (since the beginning of the sequence), and is
represented by a vertical gray line.  If "Lock Timings" is off (unchecked), and the current timing grid
is a freeform timing grid, you can change the time of a timing by hovering over its line with your
mouse (which will change your mouse cursor from a "pointer" cursor to an "east-west" cursor), and
clicking and dragging the line to the left or the right.

If "Lock Timings" is on (checked), you cannot do this.  This prevents you from accidentally changing
the time of a timing while you're trying to modify the lighting effects in a cell between two timings.

See also Drag Events with Timings, which controls whether or not effects that start or end at the
dragged timing will be dragged along with it.
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Drag Events with Timings

Timings in a sequence can be dragged with the mouse to change the time that they are at (unless
the Lock Timings option is turned on).  If "Drag Events with Timings" is turned on, and any effects
start or end at the same time as the timing being dragged, they will be dragged along with it.  If not,
only the timing will move; the effects will remain unchanged.

5.3.5.10 Right-Click Context Menu

Right-clicking on the sequence grid brings up a pop-up menu.  This menu contains items which allow
you to modify the currently selected cells, in a variety of ways.  For example, you can insert lighting
effects, cut, copy, and paste (both effects and timings), and delete or resize timings. Some items on the
menu may be hidden depending on the type of grid row you click on and your license level.

The Right-Click Context Menu
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The following items are available on this right-click context menu:

Insert On Effect
Insert Twinkle Effect
Insert Shimmer Effect
Insert Motion Effect
Insert SuperStar Effect
Insert Toolbar Effect as Fade Down
Insert Toolbar Effect as Fade Up
Insert Toolbar Effect at Max Toolbar Intensity
Insert Toolbar Effect at Min Toolbar Intensity
Chase
Custom Chase
Matching Fill
Clear
Prompt For New Effect sub-menu
Empty Areas (background) sub-menu
Existing Effects (foreground) sub-menu
Advanced Tools
Select sub-menu
Cut, Copy, Paste
Paste Special
Timing Mark sub-menu 
Audio Wizards
Undo and Redo

Insert On Effect

Inserts an "on" effect into the currently selected cells at the maximum value in the toolbar's intensity
range. It does this regardless of the currently selected effect on the toolbar.

ON effect (w ith intensity range 50-100%)

Insert Twinkle Effect

Inserts a "twinkle" effect into the currently selected cells at the maximum value in the toolbar's
intensity range. It does this regardless of the currently selected effect on the toolbar.

TWINKLE effect (w ith intensity range 0-100%)

Insert Shimmer Effect
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Inserts a "shimmer" effect into the currently selected cells at the maximum value in the toolbar's
intensity range. It does this regardless of the currently selected effect on the toolbar.

SHIMMER effect (w ith intensity range 0-100%)

Insert Motion Effect

This command only appears on the menu if you have selected one or more cells on a motion effect
row. It opens the Motion Effect Generator, where you can create an effect. After clicking the OK
button in the Motion Effect Generator, the effect that was created will be inserted into the selected
cells at the maximum value in the toolbar's intensity range, 

To edit the motion effect, just double-click on the effect in the sequence grid and the Motion Effect
Generator will re-open.

This command requires a Pro level license.

Insert SuperStar Effect

This command only appears on the menu if you have selected one or more cells on a motion effect
row. It opens the SuperStar Sequencer, where you can create one effect, or many effects, or load a
purchased sequence. After you finish your sequencing in SuperStar, close SuperStar by clicking on
the Red X in the upper right of the program (there is no need to use SuperStar's save function). You
will then be returned to the S5 Sequencer and your new SuperStar effects will be automatically
saved as part of the S5 Sequencer's sequence. They will be displayed in the selected cells as a
single effect at the maximum value in the toolbar's intensity range, 

To edit the SuperStar effect, just double-click on the effect in the S5 Sequencer's grid and SuperStar
will re-open.

This command requires a Pro level license.

Insert Toolbar Effect as Fade Down

Inserts the current effect into the selected cells as a ramp from the maximum value in the toolbar's
intensity range to the minimum value in the toolbar's intensity range.

Fade Down (ON effect w ith intensity range 0-100%)

Insert Toolbar Effect as Fade Up
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Inserts the current effect into the selected cells as a ramp from the minimum value in the toolbar's
intensity range to the maximum value in the toolbar's intensity range.

Fade Up (ON effect w ith intensity range 0-100%)

Insert Toolbar Effect at Max Toolbar Intensity

Inserts the current effect into the selected cells at the maximum value in the toolbar's intensity range

Max Intensity (ON effect w ith intensity range 50-100%)

Insert Toolbar Effect at Min Toolbar Intensity

Inserts the current effect into the selected cells at the minimum value in the toolbar's intensity range

Min Intensity (ON effect w ith intensity range 50-100%)

Chase

Creates a chase across the selected cells.

Custom Chase

Opens the Custom Chase dialog, then creates the chase across the selected cells with the options
specified in the dialog.
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The Custom Chase dialog

Row Mode: 
Chase Each Row: perform the chase on each row in the selected area 
Chase Each Prop: perform the chase on the first row of each prop in the selected area
(makes a difference on pixel props with multiple motion effect rows)

Clear existing effects: clears the chase area of any existing effects before placing the new
effects that are part of the chase.

Matching Fill

Creates a matching fill across the selected cells.

Clear

Deletes any effects in the selected area of the grid.

Prompt For New Effect sub-menu

Opens the Prompt For New Effect sub-menu.

Empty Areas (background) sub-menu

Opens the Empty Areas (background) sub-menu.

Existing Effects (foreground) sub-menu

Opens the Existing Effects (foreground) sub-menu.

Advanced Tools

Opens the Advanced Tools sub-menu.

Select sub-menu

This sub-menu displays items to expand the grid selection to encompass:

the entire effect
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the entire row
the entire column
the entire grid

Cut, Copy, Paste

These items perform standard cut, copy, and paste functions. See the Clipboards & Cut/Copy/
Paste/Repeat topic for more information.

Paste Special

Opens a dialog window that allows you to select additional options when you are pasting. See the 
Clipboards & Cut/Copy/Paste/Repeat topic for more information.

Timing Mark sub-menu

Opens the Timing Mark sub-menu.

Audio Wizards

Opens a sub-menu that allows you to initiate an Audio Wizard.

Undo and Redo

These allow you to undo and redo changes that you make to a sequence.  A wide variety of changes
can be undone and redone - changing lighting effects, moving timings, and many more.  If there is no
action to be undone, the "Undo" menu item will not be shown. If there is no action to be redone, the
"Redo" menu item will not be shown.

There is a limit to how many changes will be remembered for the purposes of undo and redo, so if
you make many changes to a sequence and then start undoing them all, you may eventually reach
a point where you can't undo any more, even though you haven't undone all of the changes that you
made.

Undo and redo have keyboard shortcuts: Ctrl-Z and Ctrl-Y, respectively.

5.3.5.10.1  Right-Click Prompt For New  Effect Sub-menu

A variety of tools for adding new effects are available by right-clicking on the sequence grid and then
opening the "Prompt For New Effect" sub-menu. As the name implies, you will be prompted for the effect
first, and then the chosen effect will be inserted into the selected area of the grid.

From "Prompt For New Effect" sub-menu you can:

Create new Fade Down, Fade Up, Max Intensity, or Min Intensity effects
Modify Existing Effects
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Right-click menu with the Prompt For New Effect sub-menu open

Fade Down, Fade Up, Max Intensity, Min Intensity

These items will open a dialog that allows you to choose the type of effect to be inserted. The particular
dialog that is opened will depend on the type of grid rows in the selection. The dialog for each row type is
shown below. After clicking the OK button in the dialog, the entire selection will be filled with the chosen
effect at the intensity level specified by the menu item.

The result of Prompt For New Effect > Fade Down, and

then choosing the Shimmer effect from the dialog

Regular Channels and Beat Channels
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When used on Regular Channels and Beat Channels, these menu items will open the following
dialog:

RGB Channels

When used on RGB Channels, these menu items will open the following dialog:

Motion Effect Rows

When used on Motion Effect Rows, these menu items will open the Motion Effect Generator.

Modify Existing Effects

This menu item will open the same dialogs shown above. However, after clicking the OK button in the
dialog, only existing effects in the grid selection will be changed, and the intensity of those effects will
remain the same.

For example, if the grid contained this:

Before Modify Existing Effects
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Selecting Prompt For New Effect > Modify Existing Effects, then selecting Shimmer from the dialog,
would result in this:

After Modify Existing Effects

5.3.5.10.2  Right-Click Empty Areas (background) Sub-menu

The "Empty Areas (background)" sub-menu contains a list of functions that are applied to empty parts of
the selected area. These functions do not make any changes to grid cells that already contain effects.

The effects that are created using these tools depend on the Intensity Range and current effect that are
shown on the toolbar. For RGB channels and motion effect rows, the toolbar color will also be used. For
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a more detailed explanation of the toolbar settings, see the Adding Effects topic.

Toolbar settings

Insert Toolbar Effect as Fade Down

Adds the currently selected effect to empty portions of the selected area. This function applies the
maximum intensity in the intensity range to the left side of the selection, and ramps down to the
minimum intensity on the right. 

Before Insert

After Insert w ith tw inkle

effect, intensity range

0-100%

Insert Toolbar Effect as Fade Up
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Adds the currently selected effect to empty portions of the selected area. This function applies the
minimum intensity in the intensity range to the left side of the selection, and ramps up to the
maximum intensity on the right. 

Before Insert

After Insert w ith tw inkle

effect, intensity range

0-100%

Insert Toolbar Effect at Max Intensity

Adds the currently selected effect to empty portions of the selected area at the maximum intensity
in the toolbar intensity range. 

Before Insert
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After Insert w ith tw inkle

effect, intensity range

0-100%

Insert Toolbar Effect at Min Intensity

Adds the currently selected effect to empty portions of the selected area at the minimum intensity in
the toolbar intensity range. 

Before Insert

After Insert w ith tw inkle

effect, intensity range

50-100%
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5.3.5.10.3  Right-Click Existing Effects (foreground) Sub-menu

The "Existing Effects (foreground)" sub-menu contains a list of functions that are applied to existing
effects in the selected area. These functions do not make any changes to grid cells that are empty.

The available functions are:

Fade Down Across Selection
Fade Up Across Selection
Fade Down Each Effect
Fade Up Each Effect
Set to Max Intensity
Set to Min Intensity
Apply Toolbar Effect
Apply Toolbar Color   (RGB channels only)
Apply Toolbar Hue   (RGB channels only)
Lower to Max Intensity (cap)
Raise to Min Intensity (floor)
Increase Intensity
Decrease Intensity
Scale Intensity
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Fade Down Across Selection

Resets intensities on existing effects in the selected area. This function applies the maximum
intensity in the intensity range to the left side of the selection, and ramps down to the minimum
intensity on the right. This is useful for fading out your lights at the end of a sequence.
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Before Fade Down

After Fade Down, intensity

range 0-100%

Fade Up Across Selection

Resets intensities on existing effects in the selected area. This function applies the minimum
intensity in the intensity range to the left side of the selection, and ramps up to the maximum
intensity on the right. This is useful for fading in your lights at the beginning of a sequence.

Before Fade Up
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After Fade Up, intensity

range 0-100%

Fade Down Each Effect

Resets intensities on existing effects in the selected area. This function applies the maximum
intensity in the intensity range to the left side of each effect, and ramps down to the minimum
intensity on the right side of the effect.

Before Fade Down

After Fade Down, intensity

range 0-100%

Fade Up Each Effect
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Resets intensities on existing effects in the selected area. This function applies the minimum
intensity in the intensity range to the left side of each effect, and ramps up to the maximum intensity
on the right side of the effect.

Before Fade Up

After Fade Up, intensity

range 0-100%

Set to Max Intensity

Resets intensities on existing effects in the selected area. This function applies the maximum
intensity in the intensity range to each effect.

Before Max Intensity
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After Max Intensity,

intensity range 0-100%

Set to Min Intensity

Resets intensities on existing effects in the selected area. This function applies the minimum
intensity in the intensity range to each effect.

Before Min Intensity

After Min Intensity,

intensity range 25-50%

Apply Toolbar Effect

Changes existing effects in the selected area to be the effect on the toolbar. It does not change the
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intensity.

Regular Channels

Before "Apply Toolbar

Effect"

After "Apply Toolbar

Effect", effect on toolbar

was SHIMMER

RGB Channels

On RGB channels, the color is maintained; only the toolbar effect is applied.

Before "Apply Toolbar Effect"
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After "Apply Toolbar Effect", effect on toolbar was SHIMMER

Motion Effect Rows

In order to use this tool with motion effect rows:

1. Left-click on a motion effect that you want to apply to another area. This makes the effect you
clicked on the "current effect", and it will be displayed in the playback window.

2. Using the right-click and drag technique, drag over the destination and select this menu item
from the pop-up menu.

3. Any existing motion effects in the selected area will be changed to the source effect, while
leaving the intensity of those effects unchanged.

Before "Apply Toolbar Effect" (Bars)

After "Apply Toolbar Effect" (Snowflakes)

Apply Toolbar Color

Replaces the color of selected RGB channel effects with a new color. The new color will be taken
from the Color Fade Tool if it is open; otherwise the color on the color fade button on the toolbar will
be used.
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Before "Apply Toolbar Color"

After "Apply Toolbar Color" (green)

Apply Toolbar Hue

Replaces the hue of selected RGB channel effects with a new hue. The new color will be taken from
the Color Fade Tool if it is open; otherwise the color on the color fade button on the toolbar will be
used. The difference between this tool and "Apply Toolbar Color" is that this tool will maintain any
place there is a fade to black.

Before "Apply Toolbar Hue"
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After "Apply Toolbar Hue" (green)

Lower to Max Intensity (cap)

The Cap operation imposes a maximum upon the intensities in the selected area.  This function
applies the maximum intensity in the intensity range to each effect. The starting and ending effect
intensities are treated independently. For example, using a percent of 80, any intensities above 80%
of the effect type's maximum will be reduced to 80%, and any intensities that are already at or below
80% will be left unchanged. 

Note that most effect types (intensity, twinkle, shimmer) have maximum possible values of 100, so
for those effect types this means the same thing as "any intensity above 80 will be reduced to 80". 
However, the DMX intensity effect has a maximum value of 255, not 100, so for it, capping with a
percent of 80 means capping at a value of 204 (i.e. 80% of 255).

Before "Lower to Max

Intensity"
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After "Lower to Max

Intensity", intensity range

0-80%

Raise to Min Intensity (floor)

The Floor operation imposes a minimum upon the intensities in the selected area.  This function
applies the minimum intensity in the intensity range to each effect. The starting and ending effect
intensities are treated independently. For example, using a percent of 80, any intensities below 80%
of the effect type's maximum will be increased to 80% of the maximum, and any intensities that are
already at or above 80% will be left unchanged.

Note that most effect types (intensity, twinkle, shimmer) have maximum possible values of 100, so
for those effect types this means the same thing as "any intensity below 80 will be increased to 80".
 However, DMX intensity effect has a maximum value of 255, not 100, so for it, imposing a floor with
a percent of 80 means imposing a floor at a value of 204 (i.e. 80% of 255).

Before "Raise to Min

Intensity"
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After "Raise to Min

Intensity", intensity range

80-100%

Increase Intensity

The Increase operation increases all intensities in the selected area by the specified percent of the
effect type's maximum value.  For example, using a percent of 20, a fade up from 0 to 60 will be
changed to a fade up from 20 to 80.

Note that most effect types (intensity, twinkle, shimmer) have maximum possible values of 100, so
for those effect types this means the same thing as "any intensity will be increased by 20". 
However, the DMX intensity effect has a maximum value of 255, not 100, so for it, increasing with a
percent of 20 means increasing by a value of 51 (i.e. 20% of 255).

If the increase pushes any intensity above the effect type's maximum possible value, it will be set to
that maximum.  For example, using a percent of 20, a fade up from 50 to 90 will be changed to a
fade up from 70 to 100.

Before "Increase

Intensity"
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After "Increase Intensity"

by 20

Decrease Intensity

The Reduce operation decreases all intensities in the selected area by the specified percent of the
effect type's maximum value.  For example, using a percent of 20, a fade up from 50 to 60 will be
changed to a fade up from 30 to 40.

Note that most effect types (intensity, twinkle, shimmer) have maximum possible values of 100, so
for those effect types this means the same thing as "any intensity will be reduced by 20".  However,
the DMX intensity effect type has a maximum value of 255, not 100, so for it, decreasing with a
percent of 20 means decreasing by a value of 51 (i.e. 20% of 255).

If the decrease pushes any intensity below zero, it will be set to zero.  For example, using a percent
of 20, a fade up from 10 to 90 will be changed to a fade up from 0 to 70.

Before "Decrease

Intensity"
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After "Decrease Intensity"

by 20

Scale Intensity

The Scale operation scales all intensities in the selected area by the specified percentage.  For
example, a percent of 200 means doubling; a fade up from 30 to 40 will become a fade up from 60 to
80.  A percent of 50 means halving; a fade up from 30 to 40 will become a fade up from 15 to 20.

If the scaling pushes any intensity above the effect type's maximum possible value, it will be set to
that maximum.  For example, using a percent of 200, a fade up from 30 to 80 will become a fade up
from 60 to 100.

Before "Scale Intensity"

After "Scale Intensity" by

50%
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5.3.5.10.4  Right-Click Advanced Tools Sub-menu

The "Advanced Tools" sub-menu contains a list of functions that are valuable in specific circumstances.

The available functions are:

Insert at Sound Level   (musical sequences only)
Skew Selection
Toggle
Fade Down Each Cell
Fade Up Each Cell

Insert at Sound Level

This command inserts a series of ON effects into the selected area, whose intensity reflects the
sound level of the music. The command finds the loudest sound across the selection and uses that
sound level as the 100% intensity level. All other effects being added are scaled using that loudest
sound.
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Before "Insert at Sound Level"

After "Insert at Sound Level"

Skew Selection

This command will allow you to move effects and/or timing marks to the left or right. It opens a
dialog with fields that allow to specify how the effects and timing marks in the selected area should
be moved.

Also see the Nudge Tools for a similar function.
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The Skew Selection dialog

After you click the OK button, the actions you specify will be applied to the selected area of the
sequence.

Before Skew Selection
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After Skew Selection, effects but not timing marks,

to the right by 0.15 seconds

Toggle

This menu item applies the Toggle function to the selected area of the sequence grid.

Fade Down Each Cell

Creates a fade down effect in each selected cell using the toolbar intensity range and toolbar effect.

Before Fade Down Each

Cell
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After Fade Down Each Cell,

intensity range 0-50%, ON

effect

Fade Up Each Cell

Creates a fade up effect in each selected cell using the toolbar intensity range and toolbar effect.

Before Fade Up Each Cell

After Fade Up Each Cell,

intensity range 0-100%,

TWINKLE effect

5.3.5.10.5  Right-Click Timing Mark Sub-menu

A variety of tools to modify timing marks in freeform timing grids are available by right-clicking on the
sequence grid and then opening the "Timing Mark" sub-menu.
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From the "Timing Mark" sub-menu you can:

Insert Timing at X.XX
Insert Timing at ...
Insert Timing at Selection (Left, Right, or Both)
Insert Multiple Timings
Subdivide Timings
Delete Timing near X.XX
Delete Selected Timings
Resize Timing(s) to ...
Resize Timings to Equal Times
Copy Timing
Paste Timing at X.XX
Paste Timing at ...
Paste Multiple Timings
Lock Timings
Drag Events With Timings

Right-click menu with the Timing Mark sub-menu open

Insert Timing at X.XX
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This menu item can be used to insert a timing into the sequence.  It opens a dialog asking you for
the time that you want to insert a timing at (defaulting to the time that you right-clicked when
opening the context menu).  Please see Time Format for details on how to enter times.

Insert Timing at ...

This menu item can be used to insert a timing into the sequence at the time that you right-clicked
when opening the context menu.

Insert Timing at Selection (Left, Right, or Both)

If you make a selection that does not start or end on a timing mark (perhaps by using the Ctrl key
while dragging the mouse), you can use this function to add timing marks where the selection starts
and/or ends.

Insert Multiple Timings

This menu item can be used to insert multiple timings into the current selection by dividing it into
equally-sized parts.  For example, if you select an area whose time range is from 6 to 8 seconds,
and use "Insert Multiple Timings" to insert 3 equally spaced timings, then the new timings will be
inserted at 6.5, 7, and 7.5 seconds, splitting the selection into four equally spaced parts of half a
second each.

Before applying Insert Multiple Timings

After applying Insert Multiple Timings

Also see Subdivide Timings, which divides each selected cell into equally-sized parts, as opposed
to dividing the entire selection into equally-sized parts.

Subdivide Timings

This allows you to insert multiple timings into the current selection, dividing each selected cell into
equally-sized parts.  For example:

if you select 2 cells: from 6 to 7.3 seconds, and 7.3 seconds to 8 seconds,
then use "Subdivide Timings" to subdivide each original cell into two new cells, 
then you will end up with 4 cells: from 6 to 6.65, 6.65 to 7.3, 7.3 to 7.65, and 7.65 to 8.
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Before applying Subdivide Timings

After applying Subdivide Timings

Also see Insert Multiple Timings, which divides the entire selection into equally-sized parts, as
opposed to dividing each selected cell into equally-sized parts.

Delete Timing near X.XX

This item can be used to delete the timing closest to where you right-clicked when opening the
context menu.

Delete Selected Timings

This item can be used to delete the timings inside the currently selected cells.  Note that the two
timings on the edges of the currently selected cells are not deleted.

Resize Timing(s) to ...

This item can be used to change the duration of time between the selected timings.  It will not allow
any of the timings to be pushed beyond the next timing in the sequence.  Please see Time Format
for details on how to enter times.

Note that the length of the sequence will not be affected, nor the positions of the timings past the
selected range.  So, if you choose to resize some timings such that their total length decreases,
this will cause the cell just past them to increase in size (since the last selected timing is moved
earlier, while the next timing remains the same).

Resize Timings to Equal Times

This item can be used to change the duration of time between the selected timings so that all such
durations are equal (or as close to equal as possible).  For example, if you select two cells with
durations of 0.2 seconds and 0.8 seconds, and use "Resize Timings to Equal Times", they will both
change to 0.5 seconds.

Copy Timing

After selecting an area on the grid, you can use "Copy Timing" function to record the timing marks
within the selection.  After that, you can paste the timings to another point in the sequence (or even
to another sequence) using any of the "Paste Timing" functions.  Note that this copies only the
timings, not any lighting effects (see Clipboards & Cut/Copy/Paste/Repeat for information on
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copying lighting effects).

For example, if you copy timings that are at 3 seconds, 3.5 seconds, and 5 seconds, and paste
those timings starting at 7 seconds, you will wind up with timings at 7 seconds, 7.5 seconds, and 9
seconds.

Paste Timing at X.XX

This menu item can be used to paste copied timings into the sequence, starting at the time that you
right-clicked when opening the context menu.

Paste Timing at ...

This menu item can be used to paste copied timings into the sequence.  It opens a dialog asking
you for the time that you want to paste the timings to (defaulting to the time that you right-clicked
when opening the context menu).  Please see Time Format for details on how to enter times.

Paste Multiple Timings

This item can be used to paste copied timings into the sequence, multiple times in a row.

Lock Timings

Each timing in a sequence is a particular point in time (since the beginning of the sequence), and is
represented by a vertical gray line.  If "Lock Timings" is off (unchecked), and the current timing grid
is a freeform timing grid, you can change the time of a timing by hovering over its line with your
mouse (which will change your mouse cursor from a "pointer" cursor to an "east-west" cursor), and
clicking and dragging the line to the left or the right.

If "Lock Timings" is on (checked), you cannot do this.  This prevents you from accidentally changing
the time of a timing while you're trying to modify the lighting effects in a cell between two timings.

See also Drag Events with Timings, which controls whether or not effects that start or end at the
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dragged timing will be dragged along with it.

Drag Events With Timings

Timings in a sequence can be dragged with the mouse to change the time that they are at (unless
the Lock Timings option is turned on).  If "Drag Events with Timings" is turned on, and any effects
start or end at the same time as the timing being dragged, they will be dragged along with it.  If not,
only the timing will move; the effects will remain unchanged.

5.3.5.11 Freeform Play Range

What Is A Freeform Play Range?

A freeform play range is a user selected time range within a sequence. There can be at most one
freeform play range specified at any given time.

A freeform play range is displayed with a dimmed area on the time scale and dashed vertical red lines
running through the sequence grid at the beginning and end of the range.

A sequence with a freeform play range

How Are They Created?

A freeform play range can be created using either of these techniques:

By clicking and dragging across the time scale (not the waveform area). This is the quickest way
to create a range that is limited to the visible area of the sequence grid.
By right-clicking on the time scale or waveform area and using the Set Play Range Start/End
menu items.
During sequence playback, pressing the keyboard's down arrow will mark the current time as the
start of a "freeform play range".  Later pressing the up arrow will mark the current time as the end
of the freeform play range.
After right-clicking on the audio waveform or timeline, select the "Set Play Range Start" or "Set
Play Range End" menu items to create or extend a freeform play range.
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What Can You Do With Them?

As the name implies, a freeform play range can be used to play back the specified region of the
sequence.

5.3.5.12 Playback

You can play back your sequence in the Light-O-Rama Sequencer. If the playback window is open, it
will show a simulation of your display. The simulation is based on the preview associated with the
sequence.

Calculating Preview
Sequence Playback
Zoomed Playback
Playback in Action

Calculating Preview

When opening your sequence, the simulated preview is calculated in memory, which can take some
time. A spinner will be displayed and the play buttons disabled until the calculations are complete: 

Calculations in progress

Once complete, a green check mark is displayed next to the preview name. Any subsequent
changes to the sequence will cause the preview for the affected props to be recalculated; the play
buttons will again be temporarily disabled until the recalculation is complete.

Calculations complete

Sequence Playback

Playback Using The Toolbar Buttons

These toolbar buttons control sequence playback:

Play the full sequence

Play from the left edge of the visible sequence grid to the end of the sequence

Play from the beginning of the sequence to the right edge of the visible sequence
grid

Play the visible portion of the sequence
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Play the current selection. If there is a freeform play range defined then that is
played; otherwise the current grid selection (dashed yellow outline) is played.

Pause playback. Press again to un-pause

Stop playback

Repeat playback. This icon will have a red slash through it if repeat is disabled

Playback speed. Playback speeds other than normal may not be supported on
some types of media files.

Playback Using The Spacebar

Play the sequence using the space bar

Sequence playback can also be started and stopped using the spacebar.

If playback is currently stopped, then pressing the spacebar will:

Play the freeform play range if one is defined, otherwise it will
Play starting with the current selection (yellow outline) and continue to the end of the
sequence if a grid selection exists, otherwise it will
Play starting at the left edge of the visible sequence area and continue to the end of the
sequence

If the sequence is playing when the spacebar is pressed, playback will be stopped and the grid
column where playback was stopped will be selected. Pressing the spacebar again will restart
playback at approximately the place where you had stopped it.  This can be used to effectively
pause and un-pause play.

Pressing shift-spacebar will clear any freeform play range, and then perform the same action as
pressing the spacebar without the shift key.
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Zoomed Playback

You can also zoom in on a specific prop or preview group during playback. To do this, right-click on
a prop name (not a grid view group) and open the "Zoomed Playback" sub-menu. 

Zoomed Playback menu

Playback in Action

During playback, color samples will be displayed real-time, immediately to the right of the channel
name. The color samples will be displayed for traditional channels and RGB channels. They will not
be displayed for motion effect rows. A playback marker will move as play progresses. You can
change the width of the color samples and the style of the playback marker in Sequence Grid
Preferences.

Playback in progress
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5.3.5.13 Audio Waveform

For most musical sequences, the Sequencer can display a waveform of the audio at the top of the
sequence grid.  This can be useful for visually matching up timings and events to the sound.  The
Waveform Display supports a wide range of media types, including video media.  However, not all types
of media or media containers are supported (for example, midi files are not supported).

In addition to the waveform itself, a vertical highlight bar is displayed at the current time that your mouse
is pointing at.

Right-clicking on the waveform or the time scale will open a menu that allows you to:

Zoom in and out
Set the freeform play range
Scale and filter the waveform
Set the waveform area height
Change the waveform area colors

Waveform area height set to large and the right-click menu displayed

Zooming In And Out

The first 2 options on the menu allow you to zoom the time scale in and out.

The next 3 options zoom to a fixed time scale: 5, 10, or 15 seconds wide. These can quickly take
you to a reasonable time scale if you have zoomed in too far.

You can also zoom in by left-clicking on the waveform and dragging across the area of the waveform
where you want to zoom. When you release the mouse button, the new zoom level will take effect.
Note that this only works in the waveform area, not on the time scale.
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See the Zoom topic for more ways to zoom the sequence grid in and out.

Setting The Freeform Play Range

The "Set Play Range Start" and "Set Play Range End" menu items can be used to create or extend
a freeform play range.

Scaling And Filtering The Waveform

The Sequencer will automatically scale the audio waveform vertically so that it fills the entire height
of the waveform area. By default, all audio frequencies are displayed.

You can zoom the waveform up or down, or apply a frequency filter by choosing "Waveform Filter &
Scale" from the right-click menu.
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The Audio Filter and Scale dialog

No Filter

The following screens are taken from a sequence that uses a specially constructed audio file. The
audio consists of 5 tones, each 2 seconds long and each one an octave higher than the previous
tone (10 seconds total). The first 2 seconds have a 110 Hz tone (A2), followed by 2 seconds at 220
Hz (A3), followed by 2 seconds at 440 Hz (A4), followed by 2 seconds at 880 Hz (A5), followed by 2
seconds at 1760 Hz (A6). Here is what the waveform looks like with no audio filtering:
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Emphasize Low Tones

Here is the same sequence with the low tones emphasized. Notice that the frequency cut-off for the
filter is adjustable using the slider.

Emphasize Mid Tones

Here is the same sequence with the middle tones emphasized. Notice that the mid-point frequency
for the filter is adjustable using the slider.
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Emphasize High Tones

Here is the same sequence with the high tones emphasized. Notice that the frequency cut-off for the
filter is adjustable using the slider.

Scaling the Waveform

You can use the bottom section of the "Audio Filter and Scale" dialog to scale up low level audio



The Light-O-Rama Software Package 325

© 2019 Light-O-Rama, Inc.

signals to see more detail. The next example shows how this can be used to see where the beats
are more clearly.

Increasing the vertical scale of the waveform

Setting The Waveform Area Height

The height of the waveform area can be set to small, medium, large, or hidden -- small is the default
for musical sequences. Choose “Large” to see the maximum amount of detail in the waveform.
Choose “Small” to see the waveform, but have more room to display the sequence. The height can
be changed by selecting Sequence > Waveform Area from the main menu, or by right-clicking inside
the waveform area.

 You can also click on the waveform icon on the toolbar to hide or unhide the waveform area.

The waveform area right-click menu

Changing the Waveform Area Colors

The colors used to display the waveform can be changed via the Waveform Colors dialog, which can
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be opened by right-clicking on the waveform and selecting "Waveform Colors" from the pop-up menu:

The Waveform Colors dialog

Three different colors can be set: "Foreground" is the color of the wave itself; "background" is the
field that it is drawn upon; "highlight" is the vertical bar showing the position of the mouse.

The colored buttons on the left can be used to set each of these three colors, and the display on the
right shows how a sample waveform would look using these colors.

The Sequencer will remember the colors that you chose, so that other waveforms will automatically
be displayed using those colors.

You can revert to the system default of blue on white by clicking the "Set Defaults" button.

The Waveform Colors dialog, w ith different colors chosen

5.3.5.14 Audio Wizards

There are 4 audio wizards that you can use to convert the beat of the music to timing marks and/or
channel effects:

The Tapper Wizard
The Beat Wizard
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The VU Wizard
The MIDI File Wizard  (can only be used on MIDI files)

They can be accessed from:
the Sequence > Audio Wizards sub-menu
by right-clicking on the sequence grid
by right-clicking on the name of a beat channel in the sequence grid

5.3.5.14.1  The Tapper Wizard

The Light-O-Rama Sequencer's Tapper Wizard is a tool that lets you populate a musical sequence with
timings and  lighting effects simply by tapping along with the song, on your keyboard or your mouse. 
The Tapper Wizard will remember the moments in the song that you tapped at, and will insert timings
and effects into the sequence at those times.

The Tapper Wizard is available as an option when creating a new musical sequence, and can be
accessed later by opening the Sequence > Audio Wizards sub-menu, by right-clicking on a beat
channel name, or by right-clicking in the sequence grid and opening the Audio Wizards sub-menu.

Note that you can insert timing marks into the sequence grid without using the Tapper Wizard. Simply
start playing the sequence, then use the "T" shortcut key to insert timing marks.

The Tapper Wizard has the following sections and controls:

Play Options
What to Do with Taps
Input Options
Start and Stop
Play Back
Tap
Apply
Undo and Redo
Apply and Exit
Exit
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The Tapper Wizard

Play Options

This section of the Tapper Wizard lets you control how the song will be played while you are
tapping.  You can select to play the entire song, or just a certain time range of the song. You can
also choose the speed at which the song will be played: half speed, normal speed, or double speed.

Whenever the sequence is opened, this option will be set to "Play the entire song". If you change
this to "Play part of the song", that option will be used as long as the sequence is open, or until you
change it back to "Play the entire song".

The time range will be set as follows:
If there is a freeform playback range defined, that range will be used, otherwise
If there is a selection on the sequence grid, its time range will be used, otherwise
The currently visible time range will be used

What to Do with Taps

This section lets you tell the Tapper Wizard what you want it to do with your taps.  You can choose
the track and the timing grid to apply the taps to (or create a new timing grid to use), and then
choose to insert timings into the timing grid, or to insert lighting effects into a channel of the track,
or both.
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If you choose to insert lighting effects into a channel, you can either have the channel briefly turn on
for each tap, or you can choose to have it toggle on with one tap, off with the next, on with the third,
and so forth.  If you choose to have it turn briefly on for each tap, you can additionally choose to
have it fade off after the tap (otherwise it will simply turn off).

You also have the option to "snap to existing events".  If you select this option, and you tap at a
point in time that is near an existing timing (with "near" meaning within the number of hundredths of
a second that you specify here), instead of using the exact time that you tapped, the Tapper Wizard
uses the time of that timing.  This makes it easier to cleanly use the Tapper Wizard multiple times
on the same sequence (for different channels), without introducing minor timing errors based upon
your reaction time.

After you have done your tapping, and used this section to tell the Tapper Wizard what to do with
your taps, click "Apply", or "Apply and Exit" to apply them to the sequence.  If you clicked "Apply"
rather than "Apply and Exit", then the Tapper Wizard will remain open.  At this point, you could
change your settings in this section to apply your existing taps in a different way (such as to a
different channel, or with different types of effects), or you could tap again (by hitting "Start" again) to
collect new taps.  You could also undo and redo any changes that the Tapper Wizard made to your
sequence.

Input Options

This section of the Tapper Wizard allows you to control how you will tap.

You can use the mouse, or the keyboard, or both.

If you use the mouse, you have two options: pushing the mouse button down and then letting it up
count as two separate taps, or as a single tap.  To use the mouse, you must click on the Tap
button.

If you use the keyboard, you can tap with practically any key, or even multiple keys.

You can also choose whether to use a countdown or not; if you do, then when you start the song
(by clicking Start), a countdown will be displayed before the song begins, rather than starting
immediately.  This may give you time to get ready after clicking "Start".

Start and Stop

Use these buttons to start playing the song (or to start the countdown before play), and to stop the
song.  When the song begins, the Tap button will become enabled.  When the song ends, you do
not have to use the Stop button; the Stop button is for stopping the song in the middle, for example
if you are unhappy with the taps that you made.

After the song ends (or after you hit Stop), you can click Start again in order to redo your taps.  This
will wipe out any previously recorded taps.  You will be warned that they will be wiped out, and will
be given an option to cancel.

You can also redo your taps after having applied them to the sequence.  This lets you use different
sets of taps for different purposes, all without closing the Tapper Wizard.

Tap
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While a song is playing, the Tap button is enabled.  Every time that you tap (whether by mouse or
by keyboard), it will provide feedback by briefly flashing.

Play Back

After you have recorded taps, you can click "Play Back" to play the song over again.  The Tap
button will flash at the points in time that you tapped.  You can use this to double check that you
are satisfied with your taps before entering them into the sequence (by clicking the Apply button); if
you are not satisfied with them, you can wipe them out and try again by hitting the Start button
again.

Apply

After you have tapped, and have told the Tapper Wizard what to do with the taps, click the Apply
button to apply those taps to your sequence.

Note that you can then change the settings in the "What To Do with Taps" section, and click Apply
again; this will apply the new settings, using the same taps, to the sequence.

Or, you could click Start again, to collect new taps.  Your old taps will be deleted when you do this,
but any  timings or effects that you inserted into the sequence based on them will remain.  In this
way, you can use different sets of taps to do different things, all without closing the Tapper Wizard.

Undo and Redo

After applying your taps to the sequence, you can use these buttons to undo and redo any such
applications, without exiting from the Tapper Wizard.

Apply and Exit

Clicking the Tapper Wizard's Apply and Exit button will apply your taps to the sequence, in the
manner that you specify in the "What To Do with Taps" section, and then exit from the Tapper
Wizard.

If you want to apply your taps without exiting the Tapper Wizard, so that you can apply them again
using new settings, or so that you can collect different taps, use the Apply button instead.

Exit

This button simply exits from the Tapper Wizard, without applying your taps to the sequence.  Note,
though, that if you have already applied your taps (using the Apply button), they will remain in your
sequence; using this button (instead of Apply and Exit) will prevent your taps from being applied
again.  

For example, if you apply your taps, then change the settings in the What To Do with Taps section,
and then click Exit, your applied taps, based on your original settings, will remain in the sequence,
but your taps will not be reapplied based on the changed settings.
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5.3.5.14.2  The Beat Wizard

The Light-O-Rama Sequencer's Beat Wizard can analyze the song associated with a musical sequence
to try to determine its tempo, and can insert timings and lighting effects into the sequence based upon
it.  These are not necessarily inserted exactly the same distance apart from each other; rather, the Beat
Wizard attempts to match them up with peaks in the audio that are near the tempo.  This is to allow for
subtle variation in the speed of the song.

The Beat Wizard is available as an option when creating a new musical sequence, and can be accessed
later by opening the Sequence > Audio Wizards sub-menu, by right-clicking on a beat channel name, or
by right-clicking in the sequence grid and opening the Audio Wizards sub-menu.

The Beat Wizard supports a wide range of media types, including video media.  However, not all types of
media or media containers are supported.  If the Beat Wizard cannot be used with the media file
associated with your sequence, you will be presented with a message box alerting you to that fact. 
Also, the Beat Wizard may not be able to be used with very large media files.

Selecting the Time Range
Selecting the Tempo
Previewing
What To Do with Beats
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The Beat Wizard

Selecting the Time Range

The Beat Wizard can try to determine the tempo of a song as a whole, or of just a portion of the
song.  Use the "Time Range" settings to tell it which to try.  If you select a portion of the song, be
sure to click the "Update" button after changing the "From" or "To" times.

Choosing a portion of the song is useful if the song's tempo changes; the Beat Wizard will be more
accurate if it only is asked to operate on a section with a near-constant tempo throughout.  It may
also be useful if the Beat Wizard has a problem with a certain portion of a song; if the beats seem
off in a particular spot, you may want to try running the Beat Wizard on that spot individually.

Whenever the sequence is opened, this option will be set to "Play the entire song". If you change
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this to "Play part of the song", that option will be used as long as the sequence is open, or until you
change it back to "Play the entire song".

The time range will be set as follows:
If there is a freeform playback range defined, that range will be used, otherwise
If there is a selection on the sequence grid, its time range will be used, otherwise
The currently visible time range will be used

Selecting the Tempo

The Beat Wizard shows its best guess as to the tempo of the selected portion of the song.  You can
choose to use that tempo, or faster or slower related tempos - for example, three times as fast, or
twice as slow.  Depending upon the song, one of the related tempos may seem more natural when
you preview it.

Another use of related tempos is to simply insert more timings, allowing for faster lighting effects to
be used that are still synchronized to the beat of the song.  For example, it is unlikely that a "10x
Faster" tempo will seem "more natural" in any sense, because it will probably be too quick to count
along with.  However, selecting it will, for example, let you set up a lighting effect with ten different
channels that looks like the lights are quickly chasing each other to the beat of the music.

If a slower related tempo is chosen, you must also choose a "beat offset" to determine which beats
of the "best guess" tempo will be selected: You might feel that the best guess tempo is actually
twice as fast as it should be - that you would count along to it as "one - and - two - and" instead of
"one - two - three - four", for example.  If you therefore choose a "2x Slower" tempo, the Beat Wizard
will use only every other beat from its "best guess" tempo, but it doesn't know whether to use every
first beat or every second beat.  So, you can let it know which to use by selecting the "beat offset".

Previewing

After you choose a tempo to use in the Beat Wizard, you can get an idea of what it will make your
lights look like by using the controls in the "Preview" section.  Simply click "Start" to start the
preview.

The boxes to the right of the button will light up sequentially, in time with the tempo.  Only the white
boxes will be used; the greyed out boxes will not.  However, you can choose how many white boxes
there are by selecting the radio button under one of the boxes.

This allows you to make the preview section look more natural - for example, the boxes lighting up
sequentially in a song that you count along with as "one, two, three, one, two, three" will look most
natural if you select three boxes - doing so will make the same box light up every time you count the
same number.

Clicking directly in one of the boxes will reset it so that that box lights up at that moment (and the
other boxes follow sequentially from there).  This is also useful for making the preview seem more
natural - for example, the third box might be lighting up every time that you count "one", and if so, it
might look more natural if you reset it so that the first box lights up at that time instead.

None of this has any effect on the timings or lighting effects that will be inserted into the sequence
when you decide what to do with beats - it is merely to help you see how the selected tempo looks
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in relation to the song.

Finally, if you are unsatisfied with the selected tempo, simply choose another tempo, or choose a
different portion of the song to analyze.

What To Do with Beats

When you have selected a time range and a tempo for the Beat Wizard to use, and are satisfied
with it after previewing it, you can use the controls in the "What To Do with Beats" section to insert
timings, lighting effects, or both, based upon the selected tempo into the sequence .

If you choose "Turn on a channel every so many beats", you will also have to specify the channel,
the number of beats, and a "beat offset".  For example, to make a set of four channels chase each
other in time with the beat, you could:

Select the first channel, four beats, and a beat offset of zero;
Click "Apply";
Select the second channel, four beats, and a beat offset of one;
Click "Apply";
Select the third channel, four beats, and a beat offset of two;
Click "Apply";
Select the fourth channel, four beats, and a beat offset of three;
Click "Apply and Exit".

Note that you can apply multiple effects to different channels, all in the same use of the Beat
Wizard, by using "Apply" multiple times. You can even apply effects based on different portions of
the song or different tempos, all without leaving the Beat Wizard.

5.3.5.14.3  The VU Wizard

The Light-O-Rama Sequencer's VU Wizard can analyze the song associated with a musical sequence
to try to find peaks in the audio - much like a VU meter - and can insert timings and lighting effects into
the sequence based upon them.

The VU Wizard is available as an option when creating a new musical sequence, and can be accessed
later by opening the Sequence > Audio Wizards sub-menu, by right-clicking on a beat channel name, or
by right-clicking in the sequence grid and opening the Audio Wizards sub-menu.

The VU Wizard supports a wide range of media types, including video media.  However, not all types of
media or media containers are supported.  If the VU Wizard cannot be used with the media file
associated with your sequence, you will be presented with a message box alerting you to that fact. 
Also, the VU Wizard may not be able to be used with very large media files.

Selecting a Time Range
Attack and Decay Settings
The Peak Threshold
Preview
What To Do with Peaks
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The VU Wizard

Selecting a Time Range

You can choose to let the VU Wizard look for audio peaks throughout the entire song, or limit it to a
specific portion of the song.  If you choose to use only a portion of the song, be sure to hit the
"Update" button after setting the "From" and "To" times.

Whenever the sequence is opened, this option will be set to "Play the entire song". If you change
this to "Play part of the song", that option will be used as long as the sequence is open, or until you
change it back to "Play the entire song".
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The time range will be set as follows:
If there is a freeform playback range defined, that range will be used, otherwise
If there is a selection on the sequence grid, its time range will be used, otherwise
The currently visible time range will be used

Attack and Decay Settings

These two values determine how quickly the VU Wizard will react to changes in the audio volume. 
"Attack" is how quickly it reacts to increased volume, and "Decay" is how quickly it reacts to
decreased volume.  The higher the number, the more slowly it reacts to changes.

You can enter specific numbers (make sure to hit "Update" if you do), or you can use one of the
"Preset" buttons to simulate common types of audio meters:

"VU Meter" simulates a standard VU meter, as often found on home stereo systems.
A "Peak Program Meter" reacts very quickly to increased volume, but very slowly to
decreased volume.  This causes peaks to last longer.
A "Peak Meter" reacts instantaneously to changes in volume.

Peak Threshold

Using the Peak Threshold section, you can tell the VU Wizard to look for audio peaks on either the
left stereo channel or the right stereo channel, or on the sum of the two.

The track bar (slider) represents the threshold for what will be considered a peak.  Above the slider's
handle is a peak; below the handle is not.  The handle can be slid left and right to increase and
decrease the threshold.

The "Time On" percentage displayed in this section shows the percentage of the selected time
range that is above the specified peak.  Updating any of the settings such as the peak threshold,
the attack and decay, or the time range will cause the "Time On" percentage to be automatically
updated as well, taking the new settings into account.

When you play the song (using the "Preview" section), the rows will pulse along with the audio
volume, showing blue starting at the left and continuing rightwards based upon how loud the audio is
at any given point in time.  When the selected stereo channel (or channels) is above the threshold, it
will turn red instead of blue.

Note that this is strongly affected by the attack and decay settings - lower values will cause the
pulsing to react more slowly to the music, and higher values more quickly.  Try playing with the
various "Preset" buttons to see this.

Preview

Clicking the Start button in the VU Wizard's Preview section plays the song, and pulses the rows in
the Peak Threshold section along with the audio.  It also flashes the box in the Preview section
whenever the pulse is above the selected threshold.
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You can change both threshold settings and the attack and decay settings during preview, and the
VU Wizard will react instantly to such changes.  However, only the final settings will be used when
you apply the peaks to the sequence (using the "What To Do with Peaks" section).

What To Do with Peaks

Once you are satisfied with the peaks found using your chosen attack and decay settings and peak
threshold settings, you can apply the peaks to the sequence using the "What To Do with Peaks"
section of the VU Wizard.  You can insert a timing every time the threshold is crossed (no matter
whether from below or from above), or turn a selected channel on whenever above the threshold, and
off whenever below, or both.

You can reuse the VU Wizard for multiple channels (and multiple settings) without closing it by
clicking "Apply" rather than "Apply and Exit".

5.3.5.14.4  The MIDI File Wizard

The Light-O-Rama Sequencer's MIDI File Wizard can be used to automatically populate beat channels
based on a the notes in the MIDI file.

The MIDI File Wizard is available (for musical sequences based on MIDI files) as an option when creating
a new musical sequence, or can be accessed later via any of the methods listed in the Audio Wizards
topic.
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The MIDI Wizard w indow

Select Which Instruments to Include

The window lists all of the instruments used in the song. For each instrument it lists:

how many total notes are played by the instrument
the number of distinct notes played by the instrument

Check the boxes next to the names of the instruments you wish to include.

Combine Instruments?

Click the radio button that indicates how you want the beat channels created:

One channel for each note -- combining the notes for all selected instruments
One channel for each note and instrument (this can produce a lot of beat channels)

Channel Color

Choose the color that the new beat channels will use when displayed on the sequence grid.
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Replace Existing Beat Channels?

The MIDI wizard can create a lot of beat channels. By checking this box, you can have the existing beat
channels deleted and replaced with the new set you are creating. Leave the box unchecked if you want
to keep the existing beat channels -- the new ones will be appended to the list.

Finish

Click the "Create Beat Channels" button to create the new beat channels and close the window.

5.3.5.15 Tooltips

When hovering over a cell in the Sequencer's sequence grid, a tool-tip can be displayed which shows
information about the grid cell and any effect it might contain.

Tool-tips can be turned on or off.  There are also options for how long to hover before they are displayed
and how they should be closed.  These settings can be changed in Sequence Grid Preferences.

5.3.5.16 Loops in Animation Sequences

An animation sequence (but not a musical sequence) can contain loops.  When the Show Player or the
Sequencer plays a sequence with loops, when the end of a loop is reached, the sequence will go back
to the beginning of the loop. This will happen a certain number of times (which you specify), after which
the sequence will continue on past the end of the loop.

Each time through a loop, you can have the sequence speed up, slow down, or remain at the same
speed.

A sequence can contain many loops.  Loops can be nested - that is, a loop can contain other loops.

Loop rows are shown with a white background are fixed to the top of the sequence grid. They do not
scroll away when the rest of the sequence is scrolled vertically. 
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For example, the following picture shows a sequence with a loop starting at 1 second and ending at 2
seconds. The number of times the loop will repeat is shown in the middle of loop (1 in this case). If the
loop were to speed up after each pass, then the repeat count would be followed by a "+" symbol.  If the
loop were to slow down after each pass, then the repeat count would be followed by a "-" symbol. In this
case the loop speed is set to stay the same, so no symbol is displayed.

A sequence with a loop starting at 1 second and ending at 2 seconds

More than one loop can be in a sequence.  For example, here is the same sequence, with a second
loop added, from 2.5 seconds to 3 seconds:

Two loops in a sequence

Subjects covered in this topic:

Adding a Loop Row
Adding A Loop
Modifying a Loop
Deleting a Loop
Right-Clicking on the Loop Name

Adding a Loop Row

Loops can contain loops; this is represented by having multiple rows of loops. For example, in the
following picture, a second loop level has been added, and a loop was put into it from 0.5 seconds to 3
seconds, thus containing both of the loops of the lowest loop level. 
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A loop containing loops

To create a loop row, select "Loop Level" from the "Add New" menu present on both the Sequence menu
and the Grid View menu. You can also right-click on the name of an existing loop to add additional
levels. The bottom loop level in a sequence is always labeled "Loop 1"; the one immediately higher than
that is labeled "Loop 2", and so on.

Adding A Loop

To add a loop to a loop row, select the desired time range on the row, then either right-click and select
"Insert Loop" or use the "shift-A" shortcut key.

The Loop Context menu

You will then be prompted for how many times the loop should loop back and whether (and by how
much) it should increase, decrease, or remain the same speed in each pass through the loop:
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Loop Effect dialog

Modifying a Loop

To modify a loop, just double-click on it -- the Loop Effect dialog will open, allowing you to make
changes.

Deleting a Loop

To delete a loop, select it, then either right-click on the selection and choose "Clear" from the pop-up
menu, or use the "Delete" shortcut key.

Right-Clicking on the Loop Name
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Menu when right-cliicking on a loop name

Right-clicking on a loop name, such as clicking on "Loop 2" in the picture above, opens the Loop
Context menu.

Add Loop Level Above

This item on the Loop Context menu can be used to add another loop level to the sequence, above
the selected loop level.  Loops on the new (higher) level can contain loops within the preexisting
(lower) level.

Add Loop Level Below

This item on the Loop Context menu can be used to add another loop level to the sequence, below
the selected loop level.  Loops on the preexisting (higher) level can contain loops within the new
(lower) level.

Remove Loop Level

This item on the Loop Context menu can be used to delete the entire selected loop level, including
all loops on it.

If you wish to delete all of the loops on a level, but to keep the level itself, use Remove All Loops on
Level instead.

Remove All Loops on Level

This item on the Loop Context menu can be used to delete all of the loops on the selected loop
level, but to keep the loop level itself.

If you wish to additionally delete the loop level itself, use Remove Loop Level instead.

5.3.5.17 Sharing Sequences

Sequences created using the S5 Sequencer can be shared with fellow lighting enthusiasts. To share a
sequence, you would send the other person your LOREDIT file. This file includes a copy of the preview
for that sequence. However, your sequence may also need other files to play back properly. To see a list
of those files, select Sequence > File References from the main menu.

Conversely, if a person shares a sequence with you, they should send you their LOREDIT file and
potentially other files. The first time you open their file in the Sequencer, you will receive a pop-up
message indicating that the preview was imported. The new preview will have a name like “Imported from
JingleBells.loredit on 6/17/2018”. After the sequence opens, you should then check File References to
make sure the sequence can find any other files it needs, and make corrections if necessary.
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5.3.6 Motion Effect Generator

The Motion Effect Generator is the tool used to create and modify motion effects in the Light-O-Rama
Sequencer.

The Motion Effect Generator window has three parts. The left and right sides can each independently
generate an effect. The result of those two effects is mixed in the middle. This middle portion is what
gets saved to the grid when you click OK to close the Motion Effect Generator window.

Opening the Effects Generator
Creating an Effect
Using the Effect Slider
Mixing Two Effects
Favorites
Effect Length
Bulb Size

5.3.6.1 Opening the Motion Effect Generator

The Light-O-Rama S5 Sequencer’s Motion Effect Generator can be opened in several ways:

From the Tools menu. 
o This menu item can be used when no sequences are open to test effects and optionally save the

one’s you like as favorites. You can do this at any license level. 
o When a sequence is open, this menu item can be used to place motion effects in the active 

sequence See the Sequencing topic for more information on how to use the Motion Effect
Generator when editing your sequences. Placing motion effects in a sequence requires the Pro
license level.
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Double-click on a motion effect on the sequence grid. This will select the entire motion effect and
then open the Motion Effect Generator set to this effect. If you make changes and click OK, the
changes will be saved back to the selected effect on the grid. This is the fastest way to modify
existing motion effects in your sequence.

Select an empty set of cells on a motion effect row, and then right-click and select Insert Motion
Effect from the pop-up menu. Or you can use one of these shortcut keys: shift-A (max intensity),
shift-U (ramp up), or shift-D (ramp down). The Effect Generator will open allowing you to choose a
new effect. When closed, the new effect will be applied to the selected cells.

Select a range of cells containing one or more effects on the grid, right-click in the selected area,
and choose Prompt For New Effect > Modify Existing Effects from the pop-up menu (or shortcut key
shift-M). In this case, the new effect will overwrite the existing effects in the selection. However, the
intensity (for example 100% on, ramp up, or ramp down) of the existing effects will be preserved.

With a sequence open, click the Motion Effect button  on the toolbar. The pointer will change to a

pencil  when positioned over the sequence grid. Drag the pencil over some cells on a motion
effect row. The Motion Effect Generator will open, allowing you to build a motion effect.

5.3.6.2 Creating an Effect

When creating an effect in the Sequencer’s Motion Effect Generator, the left and right sides operate
identically. However, it is recommended to always start on the left side, just to be consistent. On the
effect settings panel, you can:

Select an effect
Select colors from the current palette
Load and save the color palette
Modify effect parameters

Effect Settings Panel
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Select An Effect

The first step in creating an effect is selecting the effect from the drop down list. The list is grouped by
effect author/publisher.

The best way to get familiar with the effects is to try each one.

Select Colors From The Current Palette

Choose the colors for the selected effect by clicking the checkboxes next to the desired colors. Not all
effects use every chosen color. For example, the Color Wash effect only uses the first selected color.
The Butterfly effect doesn’t use any. If you haven’t selected any check boxes, the color defaults to
white. 

The Color Palette

The size of the palette is fixed at 6 entries, but each palette entry can be set to a color of your choosing.
Simply click on the color (not the check box), and the Select Color Transition window will open allowing
you to choose a previously saved color, a custom color, or a random color. Selecting a single color will
cause that color to be used for the entire duration of the effect. Selecting a color transition will cause the
color to change over the course of the effect, starting with the color on the left and ending with the color
on the right.
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The Select Color Transition Window

For some effects, color order is important. Color order can be changed by dragging a color to a new
location. To start dragging, click on the color you want to move (avoiding the check box). Then drop it on
top of another color square. When you do, the colors will rearrange.

Load And Save The Color Palette

The current palette (6 colors) can be saved for later reuse. This is controlled using the palette toolbar.

The palette toolbar

  Click this icon to load a palette that has previously been saved

 Click this icon to save the current palette. 

 Click this icon to open the Palette List dialog, which allows you to rename, copy, and delete the
saved palettes. 

In the Palette List dialog, each palette is listed by name. Following the name are the 6 palette entries. If
an entry is split into 2 parts, the left part is the color at the start of an effect and the right part is the color
that applies at the end of an effect.
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The Palette List dialog

Modify Effect Parameters

Example of Effect Controls

Below the palette area will be a set of buttons, sliders, and other controls that are specific to the type of
effect you have chosen in the drop down. Each time you select a different effect type, these buttons,
sliders, and other controls will change. Modifying a control will change how the effect is displayed. Feel
free to experiment with all of the options. That is part of the fun of the Motion Effect Generator – seeing
all of the different effects you can make!

5.3.6.3 Using the Effect Slider

Basic Operation

In the Sequencer’s Motion Effect Generator, the top of the effect slider is green, indicating the value that
will be used when the effect begins. The bottom of the slider is red, indicating the value that will be used
when the effect ends. By default, the red and green handles are locked together, which is indicated by

the lock icon . In this mode, the value does not change during the course of the effect, and the value
can be changed by dragging the top or bottom handle using your mouse.
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Speed fixed at 12

However, if you double-click anywhere along the effect slider, the handles will become unlocked and you
can set the start and stop values independently. In the example below, the speed will start out fast and
then get slower during the course of the effect. To re-lock the start and stop positions, just double-click
on the slider again.

Speed starts at 31 and slows to 12

Keyboard Operation

After clicking on a slider using your mouse, the slider will have "focus", meaning that the value can be
adjusted using the left and right arrows on your keyboard. A slider with focus will have a box drawn
around it, as shown below. You can move focus to the next control using the tab key. You can move
focus to the previous control using the shift-tab keyboard combination.

A slider w ith focus

Transition Modes

You can customize how the value transitions from the start value to the end value by clicking on the icon
to the right of the slider. This will open the menu of choices shown below:
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Slider transition menu

Icon Mode

Slider is locked. The start and end values are always the same.

Slider value changes with the loudness of the music. The start
value corresponds to low volumes, and the end value
corresponds to high volumes.

Slider value smoothly oscillates between the start value and the
end value (sine wave).

Slider value starts oscillating between the start and end values,
but dampens to the mid-point between the start and end values
when the effect finishes.

Slider value ramps back and forth between the start and end
values (triangle wave).

Slider value ramps from the start value to the end value (linear).

The transition starts slowly and then speeds up.

The transition starts quickly and then slows down.

The transition happens all at once (step).

The slider value ramps from start value to end value and then
returns back to the start value.

The slider value smoothly transitions from start value to end
value and back to the start value

Customizing the Transition

Opening the slider transition menu and selecting "Customize the transition" (last option) allows you to
further customize how the transition occurs during the course of the effect. For transitions that oscillate,
you can customize the oscillation frequency as shown below:
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Customizing the oscillation frequency

For most transitions, you can also customize when the transition ends. This is specified as a
percentage of the total effect length. It is especially useful for the step transition mode, as this controls
when the step occurs. In the picture below, the step transition is customized to occur at 50% of the way
through the effect.
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Customizing the end of the transition

5.3.6.4 Mixing Two Effects

In the Sequencer’s Motion Effect Generator, you can use just the left side of the window to create your
effects. But for even more creative possibilities, you can create a second effect on the right and see the
mixed result in the middle. Controls below the middle window adjust how the left and right sides are
mixed. You can select the type of mixing with the drop down, then control the strength (more left or
more right) using the slider. You can also adjust the brightness of the result using the Brightness Mode
drop down. 

Mix Types
Copy/Swap Buttons
Sparkle
Brightness Modes
Masking Effects on One Side
Masking Effects on Arbitrary Rows or Columns
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Mixer Section of the Motion Effect

Generator

Mix Types

Mix Types

Mix Average

The combined effect is a weighted average of the effect on the left side with the effect on the right side.
The weighting is determined by the slider below the Mix Type selector. Setting the slider all the way to
the left will result in the combined effect being the same as the left effect. Setting the slider all the way
to the right will result in the combined effect being the same as the right effect. Setting a transition mode
on the slider can be a used to smoothly transition between the left and right effects.
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A 50% mix of left and right, leaves both effects dimmed in the combined effect.

Mix Overlay

Areas that are completely black on one side, will be replaced by the corresponding area on the other
side. Areas that are not black on both sides will behave like Mix Average.
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In Mix Overlay mode, the transparency of the meteor tails is not taken into account.

Mix Alpha Blend

Darkened areas of effects are treated as partially transparent (or completely transparent if black). The
combined effect overlays the left effect on top of the right effect, blending the areas that are partially
transparent.
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With Mix Alpha Blend, the tails of the green meteors are properly blended with the blue background.

Note that the Picture effect also supports transparency:

GIF images can have a single color that is designated as the transparent color, and any pixels
with that color are treated as transparent. Thus pixels in a GIF image are either fully transparent or
fully opaque.
PNG images support partial transparency -- any pixel in the image can be fully transparent, fully
opaque, or somewhere in between.



The Light-O-Rama Software Package 357

© 2019 Light-O-Rama, Inc.

PNG image blended with a blue color wash. The picture on the left is white across the top and gradually

fades out to black across the bottom; transparency goes from completely transparent on the left to

completely opaque on the right. 

Mix Maximum

For each pixel in the combined effect, the pixels from both sides are used to achieve maximum
brightness. This is calculated as the maximum of the red values from each side, the maximum of the
green values from each side, and the maximum of the blue values from each side. 
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In Mix Maximum mode, the meteor tails get blended, but produce the wrong color (teal instead of green).

Mix Bottom / Top

The left effect is used on the bottom portion of the combined effect, and the right effect is used on the
top portion. The split between bottom and top is controlled by the slider below the Mix Type selector. 
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Mix Bottom / Top example

Mix Left / Right

The left effect is used on the left portion of the combined effect, and the right effect is used on the right
portion. The split between left and right is controlled by the slider below the Mix Type selector. 

Mix Left / Right example

Mix Right Hides Left
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The combined effect is the left effect, except where there are non-black pixels on the right. In other
words, the right side creates a hole in the left side.

Mix Right Hides Left example

Mix Right Reveals Left

The combined effect is the left effect, only where there are non-black pixels on the right.
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Mix Right Reveals Left example

Mix Vertical Center / Edges

The left effect is used on the center portion of the combined effect, and the right effect is used on the left
and right edges. The split between the center and edges is controlled by the slider below the Mix Type
selector. 

Mix Vertical Center / Edges example
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Mix Horizontal Center / Edges

The left effect is used on the middle portion of the combined effect, and the right effect is used on the top
and bottom edges. The split between the middle and edges is controlled by the slider below the Mix
Type selector. 

Mix Horizontal Center / Edges example

Mix Center / Edges

The left effect is used on the center portion of the combined effect, and the right effect is used on all
edges. The split between the center and edges is controlled by the slider below the Mix Type selector. 
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Mix Center / Edges example

Mix Odd / Even Columns

The left effect is used on odd-numbered columns of the combined effect, and the right effect is used on
even-numbered columns.
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Mix Odd / Even Columns example

Mix Odd / Even Rows

The left effect is used on odd-numbered rows of the combined effect, and the right effect is used on even-
numbered rows.
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Mix Odd / Even Rows example

Overlay From Top

This does an alpha blend on the top and the right effect on the bottom.  The split between bottom and
top is controlled by the slider below the Mix Type selector. 
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Overlay From Top example

Overlay From Bottom

This does an alpha blend on the bottom and the right effect on the top.  The split between bottom and
top is controlled by the slider below the Mix Type selector. 
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Overlay From Bottom example

Overlay From Left

This does an alpha blend on the left and the right effect on the right.  The split between left and right is
controlled by the slider below the Mix Type selector. 
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Overlay From Left example

Overlay From Right

This does an alpha blend on the right and the right effect on the left.  The split between left and right is
controlled by the slider below the Mix Type selector. 
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Overlay From Right example

Dissolve Bottom / Top

This is like Mix Bottom / Top, except that the transition area is blended.
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A transition from the left effect to the right effect, w ith a blended area in the middle.

Dissolve Left / Right

This is like Mix Left / Right, except that the transition area is blended.
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A transition from the left effect to the right effect, w ith a blended area in the center.

Dissolve Blocks

This divides the effect area into 9 sub-blocks (3 x 3) and transitions one block at a time.
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Here, 4 of the 9 blocks have completely transitioned, and the 5th block (center) is partially transitioned.

Copy/Swap Buttons

In some cases, you might want to copy an effect from one side to the other, or to swap them. This can
be done using the buttons to the right of the mix type selector. If the buttons are not displayed, try
making the Motion Effect dialog wider by dragging the left or right edge of the dialog.

Button Action

Copies the effect on the right side to the left side.

Swaps the effects on the left and right sides.

Copies the effect on the left side to the right side.

Sparkle

The Sparkle slider does what it says: move it to the right to add some sparkle to the combined effect.
Move it farther to the right and sparkles will be created at a faster rate.



The Light-O-Rama Software Package 373

© 2019 Light-O-Rama, Inc.

Sparkle applied to a red Color Wash effect

Brightness Modes

Brightness Modes

Full

The "Full" mode displays the effect at maximum brightness. Note that with the brightness mode set to
"Full", the effect can still be dimmed by placing the effect in the sequence grid at less than 100%
intensity.

Manual

Switching to "Manual" mode will display a slider below the Brightness Mode selector, allowing you to
manually adjust the brightness of the combined effect. Move the slider to the left to make the effect
dimmer; move it to the right to make it brighter.
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Manual brightness example

Strobe

The "Strobe" mode will cause the combined effect to flash with a short "on" time and long "off" time. A
slider below the Brightness Mode selector allows you to adjust the flash rate. Move the slider to the left
to make the flash rate slower; move it to the right to make it faster.

Strobe example

Fade In And Out

The "Fade In and Out" mode will cause the combined effect to smoothly fade in and out. A slider below
the Brightness Mode selector allows you to adjust the fade rate. Move the slider to the left to make the
fade rate slower; move it to the right to make it faster.

Fade In And Out example

Blink In Unison

The "Blink In Unison" mode will cause the combined effect to flash with equal on and off times. A slider
below the Brightness Mode selector allows you to adjust the blink rate. Move the slider to the left to
make the blink rate slower; move it to the right to make it faster. Effects with the same blink rate on
multiple props will result in those props blinking in unison (i.e. the blinking will be synchronized).

Blink In Unison example

Masking Effects on One Side
If you just want effects displayed on the left or right side of your prop, set the mixer to "Mix_Left_Right".
 If you want an effect on the left side of your prop, use the effect selection on the left side of the Effect
Generator and make sure the right side effect is set to "none".  If you just want the effect on the right
side of your prop, use the effect selection on the right side of the Effect Generator and make sure the left
side effect is set to "none".  Use the slider below the Mix selection to determine where the separation
between left and right occurs.
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The same technique can be used if you want an effect only displayed at the top or bottom.  Just set the
mixer to "Mix_Bottom_Top".

Masking Effects on Arbitrary Rows or Columns
Sometimes you just want to light up certain rows or columns on your display element (e.g. a pixel tree
or matrix).  In this topic we show you how.  Here are the steps:

1. Open Microsoft Paint (you can use other paint programs, but you will have to adapt these instructions
for your preferred paint program).

2. Type Ctrl-E to open the image properties.  Set the units to "Pixels" and the Colors to "Color".  Set the
width and height to exactly match the dimensions of your prop.  Click "OK" to save the changes.

3. Zoom in as much as possible to make it easier to see your new image.

4. Make the current color black.  Use the fill tool (the paint can icon) to turn the entire image black.

5. Make the current color white.  Use the pencil tool to draw white in the rows and/or columns where you
will want effects displayed.  The example shown below is 5 pixels wide by 10 pixels high.  Columns 2
and 4 have been painted white.  When used as a mask in the following steps, this will only allow
effects to be displayed in those two columns.
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6. Save the result as a PNG image (BMP is OK too), and then close Microsoft Paint.  Remember where
you save it.

7. Open the Motion Effect Generator.

8. On the right side, select the prop you generated the mask for.

9. Change the right effect to "Picture".  Click the "Choose" button and select the image file that was
created above.  Uncheck "Scale Image".

10.In the middle, set the mix to "Mix Rt. Reveals Lt."

11.Change the left effect to the desired effect.  Only the rows or columns you enabled (turned white) in
your image will light up in the middle (result) window.

12.You can enable the opposite columns by changing the mix to "Mix Rt. Hides Lt.".

13.You can make the mask move by changing the "Movement" setting on the picture effect.

Here is the result (the bars effect is shown, but the technique works with any effect selected on the left):

5.3.6.5 Favorites

In the Sequencer’s Motion Effect Generator, if you create an effect and want to save it for later use, you
can save it to the Favorite Effects area (bottom center). 

To save the current Effect Generator settings as a favorite, first click a folder in the favorites tree



The Light-O-Rama Software Package 377

© 2019 Light-O-Rama, Inc.

where the effect should be saved (the first time click on “Favorites”), then click Save.
To recall a favorite (i.e. load it into the Effect Generator), just double click on it.
To move an entry up or down, select an entry by left-clicking on it, then use the up and/or down
arrows to move it to the desired position.  Alternatively, you can right-click on the entry, then
select Move Up or Move Down from the popup menu.
You can move effects from one folder to another simply by dragging the effect to the new folder. 
You can even drag entire branches of the tree if you need to move them.
To delete an entry or an entire branch, right-click the node to delete, then select Delete from the
popup menu.
To add a new branch to the tree, right-click on the parent folder, then select New Subfolder from
the popup menu.  Enter the name for the new folder when prompted, then click OK.
To rename an entry (folder or favorite effect), right-click on the node, then select Rename from the
popup menu.  Enter the new name when prompted, then click OK.
To copy an effect, right-click on the node, then select Copy from the popup menu.  Enter the
name for the copy when prompted, then click OK.
To export favorites to a file, right-click on a folder, then select Export from the popup menu. 
Select the directory and file name, then click OK.  All children of the selected folder will be
exported.  This file will have an LPEFAV extension.
To import favorites from a file, right-click on a folder, then select Import from the popup menu. 
Select the file to import, then click OK.  Imported favorites will become children of the selected
folder.

5.3.6.6 Effect Length

In the Sequencer, every effect on the sequence grid has a length. Even when you open the Motion Effect
Generator with no sequence open, effects are displayed with a default length of 5 seconds. Over the
course of the effect, palette colors and parameter values can change:

You can set a color transition for a palette entry. The effect will begin with the starting color and
smoothly transition to the ending color.
For slider controls, you can set a starting and ending value or have the value change with the
loudness of the music.

Playback Modes

There are 2 playback modes in the Motion Effect Generator: continuous and fixed. The mode is switched
by clicking the button with the blue loop icon.

Continuous Playback: playback never stops. After effect playback has reached the effect length,
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the ending value of color transitions and slider controls is used.

Continuous playback

Fixed Playback: playback stops once the effect length is reached. A progress bar shows
playback status.

Fixed playback (loop button has a slash

through it)

Restart Effect Button

In both modes, a play button is available to restart the effect from the beginning.

Play button (third from the left)

Mute Button

When editing effects in musical sequences, a mute button is displayed so you can choose to hear the
music that goes with the effect, or not.

Sound enabled

Sound disabled

5.3.6.7 Bulb Size

The Sequencer’s Motion Effect Generator has a bulb size setting that is separate from the preview bulb
size. To change the bulb size for the prop currently displayed in the Motion Effect Generator, move the
slider next to the OK/Cancel buttons.

5.3.7 Playback Window

The playback window has 2 purposes:

1. Display a simulation of your lights during sequence playback
2. Display a motion effect when one is selected in the sequence grid
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Sequence Playback

The primary purpose of the playback window is to display a simulation of your lights while the sequence
is playing in the Sequencer. If you have a second display monitor, this is a good window to float and
drag to the other monitor. That way you can sequence on one monitor and view playback on the other.

Note that there are certain items that are not displayed during sequence playback. These include:
props with a shape of "hidden"
archived props
beat channels

The Playback Window displaying a simulation of the lights while the sequence is being played

You can right-click on the window and get a pop-up menu to start and stop playback. If your preview has
a background image, this menu can also be used to change the brightness of the image.
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The right-click menu

Displaying Motion Effects

If you have the Pro version and are using motion effects, the playback window has a second purpose: it
displays the currently selected motion effect. So if you use a lot of motion effects, you will want to keep
the playback window visible at all times. This allows you to click on any motion effect in the grid and
have it play in the playback window. This makes it much faster to identify motion effects on the
sequence grid.

The Playback Window displaying a motion effect
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5.3.8 Motion Effects Window

The "Motion Effects" window is normally docked on the right side of the main Light-O-Rama S5
Sequencer program window. To keep the window open, click the pin icon in the upper right corner of the
window. From the Motion Effects window you can view thumbnails of motion effects. The Motion Effects
window can only be displayed with a Pro level license.

The selected thumbnails can be the user’s Motion Effect favorites, a sub-tree of favorites, all of the basic
effects, or the basic effects from a particular publisher (e.g. Light-O-Rama). Effects are plug-ins and
there will be more publishers after S5 is released.



Light-O-Rama v5.2.4382

© 2019 Light-O-Rama, Inc.

5.3.9 Control Lights Window

The "Control Lights" window is normally docked on the right side of the main Light-O-Rama S5
Sequencer program window. To keep the window open, click the pin icon in the upper right corner of the
window. From the Control Lights window you can:

Control whether the effects in your sequence are sent to real lights
Specify whether lights will be turned off when playback stops
Turn all lights off immediately
Access Light-O-Rama Network Preferences
Specify which networks are enabled when controlling lights

Control Lights Check Box

If the Control Lights box is checked, then the Sequencer will control your lights. This setting applies to
all open sequences.

When the Control Lights box is checked, the Sequencer will send out data to:

A prop when an effect for that prop is selected in the sequencing grid

A prop when you double click on the prop’s name (or right-click on the prop name and select one
of the play options)

All props when you click one of the play buttons above the sequencing grid.

If the Control Panel is not running and the “Control Lights” box is checked, you will get this message:
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Turn Lights Off When Playback Stops

This check box specifies whether lights should be turned off whenever playback stops. This only affects
playback in the sequencer; it does not affect playback in a scheduled show.

Lights Off Now

This will turn off all lights on the networks being controlled.

Networks Being Controlled

Check the boxes next to each network that you want to control. Each Light-O-Rama network will be
listed separately. If you have DMX universes defined, they will be grouped together into a single line item.

Why Aren't My Lights Turning On?

Before trying to control your lights, make sure these steps are done first:

Connect LOR and/or DMX USB adapters to the computer where the Sequencer is running. 

Make sure your light controllers are initialized correctly with the correct unit IDs (for the LOR
protocol) and DMX universes (for the DMX protocol). 

Make sure the firmware for your controllers is up-to-date.

Define the LOR and DMX lighting networks in the Light-O-Rama Network Preferences tool. 

Motion Effects (including SuperStar effects) can only be sent to enhanced LOR networks and
DMX networks.

Connect your light controllers to the USB adapters (or to your Ethernet network in the case of
E1.31 devices).

Ensure all lights and controllers have power.
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Start the Light-O-Rama Control Panel if you haven't already done so. You should see the light bulb
icon in the Windows notification area (also called the "system tray")  in the lower right corner of
your screen. 

No shows should be currently scheduled or playing. The light bulb icon in the Windows notification
area should be red.?

The Hardware Utility should be closed while the Sequencer is running.
?

Make sure the props you have created in your S5 preview have the correct network, unit IDs, and
circuit numbers defined (they must match the hardware settings).

5.3.10 Customizing Window Layouts

In the S5 Sequencer, you can customize the position, size and behavior of windows to create window
layouts that work best for your computer setup. When you customize the layout, the Sequencer
remembers it. For example, if you change the docking location of the Playback window and then close
the Sequencer, the next time that you start, the Playback window will be docked in that same location. 

Windows That Can Float

The Playback Window, Previews Window, Control Lights Window, Motion Effects Window, and Start
Page can be docked in any position within the main program window, or they can float outside the
program window. Note that the Motion Effects Window is only displayed when you have the a PRO
license.

Clicking the "X" in the upper right corner of one of these windows will hide it. Hidden windows will
appear on the the Window menu. Selecting the name of a hidden window on the Windows menu
will unhide it.

The Window menu with all options

displayed

 If a sequence is open, you can click on this toolbar icon to hide and unhide the Playback
Window.

Any of these windows that is docked inside the main windows can be pinned so that they stay
open, or unpinned so that they automatically hide themselves after use. 
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Unpinned Window

Pinned Window

These windows can float outside of the main program window. If you have multiple display
monitors, the floating windows can be moved onto them, giving you lots of space to do your
sequencing. 

There are several ways to float a window:
To float the current window (the one whose title bar is highlighted), select Window > Float
Current Window from the main menu, or
Click on the title bar of a window and drag it away from the main window, or
Double-click on the title bar of a window

Likewise, there are several ways to dock a window that is floating:
Click on the title bar of a floating window and drag it back over the main window. As you
are dragging, landing spot icons will appear -- release the mouse button when the cursor
is over one of the landing spots to finish the docking, or
Double-click on the title bar of a floating window, or
Select Window > Reset Window Layout from the main menu, which will dock all windows

An example w ith 3 floating w indows

Sequence Windows
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Sequence windows can only be docked within the main program window; they cannot float or be hidden.
Each sequence window has a tab at the top which displays the name of the sequence. Hovering your
cursor over a tab will display a tool-tip with the full path to the sequence file.

To the right of the name is an "X", which when clicked, will close the sequence. If you close the
sequence and there are unsaved changes, you will be asked whether you want those changes
saved or discarded.
While sequence tabs cannot float outside of the main window, the tab can dragged and docked to
other sequences. This allows for sequences to be viewed side by side or one below the other.
Select Window > Reset Window Layout from the main menu to restore the sequence tabs and all
other windows to their default locations.

How to view sequences side by side

5.3.11 Upgrading Sequences

.This section is under development
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5.3.12 Background Image Brightness

If you have set a background image for your preview, you can change the image's brightness at any time
to suit your needs (for example to simulate nighttime). Changing the brightness of the background image
for a preview changes the image's brightness for all sequences that use that preview. There are several
places where the background image brightness can be changed:

from the Sequence Tab
from the Playback Window
in Preview Design

Change Background Brightness From the Sequence Tab

Click on the Preview Name on the sequence's toolbar, then select "Background Image".

Change background image brightness from the

sequence tab

Change Background Brightness From the Playback Window

Right-click anywhere on the Preview Playback window, then select "Background Image" from the
pop-up menu.
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Change background image brightness from the Playback window

Change Background Brightness In Preview Design

Open the Background tab, then use the Brightness slider to adjust the background image. You can
also assign or clear the background image from here.

Change background image brightness from Preview Design
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5.3.13 Keyboard Shortcut Summary

There are separate lists of keyboard shortcuts for:

Preview Design's Design tab
Prop Definition's Custom Grid window

All keyboard shortcuts that can be used in the main Sequencer window are listed below:

Main Menu

Key Action

Alt-F opens the File menu

Alt-S opens the Sequence menu

Alt-T opens the Tools menu

Alt-W opens the Windows menu

Alt-H opens the Help menu

Once the menu is opened, the arrow keys can be used to navigate around the menu and open sub-
menus. Once you have reached the desired menu item, use the Enter key to activate it.

Sequence Open / Close / Save

Key Action

create a new musical sequence

create a new animation sequence

open existing sequence

close the current sequence

save the current sequence

save as (current sequence takes on the new name)
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save a copy (make a backup)

help

Sequence Grid Navigation and Selection

Key Action

Use the arrow keys to move one cell in the direction of the
arrow

Move to the first cell in the current row

Move to the last cell in the current row

Move up 1 screen 

Move down 1 screen 

Expand the selection by holding down the shift key while
using any of the keys listed above

If part of an effect is selected, then "E" will expand the
selection to encompass the entire effect

"C" will expand the selection to the entire column

"R" will expand the selection to the entire row

Ctrl-A will select the entire grid.

zoom in on time scale

zoom out on time scale

Sequence Modification

Key Action
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Set the selected cells to the current toolbar effect at MAX
toolbar intensity

set selected cells to toolbar effect at MIN toolbar intensity

set selected cells to FADE UP using toolbar intensity range

set selected cells to FADE DOWN using toolbar intensity
range

apply current settings to selected effects

SHIFT plus any of the keys above, will prompt for a new
effect then fill the selection

fill selected cells

toggle selected cells

create chase in selected cells

clear selected cells

open the color fade selector

Use the currently selected tool (from the toolbar) on the grid
selection

set selected cells to ON effect at max toolbar intensity

set selected cells to TWINKLE effect at max toolbar
intensity

set selected cells to SHIMMER effect at max toolbar
intensity

  or
activate the Select Tool

insert a SuperStar effect into the selected area (requires a
Pro license)

the repeat function

cut

copy

paste

paste special
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undo last operation

redo

Sequence Playback

Key Action

Start and stop playback

Clear the freeform play range, then start playback

During sequence playback, pressing the keyboard's down arrow
will mark the current time as the start of a freeform play range. 
Later pressing the up arrow will mark the current time as the end
of the freeform play range.

During playback, "T" inserts a timing mark

If you have media keys on your keyboard (like the ones shown above), then you can:

Use the play/pause button (shown in blue) to start and pause playback. If there is a
freeform play range, then this button will play that range; otherwise, it will play the
visible portion of the sequence.
Use the stop button (shown in red) to stop playback.
Use the mute and volume keys to adjust the volume.

5.4 SuperStar Sequencer

The Light-O-Rama SuperStar Sequencer can be used as a sort of front end to the Light-O-
Rama Sequencer, to create sequences for Cosmic Color Ribbons or other lights visually
instead of using a channels-versus-time grid.  For more information, please see the following
pages:

Welcome
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Overview
Instant Sequences
Custom Sequences
Summary of Commands and Keyboard Accelerators
Purchased Sequences

5.4.1 Welcome

Launching SuperStar in S5

To launch SuperStar from the S5 Sequencer you must have the Pro license. Once you have the Pro
license you can create motion effect rows.  If you do not plan on purchasing the Pro license then it is
recommended that you use S4.  The version of SuperStar that is in S4 has all the same features as the
version that is in S5.

Once you have the Pro license then the way to use SuperStar in S5 is to do the following:
 

1. Select some of all of a motion effect row (To select all of a row do right click on the row and select
“Select” and then select “Row”).

2. Right click on the region you just selected and select Insert SuperStar Effect
3. Wait a few seconds and SuperStar will launch.
4. Do your sequencing. There are several ways to do your sequencing as listed below:

Load in a Purchased Sequence
Click on the “File” menu and select “Open” and open a .sup file that you have purchased. The
effects will be loaded into the SuperStar screen and you can play them to the screen. Note that
you should be using a preview that matches the layout that the sequence was designed for.

Instant Sequences
Create sequences in seconds using the “Instant Sequence” feature by simply doing the
following:

Press Ctrl+I to launch the Instant Sequence dialog box, use the 3 buttons in the lower left
of the dialog box
Click on the “Open Audio File” button to open your audio file
Click on the “Sequence All” button
Click on the “Play/Stop All” button

Custom Sequences
Create Super Sequences like the ones at www.superstarlights.com
These sequences were created using scenes, morphs, images, and text actions. Learn more
about how to do this in the Custom Sequences topic.

Auto Sequence
In the Scene, Morph, Smooth Effects, Image, and Text dialog boxes you can click on the button
that has a car on it and add an Auto Sequence Effect.  SuperStar will automatically move the
effect with the music. It takes a little longer to learn to do Auto Sequence than Instant Sequence
but it is more versatile and allows individual creativity in applying your effects. For complete
instructions visit the Auto Sequence topic.

5. After doing your sequencing in any of the ways listed in step 4, simply shut down SuperStar by
clicking on the Red X in the upper right of the program.  You will be returned to the S5 Sequencer

http://www.superstarlights.com
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and the the sequencing that you did will automatically get saved into the S5 Sequencer.  Click on
the “Play” button in the S5 Sequencer and the sequencing will be played to the S5 computer
screen.

6. If you wish to edit your sequencing, double click on the sequencing in the S5 Sequencer motion
effect row, SuperStar will launch and the effects that you saved will be in SuperStar and you can
edit the effects and then shut down superstar and those changes will automatically be saved.

5.4.2 Overview

This page gives an overview of the Light-O-Rama SuperStar Sequencer:

Launching SuperStar in S5
Exporting a sequence
Exporting in the legacy format
Exporting in the new intensity data format
Playing a sequence exported as intensity data
Floating windows

Launching SuperStar in S5

To launch SuperStar from the S5 Sequencer you must have the Pro license. Once you have the Pro
license you can create motion effect rows.  Then you do the following:
 

1. Select some of all of a motion effect row (to select an entire row, right click on the row, open
the “Select” sub-menu, and then select “Row”).

2. Right click on the region you just selected and select “Insert SuperStar Effect”
3. Wait a few seconds and SuperStar will launch.
4. Do your sequencing
5. Shut down SuperStar by clicking on the Red X in the upper right of the program.  You will be

returned to the S5 Sequencer and the the sequencing that you did will automatically get
saved into the S5 Sequencer.  Click on the “Play” button in the S5 Sequencer and the
sequencing will be played to the S5 computer screen.

Note:
If you have the Demo version of SuperStar the sequence is still saved, but you will not be able to
play the SuperStar Sequencing to the S5 Preview nor will you be able to play the SuperStar
sequencing to your actual lights.  But everything else in SuperStar will be fully functional.

Exporting a Sequence

In S5, “Export to Sequence Editor” is allowed but not recommended.   The only reason you
would use it would be to export the sequence so it can be played in the S4 Sequence
Editor.

To export a sequence so you can play it in the S4 Sequencer, click on the File menu and select



The Light-O-Rama Software Package 395

© 2019 Light-O-Rama, Inc.

"Export to Sequence Editor".  The "Export to Sequence Editor" dialog box will appear.

"Export in Legacy Format": Legacy format is the format that was always used prior to the S4
release.  Use this option to export in the same way that was always used prior to the release of
S4.
“Include Macro Channels for Cosmic Color Devices”. Light-O-Rama Cosmic Color Devices have
seven macro channels. Superstar does not use the macro channels, but the default is to include
them in the export. If you use copy/paste into a main sequence, the main sequence will have the
macro channels and it is important for the source and destination of the copy/paste to match. If
you are using RGB pixel devices not made by Light-O-Rama they will not have macro channels. If
you are using copy/paste to get the exported sequence into the RGB pixels you will not want the
macro channels in the export.
"Export in New Format (as Intensity Data)": This option will export in the new format as intensity
data.  All of the exported data will appear as one line at the bottom of the sequence in the
Sequencer.  The new intensity data format is designed to better support large numbers of
channels and pixels. The intensity data format is also very handy because it automatically gets
merged in with your main sequence and will play alongside your main sequence.  Please note
that you must have a Pro level license in order to use intensity data.
"Add Intensity Data to Existing Sequence": Choose this option if you already have a main 
sequence and you want to add the exported data to the existing main sequence.
"Add Intensity Data to New Sequence": Choose this option if you want to add the intensity data to
a new sequence.  SuperStar will create a new Sequencer sequence with a main body that is
empty and will add the intensity data to it.  You can then play the sequence.  This is a way to
play the exported sequence as a "stand alone"sequence.

Exporting in the Legacy Format

If the name of your SuperStar sequence was “MyAwesomeSequence.sup” then the default name for
the exported sequence will be “MyAwesomeSequence_sup.lms.” You can change the name if you
wish.

When use the legacy format you can play it as a stand-alone sequence in the S4 Sequence Editor.

Exporting in the New Intensity Data Format

Intensity data gets placed on a line at the bottom of an S4 Sequence Editor sequence. The intensity
data is played alongside the rest of the sequence so it automatically gets merged with the rest of
the sequence. Note that the intensity data should not send commands to any of the same channels
that are in the main sequence. 

Playing a Sequence Exported as Intensity Data

Launch the Light-O-Rama S4 Sequence Editor
Click on the “Existing Sequence” tab
Select the file you exported
Click on the “Ok” button
Click on the “Play” button in the Light-O-Rama Sequence Editor
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Floating Windows

When using a large number of CCRs, the sequencing grid and/or the visualization in SuperStar can
become small.  You can put the sequencing grid and the visualization each in their own window. 
That way you can place them where you want, and size them how you want.  And if you have two
monitors, you can put one of them in each monitor.

To activate floating windows, click on the "View" menu and select "Floating Windows".

5.4.3 Instant Sequences

Using the Light-O-Rama SuperStar Sequencer, you can now create a sequence in seconds using the
"Instant Sequence" feature.  This is a first for the home light show industry.

Creating an instant sequence
Timing map description
Apply different sets of theme, color, and movement to different parts of the song

Creating an Instant Sequence

Click on the Tools menu and select "Instant Sequence..." (or you can press Ctrl+I), which will open
the Instant Sequence dialog.  In the lower left of the Instant Sequence dialog, click on the "Open
Audio File" button.  Then click on the "Sequence All" button.  The effects for a sequence will appear
in the time layers.  Click on the "Play/Stop All" button.

Was that totally awesome or what! The timing marks were created by analyzing the audio file.  The
sequence was created using the timing marks and the theme, color and movement variations that
you see in the dialog box.  Now let's create another sequence:

Click on the "Roll Dice" button to get a random set of theme, color, and movement variations.  Click
on the "Sequence All" button; it will ask you if you want to erase the current sequence without
saving (answer "Yes").  Click on the "Play/Stop All" button.

"Roll Dice" is the easiest way to try different TCM ("theme, color, movement") settings, but you can
set them manually also:

Theme: The theme contains one or more effects.  These effects are placed at each trigger.  For
example, "3 Segs" is made of three scenes that will place segments onto the ribbon, with
segments having gaps between them.  "1 Morph Full Length" has one morph in it which is always
assigned to span the entire length of the ribbon.  "Morphs colliding" is two morphs, each morph
being half the length of the ribbon, with the two morphs coming towards each other and stopping
when they meet each other.  The best way to see what each morph is is to try it out and play it
back.

Color: This setting controls the colors assigned to the theme:

Native: The theme uses the colors that the effect was created in.  Most themes were created
using red.  If the theme has more than one effect, then it may have other colors.  For
example, the three segments in "3 Segs" were created using red, green, and blue, and so
using Native for "3 Segs" will result in all of the effects being red, greeen, and blue.
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RGBW by group: This setting will take each group of effects in the theme and assign red,
then green, then blue, then white to them.  For example, if using the "3 Segs" theme, all three
scenes in the theme will be red the first time the theme is triggered, green the second time,
blue the third time, and white the fourth time.  The fifth time, it will cycle back to red.

RGBW by effect: This setting will take each effect in the theme and assign red, then green,
then blue, then white to them.  For example, if using the "3 Segs" theme, the first time the
theme is triggered, the first scene will be red, the second green, and the third blue.  The
second time the theme is triggered, the first scene will be white, the second red, and the third
green.  The end result is that RGBW by effect results in more colors than RGBW by group. 
Note that if the theme has only one effect in it, there will be no difference between RGBW by
group and RGBW by effect.

Color wheel by group: This works similarly to RGBW by group, except it cycles through 21
different shades of colors in the color wheel when assigning a color to the group of effects in a
theme.

Color wheel by effect: This works similar to RGBW by effect  except it cycles through 21
different shades of colors in the color wheel when assigning a color to individual effects in a
theme.

Custom Colors by group: This works similar to RGBW by group except it cycles through the
custom colors chosen for this TCM. For example, to choose the custom colors for TCM 1
click on the “Set Custom Colors 1” button.

Custom Colors by effect: This works similar to RGBW by effect except it cycles through the
custom colors chosen for this TCM. For example, to choose the custom colors for TCM 1
click on the “Set Custom Colors 1” button.

Red, Orange, Yellow, White, Green, Blue, Purple: Select any of these colors to make all
effects in the theme be that color

Color by time: This setting can only be used when color is set to RGBW by group, RGBW by
effect, Color wheel by group, or Color wheel by effect.  With this setting, you choose a length of
time for all of the effects in the theme to change color.  For example, if you select "every 4
seconds", then instead of changing color at each trigger, the theme will change every four
seconds.

Movement: This setting controls the start and end point of the effects in the theme.The first drop-
down list is the movement type. The second drop-down list is the movement speed:

None: The theme will start and end at the same location every time it is triggered.  Note that
"None" does not mean that the theme will have no movement; it just means that the start and
end of its movement does not change.

Right same row: Move the start and end points of a theme to the right every time it is
triggered. When a start or end point reaches the end of the ribbon it wraps around to the
beginning. The themes that contain effects that span the entire length of the ribbon are special
cases. For those effects assigning any movement other than “None” will make them alternate
directions. “1 morph full length” is an example of a theme that always spans the entire length
of the ribbon.

Left same row: Same as “Right same row” except the start and end points of the theme move
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to the left.

Up same column: Same as “Right same row” except the start and end points of the theme
move up.

Down same column: Same as “Right same row” except the start and end points of the
theme move down.

Pass by: The start: point is moved at a faster pace than the end point so that it “passes by”
the end point. 

Random same row: The start and end points are random on the same row

Right multi-row: The start and end points move to the right. When the end of a row is
reached, the point moves down to the next row. When the end of the bottom row is reached it
wraps back up to the top row.

Left multi-row: The start and end points move to the left. When the left end of the row is
reached the point moves up to the next row. When the end of the top row is reach it wraps
down to the bottom row.

Up multi-column: The start and end points move up. When the top column is reached it
wraps to the next column to the right. When the top of the last column is reached it wraps to
the first column on the left.

Dn multi-column: The start and end points move down. When the bottom column is reached
it wraps to the next column to the left. When the bottom of the beginning column is reached it
wraps to the last column on the right.

Snake up: The start and end points move to the right and then when the end of the row is
reached it moves to the next row up, and then moves to the left until it reaches the beginning
of that row and then moves up and starts moving to the right and so on.

Snake dn: The start and end points move to the right and then when the end of the row is
reached it moves to the next row down, and then moves to the left until it reaches the
beginning of that row and then moves down and starts moving to the right and so on.

Random Rows: The start and end points move to random rows. In other words, the start and
end points will always be on the same row, but the row they are on will be random.

Random Points: The start point is at a random location, and the end point is at a random
location.

VU Meter: Makes the triggers behave like a VU Meter at the top of the ribbons. A VU Meter is
a meter like what you might see on a stereo that has an equalizer. When using VU Meter as
the movement, you should use “1 Pixel” as the Theme.

Movement Speed: This is the number of pixels moved at every trigger.  For example, a value of
1.0 will move 1 pixel every trigger.  A value of 0.2 will move 0.2 pixels every trigger, but since
fractional pixel movement cannot be seen on the screen, it will move 1 pixel for every 5 triggers.

Intensity: This setting controls the intensity of the color assigned to the theme.
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Trigger: This is the trigger type.

Normal: This is the only trigger type that Instant Sequence originally had. It produces one
trigger every time the strength of the sound at the Frequencies chosen go above and below a
certain threshold.

Rapid Fire: Think of this trigger type as the “scoot along” trigger. This is a new trigger type
that is designed to work better for visualization sequences, especially those with low numbers
of channels. Rapid Fire produces a trigger for each of the Frequencies chosen. If there are
many frequencies chosen for a ribbon in the timing map, then many triggers can get
produced. The result is that the effects “scoot along” with the music. You should use “1 Pixel”
as the Theme when using Rapid Fire. You can use other Themes but realize that since it
produces so many triggers, you can end up with thousands of effects. It is recommended to
use Rapid Fire on only one or two of the ribbons.

To get "Rapid Fire" to respond to all frequencies in the song, click on the Timing Map button
and set "All Freqs" for the row that corresponds to the row assignment of the TCM that is
using "Rapid Fire".  For example:

Set "Rapid Fire" for TCM 1.
In "Row Assignments to TCM (Theme/Color/Movement)", set TCM 1 to Row 1.  Set all
other rows to "None".
Click on the "Timing Map" button.
In the Timing Map dialog box, set "All Freqs" under Row 1.
In the Instant Sequence dialog box, click on the "Sequence All" button, then the "Play/
Stop All" button.

Ribbon assignments to TCM: Across the top are the ribbon numbers.  On the left is TCM1, TCM2,
TCM3, TCM4, and None.  By clicking on the grid of circles, you can assign a TCM to each ribbon. 
For example, if you have four ribbons, you could assign TCM1 to Ribbons 1 and Ribbons 2 by
clicking on the two upper left circles.  Then you could assign TCM2 to Ribbon 3 and Ribbon 4 by
clicking on the circles in the second row that are underneath the numbers 3 and 4.  You can choose
"Non" to make no effects be assigned to a ribbon.

To increase or reduce the number of effects being created, you can change the sensitivity.  Do this
by clicking on the "Timing Map" button and changing the Sensitivity setting in the upper left of the
Timing Map dialog box.  Click on the "Sequence All" button in the "Instant Sequence" dialog box to
create a new sequence using the new sensitivity setting.

The sensitivity setting may be the only setting that you ever change in the Timing Map dialog box,
but if you are adventuresome and want to experiment with the other Timing Map settings, read the
next section.

Timing Map Description

Click on the "Timing Map" button in the Instant Sequence dialog box.  A large dialog box entitled
"Timing Map" will appear.  This dialog box gives you control over the mapping of the frequency
spectrum to the ribbons, which is how the timing marks get created:

Freq 1 through Freq 32
Beat, Both, Left, Right
Sensitivity
Length of Effects
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Extend Length of Effects
Apply Sensitivity as
Default Freq Settings
Change the Timing Map

Freq 1 through Freq 32

Note that there are check marks showing that Freq 1 and Freq 2 are mapped to Ribbon 1.  Freq 3
and Freq 4 are mapped to Ribbon 2, and so on.  On the right side of the dialog box is a piano
keyboard which shows which notes the Freqs map to.  The default is to have the low frequencies
assigned to ribbon 1 and asign higher frequencies to each ribbon thereafter, with the highest
frequency assigned to the highest number ribbon that you have.  

One reason you might want to change these settings is if your high number ribbons are not getting
many effects assigned to them.  This would happen if the song does not have many high notes in it.
 So, to get more action on the high number ribbons, you can assign more frequences to them.

Beat, Both, Left, Right

The default setting is "Both", meaning both the left and right channels of the stereo sound will be
used when creating effects.  You can also set "Left" or "right" to use the left or right channel of the
stereo sound.  Click on "Beat" to use the beat when creating effects.

Sensitivity

Sensitivity can be set to values from 1 to 10.  The default is 5.  Setting to a higher number will create
more effects.  Setting to a lower number will create fewer effects.

Length of Effects

Length of Effects can be set to values from 1 to 10.  The default is 5.  Setting to a higher number will
make some of the effects last longer.  Setting to a lower number will make some of the effects
shorter.  You can also think of this as the "Ritalin" setting, in that a higher number will sedate
hyperactive sequences and make them more mellow.

Extend Length of Effects

This option extends the length of each effect.  The length of each effect will extend up to the start of
the next effect.  This makes the instant sequence less "blinky".

Apply Sensitivity as

Volume Relative: This is the default.  With this setting, the sensitivity is applied by looking at
the overall volume of the song.  In essence, it raises and lowers the sensitivity to more nearly
match the volume of the song at each point in the song.  This helps even out the number of effects
that are triggered even in the quieter parts of the song.  Note, however, that the quieter parts of the
song will still have fewer effects triggered than the louder parts of the song.

Freq Relative: With this setting, the sensitivity is applied by looking at the volume for an
individual frequency and adjusting the sensitivity for each frequency to more nearly match the
volume of the song for that frequency at that point in the song.  This helps even out the number of
effects that are triggered for all frequencies.  For example, if the song has a strong bass part in it
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and has some distinctive higher notes that are not as strong, this setting will help trigger those
higher frequencies even though their volume is weaker.  Note that it helps even out the number of
effects in all frequencies, but the weaker frequencies will still have fewer effects triggered than the
louder frequencies.

Absolute: With this setting, the sensitivity is applied "as is".  In other words, the louder parts of
the song and the louder frequencies will get triggered more than the weaker parts of the song, and
no attempt is made by the software to level out the number of effects that are triggered.

Default Freq Settings

There are seven default freq settings that you can use.  For example, click on "Stereo Low to High"
and then click on "Set Freq Spectrum", and you will see the check marks and radio buttons change
in the timing map so that the left and right channels of the stereo sound are used.

You can choose to "Include Beat" in the generation of effects.

By default, "Set Theme, Color, and Movement" is selected, meaning that when you click on the "Set
Freq Spectrum" it will also set some default values for the Theme, Color, and Movement.  If you want
to keep the Theme, Color, and Movement settings that you have, then you would uncheck "Set
Theme, Color, and Movement".

Change the Timing Map

In the "Default Freq Settings" area, click on "Stereo Low to High", and then click on "Set Freq
Spectrum".  Go back to the "Instant Sequence" dialog box and click on "Sequence All".  It will ask
you if you want to overwrite your existing timings; answer "Yes".  It will ask you if you want to erase
the existing sequence without saving; answer "Yes".  Click on "Play/Stop All".

Notice that the ribbons on the left half have effects applied based on the left stereo channel, and the
ribbons on the right half have effects applied based on the right stereo channel.

Apply Different Sets of Theme, Color and Movement to Different Parts
of the Song

By default, you sequence the entire song each time you click on "Sequence All".  To add more
variation to your sequence, you can just do a portion of the song.  To do this:

Launch the "Instant Sequence" dialog box by pressing Ctrl+I.
Near the top of the dialog box, click on the "Sequence the Selection Only" radio button.
Use the Rewind or Forward buttons on the toolbar to scroll to the beginning of the region you
want to sequence.
Use a single left mouse click to mark the beginning of the region.
Use the Forward or Fast Forward buttons on the toolbar to scroll to the end of the region you
want to sequence.
Use a single right mouse click to mark the end of the region.
Before clearing the region, it is a good practice to click on "Unique Save As".  This button is a
quick way to save the current state of the sequence to a unique file name so that you can go
back to it if you need to.
If the region is not already cleared, click on "Clear Selection without Saving".
Click on "Roll Dice", or set the theme, color, and move variations manually.
Click on "Sequence Selection".
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Note that "Clear Selection without Saving" uses the beginning of an effect to decide if it should be
deleted.  In other words, all effects whose start time falls within the selection region will be deleted.

5.4.4 Custom Sequences

What you won't see in the Light-O-Rama SuperStar Sequencer is the giant grid that the traditional
Sequencer uses; instead, effects are added by:

1. Setting time ranges in the time scale.
2. Selecting squares in the Green Pixel grid (also referred to as the sequencing grid).
3. Using the Scenes, Morphs, Images, and Text dialog boxes in the Tools menu.

For more information, please refer to the following sections of this help file:

Creating a Scene
Creating a Morph
Creating an Image Action
Import Image
Creating an Animation
Creating Text
Smooth Effects
Groups of Effects
Select One or More Rows
Transfer Effects from One Sequence to Another
Load/Save Clipboard
Change to 10 Pixels per Ribbon
"Star Rays", "Wide Grid", and "Thin Grid"
The Layout Dialog Box
The Preferences Dialog Box
Configure Controller Unit IDs Using the Light-O-Rama Hardware Utility
Configure Controller Unit IDs in the SuperStar Sequencer
Select All, Select All Left, and Select All Right
Importing a Timing Grid and up to 3 Timing Channels

5.4.4.1 Creating a Scene

In the Light-O-Rama SuperStar Sequencer, a "scene" is a set of pixels that have the same start color,
the same end color, a start time, and an end time.

Initialize the Screen
Launch the Scene Dialog Box
Select Some Pixels in the Pixel Grid
Add the Scene
Play the Scene
Create a Scene that Has an End Color
Play the Scenes
Change Some Settings
Modify a Scene
Play the Scenes Again
Why Did the First Scene Go from Red to Purple to Blue?
Undo and Redo Your Modification
Group Select
Group Modify
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Using Group Modify to Clone
Pause and Freeze Frame
Add Some More Scenes of Your Choosing
Save the Scenes You Have Created

Initialize the Screen

Click on the toolbar button with a piece of paper on it.  This will do three things: It will clear the pixel
grid, set the Start color as red, and set the time duration to 1.00-2.00 seconds.

Launch the Scene Dialog Box

Click on the Tools menu and select "Scenes".  The Scene dialog box will launch.  Whenever the
scene dialog box is launched, the "Monochrome" mode is automatically selected and the toolbar
button with a black and red rectangle will depress.

Select Some Pixels in the Pixel grid

While in "Monochrome" mode, you can color pixels in the pixel grid using the left mouse button. 
You can use single click or click and drag.  You can erase pixels in the pixel grid using the right
mouse button.  Ctrl + right mouse button will erase the entire grid.  Since the Start color is already
set to red, the pixels will become red as you select them.

Add the Scene

In the Scene dialog box, click on the "Add" button to add the scene.

Play the Scene

Click on the play button in the toolbar (the button with a triangle pointing to the right).  Note that at
1.00 seconds, the group of pixels you selected will turn red.

Create a Scene that Has an End Color

The default is for the "Start"and "End" color to both be red.  Let's change that and create another
scene:

Set the start and end time to 2.00 to 3.00 seconds.  You can select the time with the mouse
by selecting a region in the time scale, or you can type into the fields in the dialog box.
Color some pixels.
The left red control is already at 100%; the selected pixels will turn red.
Set the right red control to 0%; this represents the "End" color.  When you set the "End"
color it does not appear in the pixel grid, but it does appear as a number in the Scene dialog.
Click on the "Add" button to add this scene.

Play the Scenes

Click on the Play button in the toolbar.  At 1.00 seconds the first group of pixels will turn red and
stay red.  At 2.00 seconds, the second group of pixels will turn red and fade to black.
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Change Some Settings

In the Scene dialog box, there is a list box listing the scenes you have added.  They are listed
chronologically by their start times.  Select the first scene in the list.  Note that the time, colors, and
pixels for that scene appear in the main screen.  The "End" color for this scene is black.  Set 100%
Blue for the end color.  You can do this with the right Blue color control, or by manually typing 100
into the field in the Scene dialog box.

Note: Right click on the colored box above the color controls to bring up a "Color Picker" dialog.

Modify a Scene

Click on the "Modify" button.  This will apply the new settings to the currently selected scene.

Play the Scenes Again

Click on the Play button.  at 1.00 seconds, the pixels in the first scene will turn red, fade to purple,
and then fade to blue by 2.00 seconds.  At 2.00 - 3.00 seconds, the second scene will play, same
as it did before.

Why Did the First Scene Go from Red to Purple to Blue?

You probably already figured this out: What you really did was set a red ramp that started at 100
and ended at 0.  You also set a blue ramp that started at 0 and ended at 100.  So in the middle, red
was at 50 and blue was at 50, and the red and blue mix to make purple.

Undo and Redo Your Modification

Click on the Edit menu and select "Undo Scene Modify".  Then click on the Edit menu and select
"Redo Scene Modify".

If you do an Add, Modify, or Delete, and change your mind, you can undo your change.  You can
undo up to ten actions.  After undoing up to ten actions, you can also redo them.

Group Select

There are two ways to use the mouse to select both of the scenes:

1. Click and hold the left mouse button and drag the selection rectangle to contain both of the
scenes in the time layer area.

2. Click on the first scene to select it, then press and hold the Ctrl key while clicking on the second
scene.

Group Modify

Set the start color to yellow, by setting 100% red and 100% green (red and green mix to make
yellow).  Click on "Group Modify" in the Scene dialog box.  A popup box will appear, entitled "Scene
Group Modify".  

Because you changed the start color, "Modify Start Color" will already be selected.  Click on "OK". 
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Note that the start color of both the scenes has changed to yellow.

Using Group Modify to Clone

Click on "Group Modify" again; because you have not changed anything, none of the boxes are
selected.  However, you can select any or all of the checkboxes to clone the attributes of the first
scene onto all the selected scenes.  For example, select "Modify End Color", then click "OK".  The
End color will be cloned onto the second scene.

Group Modify is a very powerful tool that can save a lot of time as you fine tune a sequence.  It
allows you to change an attribute across an entire group of effects just to see how it looks.  As with
other features, you can undo and redo a group modify.

Pause and Freeze Frame

To the left of the stop button on the toolbars is the pause button.  When you press the pause button,
a white line appears at the time selection point.  While paused, the rewind and forward keys will
step through the sequence in "freeze frame" manner.  You can also click anywhere on the timeline
to reposition the location of the freeze frame.  This is very useful while developing sequences, to
better see what each frame of the sequence will look like.

Unpause by clicking on the pause button again, or by clicking on the stop button.

Add Some More Scenes of Your Choosing

Go ahead and add some more scenes and play with the different settings.  The times of the scenes
can overlap.  however, scenes that share the same time period should not share the same pixels. 
This creates a "pixel collision", and currently the results are not predictable (in the future, the
SuperStar Sequencer will detect and prevent collisions).

Save the Scenes You Have Created

Click on the File menu and select "Save As".  Save the scenes you have created as a file named
"MyScenes.sup".

5.4.4.2 Creating a Morph

In the Light-O-Rama SuperStar Sequencer, a "Morph" consists of the following:

Layer: Defines priority if there are collisions (future)
Acceleration: The morph can accelerate as it goes from "State 1" to "State 2"

State 1 and State 2 each consist of:

1. Start point and end point of a line
2. Head color
3. Time
4. Head length

Tail consists of:

1. Color, which can be determined in one of two ways:
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(a) Start Color and End Color
(b) Use the Head Color

2. Time length

Here is an example of how to create a morph:

Get a new screen
Launch the Morph dialog box
Observe the default settings
Add first morph
Play the morph
Set a simple morph with a different start and end color
Modify the morph
Play the morph
Add a trail length
Modify the current morph
Play the morph again
Change the State 1 line to a vertical line
Change the State 2 line to a vertical line
Set color of the State 2 line to 100% green
Set the time to 2.00 to 3.00
Add a second morph
Play the morph
The morph twist
Save your morph
Morph summary
The length of a morph

Get a new screen

Click on the toolbar button that has a picture of a piece of paper on it.

Launch the Morph dialog box

Click on the Tools menu and select Morph.  The Morph dialog box will launch, and the Scene dialog
box will automatically be shut down.  Whenever the Morph dialog box is launched, the "Morph"
mode is automatically selected, and the black toolbar button with horizontal lines on it will be
depressed.

Observe the default settings

By default, a red line for State 1 will be at the top of the pixel grid, and a red line for State 2 will be at
the bottom of the pixel grid.  The time duration will be 1.00 to 2.00 seconds.  The Tail start color will
be red, and the time length will be 1.00 seconds.

Add first morph

Press the "Add" button to add the morph.

Play the morph
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On the toolbar, press the Play button.  At 1.00 seconds, a red line will start from the top and go
down to the bottom, leaving a trail that fades to black in one second.

Set a simple morph with a different start and end color

Leave the start color at red.  Set the end color to blue.  Set the Tail Time length to 0.00.

Modify the morph

Press the "Modify" button to modify the selected morph.

Play the morph

On the toolbar, press the Play button.  At 1.00 seconds, a red line will start from the top and go
down to the bottom.  The line will change from red to purple and then to blue by the time it reaches
the bottom at 2.00 seconds.

Add a trail length

The trail length defaults to 1.  Make the morph leave a trail by typing in a number in the Trail Length
field.  For this exercise, change the State 1 Trail Length to 2, and change the State 2 Trail Length to
10.

Modify the current morph

Click on the "Modify" button.  This applies your changes to the currently selected morph in the
morph list.

Play the morph again

This time, the morph will leave a trail of two lines at the top, and will change to leaving a trail of 10
lines at the bottom.

Change the State 1 line to a vertical line

The State 1 line is defined using a click and drag with the left mouse button.  Note that one end of
the State 1 line is labeled "1a"and the other end is labeled "1b".  The start of the mouse drag will be
"1a" and the end will be "1b".  Make a vertical line by dragging on the left side of the pixel grid. 
Make your selection from top to bottom.  When you are done, the top of the line should be labeled
"1a", and the bottom of the line should be labeled "1b".

Change the State 2 line to a vertical line

The State 2 line is defined using a click and drag with the right mouse button.  Note that one end of
the State 2 line is labeled "2a" and the other end is labeled "2b".  The start of the mouse drag will be
"2a" and the end of the drag will be "2b".  Make a vertical line by dragging on the right side of the
pixel grid.  Make your selection from top to bottom.  When you are done, the top of the line should
be labeled "2a" and the bottom of the line should be labeled "2b".

Set color of the State 2 line to 100% green
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The color of the State 2 line is controlled by the right color controls.  Set the right Blue control to 0%
and the right Green control to 100%.  This will change the State 2 line color from blue to green.

Set the time to 2.00 to 3.00

You can do this with the mouse on the time scale, or you can type the values into the dialog box. 
State 1 time is the start time, and State 2 time is the end time.

Add a second morph

Press the "Add" button to add the second morph.

Play the morph

On the toolbar, press the Play button.  At 1.00 seconds, the first morph will play as it did before.  At
2.00 seconds, the second morph will start from the left and end at the right.

The morph twist

Set the Tail Time Length back to 1.00 seconds.  The Tail start color should be 100% red.  Redefine
the State 1 line by doing a mouse drag from bottom to top.  Now "1a" will be on the bottom, and
"1b" will be on the top.  Click on the "Modify" button.  Play the morph.

This time, the line will twist as it travels across.  The effect will be that the line will become shorter in
the middle and then get bigger.  This is because as the morph progresses, point "1a" moves to point
 "2a", and point "1b" moves to point "2b".

Save your morph

Click on the File menu and select "Save As".  Save the morphs you have created as a file named
"MyMorphs.sup".  Note that files can contain any combination of scenes and morphs.  In this
example, you saved them separately, but you could have saved your scenes and morphs together
into a file of any name you choose.

Morph summary

Are morphs cool or what? You can do a lot with morphs.  In the exercise, we morphed between two
horizontal lines and between two vertical lines.  You can also morph between diagonal lines.

Head Length and Tail Time Length can end up giving similar effects, but are applied differently.  Head
Length leaves a head that is a certain number of pixels long. Tail Time Length is applied after the
Head effect, and is on for a certain amount of time.  Experiment with different Head and Tail Time
Length settings to get a feel for how they work.

Also, realize that when you specify a Tail Time Length to use the Head Color, it means to use the
colors specified for the head.  If the State 1 and State 2 head colors are different, then the Tail will
use the appropriate intermediate color for the tail for the length of the tail.  When you specify "Use
Head Color", the intermediate color is determined by the location of the Tail along the morph,
whereas when you specify a start and end color for the Tail in the Tail section, the intermediate color
is determined by the time since the morph started.
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Show Entire Head at Start

This setting allows you to start with the entire head being visible from the start.  For example, if the
morph travels 50 pixels, you can set State 1 Head Length to 50 and set State 2 Head Length to 0,
and the morph will be 50 pixels long right from the start, and will get shorter and disappear at the
end.

Acceleration

An acceleration of 0 means no acceleration.  A positive number means accelerate from a slower
speed to a faster speed.  A negative number means decelerate from a faster speed to a slower
speed.  Try making a morph that travels downward and give it an Acceleration of 5.  The morph will
look like gravity is accelerating it downward.  Try making a morph that travels upward and give it an
Acceleration of -5.  The morph will look like gravity is slowing the morph down as it travels upwards.

The length of a morph

Most people won't care about the details of the total length of a morph.  But for those that really
want to know, there are three parts to a morph:

1. Root: This is the time for the leading edge of the morph to travel from State 1 to State 2.
2. Head Length: The State 2 Head Length will add the length of the head at the end of the morph. 

This head will take some time to travel past the end location of the morph.
3. Tail Length: The tail length is in seconds, and is applied after the Root and Head.

The length of the Head and the Tail are displayed on the timeline as a narrow rectangle.  Note that
only the root can be selected.  Clicking on the head or the tail will not do anything.

5.4.4.3 Creating an Image Action

In the Light-O-Rama SuperStar Sequencer, an "image action" will move an image from a start point to an
end point.  At the end, a ramp can be applied.  An image action consists of:

Layer: Defines priority if there are collisions (future)
Acceleration: The image can accelerate or decelerate as it goes from point A to point B (future)
Image: A bitmap
Start point
End point
Ramp

Ramp consists of:

Time length
Start color (future)
End color (future)

Here is an example of how to create an image action:

Get a new screen
Launch the Image Action dialog box
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Observe the default settings
Draw an image
Add an image name
Add the image
Observe the default image action values
Type an image action name
Add the image action
Play the image action
Add another image action
Play the image actions
Stop at the right edge
PreRamp and PostRamp
View the image actions on a square grid
Play it again

Get a new screen

Click on the toolbar button that has a picture of a piece of paper on it.

Launch the Image Action dialog box

Click on the Tools menu and select "Images".  The Image Action dialog box will launch, and the
Morph dialog box will automatically be shut down.  Whenever the Image Action dialog box is
launched, the "Draw" mode is automatically selected and the toolbar button with a pencil on it will
be depressed.

Observe the default settings

By default, the left red color control will be set to 100%.  The time duration will be 1.00 to 2.00
seconds.  All pixels in the pixel grid will be black.

Draw an image

Leave the left red color control at 100%.  Set the left green color control to 100%.  The start color
will now be yellow.  When drawing an image, only the start color is used; the end color is not used.

Click on the pixel grid to draw a smiley face at the top of the pixel grid.  Single clicks will draw one
pixel; click and drag will leave a trail of pixels.  Right click erases pixels.  Ctrl-right click will clear
the entire grid.  

Add an image name

At the top of the dialog box is the Image group.  In the "Name" field of the Image group area, type
"Smiley Face".

Add the image

In the Image group at the top of the dialog box, click on the Image "Add" button.

Observe the default image action values
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The default start point (x,y) is (0,0), and the default end point (x,y) is (0,50).  The default start and
end times are 1.00 and 2.00.  Leave these settings at their default values.

Type an image action name

In the Image Action group at the bottom of the dialog box, type "Smiley down".

Add the image action

In the Image Action group at the bottom of the dialog box, click on the Image Group "Add" button.

Play the image action

Play the image action.  at 1.00 seconds, your image will start from the top and travel downward,
disappearing off the bottom of the ribbons.

Add another image action

We will use the same image again, and this time move it horizontally.

For the time, select 2.00 to 3.00.  For the start point, type (-12, 10) (enter minus twelve so that the
start point and end point are different).  For the end point, type (12, 10).  For the Image Action name,
type "Smiley right" in the bottom name field.  Click on the bottom "Add" button.

Play the image actions

At 1.00 to 2.00 you will see the first image action, which goes from top to bottom.  At 2.00 to 3.00,
the second image action will move from left to right across the ribbons.

Stop at the right edge

Select the image action that goes from left to right.  Keep the start point at (-12, 10), but change the
end point to (0, 10).  At the bottom of the dialog box, enter a "Post Ramp Time" of 1.00.  Click the
Modify button.

Play the image actions and you will see the first image action go from top to bottom.  The second
image action will move from the left to the right edge and then fade for 1.00 seconds at the right
edge.  

PreRamp and PostRamp

"PreRamp Time" will fade the image in.  Selecting "Make Brighter" with a "PreRampTime" will fade
the image in brighter.  It gives the effect of "poof" and the image appears.

"PostRamp Time" will fade the image out.  Selecting "Make Brighter" with a "PostRamp Time" will
make the image brighter and then fade to black.  It gives the effect of "poof" and the image
disappears.

View the image actions on a square grid
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At the right end of the toolbar are three buttons.  If you hover the mouse over the buttons you will
see they are called "Star Rays", "Wide Grid", and "Thin Grid".  Currently the "Star Rays" button is
pressed.  Click on the "Wide Grid" button.

Play it again

Play the image actions again and you will see how they look when the ribbons are parallel to each
other and form a grid of pixels.

5.4.4.4 Import Image

On the right half of the Image Setup dialog box is the Import Image section.  This section is used to
import image files such as .jpg, .gif, .bmp, .png, and .ico files.  To import an image file, do the following:

Click on the Tools menu and select "Images..."
In the Import Image section, click on the "Import image File (JPG, GIF, BMP, PNG, ICO, etc)"
button
If you are in CCR Mode, the sequencing grid will become larger and will be 64x50 pixels in size. 
This allows you to define a large image if you want.  You can manipulate the image by using the
following controls:

Move Origin X Y
Squish/Stretch X Y
Rotation Angle
Enlarge/Shrink
Clip Grid Bitmap
Images on a Small Grid
Images on a Grid Larger than Your Actual Lights

Move Origin X Y

This control will move the origin of the image.  Use the arrow buttons to move it left, right, up, or
down.

Squish/Stretch X Y

This control will squish or stretch the image in the X or Y direction.  Using this control will change
the aspect ratio of the image.

Rotation Angle

Use this control to rotate the image.  A positive angle will rotate the image clockwise; a negative
angle will rotate it counterclockwise.

Enlarge/Shrink

Use this control to enlarge or shrink the image.

Clip Grid Bitmap
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While manipulating the image, you can click on "Clip Grid Bitmap" and set a clipping rectangle on
the sequencing grid using "Shift + Left Mouse Button".  Then when you click on "Set Grid Bitmap
from Image File", only the pixels within the clipping rectangle will get set.

After you have manipulated the image to the location, angle, and size that you want, click on the
"Set Grid Bitmap from Image File" button.  This will set the pixels on the sequencing grid to
represent the original imported image.  At this point you can manually edit the image if you wish. 
Note that you can set the color controls to the color of a pixel in the sequencing grid by moving the
mouse to a pixel and then doing a Shift + Left mouse click.  To set a pixel, set the color controls to
the color you want and then click on one or more pixels.

After you have the image the way you want it, type in a name in the Image section and click on the
"Add" button in the Image section.

Images on a Small Grid

For example, if you have 12 CCRs and you are in CCR mode, then you have a grid of 12x50 pixels
to work with.  However, when you import the image, the grid will become larger and will be 64x50
pixels in size.  If you want your image to fit within your 12x50 pixels that you have, then you will
need to shrink the imported image and move it to the left so that it will fit within the first 12 columns
of pixels.  Then you can click on the "Set Grid Bitmap from Image File" button.  You can then set
the Grid Mode to "Standard", and the sequencing grid will become the standard size of 12x50
pixels.

Images on a Grid Larger than Your Actual Lights

For example, if you have 12 CCRs and you are in CCR mode, then you have a grid of 12x50 pixels in
your actual display.  However, when you import the image, the Grid Mode will automatically be set
to "Large" and the grid will become large and will be 64x50 pixels in size.  Even though your actual
lights are only 12x50 pixels in size, you can create a larger image and move the image through your
12x50 pixels.  This allows you to display large images on a small grid.  To do this, do the following:

In the Import Image section, click on the "Import Image File (JPG, GIF, BMP, PNG, ICO, etc)"
button.
The sequencing grid becomes larger and will be 64x50 pixels in size.
Manipulate the image but keep it large so that it uses most or all of the 64x50 pixels.
Click on the "Set Grid Bitmap from Image File" button.
If you want, manually edit the pixels further.
In the image section, type in a name and click on the "Add" button.

Now you want to add an image action that will move the image through your 12x50 pixels, so do the
following:

Set the Grid Mode to "Standard".  This will change the grid to be the size of your actual
display).
In the time ruler at the top of the screen, set the time length to something long, such as 4
seconds.
In the Image Action section, set Start x, y to 12, 0, and set End x, y to -64, 0.
In the Image Action section, click on the "Add" button.
Click on the "Play 8 seconds" button to play the Image Action.  You should see the Image
move through your 12 CCRs from right to left.
To make the image move from left to right, set Start x, y to -64, 0, and set End x, y to 12, 0. 
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Note that these values assume your image is 64 pixels wide.  If it is not that wide, then you
would use smaller values.

5.4.4.5 Creating an Animation

Using the Light-O-Rama SuperStar Sequencer, you can create an animation using a series of stationary
images.  Here is an example of how to create an animation:

Load some pre-drawn images
Launch the Image dialog box
Select "Apply x,y in Preview (for animations)"
Add the first image
Add the second image
Add the third image
Add the fourth image
What are those boxes under the timeline?
Check your work
How does cut/copy/paste work?
Copy/paste four images
Image group modify
Copy/paste 8 images
Image group modify
Copy/paste 16 images
Image group modify
Copy/paste 13 images
Image group modify
Play the animation
Nudge the animation to the left
Play on "Wide grid" and "Narrow Grid"
Save your animation
Add an eye to Pac Man
Play it again, Sam

Load some pre-drawn images

Click on the File menu, select "Open...", and open the file "PacManImages.sup", located in the
"Samples" directory of your SuperStar Sequences directory.  Be sure to load PacManImages.sup, 
not PacManAnimation.sup.

Launch the Image dialog box

Click on the Tools menu and select "Images...".  Click on each image in the image list box to view
them.

Select "Apply x,y in Preview (for animations)"

Select the checkbox labeled "Apply x,y in Preview (for animations)".  This applies the (x,y)
coordinate in the preview of the image and it also disables the "End x" and "End y" edit fields (for
animation images, the start (x,y) and end (x,y) are the same).



The Light-O-Rama Software Package 415

© 2019 Light-O-Rama, Inc.

Add the first image

In the image list box, select "01 Circle".
In the Time Line, select from 1.00 to 1.10 seconds.
In the Image Action x,y Start, type "0" and "44"
In the Image Action name field, type "Mouth shut".
In the Image Action section, click the "Add" button.

"1.00 Mouth shut" should appear in the Image Action list box.

Remember: If you make a mistake, you can always undo your mistake by clicking on the Edit menu
and selecting Undo.

Add the second image

In the image list box, select "02 Half open".
In the timeline, select from 1.10 to 1.20 seconds.
In the Image Action x,y Start, type "0" and "42".
In the Image Action name field, type "Mouth half open".
In the Image Action section, click the "Add" button.

"1.10 Mouth half open" should appear in the Image Action list box.

Add the third image

In the image list box, select "03 Full open".
In the timeline, select from 1.20 to 1.30 seconds.
In the Image Action x,y Start, type "0" and "40".
In the Image Action name field, type "Mouth full open".
In the Image Action section, click the "Add" button.

"1.20 Mouth full open" should appear in the Image Action list box.

Add the fourth image

In the image list box, select "02 Half open".
In the timeline, select from 1.30 to 1.40 seconds.
In the Image Action x,y Start, type "0" and "38".
In the Image Action name field, type "Mouth half shut".
In the Image Action section, click the "Add" button.

"1.30 Mouth half shut" should appear in the Image Action list box.

What are those boxes under the timeline?

Under the yellow timeline, you should see four light gray boxes.  These boxes are the four image
actions you just added.  Click on the first of the four boxes and it wil highlight the first image action,
labeled "Mouth shut".  Click on the second and it will highlight the second image action, "Mouth half
open".  You can also highlight the image action in the list box, and it will highlight the corresponding
box under the timeline.
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Check your work

It is easy to make a mistake while adding the image actions.  Click on the first image action,
labeled "Mouth shut", in the image action list box.  Use the down arrow key to step through the
image actions.  The y coordinate should step through 44, 42, 40, and 38, and the top of the image
should step up two pixels each time.  If the image is not moving, make sure you have "Apply x,y in
Preview (for animations)" selected.

How does cut/copy/paste work?

The fourth, fifth, and sixth buttons on the toolbar are the Cut, Coyp, and Paste buttons.  By default,
the objects you paste will be placed in the first open layer, so that effects do not end up on top of
each other.  if you wish the pasted objects to stay in their original layers, press the Shift key while
clicking on the Paste button.

Copy/paste four images

Select all four of the light gray boxes under the yellow timeline.
Click on the "Copy" toolbar button.  The selected effects will be copied to the clipboard.
Click on the timeline just after the light gray boxes, which will be at 1.40 seconds.
Click on the Paste toolbar button.  The effects in the clipboard will be pasted starting at 1.40
seconds.

Remember, if you make a mistake you can click on the Edit menu and select Undo.

Image group modify

You should now have eight image actions on the timeline.  Select the last four.
Click on "Group Modify"; the Image Group Modify dialog box should appear.
Select "Modify x,y".
"Add as Offsets to x,y Positions" should already be selected; leave it selected.
Underneath "Start", type "0" into the left field, and type "-8" into the second field.  Click on "OK". 
This will subtract 8 from the y coordinate in the selected image actions.
Click on each of the image actions, and you should see your animation move up the screen.

Copy/paste 8 images

Select all of the eight light gray boxes that you now have under the timeline.  Click on the timeline
just after the boxes that are already there.  Click on Copy, and then Click on Paste.

Image group modify

You should now have 16 image actions on the timeline.  Select the last eight.
Click on "Group Modify"; the Image Group Modify dialog box should appear.
Select "Modify x,y".
"Add as Offsets to x,y Positions" should already be selected; leave it selected.
Underneath "Start", type "0" into the left field, and type "-16" into the second field.  Click on "OK".
 This will subtract 16 from the y coordinate in the selected image actions.
Click on each of the image actions, and you should see your animation move up the screen.
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Copy/paste 16 images

Select all of the 16 light gray boxes that you now have under the timeline.  Click on the timeline just
after the boxes that are already there.  Click on Copy, and then Click on Paste.

Image group modify

You should now have 32 image actions on the timeline.  Select the last 16.
Click on "Group Modify"; the Image Group Modify dialog box should appear.
Select "Modify x,y".
"Add as Offsets to x,y Positions" should already be selected; leave it selected.
Underneath "Start", type "0" into the left field, and type "-32" into the second field.  Click on "OK".
 This will subtract 32 from the y coordinate in the selected image actions.
Click on each of the image actions, and you should see your animation move up the screen.

Copy/paste 13 images

Select the first 13 light gray boxes that you now have under the timeline.  Click on the timeline just
after the boxes that are already there.  Click on Copy, and then Click on Paste.

Image group modify

You should now have 45 image actions on the timeline.  Select the last 13.
Click on "Group Modify"; the Image Group Modify dialog box should appear.
Select "Modify x,y".
"Add as Offsets to x,y Positions" should already be selected; leave it selected.
Underneath "Start", type "0" into the left field, and type "-64" into the second field.  Click on "OK".
 This will subtract 64 from the y coordinate in the selected image actions.
Click on each of the image actions, and you should see your animation move up the screen.

Your animation is now complete.

Play the animation

Click on the Play button.  You should see Pac Man chase the red ghost up the ribbons.

Nudge the animation to the left

The chomping sound starts before you see the animation start.  To synchronize the appearance of
the animation with the start of the chomping sound, select all of the image actions under the
timeline.  Click on the "Nudge Left" toolbar button (the button with an hourglass and a left arrow on
it).  All the image actions should move left by 0.05 seconds.  Nudge left three or four more times and
the animation should be more in sync with the sound.

Play on "Wide Grid" and "Narrow Grid"

Click on the "Wide Grid" toolbar buton and play the animation.

Click on the "Narrow Grid" toolbar button and play the animation.
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Save your animation

Click on the file menu, and select "Save As...".  Save the file as "MyPacManAnimation.sup".  

Note: There is already a file named PacManAnimation.sup in the Samples directory.  You can
compare your animation with this animation.

Well, it was a bit tedious, but it was worth the effort: You now have a cool Pac Man animation!

Add an eye to Pac Man

Even after the image actions are all defined, you can still modify the images that they use.  For
example, you could add an eye to the yellow Pac Man.  Note that to change the images, you will be
working in the upper Image section of the image dialog.  Do not click on anything in the lower Image
Action section.

Select "01 Circle" in the Image list box.
Use the right mouse button to erase some pixels on the yellow Pac Man to make an eye.
Click on the Image "Modify" button in the upper Image section (not the lower Image Action
"Modify" button).
Repeat the same process for "02 Half open" from the Image list box.
Repeat the same process for "03 Full open" from the Image list box.

Play it again, Sam

Play the animation again, and you will see the eye in the entire animation.

5.4.4.6 Creating Text

In the Light-O-Rama SuperStar Sequencer, text can be stationary or can move in any direction.  At the
end of the movement, the text can be stopped and displayed stationary for a specified period of time. 
Different size fonts can be used, and you can choose the text color or let the text be rainbow colored. 
Text can be treated as a positive mask or a negative mask.  Let's get started!

Select Wide Grid or Thin Grid
Set Layout to 24 ribbons
Get a new screen
Launch the Text dialog box
Observe the default settings
Add a text action
Play the text action
Change the color of the text
Modify and play the text action
Change Rotation to 0 degrees and set Direction of Motion to left
Try different rotations and directions of motion
Rainbow
Rainbow start color
Change the start color
Try a different font and change the text
Discussion on fonts
Custom fonts
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PreRamp and PostRamp
Discussion
What is a text mask?
Try some positive mask text
Apply a background effect
Understanding a positive text mask
It works with morphs too!
Move the morph to the foreground
Negative text masks
Discussion
Applying normal text to the background of a text mask
Summary

Select Wide Grid or Thin Grid

At the right end of the toolbar are three buttons that control how the ribbons are laid out.  The text
will be harder to read if you have "Star Rays" selected.  Select "Wide Grid" or "Thin Grid" and the
text will be easier to read.

Set Layout to 24 ribbons

Click on the Tools menu and select Layout.  In the layout dialog box, set the Number of Ribbons to
24.  We may not actually have 24 ribbons, but for the sake of this exercise, let's pretend we do!

Get a new screen

Click on the toolbar button that has a piece of a paper on it.

Launch the Text dialog box

Click on the Tools menu and select "Text".  The Text Setup dialog box will launch.  Whenever the
Text Setup dialog box is launched, "Text" mode is automatically selected and the toolbar button
with "ABC" on it will be depressed.

Observe the default settings

By default, the color is white, font is "8-8x8 Thin - System", time duration is 1.00 - 5.00 seconds,
text is "ABCDEF", text mode is Normal, rotation is 90 degrees, direction of motion is Up, and Stop
at Edge is unselected.

Add a text action

In the Text Action group, click on the "Add" button.

Play the text action

Click on the Play button.  You should see "ABCDEF" scroll like a marquee from the bottom to the
top of the ribbons.

Change the color of the text
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Currently, the text is white.  Leave the red color control at 100, but change the green and blue color
controls both to 0.  The text preview will now be red.

Modify and play the text action

In the Text Action group, click on Modify, then play the text action again.  Red text will scroll from
the bottom to the top.

Change Rotation to 0 degrees and set Direction of Motion to left

Set Rotation to 0 degrees and set Direction of Motion to Left.  Click on Modify, and play the text
action.  Red text will scroll from right to left across the ribbons.

Try different rotations and directions of motion

You can mix and match the rotation and direction of motion.  Try some different combinations. 
Remember to always click on Modify and then to click on Play to see the results of your new
settings.  Also, try "Stop at Edge" to see what it does.

Rainbow

In the Color/Mask group, select Rainbow.  Each character of the text now becomes a different color.
 Click on Modify, and play the text action with rainbow colors.

Rainbow start color

You can set the start color of the rainbow.  For this exercise, use the following settings:

Set Color to Rainbow
Leave Mask at Normal
Set Rotation to 90 Degrees
Set Direction of Motion to Center
Unselect Stop at Edge
Set Start time to 1.00 seconds and End time to 2.00 seconds

Click on Modify and play the text.  The rainbow text will be centered on the ribbons and will not
move.

Change the start color

Set Start time to 2.00 seconds and End time to 3.00 seconds.
Set the start color to orange.
Click on Add.  You will now have two text actions.
Click on Play.

The rainbow colors will display with red as the start color from 1.00 to 2.00 seconds, and then the
text will display with orange as the start color from 2.00 to 3.00 seconds.

By continuing to add text actions one after another with different start colors, you can make the
colors move across the characters!
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Try a different font and change the text

Delete any text actions that you currently have.  You can do this by clicking on Delete until all
text actions in the Text Action list box are gone.
In the Font list box, select "10-12x12 Bold - System".  The text will become larger.
In the Text field in the middle of the dialog box, change "ABCDEF" to "Merry Christmas!"
Set the start time to 1.00 seconds and the end time to 5.00 seconds.
Set Color to Rainbow.
Set Start Color to whatever color you want.
Set Rotation to 270 Degrees.
Set Direction of Motion to Down.
Unselect Stop at Edge.

Click on Add and play the text action.  "Merry Christmas!" will scroll from top to bottom in rainbow
characters.

Discussion on fonts

We just used the font "10-12x12 Bold - System".  The first number in the name is the pixel height of
a capital letter.  The second and third numbers are the character cell width and height.  In this font
there are two pixels reserved for the lower case descenders (for example, the bottom tail of a "y"). 
This is why the height of the character cell, 12, is greater than the height of a capital letter, 10.

Note that in the smaller fonts, the cell height is the same as the capital letter height.  This is
because there are not enough pixels to reserve room for lower case descenders.  In those fonts, the
tail of a "y" does not go below the bas line.

As mentioned, the second number is the font character cell width, but realize that this is an average
width.  The width of any individual character may be different.

Custom fonts

In the font list, there are five system fonts and five custom fonts.  The custom fonts are shipped
identical to the system fonts.  The only difference is that system fonts are not allowed to be
modified, while the custom fonts are.  If you wish to tweak some of the characters in a font, you can
do so in any of the custom fonts.  For example, let's say we want to make the exclamation point
bigger in the "10-12x12 Bold - Custom" font.  To do this, do the following:

In the central area of the dialog box, select the radio button labeled "Font Character Entry".
In the font list, select "10-12x12 Bold - Custom".  It should be the second to last font in the list. 
The Modify button in the Chars group will become enabled.
In the Char list, select the "!" character (the second character in the list.
The char cell width is 4; change this to 6 and click on the Modify button immediately below the
Char list.  Note that the yellow line indicating the char cell width changed from 4 to 6.
The current "!" character is two pixels wide.  Redraw the pixels to make a fatter 4 pixel wide "!"
character.
Click on the Char List Modify button again.
Now click on the Save button immediately below the Font list.  This saves your change to a file.
Click on the Text Action Entry radio button.
Type the word "Merry!" as the text.
In the font list, select "10-12x12 Bold - Custom".  You should see the new exclamation point that



Light-O-Rama v5.2.4422

© 2019 Light-O-Rama, Inc.

you customized.

PreRamp and PostRamp

"PreRamp Time" will fade the text in.  Selecting "Make Brighter" with a "PreRamp Time" will fade the
text in brighter.  It gives the effect of "poof" and the text appears.

"PostRamp Time" will fade the text out.  Selecting "Make Brighter" with a "PostRamp Time" will
make the text brighter and then fade to black.  It gives the effect of "poof" and the text disappears.

Discussion

You now know how to control many features of a text action.  You can move the text, have it stand
still, rotate the text, change its color, change the font, and even customize the characters within a
font.  But there is more.

What is a text mask?

In the Color/Mask group, there are three radio buttons, labeled "Normal", "Pos Mask", and "Neg
Mask".  So far we have done everything with the "Normal" setting.  Normal means that there is no
mask applied, and the text will behave normally.  "Pos Mask" and "Neg Mask" are advanced
features that allow you to apply any effect to the background and/or foreground of text.

Try some positive mask text

Delete any text actions that you have by clicking on the Delete button until all text actions are
gone from the list.
Set the start time to 1.00 seconds and the end time to 5.00 seconds.
Type the word "Merry" as the text.
Select font "10-12x12 Bold - System".
Set Color/Mask to Choose Color.
Set Color to red by setting red to 100, green to 0, and blue to 0.
Set Pos Mask.
Set Rotation to 270 Degrees.
Click on Add.
Play the text action.

The word "Merry" appears in red in the center of the ribbons.  Nothing special yet...

Apply a background effect

Click on Tools and select Scenes.
Set the start time to 2.00 seconds and the end time to 4.00 seconds.
Set the start and end colors to blue.
Set all the pixels in the pixel grid by pressing the Ctrl key and then clicking with the left mouse
button on the pixel grid.  All the pixels in the pixel grid should be blue.
Click on Add.
Play the text action.

You should first see the red "Merry", and then at 2.00 seconds the background should become blue.
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Understanding a positive text mask

In the time layer area, there should be a red bar going from 1.00 seconds to 5.00 seconds.  This bar
is the Text mask.  Click on this bar and the Text dialog should launch.

There is a box in the lower right area of the dialog box labeled "Mask Diagram".  As the diagram
shows, the effects above a text mask appear in the background, and the effects below a text mask
appear in the foreground.  So, let's try moving the scene from the background to the foreground.

Select the blue bar in the time layers.
Locate the "Move Effects Down" button in the toolbar.  It is the fourth button from the right.
The "Move Effects Down" button changes the layer of the effect.  Click on it until the scene effect
is below the mask.
Click on Play.

This time the scene gets applied to the foreground and the text becomes purple from 2.00 to 4.00
seconds.  Note: If the scene fails to get applied to the foreground, make sure the Positive Text Mask
color is set to pure red - i.e. set red to 100, green to 0, and blue to 0.

It works with morphs too!

Click on the scene and delete it.
Click on the Tools menu and select Morphs.  The Morph dialog box will launch.
Set the start time to 2.00 seconds and the end time to 3.00 seconds.
Set the start and end colors to green.
Set the tail time length to 0.50 seconds.
Set the ramp start color to green and leave the ramp end color as black.
Click on Add and then Play.

The text should appear and then the morph will be applied to the background.  Text masks are cool!

Move the morph to the foreground

Click on the green bar in the time layers and move it to the other side of the mask.  Click on Play.

This time the morph gets applied to the foreground of the text.  Note: If the morph fails to get applied
to the foreground, make sure the Positive Text Mask color is set to pure red - i.e. set red to 100,
green to 0, and blue to 0.

Negative text masks

We started out using a positive text mask.  Let's try a negative text mask.

Leave the morph on the foreground side of the text mask.
Click on the red bar in the time layers; the Text dialog box appears.
Select "Neg Mask".  A message box appears recommending that you set the text color to white
when using negative masks.  Answer "Yes" to the message box"; the text color will then be
automatically set to white.
Click on the Modify button and then Play.  This time, you will see nothing until the morph gets
applied to the text foreground.
Move the morph to the background side of the text mask, and play.  This time, you will see
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nothing until the morph is applied to the background.

Discussion

The weird thing about negative masks is that they are invisible until other effects are applied to their
foreground and/or background.  This seems weird at first, but it is the key to their power.  You can
apply multiple effects on either side of the mask.  You can even apply image actions and normal
text to the background or foreground.  But you cannot apply a mask to a mask.

Applying normal text to the background of a text mask

Move the morph to the foreground side of the mask.
Set the morph start time to 1.00 and the end time to 2.00.
Increase the tail time to 3.00.
Click on Play.  You should see the morph applied to the foreground of the text mask.
Click on the white bar in the time layer area; the Text dialog box is launched.
Type "Christmas" for the text.
Leave Rotation at 270 degrees.
Click on Normal.
Set Direction of Motion to DownRt.
Set the color of the text to red.
Set the start time to 2.00 seconds and the end time to 5.00 seconds.
Click on Add.
The red bar in the time layers represents the normal text you just added.  Move it to the
background side of the text mask.
Click on Play.

The morph should play across the word "Merry", and "Christmas" should move across the
background.

This same sequence is stored as a sample file named "TextMaskMerryChristmas.sup".

Summary

Text masks take some time to learn, but are well worth the effort.  With all the other effects, the
time layers were just a way to view the effects.  With text masks, the layers have a new meaning. 
This tutorial explored only a few of the variety of text effects that are now possible.  Cosmic Color
Ribbons have been taken to a whole new level!

5.4.4.7 Smooth Effects

Smooth Effects look best on a large matrix of RGB lights.  They are designed to change large areas of
lights in a smooth flowing manner.  There are three types of smooth effects: Shockwave, Spiral, and
Fan.

Shockwave

After launching the Smooth Effects dialog box, click on the "Shockwave" tab.

Center Point and Radius
Angle
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Width
Acceleration

Center Point and Radius (Shockwave)

In the green sequencing grid, there will be a small circle and a line ending with an arrow head.  The
small circle marks the center of the shockwave.  The line ending with an arrow head marks the
radius.  Click on the "Add" button in the "Smooth Effects" dialog box, and then click on the "Play"
button to see the shockwave.  You should see a shockwave effect start from the center and end
where the arrow head was.

To change the center point and radius, do a click and drag with the left mouse button.  You can
change the direction and length of the radius with the right mouse button.  For example, do a click
and drag with the right mouse button starting at the end of the arrow line and drag towards the
center where the circle is.  This will make the line start at the outside and go towards the middle
with the arrow pointing towards the middle.  Add another shockwave effect and play it, and you
should see a shockwave start big and contract to a smaller size.

Angle (Shockwave)

The Start Angle and End Angle are grayed out, because Shockwave does not use them.

Width (Shockwave)

There is a Start Width and an End Width.  The Start Width is the width of the "leading edge"of the 
shockwave.  The End Width is the width of the "trailing edge" of the shockwave.  Click on the Up or
Down Arrow buttons next to the Start Width or End Width to change their values.

Acceleration (Shockwave)

Setting a positive number will make the shockwave start slowly and increase in speed as it travels. 
Setting a negative number will make the shockwave start quickly and slow down as it travels.

Spiral

After launching the Smooth Effects dialog box, click on the "Spiral" tab.

Center Point and Radius
End Angle
Width
Tail Time Length
Acceleration

Center Point and Radius (Spiral)

In the green sequencing grid, there will be a small circle and a line ending with an arrow head.  The
small circle marks the center of the spiral.  The line ending with an arrow head marks the radius and
start angle.  Click on the "Add" button in the "Smooth Effects" dialog box, and then click on the
"Play" button to see the spiral.  You should see a spiral effect start from the center and end where
the arrow head was.

To change the center point and radius, do a click and drag with the left mouse button.  You can
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change the direction and length of the radius with the right mouse button.  For example, do a click
and drag with the right mouse button starting at the end of the arow line and drag towards the center
where the circle is.  This will make the line start at the outside and go towards the middle with the
arrow pointing towards the middle.  Add another spiral effect and play it.  You should see a spiral
start at the outside and spiral inward, ending where the arrow head was.

End Angle (Spiral)

The end angle of the spiral can be changed by changing the value in the End Angle field.  Changing
the value of the Revolutions field will also change the value in the End Angle field.  The default is an
end angle of 360 degrees and 1.00 revolutions.  The default setting will make a spiral that travels
clockwise from 0 degrees to 360 degrees.  Set Revolutions to 2.00 to make the spiral go around two
times.  Setting a negative number for End Angle or Revolutions will make the spiral travel
counterclockwise.

Width (Spiral)

There is a Start Width and an End Width.  The Start Width is the pixel width at the start of the 
spiral.  The End Width is the pixel width at the end of the spiral.

Tail Time Length (Spiral)

This is the time length the spiral will stay on screen before it erases itself.

Acceleration (Spiral)

Setting a positive number will make the spiral start slowly and increase in speed as it travels. 
Setting a negative number will make the spiral start quickly and slow down as it travels.  Setting
acceleration to zero means do not accelerate, but even with acceleration set to zero, spiral effects
will have a natural acceleration if the start width is smaller than the end width, and a natural
deceleration if the start width is bigger than the end width.

Fan

After launching the Smooth Effects dialog box, click on the "Fan" tab.  Fan uses a series of Spiral
effects that can look like a fan.

Center Point, Radius and Start Angle
Width
Blades
Blade Width
Revolutions Per Second
Element Angle
Element Step Angle
Acceleration
Show Entire Blade at Start

Center Point, Radius and Start Angle (Fan)

In the green sequencing grid, there will be a small circle and a line ending with an arrow head.  The
small circle marks the center of the fan.  The line ending with an arrow head marks the radius and
start angle.  Click on the "Add" button in the "Smooth Effects" dialog box, and then click on the
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"Play" button to see the fan.  You should see a fan effect start from the start angle and rotate at the
default speed of 0.25 revolutions per second.

To change the center point and radius, do a click and drag with the left mouse button.  You can
change the direction and length of the radius with the right mouse button.  For example, do a click
and drag with the right mouse button, starting at the end of the arrow line, and drag towards the
center where the circle is.  This will make the line start at the outside and go towards the middle
with the arrow pointing towards the middle.  Add another fan effect and play it.  The fan will start from
the start angle and rotate at the default speed of 0.25 revolutions per second as it did before, except
this time each element of the fan will travel inward instead of outward.

Width (Fan)

There is a start width and an end width.  The start width is the pixel width of the start of each
element of the fan.  The end width is the pixel width at the end of each element of the fan.

Blades (Fan)

This is the number of blades in the fan.  The default is two.  You can set the number of blades from
1 to 16.

Blade Width (Fan)

This is the width of each blade in the fan.  50% means the blade width will be 50% of the distance to
the next blade.  Note that the blades start out being thin and get thicker as they rotate until they get
to their Blade Width setting.

Revolutions Per Second (Fan)

This is the rotation speed of the fan.  The default is 0.25 revolutions per second.  This means it will
rotate one quarter of a revolution in one second, meaning it will take four seconds to make one full
revolution.  Positive numbers will rotate clockwise; negative numbers will rotate counterclockwise. 
With a setting of 0, the fan will build from the center outward and will not rotate.

Element Angle (Fan)

The fan is built using a series of spirals.  Each spiral is an element of the fan.  Changing the element
angle wil change the angle of each one of the spirals that make up the fan.  Setting an angle of 0 will
make straight elements.  Setting a large angle will make the fan look sort of like a spinning galaxy.

Element Step Angle (Fan)

This is the spacing between each element of the fan.  Each element is a spiral.  An element step
angle of 10 means that each spiral will be built at intervals of 10 degrees.  Setting a large element
step angle will add space between the spirals.

Acceleration (Fan)

Setting 0 means do not accelerate.  Setting a positive number will make the fan start slow and
increase in speed as it travels.  Setting a negative number will make the fan start quickly and slow
down as it travels.  Note that if you use acceleration in a fan, the width of the fan will change as it
accelerates or decelerates.
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Show Entire Blade at Start (Fan)

This means build the entire width of the blade of the fan all at once, so that the entire blade width is
seen from the start to the finish.

Modify Selected Effects

This dialog box is used to modify attributes that are shared by all types of effects. Currently it
supports modification of the Clip Rectangle in all the effects that are selected. The “Undo” feature is
not supported for this dialog box. So it is a good practice to rename your sequence before
performing this function. That way you will keep the original file before you changed it. So the steps
you want to follow are:

1. Click on the “File” menu and select “Save As” and rename your sequence
2. Select the effects you want to modify. To select all effects, click on the “Edit” menu and select

“Select All”
3. Click on the “Tools” menu and select “Modify Selected Effects…” or click on the “Modify Selected

Effects” button on the Toolbar
4. In the “Modify Selected Effects” dialog box you can choose the types of effects you want

modified. It defaults to all of them being modified.

Manual Clip Rectangle
Select “No Clip” if you do not want the effects to have a clip rectangle
Select “Manual Clip” and then press the “Shft” key while doing a mouse drag on the sequencing grid.
This will define the clip rectangle on the sequencing grid. Click on the “Modify Selected Effects”
button.

5.4.4.8 Auto Sequence Effect

Auto Sequence effects are a cross between standard effects and Instant Sequence. You create the
effect and then give it Auto Sequence settings and the effect moves and/or blinks with the music. In the
lower left of each effect dialog box is and button with an image of a automobile in it. This is the “Auto
Sequence” button. Click on the “Auto Sequence” button and the “Auto Sequence” dialog box will appear.
Click on “Add” in the effect dialog box and you will see an Auto Sequence appear in the time layers.
“Auto Sequence” effects have an image of an automobile on them.
 
Click on the “File” menu and select “Open Audio File”.  

Scenes
Morphs
Smooth Effects
Image Actions
Text Actions

Scenes

Bring up the “Scene Setup” dialog box.
Click on the squares in the green sequencing grid to create the scene pixels
Click on the “Auto Sequence” button in the lower left. The “Auto Sequence” dialog box will appear.
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Select several seconds on the time ruler 
Click on the “Add” button in the “Scene Setup” dialog box and an Auto Sequence Scene effect will
be added to the time layers
Click on the “Play 8 Seconds” button. You will see the scene move with the music

Morphs

Bring up the “Morph Setup” dialog box.
Click on the squares in the green sequencing grid and create a small morph. It will be easier to see
the movements of a small morph.
Click on the “Auto Sequence” button in the lower left. The “Auto Sequence” dialog box will appear.
Select several seconds on the time ruler 
Click on the “Add” button in the “Morph Setup” dialog box and an Auto Sequence Scene effect will
be added to the time layers
Click on the “Play 8 Seconds” button. You will see the morph move with the music

Smooth Effects

Bring up the “Smooth Effects” dialog box.
Click on the “Auto Sequence” button in the lower left. The “Auto Sequence” dialog box will appear.
Select several seconds on the time ruler 
Click on the “Add” button in the “Smooth Effects” dialog box and an Auto Sequence Scene effect will
be added to the time layers
Click on the “Play 8 Seconds” button. You will see the smooth effect move with the music

Image Actions

Bring up the “Image Setup” dialog box.
Click on the “Auto Sequence” button in the lower left. The “Auto Sequence” dialog box will appear.
Select several seconds on the time ruler 
Click on the “Add” button in the “Image Setup” dialog box and a message box will appear saying,
“When adding an Auto Sequence Image Action it is recommended that the start point be 0,0 and
end point be 0,0 and "Apply X,Y in Preview (for animations)" be selected. Set start point be 0,0 and
end point be 0,0 and select "Apply X,Y in Preview (for animations)" ?”
Click on the “Yes” button in the message box and.an Auto Sequence Scene effect will be added to
the time layers
Click on the “Play 8 Seconds” button. You will see the Image move with the music
If you want to change the starting position of the Image you can change to start point and end point.
With “Apply X,Y in Preview (for animations)” selected the start point and end point will be forced to
be the same. Having them be the same value is normally what you will want for Auto Sequence
Image Actions, otherwise the movement will be “jerky” because every time Auto Sequence moves
the Image Action it will also move from the start point and end point of the effect. If you want the
movement to be “jerky” then deselect  “Apply X,Y in Preview (for animations)” and make the start
point and end point be just a few pixels different. 

Text Actions

Bring up the “Text Setup” dialog box.
Click on the “Auto Sequence” button in the lower left. The “Auto Sequence” dialog box will appear.
Select several seconds on the time ruler 
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Click on the “Add” button in the “Text Setup” dialog box and a message box will appear saying,
“When adding an Auto Sequence Text Action it is recommended that the text be set to the center
and "Apply X,Y in Preview (for text that does not move)" be selected.
Set text to the center and select "Apply X,Y in Preview (for text that does not move)" ?”
Click on the “Yes” button in the message box and.an Auto Sequence Scene effect will be added to
the time layers
Click on the “Play 8 Seconds” button. You will see the Text move with the music
If you want to change the starting position of the Text you can change to start point and end point.
With “Apply X,Y in Preview (for text that does not move)” selected the start point and end point will
be forced to be the same. Having them be the same value is normally what you will want for Auto
Sequence Text Actions, otherwise the movement will be “jerky” because every time Auto Sequence
moves the Text Action it will also move from the start point and end point of the effect. If you want
the movement to be “jerky” then unselect “Apply X,Y inPreview (for text that does not move)” and
make the start point and end point be just a few pixels different. 

5.4.4.9 Auto Sequence Dialog Box

The Auto Sequence dialog box is launched by clicking on the button with an automobile in it. The
automobile button will be in the lower left of each of the effect dialog boxes. The Auto Sequence dialog
box has settings that will control the movement and color of the effect as it is moved with the music. If
the Auto Sequence dialog box is visible then when you click on the “Add” button of the effect dialog box
then an Auto Sequence effect will be added to the time layers. The Auto Sequence effect will have a
picture of an automobile in it. The following are the settings in the Auto Sequence dialog box.

Settings
Sensitivity
Trigger Type
Movement
Direction Angle
Speed
Use Native Color of the Effect
Cycle Through Colors Below
Freqs (Frequencies)

Creating A Sequence using Auto Sequence Effects

Sensitivity

This setting sets the sensitivity to the audio file. It is like a volume control. If you are not getting
much movement from the song then try increasing the sensitivity. But if you set it too high it could
also be less responsive. For most songs, setting the sensitivity to 4, 5, or 6 will work best.

Trigger Type

“Rapid Fire” is the default and is typically what you will want to use. The more Freqs you have
selected in the Auto Sequence dialog box, the more triggers will be produced and the effect will
move more
“Single Fire” is good if you want slower movement. Even with many Freqs selected only one trigger
will fire. This can be good for effects that have a lot of movement in them such as smooth effects.

Average the Time Length of Effects – Select this option to smooth out the length of effects. Unselect
this option and places where the music is strong to cause effects to linger.
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Movement

This is the Movement pattern that will be done on the effects. The movement will happen within the
clip rectangle for that effect.
Skip Inactive Grid Squares – Select this option to have the movement skip inactive squares on the
green sequencing grid
No Movement – The effect will happen in the same location every time it is triggered
Wrap Around – The effect will move and will wrap around to the other side of the screen when it
reaches the each of the clip rectangle for that effect.
Ricochet – The effect will move and will bounce off the edges of the clip rectangle for that effect. The
movement is like a billiard ball bouncing off edges of a billiard table.
Folding Ricochet – Images will fold on themselves as they bounce off the edges of their clip
rectangle.
Bounce and Retrace – The effect will move and bounce off the edge of the clip rectangle and will
return to its original position and will keep going back and forth along that path.
Burst and Return – The effect will move until the end of a trigger burst and then will return to its
original position. If the movement goes beyond the edge of the clip rectangle before the end of the
burst then it goes back to its original position.
Snake Up, Snake Down – The effect will move until it hits the edge of the clip rectangle for that
effect, and then it will move up or down a pixel and reverse direction. This movement is best used
with direction angles of 0, 90, 180, and 270 degrees. It will make the effect move in path as if it is a
lawn mower going back and forth until all the region has been mowed and then it reverses direction
and keeps mowing. Also, this movement is recommended for displays with traditional lights. For
example you can make a scene made of one pixel automatically traverse the entire display.

Direction Angle

The setting controls the direction angle of the movement. The angle can be set in 5 degree
increments. The angle is shown with an orange arrow at the center of the green sequencing grid.
Note that this controls only the direction angle. The original location of the effect is controlled by the
location of the native effect that you create.

Speed

This controls the speed of the movement in pixels. For example, with the speed set at 1.00 the
effect will move one pixel each time it is triggered.

Use Native Color of the Effect

The effect will always be rendered using the native color of the effect.

Cycle Through Colors Below

Use this setting to cause the effect to change colors as it moves. You number of colors for it to
cycle through can be set to 1-8. Click on a color square and a Color Picker dialog box will appear.
Note that even though there are many colors you can choose from, it will always set the color to one
of the 8 basic colors, red, orange, yellow, green, blue, purple, white and black. Also note that when
setting black it is really a very dark gray. 
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Freqs (Frequencies)

This setting controls the frequencies that the effect will be responsive to. Click and drag with the
mouse to set or erase multiple freqs. Note that when an instrument in a song plays a musical note,
the frequencies are strongest at the note but there can be strong harmonics on either side of the
note as well. The result is that any note played in a song can get “splattered” across the freq
spectrum. The “splatter” will be wider with higher sensitivity.
These freqs are equivalent to the freqs in the Timing Map dialog box. If you click on the Tools menu
and select “Timing Map” you will see the Timing Map dialog box which has a picture of a piano
keyboard and shows how the freqs map to a piano keyboard. 

Creating a Sequence using Auto Sequence Effects

You can use different Auto Sequence effects throughout your song. The typical approach is to use
the same set of Auto Sequence effect for 10-30 seconds of a song and change to another set of
Auto Sequence effects at a point where the song changes.
In SuperStar you can only see 8 seconds of the song at a time, so if you want to add or modify Auto
Sequence effects that are longer than 8 seconds then do the following:
Select the effects you want to change the time range of. Scroll to the start time that you want and
mark it with a left click on the time ruler. Then scroll to the end time that you want and mark it with a
right click on the time ruler. Then click on the “Set Group Time Range” button. The “Set Group Time
Range” button is on the toolbar and looks like an hour glass with down arrows on either side of the
hour glass.

5.4.4.10 Move or Scale Selected Effects

This feature is used to move or scale the selected effects according to the settings in the dialog box. 
Note that you cannot undo the changes done by this dialog box so it is recommended that you save the
sequence to a new name prior to using this dialog box.  For example if you are moving all the effects two
pixels to the right you would do the following:

1. Click on the File menu and select “Save As” and save the sequence to something like
“MySequence_movedRight2Pixels.sup”

2. Click on the Edit menu and select “Select All”
3. Leave “Move Origin” selected and set “Left/Right” = 2
4. Click on the OK button
5. Click on any effect and you should see that it has been moved to the right by 2 pixels

This feature is also useful for converting a sequence to different dimensions. For example, if you want to
stretch a 12 CCR sequence to be a 16 CCR sequence you would do the following:

1. Click on the File menu and select “Save As” and save the sequence to something like
“MySequence_16CCR.sup”

2. Click on the Edit menu and select “Select All”
3. Click on “Scale”
4. Set:

Source Width = 12 Dest Width = 16

Source Height = 50 Dest Height = 50
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5. Click on the Ok button
6. Click on any effect and you should see that it has been stretched to fit onto a 16 CCR layout

Selected Effects to Modify

This defaults to all effect types being selected. But if, for example, you only want to modify the
selected “Scenes” then you would uncheck all the effect types and leave “Scenes” selected

Move Origin

Select this if you want to move the effects left, right, up, or down, the number of pixels set in the
Left/Right control and the Up/Down control

Scale

Select this if you want to scale the effects. Scale means to stretch or squish.  The “Source Width”
and “Source Height” is the original width and height of the sequence.  The “Dest Width” and “Dest
Height” is the destination width and height, or in other words, the width and height that you want the
sequence to become.

Do Scene Thinning

This setting is used when “Scale” is selected.  It is easiest to explain this setting by using the
example of  a scene that is random pixels that look like stars in the sky.  If you shrink the stars and
have “Do Scene Thinning” selected then some of the stars will get removed or “thinned” out so that
the density of stars in the shrunken sky stays the same.   If you shrink the stars and have “Do
Scene Thinning” unselected then all of the stars will be kept, and in the shrunken sky the density of
stars will be greater.  In the extreme case, if you shrunk the sky a lot then there would be no space
between the stars anymore.

Change Intensity

Select this if you want to increase or decrease the intensity of the color of all selected effects. Note
this change is always relative to the current intensities.

For example, if you set 50% then all color intensities will be reduced by 50%.  If you then select the
same effects and reduce the intensity by 50% again, then the intensities will be 25% of what they
were before you did any changes.

As another example, if you set 200% then color intensities of 50 and lower will get doubled. All
values 50 and greater will become 100. This means that increasing the color intensities by 200%
and then decreasing them by 50% will not necessarily get you back to the original intensities.

5.4.4.11 Groups of Effects

Make a Group
Ungroup
Expand Group
Compress Group
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Make a Group

Do a right mouse click and drag to select a group of effects (you can add or remove effects by
doing Ctrl+Right mouse click).
After doing a right mouse click and drag, a popup menu will appear.
In the popup menu, choose "Grouping", and then choose "Group Selected Effects into a Group".
The "Edit Name of Group" dialog box will appear, allowing you to name the group if you wish.
After clicking on "Ok" in the "Edit Name of Group" dialog box, the selected effects will be
compressed into one "Group" effect.

Ungroup

Do a right mouse click on a group effect.
In the popup menu, shoose "Grouping", and then choose "Ungroup Selected Group into Separate
Effects".
The "Group" effect will disappear, and the grouped effects will become separate effects.

Expand Group

Do a right mouse click on a "Group" effect.
In the popup menu, choose "Grouping" and then choose "Expand Selected Group".  Alternatively,
you can select a "Group"effect and hit the "+" key.
All the other effects in the sequence will become hidden, and only the effects in the group will be
displayed.  You can now modify the existing effects, add new effects, or delete effects.  Anything
you do will become the new state of the group.

Compress Group

While a group is expanded, do a right mouse click anywhere in the time layers.
In the popup menu, choose "Compress Group".  Alternatively, you can press the "-" key.
All the effects currently displayed will be compressed back into the group.  You will now see the
"Group" effect displayed along with all the other effects in the sequence

5.4.4.12 Select One or More Rows

Open a sequence or create a bunch of effects.  Do a right click on a row in the Time Layers.  For
example, you could do a right click on Row 3 in the Time Layers.

In the popup menu that appears, select "Row 3" and then select "Select All", "Select All Left", or "Select
All Right", and the selection will be applied only to Row 3.

You can also do a right mouse click and drag across more than one row.  For example, you could do a
right mouse click and drag across Rows 3-6.

In the popup menu that appears, select "Rows 3-6" and then select "Select All", "Select All Left", or
"Select All Right", and the selection will be applied only to Rows 3-6.

5.4.4.13 Transfer Effects from One Sequence to Another

In the Light-O-Rama SuperStar Sequencer, using the clipboard, you can transfer effects from one
sequence to another, as in this example:
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Open the file "JingleBellRock_24sec.sup", located in the Samples directory of the SuperStar
Sequences directory.
Scroll to the 16.00 second mark and you will see a stack of six white boxes in the time layers.
Select the stack of boxes.
Click on the Copy button.
Click on the toolbar button with a piece of paper on it.  This will do three things: It will clear the
pixel grid, set the start color as red, and set the time duration to 1.00-2.00 seconds.
Click on the Paste button, and the stack of boxes gets pasted to the new file.

5.4.4.14 Load/Save Clipboard

In the Light-O-Rama SuperStar Sequencer, there are 20 sample effects that can be loaded into the
clipboard.  Once the effects are loaded into the clipboard, you can paste them into your sequence. 
Anything that you copy to the clipboard can also be saved to a file.

Start with a new sequence
Launch the Load/Clip dialog box
Load a sample file into the clipboard
Paste the clipboard into your sequence
Play the pasted effects
Save your own clipboard effects
Discussion

Start with a new sequence

Click on the "New" button on the toolbar, which looks like a piece of paper.

Launch the Load/Clip dialog box

Click on the Edit menu, then select Load/Save Clipboard.  You can also launch the dialog using Ctrl
+B.

Load a sample file into the clipboard

At the top of the dialog box is a list of the saved clip files ("clip" is short for "clipboard").  All of the
sample files start with "Sys -", meaning they are a system file that can be loaded but not saved to. 
Select the "SharkFinForHorizontalRibbons.scb" file, then click on "Load Clipboard from File".

Note that the lower half of the dialog box is now populated.  In the description area are the
description and instructions on how to modify the effects.

Paste the clipboard into your sequence

Once the clipboard is loaded, you can paste the effects into your sequence.  There are four ways to
do this:

1. Use the Paste button in the dialog box.
2. Use the Paste button on the toolbar.
3. Put the focus on the work area by clicking on the time layers area, and then press Ctrl-V.
4. Click on the Edit menu and select Paste.
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Play the pasted effects

A shark fin will travel lengthwise across the ribbons, first one direction and then the other.  The water
underneath the shark fin will shimmer.  

For demonstration purposes, the shimmering water is done in two different ways: The first time, it is
done with scenes that fade between two intensities.  The second time, it is an animation done with
images.  The description of this effect in the Load/Save dialog box describes how to modify the
shark fin and the water.

Save your own clipboard effects

Any effects you have modified our created can be saved to file by doing the following:

Select what you want to save.
Click on the "Copy Effects" button on the toolbar.
Press Ctrl-B to launch the Load/Save Clipboard dialog.
In the Clipboard Name filed, type your filename (such as "MyAwesomeEffects").
Click on the "Save Clipboard to File" button.

Note that your file is now in the list of saved clip files.

Discussion

The load/save of the clipboard is a powerful feature! You can now store and easily transfer effects
from one file to another.  The shark fin effect shows how a shaded object can be drawn as an image
action.  Artists will have fun with this, and non-artists will be grateful they can copy and paste these
images!

Currently the SuperStar Sequencer does not support importing .gif or .jpg images.  However, realize
that even if you have twelve CCRs, you only have 12x50 pixels to work with.  This is very low
resolution by computer standards.  Import of images would typically not look good at such low
resolution.  The best images will always be those that are carefully tailored to the low resolution that
we must work with.

5.4.4.15 Change to 10 Pixels per Ribbon

Cosmic Color Ribbons default to having 50 pixels per ribbon.  Each pixel is actually a group of three
LEDs with red, green, and blue elements.  You will normally want to keep the ribbons in 50 pixel mode.

You can, however, change the number of pixels per ribbon to 25, 10, 5, or 1, using one of the macro
commands built into the ribbons.  The reason you may want to do this is to reduce the number of
channel commands, making the effect more instantaneous.  For example, a white morph that goes the
full length of 12 ribbons will generate 12x50x3 = 1800 commands.  If the morph is fast, and tries to do
this in a short period of time, like 0.4 seconds or less, you may perceive some lag in the ribbons.  In a
fast effect, you will get better results by using 10 pixels per ribbon, because it will use 1/5 the number of
channel commands and so will eliminate the lag, and since it travels fast, it will still look good in 10 pixel
resolution.

Here is an example of how to use both 10 pixel and 50 pixel resolution in the Light-O-Rama SuperStar
Sequencer:
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Initialize the screen
Launch the Macro dialog box
Add a "10 pixel per ribbon" macro
Add a scene inside the macro region
Add a morph inside the macro region
Add a morph outside the macro region
Try to add a morph that straddles the macro
Discussion

Initialize the screen

Click on the toolbar button with a piece of paper on it.  This will do three things: It will clear the pixel
grid, set the start color to red, and set the time duration to 1.00 to 2.00 seconds.

Launch the Macro dialog box

Click on the Tools menu and select Macro.

Add a "10 pixel per ribbon" macro

Set "Pixels Per Ribbon" to 10.
Set the time duration to 1.00 to 3.00 seconds.
Click on the Add button.

A bracket should appear in time layer 6.

Add a scene inside the macro region

Click on the Tools menu and select Scene.
Set the time duration to 1.00 to 2.00 seconds.
Set some pixels at the top of the pixel grid.
Click the Add button.

A scene should appear in time layer 1.  Note that the scene only has ten pixels per ribbon in the
pixel grid.  Also note that the ribbons still display as if they were in 50 pixel mode, but when playing
the sequene to the real Cosmic Color Ribbons, they will be in 10 pixel mode.

Add a morph inside the macro region

Click on the Tools menu and select Morph.
Set the time duration to 2.00 to 3.00 seconds.
Click on the Add button.

A morph should appear in time layer 2.  Note that the morph has ten pixels per ribbon in the pixel
grid.

Add a morph outside the macro region

Set the time durationto 5.00 to 6.00 seconds.
Click on the "Add" button.
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Note that the morph has 50 pixels per ribbon in the pixel grid.

Try to add a morph that straddles the macro

Set the time duration to 2.00 to 4.00 seconds.
Click on the Add button.

An error message will appear.

Discussion

When playing the sequence to the Cosmic Color Ribbons, the ten pixel macro will send a command
1/100th of a second before the macro time duration to set each ribbon in 10 pixel mode.  It will send
a command 1/100th of a second after the macro time duration to set each ribbon back to 50 pixel
mode.  No effects should be active when these commands are sent.

Note that at 32.45 in the sample file CarolOfTheBells.sup, there is a morph that uses 10 pixel mode.
 In this morph, all the ribbons burst downward into a flash of white.  In normal 50 pixel per ribbon
mode, this would require 1800 channels to be turned on in a very short period of time.  Using 10
pixel per ribbon mode requires only 360 channel commands, and can make the effect more
instantaneous.

5.4.4.16 "Star Rays", "Wide Grid", and "Thin Grid"

In the Light-O-Rama SuperStar Sequencer, there are three buttons at the right end of the toolbar that will
set the ribbons into "Star Rays", "Wide Grid", or "Thin Grid":

Star Rays

In this layout, morphs that come from the top to the bottom should accelerate, and the trail should
get longer.  Typical settings might be a start trail of 2 and an end trail of 12.

Scenes that come from the top to the bottom should get larger.  The yellow perspective marks on
the right side of the pixel grid are designed to help you do this.

Wide Grid

This view spaces the ribbons to give square pixels.  That is, the space between the ribbons is equal
to the height of each pixel.  If you are using the ribbons primarily for animations and text, you will
probably use a layout like this.

Thin Grid

This view spaces the ribbons closer together.  The quality of the animations will improve, but it will
take more ribbons to cover the same amount of area.

5.4.4.17 The Layout Dialog Box

In the Light-O-Rama SuperStar Sequencer, the layout settings get saved into each .sup file.  The layout
you set also gets saved as a default layout.  This default layout will be used for new sequences that you
create.
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CCR Mode
Number of Ribbons (1-24)
Ribbon Orientation
Ribbon Shape
Ribbon Length
Visualization Mode
Visualization Files
Pixel Extender

CCR Mode

In CCR mode, the screen will use the layout you have selected in the lower part of the Layout dialog
box.  The unit ID and configuration information will be obtained from the Configuration dialog box, and
this information will be used when exporting the file to the Sequencer.

Number of Ribbons (1-24)

This will set the number of rows of ribbons if in horizontal view, or the number of columns of ribbons if
in vertical view.  Note that if you are using half ribbons, this setting is the number of rows, not the
number of ribbons.

Ribbon Orientation

Setting "Vertical" will display the ribbons vertically in columns.  

Setting "Horizontal" will display the ribbons horizontally in rows.  Note that the star is not supported
in the horizontal view.

Ribbon Shape

Setting "Straight" will display the ribbons in straight lines.  This is the common way to display the
ribbons. 

Setting "Circle" will display the ribbons in circles. The start of the ribbon will be at the left center of
each circle.  This allows for a variety of circular patterns.  Sequencing circles can be a challenge,
but the results can be amazing.  An example can be seen on the Light-O-Rama website with Deck
the Halls for 2 CCRs and for 4 CCRs.

Ribbon Length

Setting "Full" will display the ribbons as a full length 50 pixel ribbon.  This is the normal setting.

Setting "Half" will display the ribbons as a half length 25 pixel ribbon.  The common use of this
setting is to allow a matrix with fewer ribbons.  For example, using 4 CCRs you can create a matrix
of 8 rows with 25 pixels in each row.  You can cut the ribbons per the instructions that come with
the CCRs, but if you do this, you void the warranty.  Another option is to loop the ribbons back
without cutting them.  You will lose some pixels in the loop, but you will not void the warranty.  

When using half ribbons you must lay out your ribbons as diagrammed below:

Location of Ribbon Controllers when Ribbon Length is set to Half and Ribbon Orientation is set to
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Horizontal
Location of Ribbon Controllers when Ribbon Length is set to Half and Ribbon Orientation is set to
Vertical

Location of Ribbon Controllers when Ribbon Length is Set to Half and Ribbon
Orientation is Set to Horizontal

Set "Left" if your CCR controllers are on the left end of your ribbons.
Set "Right" if your CCR controllers are on the right end of your ribbons.
Note that for a horizontal layout, the first controller should be at the bottom, and the last controller
at the top.

Location of Ribbon Controllers when Ribbon Length is Set to Half and Ribbon
Orientation is Set to Horizontal

Set "Top" if your CCR controllers are on the top of your ribbons.
Set "Bottom" if your CCR controllers are on the bottom of your ribbons.
Note that for a vertical layout, the first controller should be at the left, and the last controller should
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be at the right.

Visualization Mode

In visualization mode, the screen will use the row visualization file you have imported.  All unit ID and
configuration information is obtained from the real visualization file, and this information will be used
when exporting the file to the Sequencer.

Visualization Files

This area shows the names of the row visualization and the real visualization.  The row visualization
should be laid out in rows, and is used when SuperStar maps the fixtures to the sequencing grid. 
The real visualization should be laid out the way your light display actually appears, and is used
when playing the sequence and when exporting the sequence.  Note that the row visualization and
the real visualization will be the same file if you do "Import Visualization" in the File menu.  If you do
"Import Visualization Pair" in the File menu, then you can specify different files for the row
visualization and the real visualization.

Pixel Extender

The Pixel Extender allows you to stretch or shrink the pixels in a region of a sequence done on a
visualization.  While you can stretch or shrink the pixels, the most common use is to stretch or
extend the pixels.  For example, it allows you to convert a sequence written for 25 or 50 pixels on
strings that have 100 or 150 pixels.

Enable Pixel Extender: Select this to enable the Pixel Extender.
X Origin: The X origin of the region to be extended.
Y Origin: The Y origin of the region to be extended.
Width: The width of the region to be extended.
Length: The length of the region to be extended.
Stretched/Shrunk Length: The new length after the region has been stretched or shrunk.

Pixel Extender Example

Make a visualization of your CCP Tree that has 50 pixels per strand.

Load the standard sequence made for a CCP Tree with 25 pixels per strand.

Import your visualization of your CCP Tree that has 50 pixels per strand.

Set the Pixel Extender as follows:

X Origin: 0
Y Origin: 16 (this is because the Globe is at the top of the sequencing grid and the CCP Tree
starts at row 16)
Width: 24
Length: 25
Stretched/Shrunk Length: 50

At this point, you can play the sequence to your visualization and see the stretched pixels play to
your visualization.
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5.4.4.18 The Preferences Dialog Box

The Light-O-Rama SuperStar Sequencer has the following choices in the Preferences dialog:

Color Mode (Balanced vs. Full Range)
Color Temperature (Cool White vs Warm White)
Enable Time Layer Priority Feature
Smooth Ramps
Export Raw Color Values
Grid Orientation

Color Mode (Balanced vs. Full Range)

If you use the Light-O-Rama Hardware Utility to try various setting for the RGB values of CCR pixels, you
will find three important characteristics:

1. The brightness is not linear.  For example, a setting of 100 is only a little brighter than a setting of
50, but 50 is significantly brighter than 25.

2. The red, green, and blue elements are not balanced.  For example, on a computer screen, setting
red to 100 and green to 100 will result in yellow, but on a CCR pixel, it will be more of a greenish
yellow.  This is because the CCR's green element is stronger than the red element.  Setting red
and blue to 100 will result in a bluish purple, because the blue element is stronger than the red
element.

3. The LEDs are so bright that the perceived colors will not be as deep as what you see on the
computer screen.  This must be taken into account when comparing the colors on the computer
screen with what you will get on the ribbons.  For example, red 100 and green 50 will give a bright
orange; red 60 and green 30 will give a dim orange that will show as a muddy orange on the
computer screen, but on the Cosmic Color Ribbons it will still be a fairly bright orange.

Making the brightness linear

The Light-O-Rama SuperStar Sequencer automatically adjusts the start and end settings to make
them linear.  For example, a start setting of 50 in the SuperStar Sequencer will export to a setting of
25 in the Sequencer.  This gives the proper intensity for the start and end color of an effect.  But
realize that a ramp that goes from 100 to 0 will not go from 100 to 0 smoothly: The hardware will
bring the voltage down from 100% to 0% smoothly, but the brightness will go down slowly at first,
then quickly at the end.  The SuperStar Sequencer simulates this fast drop off when it plays the
sequence onto the ribbons.  Note that this fast drop off can be solved using the "Smooth Ramps"
setting.

Balanced Color Mode

The SuperStar Sequencer defaults to "Balanced Color Mode".  In this mode, the red element is used
in its full range, but the green and blue elements are limited to less than full brightness.  So, for
example, if you set red to 100 and green to 100, you will get a true yellow on the ribbon.

Full Range Color Mode

To set this mode, go to the Tools menu and select Configuration.  When in Full Range Color Mode,
the color controls will have the following ranges:
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Red: 0-100
Green: 0-120
Blue: 0-130

In this mode, setting red, green, and blue all to 100 will give the same results as in Balanced Color
Mode.  Setting red to 100, green to 120, and blue to 130 will give a bluish white.  The SuperStar
Sequencer simulates this color shift, but to do so it must "dim down" the settings that are 100 and
below in order to support simulation of the colors that are at 100 and above.  Realize that even
though the colors on the screen are dimmed down, the colors on the Cosmic Color Ribbon will not
be.

Go Back to Balanced Color Mode

When going back to Balanced Color Mode, the SuperStar Sequencer advises that any settings
greater than 100 will automatically be adjusted down to 100.  Note that after going into Balanced
Color Mode, the next time you click on a color control, a warning box may appear that says "Enter
an Integer between 0 and 100."  This is a bug which will be fixed in the future.  Click "OK" on the
warning box; if another warning immediately appears, click "OK" on that also.  These warnings can
be ignored.

Color Temperature (Cool White vs Warm White)

Most Cosmic Color Ribbons have “cool white” LEDs which means they are bluish white when Red,
Green, and Blue are completely “on.” But some batches of Cosmic Color ribbons have “warm white”
LEDs which means they are a true white when Red, Green and Blue are completely “on.” Although they
are a true white, when held next to a “cool white” pixel that is completely “on” they will look yellowish.

The same is true for DMX ribbons and strings. Some of them are “cool white” and some are “warm
white.” Choose the setting that matches your particular lights and the colors on the lights will more
nearly match the colors that you saw on the computer screen when you made the sequence.

Enable Time Layer Priority Feature

When this checkbox is not selected all effects are transparent. This means that effects that where
effects of different colors overlap the colors will mix. For example, , if a red effect is place on top of a
green effect, in the places where the effects overlap the red and green will mix and will be yellow.

When this checkbox is selected the effects on low time layers will render in front of effects on higher
time layers. For example, if you place a morph on time layer 1 and you place a scene on time layer 3,
then if the morph goes across the same area as the scene then the morph will render on top of the
scene. In other words it will look like the morph is above the scene.

For backward compatibility sequences created before this feature was available will have this feature
unselected.

Each of the effect dialog boxes has the options Transparent, Semi-Transparent, and Solid. Their behavior
is as follows:

Transparent – The effects are transparent. For example, if a red effect is place on top of a green
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effect, in the places where the effects overlap the red and green will mix and will be yellow.
Semi-Transparent – The colors in an effect that are dim will be transparent, but the colors in the
effect that are the full color of the effect will be solid. For example, if a green morph with a tail is
placed above a red scene, then the green head of the morph will be solid but the tail will be
transparent. This is probably the setting you will want to use for scenes, morphs, and smooth
effects.
Solid – All colors in the effect will appear solid. This is probably the setting you will want for use
with images, and text. 

Smooth Ramps

As discussed in the Color Mode (Balanced vs. Full Range) section, the start and end setting of each
color is adjusted by the Light-O-Rama SuperStar Sequencer so that the brightness is linear.  However,
on a single fade, the SuperStar Sequencer cannot control the rate at which the brightness changes in
between the start and the end.  To get around this, the SuperStar Sequencer can use "smooth ramps". 
In smooth ramps mode, ramps that are one second long or longer are actually treated as ten short
ramps.  In this way, the SuperStar Sequencer gains control of the rate of change of the ramp.  

The fast change of ramps is not easily perceived for short ramps, but with very long ramps you will notice
it.  To see the difference, try the following:

1. Set Smooth Ramps mode

Click on the Tools menu and select Configuration.
Select Smooth Ramps in the Configuration dialog box.

2. Add a non-smooth ramp

Launch the Scene dialog box.
Select pixels 0-10 on the pixel grid.
Set the time duration to 1.00 to 1.95 seconds.
Set the start color to red = 100.
Set the end color to red = 0.
Click on the Add button.

The scene will be added to layer 1.

3. Add a smooth ramp

Select pixels 11-20 in the pixel grid.
In the scene dialog box, set the time duration to 1.00 to 2.00 seconds.
Leave the start color at red = 100.
Leave the end color at red = 0.
Click on the Add button.

The scene should be added to layer 2 so that they both are stacked on top of each other.

4. What are we doing?

Both of the scenes cover almost the same time range.  The two scenes should be stacked on
top of each other.  The pixels you selected should not collide (that is, each scene should turn
on a different set of pixels). 
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5. Observe the difference

Click on the Play button.  The first scene added is of a duration less than one second, so the
ramp will not be smoothed.  The second scene is a second long, and so the ramp will be
smoothed.

Note that the top pixels (belonging to the first scene) will not drop in brightness as fast as the
bottom pixels (belonging to the second scene).

6. Summary

When in Smooth Ramps mode, only ramps 1.00 second long and longer are smoothed.  Even if
you are in Smooth Ramps mode, smoothing is not done for ramps less than 1.00 second.  This
is because the smoothing of short ramps is not easily perceptible to the eye.  Realize that any
ramp that is smoothed gets chopped up into ten ramps, and thus the number of commands is
ten times greater, and the length of the exported sequence file is ten times greater for that
effect.  This is why smoothing of short ramps is not done.

Smooth Ramps mode defaults to off, but you can turn it on, and then the setting gets stored in
both your launch configuration file and in the .sup file.  It affects the export of a Light-O-Rama
.lms or .las file, and as mentioned, exported files using smoothed ramps will be larger.

Export Raw Color Values

When exporting a sequence, SuperStar will adjust the color values so they appear best on your lights.
This is because LED lights require adjusted values in order to get them to best match the colors that
you see on the computer screen. The result is that the colors you see in the exported file in the 
Sequencer may look a bit different than in SuperStar, but they will look good on your actual lights.

If you do not want SuperStar to adjust the exported values, then select “Export Raw Color Values.” This
will make the colors in the exported file match what you saw on the computer screen in superstar, but
the colors will not look as good on your actual lights.

Grid Orientation

Use this setting to change the orientation of the sequencing grid between Horizontal and Vertical.

5.4.4.19 Configure Controller Unit IDs Using the Light-O-Rama Hardware Utility

After purchasing Cosmic Color Ribbons, you must configure them using the Light-O-Rama Hardware
Utility.  There are instructions on how to do this in the manual that comes with the ribbons.  You will
assign a unit ID to each controller, the same as you would with any other controller.

In addition, the Hardware Utility has a Cosmic Color Ribbon Configuration screen.  Be sure to use the
following settings on it:

Unit ID Mode: Normal (single ID).
Channel Mode: Triples (RGB, RGB, ...)
Resolution: 50 pixels
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Strips: 1
DMX Mode: Both macro and RGB channels

The "Standalone Speed" setting does not matter with respect to the Light-O-Rama SuperStar
Sequencer.

5.4.4.20 Configure Controller Unit IDs in the SuperStar Sequencer

After setting the unit ID for each of your Cosmic Color Ribbons with the Light-O-Rama Hardware Utility,
you then must let the Light-O-Rama SuperStar Sequencer know which unit IDs you assigned.

Note that a Light-O-Rama unit ID is a hexadecimal number from 01 to F0. If they were decimal numbers,
the ID would be from 1 to 240, but since they are hexidecimal, the IDs are 01, 02, 03, 04, 05, 06, 07, 08,
09, 0A, 0B, 0C, 0D, 0E, 0F, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 1A, 1B, 1C, 1D, 1E, 1F, 20, and so
on.

Launch the Configuration dialog box
Set the unit ID of the star controller
Set the unit ID of the first ribbon controller
Number of DMX pixels
Network settings
Examples
Do I need more hardware to use more than one network?
Setting more than one network in the Light-O-Rama Sequencer

Launch the Configuration dialog box

Launch the SuperStar Sequencer, click on the Tools menu, and select Configuration.

Set the unit ID of the star controller

If you are not using a star, select "No" underneath "Star in Use".  The Unit ID field will be dimmed,
indicating that no unit ID for a star controller will be used.

If you are using a star, select "Yes" underneath "Star in Use".  Set the unit ID of the Light-O-Rama
controller for the star using the dropdown list.

The typical Light-O-Rama controller has 16 channels.  Note that if you use the star, you must use
the first 6 channels of the controller for it.  The remaining 10 channels will not be used by the 
SuperStar Sequencer, which means you can use them in your main sequence if you choose to do
so.

Set the unit ID of the first ribbon controller

Set the unit ID of the first ribbon controller using the dropdown list.  The remaining ribbon controllers
must be assigned unit IDs that are in successive numeric order, keeping in mind that they are
hexidecimal numbers.  For example, if you have four ribbons, and the first ribbon has unit ID 18, then
the next three ribbons must have unit IDs 19, 1A, and 1B.

If you have DMX pixels then select "DMX" and set the Universe and Channel of the first pixel of your
first ribbon/string. There are three DMX addressing options to choose from:
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Tightly Packed: All 170 pixels are used in each Universe.  After all pixels in the first string
are assigned, the first pixel of the second ribbon/string will use the next available DMX
channel.  When all the available channels of a Universe are used then the addressing moves
to channel 1 of the next Universe.  This is done until all pixels of all ribbons/strings are
defined.
Semi-Packed: As many full strings as possible are put into each Universe.  For example, if
each string has 50 pixels, then 3 strings will fit into the 170 pixels available in one Universe. 
So the first 3 strings will use the first Universe; strings 4, 5, and 6 will use the Universe after
that.  With Semi-Packed, a transition to another Universe will never happen in the middle of a
string.
Not Packed: Each string has its own universe.  This means that each string will start with
pixel one of a Universe.

Number of DMX Pixels (10-170)

Set the number of DMX pixels that are in each of your DMX pixel strings.  For example, if your
strings have 150 pixels in each string, set 150, and when the sequence is exported it will expand the
50 pixel sequence into 150 pixels.  This is an important feature! It makes sequences written for 50
pixels transportable to DMX strings of any length between 10 and 170.

Network settings

Generally speaking, Light-O-Rama supports up to 16 Light-O-Rama networks, but the SuperStar
Sequencer currently only supports up to four of them.  The default setting for the SuperStar
Sequencer is to use one network (the Standard network), with the other three networks (Auxiliary
Networks A, B, and C) disabled.  When using one network (the Standard network), you must set the
first and last unit IDs that are controlled by the network.

If using more than one network, enable the auxiliary networks you are using and set the first and last
unit IDs controlled by each auxiliary network.

Examples

Setting up one network for the star and 12 ribbons
Setting up one network for the star, 8 ribbons, and other lights
Setting up four networks with no star, 24 ribbons, and other lights

Setting up one network for the star and 12 ribbons

Let's say we have a star, 12 ribbons, and no other lights. We are controlling the star with a standard
16 channel Light-O-Rama controller that has unit ID 01, and the twelve ribbons are controlled by their
respective controllers with unit IDs 02 through 0D.  Then we would use the following settings:

Star in Use: Yes
Unit ID of Star Controller: "01"
Unit ID of First Ribbon Controller: "02"
Standard Network: Enabled
Standard Network, Unit ID of First and Last Controller: "01" "0D"
Auxilliary Networks: Disabled

Setting up one network for the star, 8 ribbons, and other lights
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Let's say we have a star and 8 ribbons, and will be running them alongside other lights.  We are
controlling the star with a standard 16 channel Light-O-Rama controller that has unit ID 01.  We also
have three other 16 channel Light-O-Rama controllers, with unit IDs 02, 03, and 04.  The eight
ribbons are controlled by their respective controllers with unit IDs 05 through 0C.  Then we would use
the following settings:

Star in Use: Yes
Unit ID of Star Controller: "01"
Unit ID of First Ribbon Controller: "05"
Standard Network: Enabled
Standard Network, Unit ID of First and Last Controller: "01" "0C"
Auxiliary Networks: Disabled

Setting up four networks with no star, 24 ribbons, and other lights

Let's say we have no star, but 24 ribbons, and will be running them alongside other lights.  We have
256 channels for other lights, which are controlled by 16 standard 16 channel Light-O-Rama
controllers with unit IDs 01 through 10.  We have 24 ribbons controlled by their respective
controllers, with unit IDs 11 through 28.  We want to run the various ribbons on four different 
networks.  Then we could use the following settings:

Star in Use: No
Unit ID of Star Controller: Disabled
Unit ID of First Ribbon Controller: "11"
Standard Network: Enabled
Standard Network, Unit ID of First and Last Controller: "01" "10"
Auxiliary Network A: Enabled
Auxiliary Network A, Unit ID of First and Last Controller: "11" "18"
Auxiliary Network B: Enabled
Auxiliary Network B, Unit ID of First and Last Controller: "19" "20"
Auxiliary Network C: Enabled
Auxiliary Network C, Unit ID of First and Last Controller: "21" "28"

Do I need more hardware to use more than one network?

If you have one USB485 connector plugged into one USB port of your computer, then you are using
one network.  To use more than one network, you must first purchase other USB485 connectors
(one for each additional network).  Plug in each USB485 connector to a different USB port on your
computer.  Then plug in the Cat 5 cable coming from each USB485 connector into the first controller
of the network group you are going to control with that network.

Setting more than one network in the Light-O-Rama Sequencer

Launch the Light-O-Rama Network Preferences program.
Make sure you are in Advanced Mode.
Select a comm port for each network that you plan to use.

5.4.4.21 Select All, Select All Left, and Select All Right

In the Light-O-Rama SuperStar Sequencer, you will find these actions in the Edit menu.  "Select All" will
select all effects in the SuperStar sequence; "Select All Left" will select all that are left of the time
selected in the time scale; "Select All Right" will select all to the right of the time selected in the time
scale.
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Select All is useful for adding some blank space to your SuperStar sequence: If you needed to create a
small amount of blank space at the beginning of a sequence, you could Select All, then use the Nudge
Right button.  To create a large amount of space, you could Select All, press the Cut button, select a
time on the time scale, and then press the Paste button.

Similarly, Select All Right is useful for creating some blank space in the middle of your SuperStar
sequence: You could Select All Right, Cut, then Paste at the desired new location.

5.4.4.22 Importing a Timing Grid and up to 3 Timing Channels

In the Light-O-Rama SuperStar Sequencer, you can create a timing grid and timing marks by clicking on
the Tools menu and selecting "Create Timings".  However, if you already have a timing grid and some
timing channels that you have created in the Light-O-Rama Sequencer, you can import one timing grid
and up to three timing channels from a sequence file:

Launch the SuperStar Sequencer.
Click on the Tools menu, select Layout, and set the number of CCRs that you have.
Click on the File menu, and select Import Timings.
Uncheck "Import First Freeform Timing Grid".
Type the name of the timing grid to import.
Type the name of the first timing channel to import.
Type the name of the second timing channel to import.
Type the name of the third timing channel to import.
Click on the "..." button and select the sequence file that you wish to import timings from.
Click on OK.

The timing grid and timing marks will appear at the top of the time layers.

5.4.5 Summary of Commands and Keyboard Accelerators

The following pages in this help file summarize various commands and keyboard accelerators in the 
Light-O-Rama SuperStar Sequencer:

Toolbar Summary
Toolbar Buttons that have Keyboard Modifiers
Timeline and Effect Object Selection
Top Part of Color Controls
Color Picker Dialog Box
Bottom Part of Color Controls
Sequencing Grid Commands for Scenes
Selection Grid Commands for Morphs
Sequencing Grid Command for Images

5.4.5.1 Toolbar Summary

The following is a summary of the various buttons in the toolbar of the Light-O-Rama SuperStar
Sequencer:

New Sequence, Open Sequence, Save Sequence, Cut, Copy, Paste
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Delete a selected group, Fast Rewind, Rewind, Pause or Freeze Frame, Stop, Play 8 seconds, Forward,

Fast Forward, Play All

Note: The space bar is an accelerator for "Play All".

Scene Mode, Morph Mode, Smooth Effect Mode, Image Mode, Text Mode

Set Group Time Range, Nudge Left, Nudge Right, Nudge Length Left, Nudge Length Right, Move Effects

up, Move Effects Down

Star Rays, Wide Grid, Narrow Grid

Select Props, Select Fixtures

Time Line
To create a selection on the Time Line of 8 seconds or less – Do a click and drag to select a region
on the time line.

To create a selection on the Time Line that is longer than 8 seconds -  Scroll to where you want the
selection to start and mark the start of the selection with a left mouse click. Scroll to the region
where you want the selection to end and mark the end of the selection with a right mouse click.

Set Group Time Range – Create a selection on the Time Line, Select a group of effects, and then
click on the “Set Group Time Range” button. All the selected effects will be set to the time range on
the Time Line.

See also Toolbar Buttons that have Keyboard Modifiers.

5.4.5.2 Toolbar Buttons that have Keyboard Modifiers

The following is a summary of toolbar buttons that have keyboard modifiers in the Light-O-Rama
SuperStar Sequencer:

Shift +  = Paste and keep all effects in their original locations

Ctrl +  = Fast rewind to beginning

Ctrl +  = Fast forward to end

 = Freeze frame mode: Use the left and right arrow keys to step through the sequence.



The Light-O-Rama Software Package 451

© 2019 Light-O-Rama, Inc.

Ctrl +  = Big nudge left

Ctrl +  = Big nudge right

Ctrl +  = Big nudge length left

Ctrl +  = Big nudge length right

See also Toolbar Summary.

5.4.5.3 Timeline and Effect Object Selection

The timeline and selecting effect objects in the Light-O-Rama SuperStar Sequencer:

Timeline and Effect Object Selection

Dragging the mouse on the gray area of the timeline will select the time duration.  Selecting an object
will also set the time duration in the timeline.

To set a timeline selection longer than eight seconds, mark the beginning of the timeline selection with a
left mouse click, scroll the timeline as necessary, and then mark the end of the timeline selection with a
right mouse click.

Ctrl+mouse click on an unselected object will add that object to the selection group.

Ctrl+mouse click on a selected object will remove that object from the selection group.

Ctrl+mouse drag on unselected objects will add those objects to the selection group.

Ctrl+mouse drag on selected objects will remove those objects from the selection group.

5.4.5.4 Top Part of Color Controls

The top part of color controls in the Light-O-Rama SuperStar Sequencer:

Top part of color controls

Left click on a color box, or on "Main" or "Tail" = Step through the 8 basic color wheel colors.

Right click on a color box, or on "Main" or "Tail" = Launch the Color Picker dialog box.
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5.4.5.5 Color Picker Dialog Box

The Color Picker dialog box of the Light-O-Rama SuperStar Sequencer:

The Color Picker dialog box

Select a color and click OK to set the color.

Note that the eight basic colors of the color wheel are already among the custom colors.

5.4.5.6 Bottom Part of Color Controls

The bottom part of color controls in the Light-O-Rama SuperStar Sequencer:

Bottom part of color controls

Mouse click on the control to set the intensity.  Mouse drag will also set the intensity.

Double click on the first color to set the second and third colors also.  For example:
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Before a double click on the first color

After a double click on the first color

5.4.5.7 Sequencing Grid Commands for Scenes

Sequencing grid commands for scenes in the Light-O-Rama SuperStar Sequencer:

Sequencing grid for scenes

Left mouse click = Set a pixel.
Right mouse click = Clear a pixel.
Left mouse drag = Set pixels.
Right mouse drag = Clear pixels.

Ctrl+left mouse click = Set all pixels.
Ctrl+right mouse click = Clear all pixels.

Shift+left mouse click = Toggle pixel.
Shift+left mouse drag = Toggle pixels.

Example of a toggle:

Before Shift+left mouse drag
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After Shift+left mouse drag

5.4.5.8 Selection Grid Commands for Morphs

Selection grid commands for morphs in the Light-O-Rama SuperStar Sequencer:

Selection grid for morphs

Left mouse drag to set the State 1 line: "1a" marks the beginning of the left mouse drag; "1b" marks the
end.

Right mouse drag to set the State 2 line: "2a" marks the beginning of the right mouse drag; "2b" marks
the end.

When the morph is performed, "1a" morphs to "2a", and "1b" morphs to "2b".

5.4.5.9 Sequencing Grid Commands for Smooth Effects (Shockwave, Spiral and Fan)

Sequencing Grid commands for Smooth Effects (Shockwave, Spiral and Fan) in the Light-O-Rama
SuperStar Sequencer:

Use left mouse drag to set the center point and start angle.  For example, Screen Shot A was created



The Light-O-Rama Software Package 455

© 2019 Light-O-Rama, Inc.

with a left mouse drag that started at the circle and ended at the arrow head.

Use right mouse drag to modify the radius.  For example, Screen Shot B was created with a right mouse
drag that started at the base of the line and ended at the arrow head of the line.

Use right mouse drag to modify the direction of the radius.  For example, Screen Shot C was created
with a right mouse drag that started at the base of the line and ended at the arrow head of the line.

5.4.5.10 Sequencing Grid Command for Images

Sequencing grid commands for images in the Light-O-Rama SuperStar Sequencer:

Sequencing grid for images

Left mouse click = Set a pixel
Right mouse click = Clear a pixel
Left mouse drag = Set pixels (draws like a pencil)
Right mouse drag = Clear pixels (clears like an eraser)

Ctrl + left mouse click = Set all pixels
Ctrl + right mouse click = Clear all pixels

Shift + left mouse click = Set the color control to the color of the pixel
Shift + left mouse drag = No action performed

5.4.6 Purchased Sequences

Sequences purchased from SuperStar lights are archive files and will have the word "archive" at the end
of the file name.  For example:

WizardsInWinter_12CCRs_archive.sup

Archive files can be exported by any license level of the SuperStar Sequencer, including the free demo
version.  However, if you add, delete, or modify any of the effects in the file, then it is no longer an
archive file and will only export if you have the appropriate license level.

Note that you can change the following in an archive file and it will still export with any license level:

You can open an audio file
You can set unit ID information and any other information in the Configuration dialog box
You can set the location of the controllers and any other information in the Layout dialog box
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5.5 Show Editor

The Light-O-Rama Show Editor is used to create shows.  Shows are groups of sequences to be
played as a group.  They can be scheduled to play at certain times using the Schedule Editor,
and will then be played using the Show Player.

Important Note: When using the S5 Sequencer, you must save each sequence as a playback
file and then build your show using the playback files.

To start the Show Editor, you can run it from your computer's Start Menu by selecting "All Programs" ->
"Light-O-Rama" -> "Light-O-Rama Show Editor".  Alternatively, if the Light-O-Rama Control Panel is
already running, you can right-click its icon in your computer's system tray, and select "Show Editor"
from the popup menu that will open.

Shows consist of several sections.  Each section serves a different purpose - for example, the "startup
section" is a list of sequences that will be played when the show begins, while the "animation section" is
a list of animation sequences that will be played throughout most of the show's duration (after startup
and before shutdown).  All sections are optional.

For details on each of the sections, please refer to the following:

The Background Section
The Startup Section
The Animation Section
The Musical Section
The Interactive Section
The Shutdown Section

The Show Editor consists of six main tabs, and a toolbar at their top.  Each of the tabs is associated
with one of the six sections of the show (such as "background" and "animation"), while the toolbar has
buttons to create, open, and save shows.

To add a sequence to a section, click on that section's tab, and then on the large "+" button.  This will
prompt you for the name of the sequence that you want to add.  Similarly, to remove one, select the
sequence from the section's list by clicking on its name, and then click the large "-" button.

A sequence can be moved up or down in a section's list by clicking on its name and then on the large up
arrow or down arrow buttons.  This generally affects the order that the sequences will be played in, but
not always: For example, in the musical section, you can select that the sequences will be played in the
order listed, or in a random shuffle; if you choose the latter, it doesn't matter what order they are listed
in.  Similarly, in the animation section, you can select that the sequences be played simultaneously (as
opposed to sequentially); if you do, their listed order does not matter.
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The Show Editor's tab for the musical section of a show

The Background Section

When a show is started (at a time determined by the schedule), all of the sequences in the show's
background section will start playing, simultaneously.  When such a sequence reaches its end, it
will simply loop back to its beginning and keep playing.  All of these sequences will continue playing
in this way until the show ends (also at a time determined by the schedule).

If your Light-O-Rama software license is for the Advanced feature level, you additionally have control
over whether this  section (and/or the rest of your show) starts immediately at its scheduled time, or
upon an input trigger (for example, when someone hits a "start" button).  See "Show Startup
Options" for details.

Only animation sequences can be used in the background section of a show.
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The Show Editor's tab for the background section of a show, w ith one sequence

The Startup Section

When a show is started (at a time determined by the schedule), the sequences in its startup section
will be played, one at a time, in order.  After they all have finished, the main portion of the show will
begin, consisting of the animation section and the musical section.

You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.

If your Light-O-Rama software license is for the Advanced feature level, you additionally have control
over whether this  section (and the rest of your show) starts immediately at its scheduled time, or
upon an input trigger (for example, when someone hits a "start" button).  See "Show Startup
Options" for details.
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The startup section in the Show Editor, w ith three sequences

The Animation Section

After a show's startup section has completed, its animation section will begin (as will its musical
section).  

Sequences in the animation section can be played concurrently or sequentially.  If you choose to
play them sequentially, the first in the list (as displayed in the Show Editor) will be played, and when
it finishes, the next will be played, and so forth.  After all of them have been played, the first in the
list will be played again.  This pattern will continue until the show is shut down (at a time determined
by the schedule).

If they are played concurrently, all of them will be played at once, and whenever one reaches its end,
it will simply loop back to its beginning and keep playing.  Again, this will continue until the show is
shut down.

You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.

Only animation sequences can be used in the animation section of a show.
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The animation section in the Show Editor, w ith five sequences, played sequentially

The Musical Section

After a show's startup section has completed, its musical section will begin (as will its animation
section).

Only one sequence from the musical section will play at a time.  They can be played in the order
listed in the Show Editor, or shuffled randomly.  If shuffled randomly, you can also control two
different aspects of how shuffling is done: Whether or not a sequence is allowed to be played a
second time before all sequences have played once, and whether or not a sequence is allowed to
play twice in a row (this latter does not apply if you have only one sequence in the musical section -
it will definitely be played back-to-back).

Play will continue until the show is shut down (at a time determined by the schedule).  If the
sequences are to be played in the order listed, and the end of the list is reached before the show is
to shut down, play will loop back to the first sequence in the list.

Optionally, a "cleanup sequence" can also be specified in the musical section.  If so, that sequence
will be played immediately after the completion of any sequence in the musical section, before the
next one begins.  Also optionally, a delay can be specified between songs.
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You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.

The musical section in the Show Editor, w ith several sequences, shuffled, w ith a delay and a cleanup

sequence

The Interactive Section

Some Light-O-Rama controllers can be used not only to control lights, but also to accept input from
people, causing Light-O-Rama to play sequences on demand.  For example, you could have a big
red button as part of your display, which, when pressed, will cause Light-O-Rama to start playing a
particular song or songs.

This is controlled through the interactive section of the show.  You can use this tab in the Show
Editor to specify what sequences are to be played when which inputs are triggered.  Please see the
separate page on interactive groups for details.

Note that, unlike for the other sections of the show, the Show Editor's "Interactive" tab actually lists
groups of sequences, rather than directly listing sequences.  Again, please see the page on
interactive groups for details on how to create and modify these groups of sequences.

You can control whether or not sequences in this section will automatically turn their lights off when
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they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox, but
unlike in other sections of the show, this setting is controlled individually for each interactive group,
rather than for the section as a whole.

The interactive section in the Show Editor, w ith two groups of sequences

The Shutdown Section

When the end of a show is reached (at a time determined by the schedule), its animation section
and musical section will end, and its shutdown section will begin.  Sequences in the shutdown
section will play, one at a time, in the order listed in the Show Editor.  After they all have completed,
the show is truly finished.

You can control whether or not sequences in this section will automatically turn their lights off when
they reach their end by setting the "Turn used lights off at the end of each sequence" checkbox.
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The shutdown section in the Show Editor, w ith two sequences

Show Startup Options

If your Light-O-Rama software license is for the Advanced feature level, you have more control over
exactly how your show will start up:

Immediate startup
Triggered startup
Immediate background startup

To choose which way you want your show to start, select the "Options" button at the top of the 
Show Editor.  This will bring up the following dialog, which has a "Startup Type" section where you
can choose which way the show will start:
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The Show Options dialog, w ith triggered startup selected

Immediate Startup

In immediate startup mode, your show will begin immediately at its scheduled start time.

This is equivalent to the same way that shows always started in earlier releases of Light-O-Rama.

Triggered Startup

In triggered startup mode, your show will start when a specified circuit on a specified Light-O-Rama
controller is triggered (as long as it is triggered during the show's scheduled run time).  For example,
you could hook up a big red button labeled "Start the Show" to a controller.  Please note that
triggers are not supported on LOR Enhanced networks.

Immediate Background Startup

In immediate background startup mode, your show's Background section will start immediately at
the show's scheduled start time, but the rest of the show will not start until a specified circuit on a
specified Light-O-Rama controller is triggered (as long as it is triggered during the show's scheduled
run time).  Please note that triggers are not supported on LOR Enhanced networks.

Sequence Loading Options

By default, when a show is being played in the Show Player, any given sequence in the show will
not be loaded until when it is about to be played for the first time.  Depending upon the size of the
sequence and the power of the computer, it may take a human-noticeable amount of time to load a
sequence; if so, this may cause an undesired delay between sequences, the first time they are
played.  So, optionally, you can choose to preload all sequences before any of them are played.  To
do so, click on the "Options" button in the Show Editor's toolbar, and then select "Sequences are
loaded before any are played" from the "Sequence Loading" section of the options dialog:
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The Show Options dialog

5.5.1 Interactive Groups

Some Light-O-Rama controllers can be used not only to control lights, but also to accept input that can
be used to trigger a  sequence or sequences.  For example, your display might have several buttons for
people to press, each of which will cause Light-O-Rama to play some particular song on demand.

This is controlled through the Interactive Section of a show.  Unlike the other sections of a show, the
Show Editor's "Interactive" tab displays not sequences, but groups of sequences, known as "interactive
groups".   Each group matches individual circuits on individual controllers with individual sequences to be
played when those circuits are triggered.

Only one musical sequence can be playing at any given time.  Therefore, if a musical sequence from an
interactive group is triggered, any musical sequence that happens to already be playing will be stopped
(for one exception to this, see the "Jukebox" type of interactive group, below).

Interactive groups cannot be used on LOR Enhanced networks.  If you want to use an interactive group,
in order to function during your show, it must be defined on a non-enhanced LOR network.

Types of Interactive Groups
Jukebox
Soundboard
Magic Toy

Choosing Sequences for a Group



Light-O-Rama v5.2.4466

© 2019 Light-O-Rama, Inc.

The Show Editor's Interactive tab

Types of Interactive Groups

When you click the large "+" button, to add a new interactive group to the show, you will then be
prompted to choose the type of interactive group to add:
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Choosing the type of a new interactive group

There are three types of interactive groups:

Jukebox
Soundboard
Magic Toy

After choosing which type of interactive group you want, you will be given a choice of which sequences
to put in the group.

Jukebox

"Jukebox" interactive groups allow you to define a group of sequences, each hooked up to be
triggered by an individual  circuit on some LOR controller, such that only one sequence in the group
can be playing at any given time, and if one already is playing when another is triggered, the first will
continue playing uninterrupted, and the trigger will be ignored.

If you assign more than one sequence to a single circuit in a single jukebox, then whenever that
circuit is triggered, the "next" sequence in the list, round-robin, will be played.
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Both musical sequences and animation sequences can be placed into a jukebox interactive group.

Soundboard

"Soundboard" interactive groups are similar to jukebox interactive groups in that only one sequence
in the group can be playing at any given time.  However, unlike jukebox interactive groups, triggering
a sequence while another sequence from the group is currently playing will cause the playing
sequence to stop, and the triggered sequence to start.

If you assign more than one sequence to a single circuit in a single soundboard, then whenever that
circuit is triggered, the "next" sequence in the list, round-robin, will be played.

Both musical sequences and animation sequences can be placed into a soundboard interactive
group.

Magic Toy

"Magic toy" interactive groups allow you to set up a group of sequences such that many of them can
be started simultaneously by a single trigger.  Any sequences already playing from the group will be
stopped when the new set is started.

Only animation sequences (as opposed to musical sequences) can be placed into a magic toy
interactive group.

Choosing Sequences for a Group

After you choose the type of your new interactive group, or upon editing an existing group, you will be
shown a list of the triggers for the group:
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The triggers in an interactive group

When you add a new trigger to this list (by clicking the large "+" button) or edit an existing trigger, you
will be given a choice of which sequences are assigned to the trigger, and which circuit on which unit of
which network triggers them (please note that triggers are not supported on LOR Enhanced networks). 
You can also assign a name to the trigger:
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Choosing the sequences assigned to a trigger in an interactive group

5.6 Schedule Editor

The Light-O-Rama Schedule Editor is used to schedule shows to be played at certain times. 
Shows are created using the Light-O-Rama Show Editor, and consist of sequences, which are
created using the Light-O-Rama Sequencer.  Scheduled shows are then played by the Light-O-
Rama Show Player.

To start the Schedule Editor, you can run it from your computer's Start Menu by selecting "All
Programs" -> "Light-O-Rama" -> "Light-O-Rama Schedule Editor".  Alternatively, if the Light-O-Rama
Control Panel is already running, you can right-click its icon in your computer's system tray, and select
"Schedule Editor" from the popup menu that will open.

For an overview of schedules, please refer to:

Schedules
The Weekly Schedule
The Calendar Schedule

For help on the Schedule Editor, please refer to:

Opening, Saving, and Reverting
Switching between the Weekly and Calendar Schedules
Adding a Show to the Weekly Schedule
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Adding a Show to the Calendar Schedule
Editing a Scheduled Show
Deleting a Scheduled Show

The Schedule Editor, showing the weekly schedule

Opening, Saving, and Reverting

Light-O-Rama maintains just a single schedule (with two parts - the weekly schedule and the
calendar schedule), so when the Schedule Editor starts, it automatically opens and displays the
current schedule.  Once you start editing it, however, the displayed schedule may differ from the
saved schedule.  So, after you have edited the schedule and are satisfied with the changes you
made, click the toolbar's Save button to save your changes.
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On the other hand, if you wish to discard your changes without saving them, click the toolbar's
Revert button instead.  Only the changes made since the last time that you saved will be discarded.

In order for the changes that you have made to the schedule to take effect, you must first save the
schedule.

Switching between the Weekly and Calendar Schedules

The schedule consists of two parts - the weekly schedule and the calendar schedule.  The Schedule
Editor only displays one of these two at a time, although both are always in effect.

When the Schedule Editor starts, it displays the weekly schedule.  You can switch to the calendar
schedule by pressing the toolbar's Calendar button, and you can switch back to the weekly
schedule by pressing its Week button.

Adding a Show to the Weekly Schedule

With the weekly schedule displayed, there are two ways to add a show to it:

Click the toolbar's Add button.
Click on an unscheduled area of the schedule and select "Add" from the popup menu.

Adding a new show to the weekly schedule

In either case, the Add Show dialog will open:
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The Add Show dialog for the weekly schedule

Opening the Add Show dialog by clicking on an unscheduled area, rather than by using the Add
button, has a couple advantages: First, it will automatically be populated with a start time and an
end time based on where you had clicked.  In the above example, the click was made at
approximately 6:30 AM, and so the start and end times were automatically set to 6:00 AM and 7:00
AM.

Second, it automatically takes into account conflicts between the new show and any existing
shows.  For example, if there were already a show scheduled starting at 6:45, the end time of the
new show would have automatically been set to 6:45 rather than 7:00.  Similarly, if a show had
already been scheduled at this time on Sunday, the "Sun" checkbox for the new show would have
automatically been unchecked.

To add a new show using this dialog, first select the name of the show file; it is easiest to do this
using the "..." button next to the File box, which will open up a dialog allowing you to choose among
the existing show files.

Next, choose the start and end time for the show, and then select the day or days of the week that
you wish this show to run.

Close the dialog by pressing "Add" (or "Cancel" if you no longer wish to add the new show), and 
save your changes by pressing the toolbar's "Save" button (or "Revert" if you wish to get rid of your
changes).

Adding a Show to the Calendar Schedule

With the calendar schedule displayed, there are two ways to add a new show.  In either case, first
select the day that you want to schedule the show for (by clicking that day in the calendar), and
then either:

Click the toolbar's Add button, or
Click on an unscheduled area of the schedule and select "Add" from the popup menu.
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Adding a show to the calendar schedule for March 15, 2008

In either case, the Add Show dialog will open:

The Add Show dialog for the calendar schedule

Opening the Add Show dialog by clicking on an unscheduled area, rather than by using the Add
button, has a couple advantages: First, it will automatically be populated with a start time and an
end time based on where you had clicked.  In the above example, the right-click was made at
approximately 3:30 PM, and so the start and end times were automatically set to 3:00 PM and 4:00
PM.

Second, it automatically takes into account conflicts between the new show and any existing
shows.  For example, if a show had already been scheduled to start at 3:45 PM, the end time in the
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above dialog would have automatically been set to 3:45 rather than 4:00.  Note that this conflict
checking is only done for other shows in the calendar schedule, not for shows in the weekly
schedule; this is because the purpose of the calendar schedule is to easily override the weekly
schedule for specific dates and times.

To add a new show using this dialog, simply select the show's filename (this is easiest using the
"..." button, which will let you choose from the list of existing shows), select the start and end times,
and "Add" (or "Cancel" if you wish to discard the new show).

Finally, remember to save your changes using the toolbar's "Save" button (or, if you with to discard
your changes, "Revert" instead).

Editing a Scheduled Show

No matter whether the weekly schedule or the calendar schedule is currently displayed, you can
edit a scheduled show by clicking on that show in the schedule, and selecting "Edit" from the popup
menu:

Editing an existing show

This will open a dialog very similar to the one you originally used to add the show.  It will allow you
to modify the name of the show file to be used, the start and end time, and, in the weekly schedule,
the days of the week that the show will run on.

Finally, remember to save your changes using the toolbar's "Save" button (or, if you with to discard
your changes, "Revert" instead).

You cannot edit the contents of a show - such as the sequences it uses - from the Schedule Editor.
 In order to do that, you need to use the Show Editor.

Deleting a Scheduled Show

No matter whether the weekly schedule or the calendar schedule is currently displayed, you can
delete a scheduled show by clicking on that show in the schedule, and selecting "Delete" from the
popup menu:

Deleting an existing show
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Note that this does not actually delete the show - it only deletes it from the schedule.  The show will
still be available for editing with the Show Editor, or for scheduling at some other time.

Finally, remember to save your changes using the toolbar's "Save" button (or, if you with to discard
your changes, "Revert" instead).

5.6.1 The Weekly Schedule

The weekly schedule is part of the schedule, saying which shows should be played when.  The other
part of the schedule is the calendar schedule.

The difference between these two parts of the schedule is that the weekly schedule allows you to
specify shows that should be played by the Light-O-Rama Show Player on a recurring, weekly basis,
while the calendar schedule allows you to specify shows that should be played by the Show Player
once, at a specific date and time.  For example, the weekly schedule would be used to have a show run
every Thursday between 5:00 PM and 10:00 PM, while the calendar schedule would be used to have a
show playing specifically on Christmas Eve.

Both parts of the schedule are created and modified using the Light-O-Rama Schedule Editor, and
shows in them are played at the scheduled times by the Light-O-Rama Show Player (assuming that
"Enable Schedule" has been turned on in the Light-O-Rama Control Panel).  The Show Player, when
deciding whether a show should be played, will first check the calendar schedule, and only play a show
from the weekly schedule if none is scheduled for the current date and time in the calendar schedule.

The following picture shows the weekly schedule, as displayed in the Schedule Editor, with two different
shows scheduled:

"Weekday Show.lss", run Mondays to Thursdays from 5:00 PM to 9:00 PM, and Fridays 5:00 PM
to 11:00 PM;
"Weekends.lss", run Saturdays from 1:00 PM to 11:00 PM, and Sundays from 1:00 PM to 9:00
PM.
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The weekly schedule, as displayed in the Schedule Editor, w ith some scheduled shows

For details on creating and modifying the weekly schedule, please see the Schedule Editor.

5.6.2 The Calendar Schedule

The calendar schedule is part of the schedule, saying which shows should be played when.  The other
part of the schedule is the weekly schedule.

The difference between these two parts of the schedule is that the weekly schedule allows you to
specify shows that should be played by the Light-O-Rama Show Player on a recurring, weekly basis,
while the calendar schedule allows you to specify shows that should be played by the Show Player
once, at a specific date and time.  For example, the weekly schedule would be used to have a show run
every Thursday between 5:00 PM and 10:00 PM, while the calendar schedule would be used to have a
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show playing specifically on Christmas Eve.

Both parts of the schedule are created and modified using the Light-O-Rama Schedule Editor, and
shows in them are played at the scheduled times by the Light-O-Rama Show Player (assuming that
"Enable Schedule" has been turned on in the Light-O-Rama Control Panel).  The Show Player, when
deciding whether a show should be played, will first check the calendar schedule, and only play a show
from the weekly schedule if none is scheduled for the current date and time in the calendar schedule.

The following picture shows the calendar schedule, with a show named "Christmas Eve.lss" scheduled
to be run on December 24, 2007 from 5:00 PM to 11:00 PM:

The calendar schedule, displayed in the Schedule Editor, w ith a show scheduled on December 24 at 5:00

PM
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For details on creating and modifying the calendar schedule, please see the Schedule Editor.

5.7 LOR Hub

Light-O-Rama Hub (or just Hub for short) is the new location in the LOR Software for all things Show
Related.  LOR Hub will eventually take over all functions of the LOR Show Player, LOR Show Scheduler,
Simple Show Builder, and SD Card creation - both simple and advanced.

Hub also enables our new 'MotionPak' technology.  When purchasing sequences from the LOR
Sequence Store, you'll also be able to purchase optional additional programming for things like Singing
Faces, Pixel Trees, and a host of other LOR Created props.  LORHub will then combine the MotionPak
with your sequence to automatically customize it.  

Hub is also one of the first fully internet integrated programs from LOR.  Hub can help you find
sequences and MotionPaks, as well as be dynamically updated to support new props in the future.

Hub is going to be continuously updated for the next several release cycles.  Currently LOR Hub
supports the following:  All Simple Show Builder functionality (Simple Show Builder is still available in
this release in case of issues with Hub, but will be removed in a future version), MotionPak Functionality,
new SD Card functionality.

Hub is not just a replacement for existing LOR programs as it also aims to improve on their functionality
and ease of use.  For example in this release is the ability to now EDIT SD cards without the need to re-
create an entire show.  This allows you to move sequences around on an SD card show, remove some,
add new, and update existing ones from the computer.  Cards must have been created with Hub or a
newer version of Hardware Utility to be edited - not all Hardware Utility MP3 functions are currently
supported.

Where possible, we try to make things simple and familiar.  For example if you have been creating
shows that run from a computer and now wish to start using an MP3 director, you will already be familiar
with how to add sequences and schedule the show.

5.7.1 Creating Shows and SD Cards

In the future, Hub will be your one-stop-shop for creating and scheduling all shows - computer and MP3
Director based.  Currently Hub has replaced all the functionality of the old Simple Show Builder.  If you
have previously used SSB to create your show, you should begin using Hub.

Hub can create and schedule shows for both Computers as well as LOR MP3 Directors.

5.7.1.1 Run from Your Computer

For building simple Computer based shows, like the ones that were previously created by Simple Show
Builder, use the HUB Computer Show Builder.  For complex computer-based shows, continue to use the
LOR Show Editor and LOR Show Sceduler (which can be accessed from buttons in Hub).  In a future
release, Hub will incorporate all functions of Show Editor and Show Scheduler.
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Please remember that if you have an existing show or schedule, they will be replaced by what you
create here.  If you have used the Show Editor or Schedule Editor programs, you should continue to use
them instead.

On the left side are all of the sequences that are available on your computer in the specified directory.  If
your sequences are not located in your Light-O-Rama data directory, you can press the 'Change
Directory' button to move to another folder on your computer.

Sequences are displayed with either [anim] or [music].  Anim are ANIMATION (.las) sequences.  Music
are of course MUSICAL (.lms) sequences.  

Select one or more sequences on the left and press the "+" button.  The sequences will then be added
to the show you are creating on the right side.

To remove a sequence from the show, select it on the right side and press the "X" button.  This removes
the sequence from the show, but does not delete the sequence from your computer.

To change the order of sequences that are played in your show, select a sequence on the right and use
the UP or DOWN arrow buttons.

You can schedule this show to run at up to 2 different times.  If you want the same schedule all 7 days a
week, select 'Same All Week' and set the time.

If you would like to have 2 different show start/stop times, select 'Separate Weekday and Weekends'. 
You can then select which days are considered 'Normal' and what days are considered 'Weekend' and
set different times for both.  Please note that even though we say 'weekday and weekend', you can
select any days for either schedule.  to change the time for a schedule, click the times.  You will then
be able to change the schedule times:

Next, choose whether you want the show to run continuously, or once every hour or every half hour.  If
you select "continuously", then after all of its sequences have been played, the show will automatically
start over with the first sequence; this will continue until the end time is reached.  If, instead, you select
"once every hour" or "once every half hour", the show will stop after its last sequence, and start again
once every hour (or half hour), until its end time is reached.
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If you select Every 30 or Every 60 minutes, you can also choose what happens between shows.  'Lights
On', 'Lights Off', or 'Slowly changing'.  Please note that these options will only control a limited number of
controllers, so not all of your lights may come on.

Pressing OK will create your show as well as schedule it for the times you selected.  Please do not
forget that you will need to load the LOR Control Panel and 'Enable Shows' for your show to start.

5.7.1.2 Run from an MP3 Director

For building simple MP3 Director based shows, like the ones that were previously created by Simple
Show Builder, use the HUB Director Show Builder.  For complex computer-based shows, continue to
use the MP3 Tab of the Hardware Utility.  In the future, Hub will support all MP3 director options.

5.7.1.2.1  Creating a new  SD Card Show

Please remember that for this initial release, Hub can only create simple SD cards much like the Simple
Show Builder.  Please see the Light-O-Rama MP3 Directors topic for more information on how SD cards
are created.

Before starting to create a new SD card show, please first insert the SD card you would like to use into
your computer's SD card reader/writer.  This will allow Hub to search for the card and correctly identify
the drive.  If you forget to insert the SD card, Hub will remind you:

When creating a new SD card show, the first thing you will be asked is which type of MP3 director you
are using:
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You should select the option for the MP3 director you own.  LOR Showtime Central controllers all use
the Mini Director, so you should select that.  If you are unsure of which director you have, select 'Help
Me Choose'.  Hub will then show and describe the Show Directors we sell and have sold in the past so
you can decide.

Next, you will be asked to verify the correct drive for your SD card, as well as select the show you will be
creating.  Hub will attempt to correctly identify the drive, however you should always double check to
ensure that you are using the correct location on your computer.  

If you insert a different SD card into your computer, please press the 'refresh drive list' button.

Show Selection

Up to nine shows can be downloaded to an SD card, and each will be assigned a number between 1 and
9.  If two shows are scheduled for the same time, the lower numbered show will be played.  Mini
Directors do not have a time clock and so the lowest show number will always be played.  For this
reason if you have a Mini Director, it is best to only ever create 'Show 1' to avoid confusion.

Once you have confirmed your selections, the main screen will be shown:

Here you will be able to add and change the order of sequences to be built for your show.  If you have a
Deluxe Show Director, you can also optionally schedule when the show should play.  Mini Directors do
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not have a time clock and so the schedule is not displayed.

On the left side are all of the sequences that are available on your computer in the specified directory.  If
your sequences are not located in your Light-O-Rama data directory, you can press the 'Change
Directory' button to move to another folder on your computer.

Sequences are displayed with either [anim] or [music].  Anim are ANIMATION (.las) sequences.  Music
are of course MUSICAL (.lms) sequences.  Animation sequences are sorted to the top, followed by
Musical sequences.

Select one or more sequences on the left and press the "+" button.  The sequences will then be added
to the show you are creating on the right side.  You can duplicate a sequence onto the SD card as
many times as you like (up to 99)

To remove a sequence from the show, select it on the right side and press the "X" button.  This removes
the sequence from the show, but does not delete the sequence from your computer.

To change the order of sequences that are played in your show, select a sequence on the right and use
the UP or DOWN arrow buttons.

Schedule (for Deluxe Show Directors only)
If you have a Deluxe Show Director, you can also optionally set a schedule for when this show should
run.  

To create a show that runs whenever the MP3 director has power (and the card is inserted), the button
in the schedule section should say 'Schedule Ignored'.  
To create a show that runs on a schedule, press the button.  The button will then say 'Run the Show
on this Schedule", and the days/times will be enabled.

To change the scheduled start/stop time, click on the times under the day you wish to change.  The
change time dialog will then be shown:
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Select the start and end time you desire.  If you would also like to quickly set other days to the same
schedule, click the boxes at the bottom (the day you initially clicked is always selected and can not be
un-selected).

Writing the SD Card
Once you are satisfied with the sequences to be created on the SD card as well as their order, press
either Create SD Card - Simple Mode or Create SD Card - Advanced Mode.

Simple mode will create an SD Card for 90% of situations.  It will use a single port of your MP3 director
at a default speed that should work with all controllers and sequences.
Advanced mode allows you to customize how the SD card will be written.  You should use advanced
mode if your display contains pixels, DMX channels, or Intensity Files (Enhanced LOR protocol).  

While writing the SD card, you will see the SD Card status screen:

It may take several minutes per sequence to create your SD card.  Once complete, you will see this
message:

5.7.1.2.2  Editing an SD Card Show

Hub, unlike the other programs in our suite, allows for the editing of previously created SD cards without
the need to completely re-build them from scratch.  In order to use the editing functionality, the SD card
must have been previously created with Hub.  If the card was not created with Hub, you will need to
create a new show the first time.  You can then start to use Hub's SD card editing features.

Before starting to create a new SD card show, please first insert the SD card you would like to use into
your computer's SD card reader/writer.  This will allow Hub to search for the card and correctly identify
the drive.  If you forget to insert the SD card, Hub will remind you:
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Next, you will be asked to verify the correct drive for your SD card, as well as select the show you will be
creating.  Hub will attempt to correctly identify the drive, however you should always double check to
ensure that you are using the correct location on your computer.  

Only shows that can be edited will be listed here.  If a show is not listed here that is on  your SD card,
that show was created with either the Hardware Utility or the Simple Show Builder and does not have the
required data to be edited.  You will need to re-create that show as new.

If there are no shows found on an SD card that can be edited, Hub will warn you:

Once you have selected a show to edit, the familiar add/change sequence screen will be shown
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The sequences on your computer are shown on the right, the sequences in the order they play on the
SD card is shown on the left.

There are several important things you need to be aware of:
1. The * in front of a sequence name on the SD card side means the sequence cannot be found in

the folder on your computer where it was originally created from.  You may have deleted the
sequence on your computer.

2. For each sequence on the SD card, Hub will verify that sequence still exists in the same folder
as it did when the SD card was created.  The * in front of a sequence name on the SD card side
means the sequence can not be found.  If you move that sequence, even to a folder that is
currently displayed on the right, hub will not be able to update the sequence when you write the
SD card.  You should always keep your sequences in the Light-O-Rama Sequences directory.

3. For any sequence with a * on the SD card side, if you remove that sequence from the SD it is
lost.  In order to re-create that sequence you MUST have the original sequence.  You can still
move the sequence in the show, or duplicate it on the SD card, but once removed it is gone. 
Before removing, you will be warned and asked if you really want to remove the sequence or not.

4. Once an SD card is created, there is no indicator on the card if it is for a Deluxe MP3 director, or
a Mini Director.  Even if you edit an SD card and turn ON scheduling, the Mini director will run
the show whenever there is power. Mini Directors ALWAYS ignore a schedule.

Here you will be able to add and change the order of sequences to be built for your show.  If you have a
Deluxe Show Director, you can also optionally schedule when the show should play.  Mini Directors do
not have a time clock and so the schedule is not displayed.

In the Sequences Available for SD Card Show, you will find a list of all sequences that can be added
from your computer or duplicated from the SD card.  The list is first sorted by sequences available on the
computer, and then by sequences already on the SD card.  Within those sequences are sorted based
on if they are Animation or Musical.  You may think it is strange to include sequences already on the
SD card in the available list.  However, this allows you to duplicate any sequence already on the SD
card - including ones where you may no longer have the source (.LMS or .LAS).  If your sequences are
not located in your Light-O-Rama data directory, you can press the 'Change Directory' button to move to
another folder on your computer.  

Sequences are displayed with either [anim] or [music].  Anim are ANIMATION (.las) sequences.  Music
are of course MUSICAL (.lms) sequences.  Animation sequences are sorted to the top, followed by
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Musical sequences.  PC is a sequence located on your computer.  SD is a sequence located on the SD
card show.

Select one or more sequences on the left and press the "+" button.  The sequences will then be added
to the show you are creating on the right side.  You can duplicate any sequence as many times as you
like (up to 99)

To remove a sequence from the show, select it on the right side and press the "X" button.  This removes
the sequence from the SD card show, but does not delete the sequence from your computer.  If you
attempt to remove a sequence that can't be found, you will be warned.

To change the order of sequences that are played in your show, select a sequence on the right and use
the UP or DOWN arrow buttons.

Schedule (for Deluxe Show Directors only)
If you have a Deluxe Show Director, you can also optionally set a schedule for when this show should
run.  If the SD card was created with a schedule, the current schedule is displayed.

To change to a show that runs whenever the MP3 director has power (and the card is inserted), the
button in the schedule section should say 'Schedule Ignored'.  
To change to a show that runs on a schedule, the button should say 'Run the Show on this Schedule",
and the days/times will be enabled.

To change the scheduled start/stop time, click on the times under the day you wish to change.  The
change time dialog will then be shown:

Select the start and end time you desire.  If you would also like to quickly set other days to the same
schedule, click the boxes at the bottom (the day you initially clicked is always selected and can not be
un-selected).

Writing the SD Card
Once you are satisfied with the sequences to be created on the SD card as well as their order, press
either Create SD Card - Simple Mode or Create SD Card - Advanced Mode.

Simple mode will create an SD Card for 90% of situations.  It will use a single port of your MP3 director
at a default speed that should work with all controllers and sequences.  All sequences from the existing
SD card that were also found on the computer will be automatically updated on the SD card.  

Advanced mode allows you to customize how the SD card will be written.  You should use advanced
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mode if your display contains pixels, DMX channels, or Intensity Files (Enhanced LOR protocol), or if
you wish to select which sequences on the SD card are updated.

While writing the SD card, you will see the SD Card status screen:

It may take several minutes per sequence to create your SD card.  Once complete, you will see this
message:

5.7.1.2.3  Advanced SD Card Wizard

When using Advanced Mode to create an SD card, either by creating a new show or editing an existing
show, the SD Card Wizard will appear.  Depending on the Director selected, if this is a new show or not,
and other options, some of these steps may not appear or some options may not be available.

When editing an SD card, the options here will default to the options of the current show on the card.

Step 1 - Update existing sequences or not

When creating a new Sequence, there is nothing that needs to be done here, just press NEXT
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If you are editing a show you will be asked if you would like to update the existing sequences on the SD
card or not:

Selecting Yes will search your computer for the sequence originally used to create the SD card.  If it is
found, any changes in the sequence on the computer will be moved to the SD card.  This is
recommended.
Selecting 'Ask' will prompt you for each sequence that is found on the computer that is also on the SD
card.  There you can select yes or no.
Selecting 'no' will leave the existing sequence on the SD card as-is.  No changes from the computer for
that sequence will be moved.

Step 2 - Currently Unused

As of this release there is nothing to be done at step 2, so it is always skipped.  In a future release this
will be where you will view/add triggers, starter or filler sequences, etc.

Step 3 - Generation and Ports

If you have a G3MP3 director, select the check box here, and then specify the number of ports for your
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director. 

Step 4 - Port information

This is what LOR Networks and/or DMX Universes the SD Card Wizard will write to the card, based on
the priority system.  This is informational only, there are no changes to be made here.

Step 5 - Misc Options

Here is where you can specify different options that your show or hardware may require.  For most
people, the defaults are OK:
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Lock Step: If you have a very large display, selecting "lock step" may help the different controllers
used in the display react with a higher degree of synchronization.  This is not supported on all
controller types, and the level of firmware in the controllers must be 3.0 or higher.

Set MP3 player's internal clock: If you wish to add a file to the SD card to set the MP3
director's internal clock, check the box that says so.  Note that there are also other ways to set
the director's clock.

Strip MP3 Header Information:  Some MP3s may have a large data block before the actual
music data.  For example, an MP3 may have several high-resolution pictures in its ID3 Tags.  The
MP3 director will correctly ignore this data, however it does take time to find the actual start of the
music file.  Stripping this data will allow the MP3 director to start playing the sequence faster.

Keep lights ON at end if using DMX:  Previously if one or both ports were controlling DMX
Universes the MP3 director would always shut off all the lights.  Checking this box will allow
channels in DMX universes controlled by the MP3 director to remain in the last state they were
sent.  If you leave a light on at the end of a sequence, that light will remain on until the start of the
next sequence.

Show can not be interrupted by input triggers:  Once this show has started on the MP3
director, pressing an input will not interrupt the show - it will run to completion.

Advanced Throttling Options:  The advanced options button will bring up an additional window
that allows you to change parameters which relate to how data will be transmitted from your MP3
Director.  Unless a specific issue is preventing your MP3 Director from working correctly, you
should not change these options.

Step 6 - Director Port Settings

Communications port setup is done on step 6.
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For each port your director has, you will be presented these options.  So for example if you have a
G3MP3 Dual Network director, you see this dialog twice.  Once for the fist physical port, and then again
for the other physical port.  Depending on the type of equipment you have, your LOR license level, and/or
the contents of your sequence, one or more of the options here may not be available to you.  

If a port is using LOR devices:
Select the communications speed that will be used to broadcast lighting commands.  The
recommended setting (57.6) will suffice for many users' displays.  If you have many controllers
that are far distances apart, a slower speed may help; if your sequences use many rapid lighting
commands, a faster speed may help.

G3 directors (and higher) have additional speeds of 500K and 1000K available.  The 500K
speed is approximately four times faster than the previous high speed of 115.4K, but is only
supported on Generation 3 (G3) devices with updated firmware.

The 1000K speed can ONLY be used with networks that only contain PixCon16 controllers or
Pixie family controllers.  No other LOR controllers support 1000K.

For directors that have multiple ports, you can specify a different speed(s) for each port.  The
MP3 Director will keep both networks synced even if your show uses multiple ports at different
speeds.

If your license supports Enhanced LOR Protocol and you are creating a card for a G3 or above
director, an additional option may be available depending on the first sequence loaded.  If the
first sequence has both Normal LOR and Enhanced LOR commands available, you can select
if you want BOTH to be written to the card (checked), or if you only want Normal (unchecked)
commands written.  If you do not have a G3 controller, or you do not have a license that
supports Enhanced LOR protocol, or if your sequence does not have both types of networks,
then this option is not available.  There is no option that will allow for only Enhanced
commands, even if your sequence has both available.

If a port is using DMX devices
DMX Universes run at a fixed speed, and therefore the options to change port speed are not
available.
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Final Step - Creating the SD Card

This final step will allow you to review how the SD card will be configured when written.  If you are
satisfied, press the 'Create SD Button'.

5.7.1.2.4  Throttle Parameters

While writing your show to the SD card for an MP3 player, the Hardware Utility will automatically
monitor how much bandwidth is required by your sequence every centi-second.  When the
bandwidth is exceeded, the program can 'compress' your data so that your music and lights stay
better in sync.  The advanced options window allows you to turn this functionality on/off or adjust its
parameters.

Please note that changing these parameters can cause your show to fall out of sync, have
unacceptable delays, or cause other issues.  You should only change these if you are
having issues with the defaults, and even then be prepared to restore to the defaults should
your show fail.  For 99.9% of shows, these defaults are already optimized.
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The Advanced Parameters w indow

Throttle Data Output for Improved Performance:  It is recommended that this option remain
ON (checked).  When checked, your sequence is monitored.  For each centi-second that passes,
the program will compute the amount of bandwidth required and compare it to the amount
available.  If unchecked, no throttling is done - this is the same mode as versions previous to
3.12.0.

Minimum Throttle Time in CS:  If throttling is enabled, this is the minimum amount that the
sequence must be behind before compression starts.  For example, if this is set to 5 CS, then
once the sequence is 5 or more centi-seconds behind the audio, compression will begin.   Setting
this higher will allow for more complex areas of your sequence to remain uncompressed at the
expense of lagging further behind your audio. The default value is 1, and this means that as soon
as the sequence falls behind, compression should begin.  

Buffer Flush Time in CS:  This can be thought of as the 'resolution' that your MP3 Director will
run at.  Setting the value lower will increase resolution as well as network load.  Setting the value
higher will decrease network load at the expense of having more commands be compressed.  The
default value of 2 most closely emulates what a computer produces for output, either in the 
Sequencer or the Show Player, when running a sequence on your hardware.  For versions before
3.12.0, this value was 1.

MP3 Director Network Efficiency:  MP3 directors will typically use 100% of the bandwidth that
is available for a port.  Setting this to a lower percentage reduces the amount of throughput, which
will cause more throttling to happen.  It may be best to think of this option as a reduction in the
network speed.  For example, if you set a port to 57.6K speed, and set this option to 70%, then
the hardware utility will throttle the sequence as if it was for a network that runs at approximately
40.3K (57.6 * 70%).
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5.7.2 Applying and Using MotionPaks

MotionPaks are the exciting new way to customize your LOR purchased sequences.  MotionPaks allow
you to add programming for custom props that you build or purchase from Light-O-Rama.

For example, LOR sells 'Singing Faces' - ready-to-go items for your display.  Once you have purchased
the hardware prop, from our sequence store you can purchase the programming to make them work. 
LOR Hub will then take the MotionPak and combine it with your sequence.  You will only ever have to
pay for programming you want, saving money.

MotionPaks are a lot like sequences - but they only contain the programming for specific elements.  You
use LOR Hub to combine the MotionPak with the existing Base Sequence

5.7.2.1 LOR Sequences

Sequences are the programs that make your show work.  The Light-O-Rama software allows you to
create your own sequences, or you can purchase ready made sequences from our sequence store.

Purchasing sequences from our sequence store makes having a show a breeze!  Our sequences are
designed to get you off to a fast start and to make you look great!  Once you have purchased a
sequence, you can customize it with MotionPaks - additional programming for additional display items
to make your show unique!  

To see what sequences are available, press the 'Shop for Sequences' button in Hub.

5.7.2.2 LOR Hardware Props

While it is possible to create your own Props and use them with MotionPaks, the easiest and fastest
way to add a new dimension to your show is to purchase the prop from Light-O-Rama.

Light-O-Rama props are pre-configured to work with MotionPaks and Light-O-Rama sequences right from
the box.  Simply connect your new prop to your existing controllers with a CAT-5 cable, purchase and
download the MotionPak for each sequence in your show for that prop, press the 'Scan For MotionPaks'
button in hub, then 'Do it!'.  All of your sequences are updated and it just works!

To see the props available from Light-O-Rama, press the 'Shop for Props/Hardware' button in Hub.

5.7.2.3 LOR MotionPaks

MotionPaks are what bring unique display elements to life.  These are not 'sequences' in themselves as
they do not contain the programming for any other part of your show - you will need to already own (or
purchase) the 'Base Sequence' from the Light-O-Rama sequence store.

The 'Base Sequence', usually just called the 'Sequence' contains all the main commands for a particular
song.  If a MotionPak is available for that particular sequence, it adds additional programming to make
things like singing faces or pixel trees work.  A MotionPak is unique to the sequence it is for, as well as
for the prop it is made to control.  For example, you could have the sequence "A Mad Russians
Christmas" by TSO in your show.  There could be several different MotionPaks available for that
sequence - one for singing faces, another for a pixel tree, and perhaps even one for a pixel screen.  You
only need to purchase the MotionPak(s) for that sequence for the prop(s) you own.  And remember that
the 'Singing Face' MotionPak for this sequence is not the same as a MotionPak for a singing face for
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"Hard Candy Christmas" by Dolly Parton.

5.7.2.4 Updating Sequences with MotionPaks

You use Light-O-Rama Hub to combine the programming of a MotionPak with an existing LOR
Sequence store sequence.  If you have not made any changes to your sequences or props purchased
from Light-O-Rama, the process is very simple.

First, be sure that your Light-O-Rama base sequences (the files with the main programming for a
sequence) are all in the Light-O-Rama Sequences directory.

Next purchase and download the MotionPak(s) you would like for the sequences you already own.  You
can always purchase a new sequence and then install a MotionPak.

In Hub, press the 'Scan/Apply MotionPaks button'.  When you do, Hub will look to find all new
MotionPaks since the last time you ran the scan.  When it is done looking you'll see something like
this:

In this case Hub has found 3 new MotionPaks, along with their associated 'Base' sequence.  For most
people, simply press 'Perform Selected Action' to continue.  Otherwise to the left of each MotionPak are
3 options you can select from:

1. Apply MotionPak - Updates your base sequence with the MotionPak programming
2. Skip This Time - Does not update the base sequence.  The next time you scan for MotionPaks,

this one will re-appear
3. Don't Ask Again - Does not update the base sequence, and the Motion Pak will not re-appear in

a scan.  See Reset Scan for why you may need this option.
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For each MotionPak that you apply, you'll be presented with some information about it:

If you did not make any changes to your LOR Prop or LOR Sequence, simply press 'Do It!'.  Your
Sequence will be updated with all the commands from the MotionPak, and the job is complete.

If when applying a MotionPak Hub finds more than one sequence that could be the base sequence, you
will be asked to select the correct one.

In this case, there are 4 sequences in the Sequences Directory that are matching up to the MotionPak.
 Please select the correct one and press the OK button.

If you need to change the default settings of a MotionPak, for example you changed the Unit ID of the
prop, press the 'Advanced Options' button.  Here you can change the network and unit ID of the
MotionPak to match your hardware.
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In this case, the show has 2 LOR networks and the Singing Faces prop for the MotionPak is on Aux A
(rather than REGular)

5.8 Simple Show Builder

Simple Show Builder has been replaced with LOR Hub

The Light-O-Rama Simple Show Builder is an alternative to the Show Editor and the Schedule Editor,
allowing you to create shows and to schedule them to be played at certain times.  While the Simple
Show Builder is easier to use, the Show Editor and the Schedule Editor are more flexible and powerful.

The Simple Show Builder progresses, step by step, through a few screens:

First, a "Welcome" screen is displayed, giving some brief instructions on what you will need to have
ready in order to use the Simple Show Builder.

Next, you are given a choice of what type of device type you want to use for your show.

Then, you can select the sequences that you want to use for the show.

Next, you can pick the time or times that the show should run at.

If you chose to use an MP3 device, you will then be asked to insert your SD card into your SD card
reader/writer, and to tell the Simple Show Builder when you have done so.  Your show will then be
downloaded to your SD card.

Otherwise, you will be presented with a final screen, showing some directions on how to enable the
Show Player to run the show that you have just scheduled.

Welcome

The first screen in the Simple Show Builder shows a list of things that it would help to have ready
before you use it.  After you have these things ready, simply click "Next".
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The Simple Show Builder's welcome screen

Choose the Device Type

The next screen in the Simple Show Builder allows you to select the type of device that you want to
control your show.  You can run it from your PC (using the Light-O-Rama Show Player), or any of a
few types of Light-O-Rama MP3 devices.  Choose the device you wish to use, and click "Next".
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Select the device type that w ill control your show

Select Sequences

The Simple Show Builder will next ask you which sequences you wish to use in the show.  On the
left is a list of your existing musical sequences  - either those with 16 channels, those with 32
channels, or all of your musical sequences, based on your choice of the radio buttons at the bottom
(note: this is not really based on the number of channels; it is based on "16" or "32" being contaied
in the sequence's filename).

Add a sequence to the show by highlighting it and then clicking the "Add" button; this will move the
show from the left pane to the right pane, which is the list of sequences in your show.  Similarly,
remove one from your show by highlighting it and clicking "Remove".

The sequences will be played in the order that you list them, but you can change the order simply
by clicking on the "Up" or "Down" arrow (on the right-hand side).

When you are satisfied with the sequences in your show and their order, continue by pressing the
"Next" button.

Note that if any other than "Use a PC" is selected, only effects on channels that are set up to use
the Regular Light-O-Rama network will be downloaded.

Note that only musical sequences can be scheduled using the Simple Show Builder.  If you wish
your show to have animation sequences, you must instead use the Show Editor and the Schedule
Editor.
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Select the sequences to be played in your show, and the order they w ill be played in

Choose the Times

The Simple Show Builder will then ask you to select the times at which you want your show to run. 
You can have different times for up to two different sets of days of the week.  You can select any
days you want to be in either set, but typically this is used to have your show played during different
times on weekdays and weekends.  Note that "weekends" here might mean "Friday and Saturday",
rather than "Saturday and Sunday", since your show will probably be playing while it's dark out, and
so "weekend" is really "the night before a weekend day".  In fact, this is how the Simple Show
Builder operates by default, but again, you can change this however you want.

After selecting the days of the week, select the start and end times for each.

Next, choose whether you want the show to run continuously, or once every hour or every half hour.
 If you select "continuously", then after all of its sequences have been played, the show will
automatically start over with the first sequence; this will continue until the end time is reached.  If,
instead, you select "once every hour" or "once every half hour", the show will stop after its last
sequence, and start again once every hour (or half hour), until its end time is reached.

When you are satisfied with the scheduled times, click "Next". 
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Select the times that you want the show to run at

Download to the SD Card

If you had asked the Simple Show Builder to control your show via a Light-O-Rama MP3 device,
rather than via the Show Player on your computer, you will then be prompted to insert your SD card
in your SD reader/writer.  When you have done so, click the large "CLICK HERE to write the SD
card" button, and wait for confirmation that your show has been written to the SD card.

The Simple Show Builder is then complete; simply move your SD card to the Light-O-Rama MP3
device, and the sequences that you selected will play at the times that you selected.
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Download the show to your SD card

Finished

If you had asked the Simple Show Builder to control your show via the Show Player on your
computer, rather than via a Light-O-Rama MP3 device, you will be presented with a final screen
giving directions on how to enable the Show Player.  After you have read and understood them,
simply click "Finish", and your show will be scheduled.
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Final directions from the Simple Show Builder

5.9 Show Player

The Light-O-Rama Show Player is a program that runs behind the scenes, monitoring your schedule to
see if a show should be playing at the current time, and if so, playing it.

To make sure that the Show Player is running, and therefore that your scheduled shows will be played,
you first must ensure that the Light-O-Rama Control Panel is running.  Next, right-click on the Light-O-
Rama Control Panel's icon in your computer's system tray, and select "Enable Schedule" from the
popup menu.  If "Enable Shows" is greyed out, that means that it is already selected.
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The Light-O-Rama Control Panel, w ith shows enabled

If the Light-O-Rama Control Panel is not running, or if "Disable Shows" is greyed out, your scheduled
shows will not be played.

Note that only one source can control your lights at any time - either the Show Player, the Sequencer,
or the Hardware Utility.  So, if you try to enable the Show Player with one of the others running, you may
be shown a message saying that you need to shut down the others before "Enable Shows" will work.

5.10 Network Preferences

Light-O-Rama software running on a computer can control several different types of hardware
devices via several different methods. In most cases, the devices are connected to the
computer via a serial port (if your computer does not have any available serial ports, adapters
such as the USB-RS485 are available from Light-O-Rama).  Light-O-Rama also supports E1.31/
ACN, which allows for control of various devices via Ethernet and a gateway device, and various
other types of hardware.

Typically, Light-O-Rama controllers are on up to sixteen different serial ports - that is, sixteen different
"networks".  In many cases, a Light-O-Rama user will use only a single network -- that is, a single serial
port -- for all of his or her controllers: the "Regular" network.  Should additional networks be needed,
fifteen auxiliary networks ("Aux A", "Aux B", and so on, up to "Aux O") are also available, each of which
would be controlled via a different serial port.

The Light-O-Rama Network Preferences program allows you to configure all of these Light-O-Rama
networks, as well as configure various other communications networks such as DMX universes.

The Network Preferences program has two operating modes: "Simple" and "Advanced".  Most users will
only need the Simple mode.  The Advanced mode is only needed by users who have more than sixteen
DMX networks, or users who have E1.31 devices.  To change between modes, use the button on the
right side marked "Simple" or "Advanced".

The Network Preferences program is also used to configure Light-O-Rama E1.31 devices, like the
PixCon16.
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Simple Mode
Advanced Mode

The Light-O-Rama Network Preferences program

5.10.1 Configuring LOR E131 Devices

E1.31 devices, like the PixCon16, are usually used for high channel density configurations.   For
example, a fully populated PixCon16 can control over 10,000 channels across 20 DMX universes.  Using
just a few of these controllers can quickly saturate a Local Area Network (LAN).  Improperly configured
networks can also generate additional traffic.  Unlike the traditional LOR network of controllers which are
run on a serial port, using E1.31 devices may require advanced knowledge of TCP/IP routing and
configuration.  

E1.31 devices may also negatively impact an existing LAN with the additional traffic.  Light-O-Rama
recommends that you run E1.31 devices on a separate physical network from your home or office LAN. 
 If you are knowledgeable in TCP/IP and/or Ethernet devices, you may be able to successfully run your
existing devices and the new E1.31 devices by segregating your network, running multiple adapter
cards, etc.  How to successfully do that however is beyond the scope of this documentation.

5.10.1.1 E131 Device List

The E1.31 device list will show all detected LOR E1.31 devices found on the network.  The E1.31
devices should be powered up before accessing the list.  If there are any missing devices, be sure they
are powered up and press the 'Search Again' button.

Under some circumstances, the program may not be able to detect all the controllers connected to your
LAN.   This can be due to multiple issues since the routing and configuration of TCP/IP can be tricky:

Typically if a previously found device can no longer be found, it may simply have missed the
command for it to report in.  Pressing 'Search Again' will usually find the missing controller.  It
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could also be that the network is currently saturated with lighting commands.  You may want to
stop any running show before attempting to configure a E1.31 device.

If this is the first time you are configuring a board, or if you changed the configuration of your
network, the device may no longer be on an IP that you are expecting.  In that case, you may
want to reset the board to factory specifications.  This will then place the board into 'DHCP' mode
where it will request an IP from your network.  This requested IP should then be able to be found
with the program.  Please note that resetting the board will clear all of your configuration
information, and you will need to re-configure the board.

Your board may also be in a state which is preventing it from booting up properly.  If that is the
case, you will need to place the board into boot-loader mode using the switch.  The boot-loader
mode will force the board to the IP address of 192.168.0.50.  Please see the hardware manual for
the board for more information about boot-loader mode.

The LOR E1.31 device list

The E1.31 device list shows the current IP address of the board, the board's type, as well as its user
assigned name and MAC address to help you identify the actual physical hardware.
When you click a row in the E1.31 device list, you will be brought to the configuration screens for that
particular board.  Remember, boards that are shown in red can not be configured, and those in blue
must first have firmware loaded to them.

Depending on the status of a particular E1.31 device, the list will be shown in one of 3 background
colors:

Red:  Devices listed in RED can not be configured.  Either these devices are not manufactured by
LOR, or are at a firmware level that is not supported by the software.  

Blue: Controllers listed in blue are currently in 'boot-loader' mode.  That is, they are awaiting
firmware to be sent to them.   Clicking on a blue device will bring you to a screen that will allow
you to update the firmware.

White: Any controller listed in White is operating normally and ready to be configured.  Clicking
on a row in white will bring up one or more screens allowing you to configure the device.
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5.10.1.1.1  IP Troubleshooter

The E131 Device List will show all LOR E1.31 devices that can be found on the local network.  However
those devices could be at IP addresses that can not be directly configured from the computer you are
attempting to use due to with how TCP/IP packets are routed.  More information on routing and setup
can be found in our "An Introduction to DMX and E1.31 for Pixel Control" document found on the LOR
Website.

If you click on a board whose configuration can not be loaded, you will be offered the opportunity to run
the IP Troubleshooter.  This troubleshooter will look at the configuration of your E131 device as well as
the network configuration of your computer and attempt to resolve the issue.  

You may need to run the troubleshooter multiple times as it may need to configure several different
parameters.  

The following messages can be generated by the Troubleshooter:

This is not an LOR PixCon16 device.  Please contact the board manufacturer.
This device while presented in the list of devices is not manufactured or supported by LOR.  You will
need to contact the manufacturer of the device for more information.

This device needs to have firmware loaded.  Please follow the device 's instructions on how
to update firmware.
The device is currently awaiting a firmware load.  IP Settings can not be changed while the board is
waiting for new firmware.  Power the board off then back on and see if it boots normally, then try again.

This version of the software does not know how to handle a device with this firmware
version.  You most likely need to update your LOR Software.
The Light-O-Rama Showtime Software suite in use is too old.  This is most likely because the
firmware on the device is newer than what the software can understand.  You will need to either
downgrade the firmware, or install the latest version of Showtime.  Installing the latest version of
Showtime may require a license renewal.

This troubleshooter will allow you to configure the board when directly connected to the
computer.  However if you plan on using E1.31 and later move this board to a network with a
router/switch it may no longer be able to communicate.  You should connect the board and
the computer in the configuration you will run shows in, then run the troubleshooter.
You said that you are directly connected to the board instead of connected through a switch or router.
 If you intend on running in this configuration, OR if you intend on eventually running the board in
ELOR mode, you can ignore this message completely.  If however you intend to use the board on a
network with other computers and/or E131 devices, you should connect them in the configuration you
intend on running them in.

Your computer is using Dynamic IP addresses.  Have you tried setting the board to run a
Dynamic Address as well?
The Troubleshooter has determined that your computer is using a DHCP address, and that your board
should be using one as well.  Answering NO will force the board to use a DHCP address.  Answering
YES will continue the troubleshooter.  You should initially allow the troubleshooter to set the dynamic
IP by answering NO.

Troubleshooter 1-Force DHCP failed.
You indicated that you wanted to use a dynamic IP address, however while attempting to set that
parameter something went wrong.  Run the Troubleshooter again, and if you get the same error,

http://www1.lightorama.com/documentation/
http://www1.lightorama.com/
http://www1.lightorama.com/
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please contact support and include the error message.

Setting the board to Dynamic should have fixed the issue.  Are you sure you selected the
correct adapter?  Many computers have multiple adapters which can all have different IP
addresses.
You indicated that you previously set the board to use a dynamic IP address, and that should have
fixed the error.  However the computer is still not able to communicate with the board.  This could be
that you selected a network adapter in the drop down that is not connected to the device.  Be sure
you have selected the correct adapter.

Have you rebooted your entire network?  If not shut down and power off ANY device that is
connected to your LAN (Computers including this one, Lighting Controllers, Hubs/Switches/
Routers, TVs and Media Players,etc).  Reboot your router, and then turn your network
devices back on.
You indicated that you have in fact selected the correct adapter.  The Troubleshooter now wants you
to reboot your entire network (LAN).  That includes ALL devices that are attached to the LAN including
devices that are not lighting controllers.

As a last resort, would you like to try to set a static IP address?
You indicated that you rebooted the entire network but are still unable to communicate with the board.
 The troubleshooter can attempt to set a Static IP address to see if that will help.

Troubleshooter 2-Force DHCP negative.
The reboot failed, and you indicated you did not want to force a static IP.  This will prevent the board
from being able to be configured.

Your adapter is using a Static IP address.  Your board should probably be using one as well.
 We can force a new IP onto the board which may fix the issue.
Your computer appears to be using a static IP address, so your device should be as well.  The
troubleshooter would like to know if you want to proceed to try a static IP address.

Troubleshooter 3-User did not force Static.
You did not want to attempt to set a static IP.   This will prevent the board from being able to be
configured.  

We will now try to set the board to use IP address: [xxx.xxx.xxx.xxx].  We have tested this
address and it  appears to not be in use on your network, HOWEVER another device on your
network that is not currently powered may attempt to use this same address in the future. 
You should ensure that this address is not in use on any other device.
The Troubleshooter has determined that the computer is using a static IP address, and the device
should be as well.  The suggested IP address should work and allow the device to be configured.  The
troubleshooter checked to see if the address was already in use on your network and it appears to be
unused.  However, another device that is currently powered off may attempt to use the same address
in the future.  You should ensure that the suggested address is not in use anywhere else.  If it is, you
can temporarily use it to gain access to the device.  You must then change the IP to a known unique
one.

Troubleshooter 4-Force IP failed.
You indicated that you wanted to use this IP address, however while attempting to set that parameter
something went wrong.  Run the Troubleshooter again, and if you get the same error, please contact
support and include the error message.
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5.10.1.2 PixCon16 Configuration

The LOR PixCon16 is configured from this screen.  No configuration changes are sent to the PIxcon16
until you select either the OK or Apply button.  Should you exit the screen without pressing these
buttons, all changes are lost.

The configuration screens are designed to handle multiple different firmware revisions.  If an option is
disabled, it may be that the firmware on the board needs to be update to a more recent version.  This
can be done on the Misc tab.

  Dual Modes (E1.31/LOR Enhanced)
Network Configuration
Pixel Port Setup
o Simple Mode

o Advanced Mode

Misc settings
Automatic configuration of Network Preferences for DMX/E1.31

Dual Modes (E1.31/LOR Enhanced)

The PixCon16 is a little different than other Light O Rama controllers when it comes to configuration and
use.  All configuration of the board is done while it is connected to a standard LAN.  The PixCon16 can
not be configured via the LOR RS485 mode.  The PixCon16 however can run in either E1.31 mode (via
an Ethernet network), or as an LOR device on an LOR ENHANCED network at 500K.  If you would like
to use the PixCon16 as an LOR device, be sure to select 'LOR Mode', explained below. 

Network Configuration (Tab 1)
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Network Configuration tab of the PixCon16 configuration

The first tab of the Pixcon 16 configuration screen allows you to change the name of the board (can
be accessed on all tabs), various network IP settings, as well as the Auxiliary DMX ports available
on the board.  There is also a section that allows the board to be put into test mode.

You should set the name of the board to something meaningful to you.  For example, if this
particular controller is used for a tree, you may want to name it 'Pixel Mega Tree' or the like.  

The IP address section allows you to change if the board is to use a Static or a Dynamic IP
address.  If you are familiar with IP addressing, it is recommended that you use a static address. 
Using a Dynamic (DHCP) IP address is best if you will eventually run in LOR mode.

To set a static address, select static and then type in the IPV4 address you would like for the
board, as well as the Subnet Mask.  The address should be in the same range as the computer you
are currently using to configure the board.  The subnet mask should match the computer's as well. 
If you change the address to one that is not within the range of your local LAN, the board may
'disappear'.  In that case you should reset the board to factory settings, search again for the board,
and attempt to reconfigure it again.

Mode of Operation:  The PixCon16 can be run in 2 different modes ->  As an E1.31 controller on an
Ethernet network, or as an LOR device on an LOR RS485 network.  To run the board as an LOR
device, select the check box labeled  'J3/J4 (DMX #1) are LOR RS485 Network IN/OUT, not DMX
[use board in LOR mode]'.  Be sure to also move the jumpers on the board from the ESTA side to
the LOR side near J4.
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The Auxiliary DMX Ports section allows you to enable/disable the 4 DMX ports available on the
board, as well as assign the universe each will control.  These ports act as a bridge between E1.31
and a DMX universe.  By using one or more of these ports, you can eliminate the use of one or more
USB DMX adapters.  These ports are not active when using the board in LOR mode.

The Test Mode section allows you to put your PixCon16 into test mode.  This is the same mode
that is described in the PixCon16 hardware manual, except when run from the PixCon16
configuration program, a new test that allows for a custom color can also be used.  This mode is not
available with the hardware buttons.

Pixel Port Setup (Tab 2)

This tab allows you to set up how the 16 pixel ports behave on your Pixcon 16.  For most users, simple
mode should suffice.  However there is an Advanced mode that allows for more control.

Pixel Type:  The Pixcon 16 can support multiple different pixel chip-sets, depending on the firmware
loaded to the board.   Select your pixel's chip-set here.  Most LOR pixels use the WS2801 chip-set.

High Speed:  Some pixel chip-sets have a low and high speed.  If your chip-sets supports high
speed, check the box.

Loss of Heartbeat:  Typically when a DMX device looses the DMX signal, it will reset to a known
state (usually OFF).  If you check this box however, the PixCon16 will continue sending the last
known DMX data to each port/universe.  This will basically 'freeze' all the pixels/devices into the last
state they heard.

There are 2 modes available for setting up the pixel ports of a PixCon16, simple and advanced.  For
most users simple is all that will be needed, however for more complex configuration options please
use the advanced mode.  Please keep in mind that Simple Mode and Advanced Mode update
separate parameters on the board and are mutually exclusive.  That means if you switch from easy
mode to advanced mode, (or vice versa) some or ALL of your changes may be lost.

Simple Mode Setup:
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Pixel Port Setup in Simple Configuration mode

Pack Pixels Tightly

Notes about addressing using the Pixcon 16 in simple mode:

The pixel ports on the PixCon16 can be automatically configured using two different
schemes, either 'Unpacked' or 'Pack Tightly'.

Unpacked is self explanatory.  Each port will be assigned a sequential Universe/Unit ID,
starting with the Universe/UID specified for port 1, and continuing for all 16 ports.  This mode
may be most familiar to those people who have used Cosmic Color controllers previously. 
For example, the Cosmic Color Bulb or Cosmic Color Pixel controller can be configured in
'Dual Normal' mode.  That means string 1 is controlled with the UnitID specified, and string 2
is controller with the next higher unit ID.  In the 'One ID per Port' mode, each string will have
a sequential Unit ID number based on the first ports Unit ID.  

The PIxcon16 can also minimize the number of universes/unit IDs and channels/circuits
required to run your RGB nodes.  This mode is called 'Pack Tightly' or 'Packed Pixels'.  In
the typical configuration, each port on the PixCon16 will have 50 pixels, and the starting
channel for the board would be 1.  That would mean that port 1 consumes 150 channels
from 1-150, port 2 would be 151-300, port 3 would be 301-450, all on the same starting
universe.  At port 4, the PixCon16 will continue to assign FULL pixels until it runs out of
channels.  In this case it will assign 20 pixels (Channels 451-510).  While there are 2
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channels left (511 and 512), that is not enough for a FULL pixel.  The PixCon16 will then
assume that the next pixel will start with channel 1 on the NEXT universe.  It will assign 30
more pixels (since there are 50 on a string), and end with channel 90 on that next universe.
 Addressing like this will continue for the entire board if desired.  If you wish to use a
different scheme, please use the advanced mode.

These addressing notes apply to using the board in both LOR mode and E1.31 DMX mode.

Notes about addressing using the Pixcon 16 in advanced mode:

In the advanced mode, you are responsible for all addressing and ensuring that addresses
do not overlap, etc.  There are several options that are available when editing a port to set
the addresses or parameters of other ports.

Maximum 170/340 pixels per port:The PixCon16 can support up to 340 pixels per port in DMX
(not LOR) mode.  If you are going to use more than 170 pixels per port, please change this
setting to 340.  Note that you can set the pixels per port to 340 even if you are using LESS than
170 pixels.  Doing so will change how the ports are addressed, so care must be taken to ensure
that you have the correct settings.

Starting Universe/Unit ID of Board: Select the universe that this board should start at. The first
pixel port will be this address, and then each higher universe will be incremented from this value,
depending on the addressing mode selected.  If you did not select 'Packed Tightly' then each
port will get one or two IDs depending on the max 170/340 selection.  If you selected 'Packed
Pixels' the Unit/Universe will be dependent on the starting channel as well as the number of
pixels.  For example, setting the starting universe to 5 (with 170 pixels on a port, starting
channel 1) means that port 1 will be universe 5, port 2 will be universe 6, all the way up to port
16 which will be universe 20 when using 170 pixels per port.

Number of Nodes (Pixels) per port:  This is the number of physical pixels that are attached to
each physical port on the board.  

Triplet Order:  If the strings that you are using are not in RGB order, you can change it here.   In
general most strings are RGB and you should not need to change this.

Port Table: The Port Table will be updated each time you make a change showing how each
physical port will be configured.  In simple mode, this table is read only.

Advanced Mode Setup:
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Pixel Port Setup in Advanced Configuration mode

The table shows the settings of each port of the PixCon16.  Scroll the list down to see higher
ports, and scroll the list to the right to see additional settings.  Clicking on a port will bring up
the advanced port configuration screen for that port.

Misc (Tab 3)

The miscellaneous tab allows you to update the firmware on the board, change the color curves, 
and set up the aux power port to power a fan or other cooling device.
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Misc PixCon16 settings

Firmware Update:

To update the firmware, press the Update Firmware button.  You will then be asked for the
location of an LOR PixCon16 Firmware File.  To ensure you have the latest firmware available,
please check the Light-O-Rama website and download the latest available.

Once you have selected the correct file, the firmware update process will start.  The process is
typically safe to perform, however we recommend that you do not update firmware unless  you
are addressing a known problem, or need to add some new functionality that a new firmware
offers.

When updating the firmware of a PixCon16, the power and status lights will flash on/off in
different patterns.  Please do not power off the board while the update is in progress.  If you are
unsure if the update was applied properly or not, wait a few minutes and then observe the power
and status lights.  This will give the board enough time to reboot and stabilize.   Also, pay
attention to any instructions that may be shown on your screen.

Should the update process fail, the board could be in one of several states after the failure:  
If the status light is blinking and the power light is solid, this typically means the update was
successful.  However, it could also mean the board did not receive or it did not properly start
the update process.  
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If the power and status lights are alternating, then the board is currently in the boot-loader
mode.

If the power light is ON but the status light is OFF there was a problem with the firmware
update.  

In all cases after allowing the board to sit for a few minutes, power it off then back on.  The
board should return to normal operation at that time.  If not, please refer to the hardware manual
of the PixCon16 for additional troubleshooting information.

The PixCon16 will only operate and be able to be updated by Light-O-Rama signed firmware. 
No other companies firmware can be used on the board.

Automatic Network Configuration

When saving the configuration of a PixCon16, the program can also optionally create all of the
entries needed in the DMX Configuration of Network Preferences using Multi-Cast settings. 
However you may have already set up proper parameters for this board and don't want to be
bothered again.  This setting is saved with the board.

Color Correction ('Color Curving')

These sliders allow you to adjust the relative amount of power supplied to each channel of a
triplet attached to the 16 pixel ports of the board.  Color Correction is typically used so that
pixels attached to this board can be adjusted to more closely match pixels on other boards. 
Please note that this setting is for the entire board and not per port.  Use the sliders to increase
or decrease the amount of 'color' for each component.

Fan Percentage

A fully populated PixCon16 can draw a significant amount of power and needs to be properly
cooled.  To help with this, the Pixcon 16 can automatically regulate power to the accessory
power connector based on the temperature the board is currently sensing.   The slider here will
control when the power is at 100% based at what the current temperature is.   You should
consider the amount of load on your PixCon16 as well as the typical ambient temperature of
your installation.

Automatic configuration of network preferences for DMX/E1.31

When you press the OK button and have configured the PixCon16 to use DMX/E1.31 you will be
asked if you would like to automatically create the necessary Network Preferences entries.  If you
select yes, the program will automatically determine all of the universes that this board will use and
then create the correct multi-cast entries in the DMX tab of LOR Network Preferences.  The system
will warn you if there are already conflicting settings present and allow you to opt-out of the changes.
 

The program will only create Multicast entries for the universes in use.  If you would rather use the
boards Unicast address, you will need to edit the entries created and specify the static IP address
of the board.  If you are not an expert in IP addressing, you may wish to leave the boards in
multicast mode.
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5.10.1.2.1  Advanced Port Configuration

The Advanced Port Configuration screen allows you to change many parameters on a port-by-port basis.
 

Advanced Port Configuration

Starting Universe of Port, Number of Nodes (Pixels), and Triplet Channel Order work nearly the same as
they do on the simple configuration with the exception that they only affect the selected port, not the
whole board.  

Starting Channel of Port: Setting this allows for a port to start at a channel other than 1.  Please note
that it is best to leave the starting channel for a port at 1 to reduce confusion.

Number of Null Pixels:   Most pixel strings have a limit on the length of wire between any 2 pixels.  This
is because each pixel 'regenerates' the signal for the next pixel in line.  However, there may be
instances where the distance to your first pixel exceeds this length.  In this case, null pixels can be
used between the board and the first 'real' pixel on the string.  The only thing these NULL pixels do is re-
generate the signal.  They do not consume any channels or light up.  Select the number of those null
pixels here.

Number of Zig-Zags:  For some uses, it is much more efficient to continue to use pixels in reverse order.
 For example, you may create a left-to-right matrix that is 10 pixels wide by 17 pixels tall.  The first row
of pixels would be 1-10 from left to right.  However, the most efficient way to build the next line is from
right to left.  Doing that will put pixel 11 under pixel 10, not on the left side as expected.  Selecting the
number of Zig Zags allows the Pixcon 16 to internally re-map those pixels so while physically it may be
pixel 20 that is on the left, numerically it is #11.

Group:  If you like, you can group one or more nodes into a single pixel.  For example, if you set the
group to 2, then every 2 nodes will act identically.

Max Intensity:  DMX uses values of 0-255 to set an intensity.  Setting a channel to 255 will tell the light
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to turn on at 100%.  This field however lets you limit that at the port level.  For example, perhaps the
pixels attached to this port are brighter than your other pixels.  You can adjust the Max Intensity of this
port lower so that it more correctly matches the other pixels.

Reversed Node Order:  Typically, the lowest number pixel is the closest to the controller.  Selecting this
option reverses that.  When selected the HIGHEST pixel is now closest to the controller.

Quickly Configuring other ports:

There are two options available when updating the port to quickly update other ports on the same
board.  If neither option is selected than only this particular port will be updated when you press OK.
 If you select one or both, the following will occur:

Checking 'Set Port Parameters...'  and pressing OK will set all 16 ports to the same values as
specified in the 'Port Parameters' - that is all ports will be updated with these parms but not any
addresses.

Checking 'Automatically compute Addresses...' and pressing ok will set this port to the address
parameters specified, and then compute the correct addresses for all FOLLOWING ports, using
the parameters here along with the number of nodes and if you are using 'Packed Pixels'.  The 
'Notes about Addressing the Pixcon 16' section  has more information on how addressing will
happen with this option.

5.10.2 Simple Mode

Most Light-O-Rama users will only need the Simple mode of the Network Preferences program.  Simple
mode allows for the configuration of all sixteen Light-O-Rama networks, sixteen DMX universes that use
adapters (rather than E1.31), and various options.

Please note that if at any time you see a row or setting with a yellow background, that indicates that the
network or universe uses advanced settings, and can only be modified using the Advanced mode.  If you
attempt to change something that uses an advanced setting here, you will be reminded to switch to
Advanced mode.

Simple mode has several different tabs:

The LOR tab
The DMX tab
The Misc tab
Find/Configure LOR PixCon16 Devices
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Simple mode of the Light-O-Rama Network Preferences program

5.10.2.1 The LOR Tab

The LOR tab of Simple mode of the Light-O-Rama Network Preference program enables you to specify
up to sixteen different networks for Light-O-Rama controllers, each using a different serial port.  The
communications speed of each network can be set independently.  Many users will only ever require a
single network, referred to as the "Regular Network".  You can quickly configure the Regular network
using the two dropdown boxes: Port and Speed.

The LOR tab, showing only the Regular network

If you need to configure additional networks (referred to as "auxiliary networks" or "Aux networks"),
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expand the second section (entitled "More (Aux Networks)").  Here you will be presented a list of all
available auxiliary networks:

The Aux networks

Clicking on any row in the list of auxiliary networks will bring up a dialog box allowing you to set the port
and speed for that particular network:

The Aux network configuration dialog

If you need to set a network up to be an enhanced network, use Advanced Mode (by clicking on the
"Advanced" button).

Serial Ports ("Port")
In the dropdown box for each Light-O-Rama network that you wish to configure, chose the serial port that
you wish to use for that network.  Make sure that they do not conflict with each other, or with the Dasher
port, X10 port, or DMX adapters.

If you do not want to use all possible networks, you can simply set the adapters for some of them to
"(None)".  Using only a single Light-O-Rama network is perfectly sufficient for the needs of many users.

Connection Speed ("Speed")
Light-O-Rama can communicate with Light-O-Rama controllers using various communication speeds. 
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These speeds can be set independently for each Light-O-Rama network:

If you do not have extraordinary needs, "57.6K (Recommended)" is suggested.
If you have controllers that are hooked up to your computer using a very long or poor quality
communications cable, you may need to set the speed to "19.2K (Slowest)".
If you have many circuits with very fast action, you may need to set the speed to "115.4K", or
even "500K (Fastest)".  Note that these settings are not supported if you are using Light-O-Rama
Easy Light Linkers for wireless communications, and that 500K is currently supported only on G3
controllers, Cosmic Color Ribbons, Cosmic Color Bulbs, Cosmic Color Pixels, and the Pixcon 16.
 You may also have to upgrade your firmware to use 500K.
If this network ONLY contains Pixcon 16 controllers running on en Enhanced LOR Network, you
may select 1000K.  1000K speed can be selected in 'Advanced' mode.

Comments
Use the comment field as you see fit for notes/etc.  

5.10.2.2 The DMX Tab

The DMX tab of the Simple mode of the Light-O-Rama Network Preferences program can be used to
specify up to sixteen different DMX universes, each using a separate adapter (to configure more
universes, or universes that use E1.31 instead of adapters, you will need to use Advanced mode instead
of Simple mode).  The protocol used for each universe can be individually specified as well.  Many users
will not use DMX, and many of those who do will only require a single DMX universe (typically universe
1), and so by default only universe 1 is shown:

The DMX tab, showing only universe 1.

To configure additional universes (numbers 2 through 16), expand the "More (Additional Universes)"
section of the tab:
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The DMX tab, showing additional universes

For each universe, the Network Preferences program presents a dropdown list of adapters available on
the system.  Note that the Network Preferences program cannot detect adapters that are currently in
use.  For example, if you have an LOR USB485 adapter that is currently assigned to an LOR network,
and you wish to asign it to a DMX universe instead, you will first need to unassign it from the LOR
network before it can be reassigned for the DMX universe.  Furthermore, you may need to stop and
restart the Sequencer, Hardware Utility, and/or Show Player before the device will be shown in the
Adapter dropdown box.

A row that is highlighted in yellow (such as universe 3's row in the picture above) indicates that the
universe is currently configured with advanced settings, and can only be changed using Advanced mode.
 Clicking on any other universe's row will bring up a dialog box enabling you to set the adapter and
protocol.  You can also set the DMX listener port by expanding the third section of the tab (labeled
"Listener Port").

DMX Adapter ("Adapter")

Each DMX universe (other than those that use E1.31, which are configured using Advanced mode)
must be assigned to a DMX adapter, such as the LOR USB485 or the ENTTEC Open DMX USB
adapter.  Each adapter can be assigned to only one universe.  If you are attempting to reassign an
adapter, you may need to stop and restart various programs in the LOR suite.  See earlier on this
page for details.

Note that there are different types of DMX protocols that can be used.  Please be sure to select the
correct protocol for your adapter.

DMX Protocol ("Protocol")

Different DMX adapters use different protocols.  You must specify the correct protocol for the DMX
adapter you wish to use:
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Adapter Type Protocol

DMXKing UltraDMX Micro ENTTEC DMX USB Pro

DMXKing UltraDMX RDM Pro ENTTEC DMX USB Pro

ENTTEC DMX USB Pro ENTTEC DMX USB Pro

ENTTEC Open DMX USB*

*: Some old ENTTEC Open dev ices, built in approximately  2008 or

earlier, may  not be supported

Raw DMX

LOR USB485 Raw DMX

LOR USB485B Raw DMX

LOR USB485-ISO Raw DMX

Lynx Lynx

Other types of adapters may or may not work with LOR software.  If they do, you may need to
experiment to find the correct protocol to use.

DMX Listener Port ("Listener Port")

This section can be used to configure the port that the LOR Comm Listener will listen on for lighting
commands to be sent to DMX devices.  The default port of 8837 should work for nearly all users, but
can be changed here if needed.

If you set the port to 0, the Comm Listener will be disabled, and lighting commands will not be sent
to your DMX devices.

Comments

Use the comment field as you see fit for notes/etc.  

5.10.2.3 The Misc Tab

The Misc tab of the Simple mode of the Light-O-Rama Network Preferences program enables you to
configure a Dasher network and/or an X10 network, along with general communications options.  Most
Light-O-Rama users will not have need for this tab.
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The Misc tab

X10 Port

No longer used.

Dasher Port

No longer used.

List Networks in Channel Configuration

No longer used.

Use Compatibility Mode for Old MC-P Channel Controllers

If you are using Light-O-Rama MC-P controllers purchased prior to November 15, 2003, they you
should enable Old MC-P compatibility mode by checking this box.  If you do not check this box,
then you will see odd behavior on circuits 9 through 16 of such controllers.

Old MC-P compatibility mode only affects controllers on the Regular LOR network; those on Aux
networks are unaffected.  Therefore, make sure to put all such controllers on your Regular network.

NOTE: Enabling Old MC-P compatibility mode may have a significant effect on
communications speed for the regular network.  It is therefore strongly recommended that you
do not enable it without reason, and that if you do enable it, you should consider moving any other
Light-O-Rama controllers (which do not need Old MC-P compatibility mode) off of the Regular
network, and onto one or more auxiliary networks.
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5.10.3 Advanced Mode

Most users' network configuration settings can be handled using the Simple mode of the Network
Preferences program.  However, for certain types of configuration, the Advanced mode is required. 
These types include having more than sixteen DMX universes, and having DMX universes that use E1.31
instead of adapters.  The Advanced mode also supports all of the same options that Simple mode does,
so even if you do not need any advanced configuration options, you may still find that you prefer to use
Advanced mode.

If at any time you are in Simple mode and see a device or port that is shown in yellow, that means that it
is currently using advanced configuration options and can only be modified from Advanced mode.

Advanced mode has several different tabs and options:

The LOR tab
The DMX tab
The Misc tab
Find/Configure LOR PixCon16 Devices
Export/Import configuration

Advanced Network Preferences with Find/Configure LOR E1.31 devices button.
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5.10.3.1 Export/Import

The Advanced and Pro versions of the software can export/import your entire network configuration to a
file.  This is useful if you would like to have multiple different configurations available, or if you use the
software on multiple machines and want to move the configuration between them.

The Import/Export function works on ALL the parameters that can be changed in the Network
Configuration program.  This includes not only actual network configurations, but also things like X10 and
Dasher networks, MCP Compatibility mode, etc.

Please be careful when importing a network configuration from another computer.  While the hardware
and software give a best-effort to configure themselves the same way across physical machines, that is
not guaranteed.  This is especially true of COM port settings, and IP addresses.  After importing a
configuration, you should always check all values to ensure they are correct.  

To export your configuration, press the Export button and give the file a name.  The exported files are
normally saved in the LOR Data path under "Network\SavedConfigurations".  An exported file will have
the .LIV extension.

To import a configuration, press the Import button and select the configuration to import.  

5.10.3.2 The LOR Tab

The LOR tab of the Advanced mode of the Light-O-Rama Network Preferences program presents a list of
all sixteen available Light-O-Rama networks, including the Regular network and all of the auxiliary
networks (Aux A through Aux O):
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The LOR tab in Advanced mode

Clicking on any row will bring up a dialog box allowing you to set the port and speed for that particular
network, as well as choosing whether or not the network should be an enhanced network:

Configuration for an LOR network
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Please refer to the Simple mode's documentation for further details on port, speed, and comments.

5.10.3.3 The DMX Tab

The DMX tab of the Advanced mode of the Light-O-Rama Network Preferences program can be used to
configure up to 999 separate DMX universes, each using a separate adapter or E1.31 address (although
please note that the software and your computer may not be able to adequately drive nearly that many
universes simultaneously).  For DMX universes that use an adapter, the adapter and the protocol used
on each can be specified; for those using E1.31, the remote IP address and port can be specified.  You
can also use this tab to specify the COMM listener port.

Note that the DMX tab can also be used in Simple mode, but Advanced mode is required to configure
universes beyond number 16, and also to configure E1.31 universes.

The DMX tab in advanced mode

To configure a particular universe, click on its row in the list.  You will then be presented with the
Advanced DMX Universe Configuration dialog, which has two main options - "Use Adapter" and "Use
E1.31":
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The Advanced DMX Universe Configuration dialog

Use Adapter

If you select "Use Adapter", you will then be able to choose the adapter to use for the universe and
the protocol that the adapter uses.  Please refer to Simple mode's documentation on adapters and
protocols for details.

Use E1.31

If you choose "Use E1.31", you will then be able to select the IP configuration for the universe to
use, by specifying the IP address and port that the E1.31-to-DMX gateway devices are listening on.

Please note that E1.31 configurations can be complex, and may require a firm grasp of networking,
network topologies, and addressing.  Such topics are beyond the scope of this document.

IP Address

Here, you must select the type of IP address you wish to use for this universe:

Multicast: Selecting this option will cause the universe to use multicast mode, allowing lighting
commands for the universe to be received by multiple E1.31-to-DMX gateway devices.  The actual
IP address that will be used depends upon the universe number, in the manner described by the
E1.31 standard.  For example, universe 37 will use IP address 239.255.0.37, while universe 650
will use IP address 239.255.2.138.

Specify: Selecting this option will cause the universe to use unicast mode, and lighting
commands for the universe will be received by a single specifc E1.31-to-DMX gateway device,
using the IP address that you specify.

Local: This option will cause the universe to send lighting commands to the computer itself, using
the local loopback address (127.0.0.1).

Port

The IP port that the remote device or devices will listen on for lighting commands should be specified
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here.  In most cases, the default value (5568) should be appropriate.

This should not be confused with the DMX Listener port.

Total Universes to Set

If you would like to set any following ports to these same parameters, simply change the value here
to the total number of Universes you would like.  The universe being edited along with as many
additional universes following this one will have the identical settings created.
 

COMM Listener Port

This section can be used to configure the IP port that the Light-O-Rama Comm Listener listens on
for lighting commands to be delivered over DMX networks.  Please refer to the COMM Listener Port
section of the Simple mode documentation for details.

Comments
Use the comment field as you see fit for notes/etc.  

5.10.3.4 The Misc Tab

The Misc tab of the Advanced mode of the Light-O-Rama Network Preferences program allows you to
change various communications options.  It is equivalent to the Misc tab of Simple mode; please refer to
that documentation for details.

5.11 Comm Listener

The LOR Comm Listener is a program that runs in the background, allowing other programs
(such as the Sequencer and the Show Player) to control LOR devices that are on LOR
Enhanced networks, and also to control  DMX devices.  The Comm Listener must be running in
order for those programs to control such devices.

The LOR Comm Listener is automatically started when the LOR Control Panel is started, unless the
license level does not support it or if no Listener port is specified in Network Preferences.  Also, it is
automatically shut down when the LOR Control Panel is shut down.  So, to make sure that you can
control your LOR Enhanced devices and DMX devices, make sure that the LOR Control Panel is running.

5.12 Hardware Utility

The Light-O-Rama Hardware Utility is used to manage the hardware that you use to control your
lights.  This includes several types of controllers as well as other devices such as Light-O-Rama
MP3 Directors and Light-O-Rama wireless devices.

Each of these types has a different tab in the Hardware Utility.  When you start the Hardware Utility, the
tab for Light-O-Rama controllers is displayed; to access one of the others, simply click its tab.

For details on each, please refer to the following sections:

Light-O-Rama Controllers
Selecting a Comm Port
Setting Unit IDs
Configuring Units
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Testing Units
Downloading Sequences
Firmware Update

Light-O-Rama MP3 Directors
Light-O-Rama Wireless Devices
Digital IO Boards
X10 Controllers
Test Console

To run the Hardware Utility, select it from your computer's Start menu (Start / Light-O-Rama / Hardware
Utility) or, if the Light-O-Rama Control Panel is currently running, right-click on its icon in your
computer's system tray and select "Hardware Utility" from the popup menu.

The Hardware Utility's tab for Light-O-Rama controllers

5.12.1 Light-O-Rama Controllers

The Light-O-Rama Hardware Utility can be used to configure and test Light-O-Rama controllers in several
ways:

Selecting a Comm Port
Setting Unit IDs
Configuring Units
Testing Units
Downloading Sequences
Firmware Updates

To use these, select the Hardware Utility's tab labeled "LOR Control" (it is already selected by default
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when the Hardware Utility is started).

The Hardware Utility's "LOR Control" tab, for configuring and testing Light-O-Rama controllers

5.12.1.1 Selecting a Comm Port

The "Setup Comm Port" section of the LOR Control tab of the Light-O-Rama Hardware Utility is used to
set which RS-232 comm port the Hardware Utility will use for Light-O-Rama controllers.  

The Setup Comm Port section

While the Sequencer and Show Player can use up to four different comm ports simultaneously for Light-
O-Rama controllers, the Hardware Utility only uses one at a time.  By default, it will be set to use the
port you have configured to be your "Regular" port (if you have done so); see "Network Preferences" in
the Sequencer for details on how to set your Light-O-Rama ports.

Only comm ports 1 through 16 are supported in the Hardware Utility.

If you know the comm port that it should be using, you can simply select it from the "Manual Select"
dropdown box.  If you select a port other than your "Regular" port, the Hardware Utility will offer to
automatically change your "Regular" port to be the one that you selected.
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If you do not know the comm port to be used, you can ask the Hardware Utility can automatically detect
it:

Connect a Light-O-Rama controller to your PC, for example using an SC485 connector or a USB-
RS485 adapter.
Connect the controller to AC power, and turn it on.
Click on the "Auto Configure" button.

The Hardware Utility should then automatically detect the comm port that you have hooked the controller
up to.  If it does not:

Check the physical connection (such as cables and the SC485 connector).
Check that the controller's power is on.
Ensure that switches or jumpers on the controller are correct.
Ensure that the correct type of cable is used.
Retry the "Auto Configure" button.

If all of the above fails to find the port, then watch the controller's blinking LED light while manually
selecting different comm ports from the list.  Once a comm port is selected, wait about five seconds.  If
the LED stops blinking, then that is the correct port.  If it does not stop blinking, try the next comm port
in the list.

If this still does not determine the correct comm port, there may be a problem with the connector or the
controller.

If "Auto Configure" does not work, but you were able to determine the comm port by manual selection,
there may be a problem with the connector.  Or, if your computer is an older PC or laptop, there may be
a compatibility issue with the computer's communications drivers.

In any case, if you can get the unit's LED to stop blinking, then that controller will most likely work on
your PC.

5.12.1.2 Setting Unit IDs

Each Light-O-Rama controller must have a unique assigned unit ID, identifying this particular controller. 
The reason for this is that every Light-O-Rama controller in a network can see every lighting command
message that is sent over the network, not only the lighting commands sent for that controller.  So, all of
the commands contain a unit ID, and a controller only acts upon a command if the unit ID of the
controller matches the unit ID of the message.

A unit ID is a two-character field.  Each character can have any of the values 0, 1, 2, 3, 4, 5, 6, 7, 8, 9,
A, B, C, D, E, and F.  For example, a unit ID might be "03", "07", "25", "37", "6B", "C8", or "DA". 
However, certain values are reserved, and so not allowed (specifically, "00", and "F1" through "FF").

Some Light-O-Rama controllers have selector switches that allow you to directly set their unit IDs.  In
that case, simply use a small screwdriver (making sure that the unit is not attached to power) to dial the
switches to the desired unit ID.

Other controllers do not have selector switches.  To set the unit IDs of these controllers, you can use
the LOR Control tab of the Light-O-Rama Hardware Utility:

Connect the Unit to the Computer
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Select the Comm Port
Set the ID of a New Unit
Change the ID of an Existing Unit
Troubleshooting

Connect the Unit to the Computer

The first step in setting a Light-O-Rama controller's unit ID using the Hardware Utility is to connect
the unit to the computer, for example using an SC485 adaptor or a USB-RS485 adaptor.  Make sure
that the selector switches are correctly set for the type of cable used (units are shipped ready to
use data cables).  Plug the unit into an AC outlet, and turn the unit on.

Select the Comm Port

After you have connected the unit to the computer, select the comm port that the Hardware Utility
should use to communicate with the controller.

Set the ID of a New Unit

If this is a new unit that has not previously been assigned a unit ID, use the "Set New Unit ID"
section of the LOR Control tab of the Hardware Utility.  Simply select the unit ID you want to assign,
and click the "Set Unit ID" button.

Setting the ID of a new unit

Change the ID of an Existing Unit

If you have previously assigned a unit ID to this unit, but want to change it, use the "Change Existing
ID" section of the LOR Control tab of the Hardware Utility.  Select the unit's current ID in the "Old
Unit ID" list, and the unit ID that you want to change it to in the "New Unit ID" list.  Finally, click the
"Set Unit ID" button.

Changing a unit ID

If you do not remember the unit's current unit ID, or if the controller doesn't seem to be reacting to its
current ID, you can change it to a new unit ID by selecting "Any Unit" in the "Old Unit ID" list. 
However, be very careful.  If you select "Any Unit", then all units that are connected to the PC will
have their unit IDs changed.  So, make sure that you have only the one controller (whose unit ID you
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wish to change) connected.

Changing a unit ID for "Any Unit"

Troubleshooting

If, while setting a Light-O-Rama controller's unit ID, you receive an error saying that the unit cannot
be located, the first thing to do is to check all connections and to make sure that the correct comm
port is selected.  If the Hardware Utility still cannot locate the unit, check the Communication LED
on the unit.  When the unit is disconnected from the data cable the LED should blink; when it is
connected and the Hardware Utility is running with the correct comm port selected, the LED should
stop blinking, turning on steady.

If the Communications LED continues to blink regardless of the steps taken, then there may be a
problem with the cable, the adaptor, the controller, or the PC's comm port.

If the LED stops blinking but you still get an error when attempting to set the unit ID, then there may
be a problem with the adaptor or the controller, or the PC may have a communications driver that is
not completely compatible with Light-O-Rama.  However, you may still be able to set the unit ID by
checking the "Ignore Errors" box and then trying to set the unit ID again.  If you do check the "Ignore
Errors" box, make sure that the unit ID has been set correctly by running some tests on the
controller.

5.12.1.3 Configuring Units

Some Light-O-Rama controllers, such as the MC-Px and CTBxxD units, have special options that can be
configured.  You can use the LOR Control tab of the Hardware Utility to do so, using the following steps:

Connect The Unit to the PC
Select the Comm Port
Select the Unit
Choose "Configuration"
Set the Minimum and Maximum Intensities
Set the Input Channel Types
Set the Port Type
Configuring DIO32 Servos
Configuring Original Cosmic Color Ribbons, Bulbs, and Pixels
Configuring Pixie Controllers including Cosmic Color 2 Ribbons, Bulbs, Pixels
Dimming Curves
Update

Connect the Unit to the PC

The first step is to connect the unit to the computer, for example using an SC485 adaptor or a USB-



The Light-O-Rama Software Package 537

© 2019 Light-O-Rama, Inc.

RS485 adaptor.  Make sure that the selector switches are correctly set for the type of cable used
(units are shipped ready to use data cables).  Plug the unit into an AC outlet, and turn the unit on.

Select the Comm Port

After you have connected the unit to the computer, select the comm port that the Hardware Utility
should use to communicate with the controller.

Select the Unit

After you have connected the unit to the PC and selected the comm port, select the unit ID of the
controller that you wish to configure: Hit the "Refresh" button, and the Hardware Utility will scan
your network for connected units.  You can then select the unit ID from the dropdown list. 
Alternatively, if you already know the unit ID, you could simply type it into the dropdown box, without
hitting "Refresh" first; this is quicker, but has some drawbacks:

Depending upon the type of controller and the level of firmware, hitting "Refresh" may allow the
Hardware Utility to automatically populate the configuration settings screen with the actual current
configuration of the controller.  Typing in the unit ID, without first hitting "Refresh", will not do this,
and so the configuration settings screen will simply show default values, which may or may not be
how the controller is currently configured.

Also, "Refresh" allows the Hardware Utility to figure out the type of the controller, which lets it know
various things about how to interact with this controller specifically; for example, the maximum
number of bytes in a standalone sequence varies with the type of controller.  If you hit "Refresh", the
Hardware Utility will know how many bytes this controller can handle, and so won't allow a larger
sequence to be sent to the controller.  Simply typing in the unit ID, without first hitting "Refresh", will
not do this, and so the Hardware Utility may try to send a standalone sequence that is larger than
the controller can deal with.

NOTE: Scanning the network may take some time.  If you have set the unit IDs of your controllers to
low values, you can use the "Max Unit ID" section to speed up this scan drastically.  It is therefore a
good habit to assign your controllers unit IDs starting at 01, and increasing sequentially through 02,
03, and so on.

Selecting the unit to configure

Choose "Configuration"

Next, click the "Configuration" button (near the bottom of the LOR Control tab of the Hardware
Utility).  This brings up configuration settings:
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The configuration section of the LOR Control tab

Set the Minimum and Maximum Intensities

While active, the controller will not set its lights' intensities below the specified minimum.  If,
however, it loses communications with its director, it will turn them off (i.e. 0% intensity).  The lights
are not turned up to the minimum until the unit receives its first lighting command.

Setting a maximum intensity below 100% may be used to help prolong the life of bulbs, although
there is an important exception: Retro LED C7 and C9 bulbs (also known as replacement LEDs) can
be harmed by using them at any intensity other than 100% or 0%.

The initial values displayed in this section are read from the controller itself (although this is
supported only for certain versions of firmware - your controller may need a firmware update in order
to read the values from the controller).

These settings only take effect for ports that are configured as "Triac Board".

Setting the intensity range

Set the Port Type

The port type can be set to Triac Board, SSR, or Servo Motor.  When set to Triac Board, dimming
and fading are possible.  When set to SSR, the unit will support SSRs with zero cross detectors. 
For the CTB08D controller, the two servo pins can be activated by setting Port B to Servo.
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Setting the port type

Set the Input Channel Types

Circuits that are used for interactive triggers can be either normally open ("N/O") or normally closed
("N/C").  The current value for each circuit is read from the controller itself, and the value can be
updated in the "Input Channels" section.

Not all versions of firmware support this feature; if your controller has not yet been updated with
firmware that supports it, the circuit will be treated as normally open (which is also the default for
versions of firmware that can support both).

Setting the input channel types

Configuring DIO32 Servos

DIO32 devices can be set up to control servos; the Hardware Utility can be used to configure them
by clicking the "DIO32-Servo Screen" button in the Configuration section.  Doing so brings up the
following:

DIO32 servo configuration options
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For each circuit, you can select the appropriate pulse width to be used for the servo attached to that
circuit.  There are at least two reasons why you might want to do this: First, some servos support
different pulse widths than others; second, you might want to use this to limit the range of the servo.

The minimum value in the selected pulse width will be used whenever a 0% intensity is set on that
circuit's channel; the maximum value will be used whenever a 100% intensity is set.  Regardless of
the pulse width, 50% intensity always corresponds to 1.5 milliseconds.

Note that only sixteen circuits are displayed, though the DIO32 has 32 circuits.  This is because its
32 circuits are spread among two unit IDs.  For example, the first sixteen circuits might be for unit
ID 01, in which case the next sixteen would be for unit ID 02.  Both sets of sixteen can be
configured independently, by selecting the appropriate unit ID.  However, if you want to configure
both, make sure to update the controller with your changes for one before proceeding to the other.

Configuring Original Cosmic Color Ribbons, Bulbs, and Pixels

Cosmic Color Ribbons, Bulbs, Pixels, have their own configuration options, unique to them.  You
can use the Hardware Utility to configure these options by clicking the "Cosmic Color/Pixie Config"
button in the Configuration section (note, though, that this button will be grey and non-selectable
unless you have selected a Cosmic Color Ribbon,Bulb,Pixel or Pixie unit; you may have to use the
Refresh button in order to let the Hardware Utility know about your Cosmic Color Ribbon or Cosmic
Color Bulb).  

There are currently 2 versions of Cosmic Color devices available, the 'Original' and the new Cosmic
Color 2 devices which are based on our Pixie controllers.  The Hardware Utility can distinguish the
difference between the two when connected to your computer and will present you the correct
dialog.

When you press the button with an Original Cosmic Color device selected, you will be presented the
following window:

Cosmic Color Ribbon/Bulb/Pixel/Pixie configuration options
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For details on these options, please refer to your device's manual (All of our hardware manuals are
available on our website in PDF format here:http://www1.lightorama.com/documentation/  ).  Not all
devices support all options.  If a device does not support a particular option, that option is grey and
can not be used.  Here is a brief overview of each:

Unit ID Mode: In "Normal" mode, the Cosmic Color device will be a single unit ID, with 157 circuit
IDs for a one-string CCD or 314 for a two-string.  In "Legacy" mode, the Cosmic Color device will
use up to ten sequential unit IDs per string (depending upon the configured resolution), with up to
16 circuit IDs for each unit ID.  In "Dual Normal" mode, which is applicable for two-string CCDs,
the device will have two contiguous unit IDs, each having 157 circuit IDs.

Channel Mode: In "Triples" mode, channels will be arranged red, green, blue, red, green, blue,
and so forth.  For example, circuit 1 is red for the first pixel; circuit 2 green for the first pixel;
circuit 3 blue for the first pixel; circuit 4 red for the second pixel; and so on.  In "Sequential" mode,
all red pixels will come first, then all green pixels, then all blue pixels.

Resolution: The number of logical pixels that the Cosmic Color device will be.  For example,
setting it to 50 will give individual control over each of the 50 physical pixels, using 150 channels
(one red, one green, and one blue for each pixel), while setting it to 1 will make all of the lights on
the Cosmic Color device act as a single pixel, using three channels (red, green and blue).

Num of end-to-end connected CCR Ribbons The number of end-to-end connected Cosmic
Color Ribbons.

Reverse String #: Reverses the order of the pixels on the ribbon, or string of the Cosmic Color
Device.  Thus, when unchecked, pixel 1 is nearest the controller, and when checked, the highest
pixel is nearest the controller.

Standalone Speed: The speed at which a standalone sequence will run.  A value of 8 is normal
speed; higher values are faster, and lower values are slower.

DMX Mode: Selects how the Cosmic Color device will appear in a DMX universe: just the RGB
channels, just the Macro channels, or both.

First Pixel is Status Indicator: For Cosmic Color devices, if this field is checked, for the first
minute after the unit is powered up (or until a lighting command is received), the first pixel of the
unit will act similarly to the unit's status indicator, blinking on and off if there is no communication,
and holding on steady if there is.

CCP Color Correction:  Select this option if you are using Cosmic Color Pixels and notice that
colors are slightly off, especially when compared to a Cosmic Color Bulb controller.

Configuring Pixie Controllers including Cosmic Color 2 Ribbons, Bulbs,
Pixels

Pixie Controllers, Cosmic Color 2 Ribbons, Bulbs, Pixels, have their own configuration options
unique to them.  You can use the Hardware Utility to configure these options by clicking the
"Cosmic Color/Pixie Config" button in the Configuration section (note, though, that this button will be
grey and non-selectable unless you have selected a Cosmic Color Ribbon,Bulb,Pixel or Pixie unit;
you may have to use the Refresh button in order to let the Hardware Utility know about your Cosmic
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Color Ribbon or Cosmic Color Bulb).  

There are currently 2 versions of Cosmic Color devices available, the 'Original' and the new Cosmic
Color 2 devices which are based on our Pixie controllers.  The Hardware Utility can distinguish the
difference between the two when connected to your computer and will present you the correct
dialog.

When you press the button with a Pixie Controller or Cosmic Color 2 device selected, you will be
presented the following window:

For most users, simple mode will be all that is needed.  For details on these options, please refer to
your device's manual (All of our hardware manuals are available on our website in PDF format
here:http://www1.lightorama.com/documentation/  ).  Not all devices support all options.  If a device
does not support a particular option, that option is grey and can not be used.  Here is a brief
overview of each:

Pixel Type:  Select the type of pixels connected to your Pixie controller.   A list of supported
pixels can be found in the documentation for your hardware.

RGB Order:  Order of the Red Green and Blue channels for your pixel.  RGB is the default. 
Selecting an option here will set ALL ports on the Pixie device to the same order.

Pixels Per Port:  Number of pixels connected to each physical port of the Pixie controller.  Can
any value 1-100.

Logical Resolution: The number of logical pixels that the Cosmic Color device will be.  For
example, setting it to 50 will give individual control over each of the 50 physical pixels, using 150
channels (one red, one green, and one blue for each pixel), while setting it to 1 will make all of the
lights on the Cosmic Color device act as a single pixel, using three channels (red, green and
blue).

Advanced Mode

If you press the 'Advanced' button, the dialog expands and shows the following:
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Port Settings:

In the Port Settings section you will see 1 line for each port that your Pixie has.  For example, if you
are configuring a Pixie 4, you would only see ports 1-4.  

Depending on the firmware your Pixie has, you may not be able to change all of these.  Only newer
Pixie firmware allows for the configuration of by port RGB Order as well as prop selection.  If your
version of the firmware does not support these, they will be grey and you will see a message that
your firmware does not support them.
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For each port you can configure:

RGB Order:  Order of the Red Green and Blue channels for your pixel.  RGB is the default.
Selecting an RGB order effects only that port.  That means each port on your Pixie can have a
different RGB order.

Reverse: Reverses the order of the pixels on the ribbon, or string connected to that port of the
Pixie.  Thus, when unchecked, pixel 1 is nearest the controller, and when checked, the highest
pixel is nearest the controller.

Prop:  Pixie controllers can be configured to run certain available LOR props, like singing faces. 
Selecting the prop here will allow the pixie to control that prop on that and the next port. If you
have a pixie 16, props are only supported on the first 8 ports.  For more information, please see
the manual that came with your LOR prop.  For regular operation select 'no prop selected',
otherwise select the name of the prop connected to that and the next port.

Misc. Options

In this section on can change some uncommon parameters.  

First Pixel is Status Indicator: For Cosmic Color devices, if this field is checked, for the first
minute after the unit is powered up (or until a lighting command is received), the first pixel of the
unit will act similarly to the unit's status indicator, blinking on and off if there is no communication,
and holding on steady if there is.

Standalone Speed: The speed at which a standalone sequence will run.  A value of 8 is normal
speed; higher values are faster, and lower values are slower.

DMX Mode: Selects how the Cosmic Color device will appear in a DMX universe: just the RGB
channels, just the Macro channels, or both.

Triplet order: In "Triples" mode, channels will be arranged red, green, blue, red, green, blue, and
so forth.  For example, circuit 1 is red for the first pixel; circuit 2 green for the first pixel; circuit 3
blue for the first pixel; circuit 4 red for the second pixel; and so on. In "Sequential" mode, all red
pixels will come first, then all green pixels, then all blue pixels.  It is recommended that you use
Triples mode - some parts of the LOR software do not support Sequential mode.

Dimming Curves

The Hardware Utility's Advanced Configuration screen can be used to set dimming curves for Gen3
controllers, or for pre-Gen3 controllers that have Gen3 firmware installed.  To get to the Advanced
Configuration screen, click on the Advanced Configuration button in the Configuration section of the
LOR Control tab of the Hardware Utility.

Dimming curves determine the output of a channel versus the intensity setting of that channel.  For
example, the On/Off only curve has the output set at 100% for intensity values greater than 50% (or
DMX 128), and the output at 0% for any other intensity value.

Each channel can be configured for a specific dimming curve.  Gen3 firmware comes with three
curves: "LOR standard" (which is normal for incandescent lights), "Dim Curve01" (which is a good
curve for LED Lighting), and "On/Off only" (which is best with loads such as strobe lights that should
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never be dimmed).

The LOR Standard and On/Off curves cannot be changed.  Any other curves can be downloaded and
updated on the controller.  If a channel is set to use a dimming curve that is not present on the
controller, then the channel will default to using LOR Standard.

The Advanced Configuration screen

Update

When you have set the configuration settings to the value you want, click the "Update Unit" button
to send the new configuration information to the controller.  Note: Doing so will update both the
settings from the main screen and the settings from the DIO32 servo screen.  

After updating, hit "Refresh" again to reload the new settings from the controller into the Hardware
Utility.

5.12.1.3.1  Light-O-Rama MP3 Directors

`The LOR MP3 tab of the Light-O-Rama Hardware Utility can be used to download both musical
sequences and animation sequences to a Light-O-Rama MP3 director (such as an "LOR1602W with
Show Director and MP3 Player"), and schedule when those sequences should be played.  

Newer Generation 3 MP3 Directors, like the MP3g3 Dual Network Director, can drive both LOR and DMX
hardware.

Note, that any loops in an animation sequence will be ignored.  Up to nine separate shows can be
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downloaded to an MP3 director.

In the future, Light-O-Rama Hub will completely replace this tab of the Hardware Utility.

For details, please refer to the following sections:

Scheduling/Show Options
Select When Show Plays
Select How Show Plays

MP3 Player Showlist
MP3g3 Directors can control DMX Devices
Priority of Networks and Universes

Download the Show
Set the Time

The LOR MP3 tab of the Hardware Utility

Scheduling/Show Options

This section allows you to select various options about the show:

Select When Show Plays
Select How Show Plays

Select When Show Plays
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This section gives three main options for when the show will play: "plays anytime powered", "plays
during scheduled time", and "plays when triggered".  Additionally, you can specify that the show
cannot be interrupted by input triggers, even if other shows are set up to start on those triggers.

Selecting "plays anytime powered" will cause the show to run whenever the MP3 director is powered
on.

Selecting "plays during scheduled time" allows you to specify a time or times when the show should
play. Up to nine shows can be downloaded to a controller, and each will be assigned a number
between 1 and 9.  If two shows are scheduled for the same time, the lower numbered show will be
played.

Selecting "plays when triggered" will cause the show to start whenever some external trigger
happens  (such as a circuit being closed or a motion detector being tripped).  If you choose this
option, you will be prompted to select the trigger's switch number (up to six switches are supported),
and whether the switch is normally open or normally closed.  

A normally open switch has its contacts open until you activate it, at which point they close; a
normally closed switch has its contacts closed until you activate it, at which point they open.  Most
switches are normally open; motion detectors, however, are typically normally closed.  This is
because they are often used in security systems, where it is important to notice that a wire has
been cut.

Select How Show Plays

In this section, you can choose whether the show should loop continuously (that is, when it finishes
playing the last sequence in its list, it will start over at the first), or only one time, or every so often
(every hour, half hour, fifteen minutes or ten minutes).  If you are using a triggered sequence you can
also select if you would like to run the sequence list in a 'Round Robin'.

If you choose to play the show every so often, you will also be prompted for what the lights should
do in between.  You can choose to have all your lights on, or off, or else use an animation sequence
as a "filler" that will play continuously during the time in between.

If you choose to play the sequences in a Round Robin, only the first sequence in the sequence list
will play.  The next time the MP3 director is triggered, it will play the next sequence in the list.  After
playing the last sequence in the list, the next trigger will start over with the first sequence.   Note:
Round Robin play can only be used with triggered sequences on G3 MP3 directors with Firmware
version 5.34 or higher.

MP3 Player Showlist

You can add both musical sequences and animation sequences to the show by clicking the "Add
Sequence" button.  To remove one, click on it to highlight it, and then click the "Remove Sequence"
button.

The sequences will be played in the order listed.  You can change the order by clicking on a
sequence to highlight it, and then clicking "Move Up" or "Move Down".

Sequences with subsequences cannot be added to the showlist.

Optionally, you can also specify a "start sequence", which will be played once and only once every
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time the show starts up, before the other sequences.  This is most useful if you selected that the
show should loop continuously.  For example, a show with a start sequence and three sequences in
the showlist will, when "loop continuously" is turned on, first play the start sequence, then the first
sequence of the showlist, then the second, then the third, and then back to the first in the showlist - 
not back to the start sequence.

Both musical sequences and animation sequences can be used as start sequences.

MP3g3 Directors can control DMX Devices

In addition to LOR Devices, MP3g3 Directors can also drive DMX devices on one or both output
ports.  In order to control DMX devices, your MP3g3 must have at least firmware version 5.28.

 Network and Universe Priorities

New advanced MP3 Directors, like the Dual Port G3MP3 Director, can drive 2 separate physical
networks of devices.  In the future new MP3 directors will be available that can drive 4 physical
networks.  These advanced directors can control LOR devices, DMX devices, or a combination of
them on separate ports.  The Hardware Utility will automatically select which networks and/or
universes in your sequence will be used by the director.  

Only the ADVANCED level of the LOR software will allow for the creation of DMX output for a
director.  All other levels are limited to creating LOR output only.
 
Older Directors, like the DC-MP3-SHOWTIME, are limited to ONLY the LOR REGULAR network.

For Advanced Directors, the Hardware Utility uses a ‘priority system’ based on the contents of the 
FIRST sequence added to the show list.  In order to prevent confusion, all sequences that are part of
a single show should use the same preview.

1. If your license supports them, there is no difference between LOR Enhanced networks and
normal LOR networks.  Both are treated the same when it comes to priority.

2. LOR networks have priority over DMX universes.  
3. The LOR REGular network has the highest priority, followed by AUX A through AUX O.
4. A lower number DMX Universe is higher priority than a higher number.
5. If the sequence contains more than 2 networks, universes, or a combination thereof, those

Networks and Universes are silently discarded.
6. If your director only has one port, then only the PORT 1 column applies.

Examples assuming that you have the ‘Advanced’ level of the software:

Your sequence
contains....

PORT 1 on the
director controls

PORT 2 on the
director controls

Notes

1. LOR REG LOR REG (*)
Only one network, so
it is placed on port 1. 

See note for port 2.
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Your sequence
contains....

PORT 1 on the
director controls

PORT 2 on the
director controls

Notes

1. LOR REG
2. LOR AUX B

LOR REG LOR AUX B
Both ports active with

LOR

1. LOR REG
2. LOR AUX A
3. LOR AUX B

LOR REG LOR AUX A
Aux B is silently

discarded.

1. DMX Universe
1

DMX Universe 1 (*)
DMX on port 1. See

note for port 2..

1. LOR AUX A
2. DMX Universe

1

LOR AUX A DMX Universe 1
LOR devices have

priority over DMX, so
AUX A is on port 1.

1. DMX Universe
1

2. DMX Universe
99

DMX Universe 1 DMX Universe 99
DMX Universes are

assigned in ascending
order.

1. LOR REG
2. LOR AUX A
3. LOR AUX B
4. DMX Universe

1
5. DMX Universe

99

LOR REG LOR AUX A

LOR Devices have
priority over DMX.
REG has highest

priority followed by
AUX A.  Others are

discarded.

*  Please note that the MP3g3 dual network controller will mirror the output of Port 1 onto Port 2 on
a per-sequence basis.  If you wish to have all controllers on port 2 stay dark during certain
sequences, ensure that ALL of the sequences in that show use the same preview.  That is to say,
ensure all of your sequences contain channels for BOTH ports, even if those channels are all OFF
for the duration of the sequence.

'Startup' sequences as well as 'Filler' sequences can also use LOR or DMX devices on advanced
directors and the same rules apply to them.  

Download the Show

When you have selected the show's options and the sequences to be played, you can download the
show to an SD card (which can later be placed into the MP3 director).  Make sure that you have
your SD card reader/writer hooked up to your PC, and click on the "Create Show" button.  This
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brings up a the Write Show to SD Card Wizard.  Once you have made your selections, press 'NEXT'
to continue.  If you would like to go back and change a selection, press 'PREVIOUS'.

There are several steps to specify the options you need to set up the SD card properly, depending
on your hardware, preferences, etc.

Step 1
Select the drive that contains your SD card.

Step 2
Select the show number that you want to use for this show.  Each show on a card must have a
unique number assigned.  If multiple shows are scheduled at the same time, the lowest numbered
show will take priority.

Step 3
if you have a G3MP3 director, select the check box here, and then specify the number of ports for
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your director. 

Step 4
This is what LOR Networks and/or DMX Universes the SD Card Wizard will write to the card, based
on the priority system from above.  This is informational only, there are no changes to be made here.

Step 5
Here is where you can specify different options that your show or hardware may require:
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Lock Step: If you have a very large display, selecting "lock step" may help the different controllers
used in the display react with a higher degree of synchronization.  This is not supported on all
controller types, and the level of firmware in the controllers must be 3.0 or higher.

Set MP3 player's internal clock: If you wish to add a file to the SD card to set the MP3
director's internal clock, check the box that says so.  Note that there are also other ways to set
the director's clock.

Strip MP3 Header Information:  Some MP3s may have a large data block before the actual
music data.  For example, an MP3 may have several high-resolution pictures in its ID3 Tags.  The
MP3 director will correctly ignore this data, however it does take time to find the actual start of the
music file.  Stripping this data will allow the MP3 director to start playing the sequence faster.

Keep lights ON at end if using DMX:  Previously if one or both ports were controlling DMX
Universes the MP3 director would always shut off all the lights.  Checking this box will allow
channels in DMX universes controlled by the MP3 director to remain in the last state they were
sent.  If you leave a light on at the end of a sequence, that light will remain on until the start of the
next sequence.

Show can not be interrupted by input triggers:  Once this show has started on the MP3
director, pressing an input will not interrupt the show - it will run to completion.

Advanced Throttling Options:  The advanced options button will bring up an additional window
that allows you to change parameters which relate to how data will be transmitted from your MP3
Director.  Unless a specific issue is preventing your MP3 Director from working correctly, you
should not change these options.

Step 6
Communications port setup is done here.
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For each port your director has, you will be presented these options.  So for example if you have a
G3MP3 Dual Network director, you see this dialog twice.  Once for the fist physical port, and then
again for the other physical port.  Depending on the type of equipment you have, your LOR license
level, and/or the contents of your sequence, one or more of these options may not be available to
you.  

If a port is using LOR devices:
Select the communications speed that will be used to broadcast lighting commands.  The
recommended setting (57.6) will suffice for many users' displays.  If you have many controllers
that are far distances apart, a slower speed may help; if your sequences use many rapid lighting
commands, a faster speed may help.

G3 directors (and higher) have an additional speeds of 500K and 1000K available.  The 500K
speed is approximately four times faster than the previous high speed of 115.4K, but is only
supported on Generation 3 (G3) devices with updated firmware.

The 1000K speed can ONLY be used with networks that only contain PixCon16 controllers. 
No other LOR controllers support 1000K.

Since the MP3g3 director has two ports, you can additionally specify a different speed for port
2 if your show will use both ports.  Single network directors do not have a second port and so
these options are not available.

If your license supports Enhanced LOR Protocol and you are creating a card for a G3 or above
director, an additional option may be available depending on the first sequence loaded.  If the
first sequence has both Normal LOR and Enhanced LOR commands available, you can select
if you want BOTH to be written to the card (checked), or if you only want Normal (unchecked)
commands written.  If you do not have a G3 controller, or you do not have a license that
supports Enhanced LOR protocol, or if your sequence does not have both types of networks,
then this option is not available.  There is no option that will allow for only Enhanced
commands, even if your sequence has both available.

If a port is using DMX devices
DMX Universes run at a fixed speed, and therefore the options to change port speed are not
available.
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Final Step
This final screen will confirm the choices you made.  When you are ready to write to the SD card,
press the 'Create SD Card' button.

Set the Time

If any of your shows are set up to run on schedules, it is important to set the MP3 director's clock
appropriately.  There are several ways to do this:

First, you can directly hook your MP3 director up to your PC, and click on the "Set to PC's time"
button (in the lower right-hand corner of the LOR MP3 tab).

If you cannot (or do not wish to) hook the MP3 director up to your PC, you can instead create a
"time file" to be placed on an SD card.  The first time that SD card is placed in the MP3 director, the
director's clock will be set to the time specified in the time file (which you can choose, so that you
have enough time to move the card from your PC to your MP3 director).

There are two ways to build a time file: First, you can click on the "Only place SET TIME file on the
SD card"; this will create a time file and download it, without downloading a show as well.  Second,
when you create a show, during the final options dialog, you can request that a time file be created
and downloaded along with the show.

Finally, you can manually set the time on an MP3 director.  See the director's user's guide for
details.

Advanced Parameters

While writing your show to the SD card for an MP3 player, the Hardware Utility will automatically
monitor how much bandwidth is required by your sequence every centi-second.  When the
bandwidth is exceeded, the program can 'compress' your data so that your music and lights stay
better in sync.  The advanced options window allows you to turn this functionality on/off or adjust its
parameters.
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The Advanced Parameters w indow

Throttle Data Output for Improved Performance:  It is recommended that this option remain
ON (checked).  When checked, your sequence is monitored.  For each centi-second that passes,
the program will compute the amount of bandwidth required and compare it to the amount
available.  If unchecked, no throttling is done - this is the same mode as versions previous to
3.12.0.

Minimum Throttle Time in CS:  If throttling is enabled, this is the minimum amount that the
sequence must be behind before compression starts.  For example, if this is set to 5 CS, then
once the sequence is 5 or more centi-seconds behind the audio, compression will begin.   Setting
this higher will allow for more complex areas of your sequence to remain uncompressed at the
expense of lagging further behind your audio. The default value is 1, and this means that as soon
as the sequence falls behind, compression should begin.  

Buffer Flush Time in CS:  This can be thought of as the 'resolution' that your MP3 Director will
run at.  Setting the value lower will increase resolution as well as network load.  Setting the value
higher will decrease network load at the expense of having more commands be compressed.  The
default value of 2 most closely emulates what a computer produces for output, either in the 
Sequencer or the Show Player, when running a sequence on your hardware.  For versions before
3.12.0, this value was 1.

MP3 Director Network Efficiency:  MP3 directors will typically use 100% of the bandwidth that
is available for a port.  Setting this to a lower percentage reduces the amount of throughput, which
will cause more throttling to happen.  It may be best to think of this option as a reduction in the
network speed.  For example, if you set a port to 57.6K speed, and set this option to 70%, then
the hardware utility will throttle the sequence as if it was for a network that runs at approximately
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40.3K (57.6 * 70%).

5.12.1.4 Testing Units

You can test the operation of Light-O-Rama controllers using the LOR Control tab of the Hardware
Utility, sending commands to turn lights on and off and to do other effects, or generate interactive
triggers, by taking the following steps:

Connect the Unit to the Computer
Select the Comm Port
Select the Unit
Testing

Testing Pixie and Cosmic Color devices
Test All Other Units

Connect the Unit to the Computer

The first step is to connect the unit to the computer, for example using an SC485 adapter or a USB-
RS485 adapter.  Make sure that the selector switches are correctly set for the type of cable used
(units are shipped ready to use data cables).  Plug the unit into an AC outlet, and turn the unit on.

Select the Comm Port

After you have connected the unit to the computer, select the comm port that the Hardware Utility
should use to communicate with the controller.

Select the Unit

After you have connected the unit to the PC and selected the comm port, select the unit ID of the
controller that you wish to use.  If you know the controller's unit ID, you can simply type it into the
dropdown box labelled "Select Unit".  If not, use the "Refresh" button, and the Hardware Utility will
scan your network for connected units.  You can then select it from the dropdown list.

NOTE: Scanning the network may take some time.  If you have set the unit IDs of your controllers to
low values, you can use the "Max Unit ID" section to speed up this scan drastically.  It is therefore a
good habit to assign your controllers unit IDs starting at 01, and increasing sequentially through 02,
03, and so on.

Selecting the unit to use

Testing Pixie and Cosmic Color devices

Because of their high channel counts, output to Pixie and Cosmic Color devices, like Cosmic Color
Bulb, Cosmic Color Pixel, and Cosmic Color Ribbon, are tested a little differently than other LOR
Controllers.  If you want to test inputs on a Cosmic Color or Pixie device that supports them, please
see below.  

The "Test Unit's Operation" screen of the LOR Control tab of the Hardware Utility is the screen
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displayed by default when the Hardware Utility is opened.  If it is not currently open, make sure you
have selected the LOR Control tab, and then hit the "Test" button near the bottom of the Hardware
Utility.  If you have selected a Pixie or Cosmic Color device, the test screen for those devices is
displayed:

The testing section of the LOR Control tab for Pixies and Cosmic Color Devices

Depending on the device you have selected as well as the parameters of that device, not all options
will be available.

Because of the large number of circuits available on Cosmic Color Devices like the Cosmic Color
Ribbon or Cosmic Color Bulbs, you do not test individual circuits.  Instead, you can select a color to
be displayed across the device/port.  You can select from a list of pre-determined colors, or select
'Custom' to set the RGB values.  Please note that due to differences in hardware, the color that is
displayed on your computer screen may not match what is displayed by the device.  

Advanced effects like twinkle, shimmer, and fade are only available on devices that are configured for
50 pixels or less.

If you would like to test individual circuits on a Pixie or Cosmic Color device, the Pixel Console can
be used.

Test All Other Units

The "Test Unit's Operation" screen of the LOR Control tab of the Hardware Utility is the screen
displayed by default when the Hardware Utility is opened.  If it is not currently open, make sure you
have selected the LOR Control tab, and then hit the "Test" button near the bottom of the Hardware
Utility:
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The testing section of the LOR Control tab

By setting the "Test Mode" appropriately, you can either test output to the controllers - that is, test
that they can control your lights - or test input from your controllers - that is, test that they can
generate interactive triggers.  

Test Outputs (test lights)

To test that your controllers can control your lights, select "Test Outputs (test lights)" as your "Test
Mode".

After selecting the circuits that you wish to test (by checking their boxes in the "Select Circuits to
Test" section), you can send a lighting effect command to those circuits by choosing the "Light
Mode", "Start Intensity", "End Intensity", and "Fade Duration", and clicking on either the "ON",
"OFF", or "Fade" buttons.  Note: If "ON" is used, the intensity is specified via "End Intensity", not
"Start Intensity".

Alternatively, the "Chase Sequence" section can be used to turn the selected circuits on and off in
sequence.

Test Inputs (for interactive)

To test that your controllers can generate interactive triggers, select "Test Inputs (for interactive)" as
your "Test Mode".

Select the circuits that you want to test.  When you trip a trigger for one of those circuits, it should
show up as red in this screen.
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Please note that triggers are not supported on LOR Enhanced networks.  If your trigger is on a
controller that is on an LOR Enhanced network, you will be able to test it in the Hardware Utility, but
it will not work during your show.

The input testing section of the LOR Control tab, w ith no circuits tripped
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The input testing section of the LOR Control tab, w ith circuit 1 tripped

5.12.1.5 Downloading Sequences

The Standalone Sequence Downloader section of the LOR Control tab of the Light-O-Rama Hardware
Utility can be used to send an animation sequence to a Light-O-Rama controller, which can later run that
sequence independently, in "standalone" mode, without being hooked up to a computer running Light-O-
Rama software.

When a unit runs a sequence in standalone mode, it not only executes the lighting commands in the
sequence that are for that controller itself, but also, if the sequence contains any commands for other
units, it will transmit them to the other units that it is connected to.  In this way, a single controller can
be downloaded with a sequence, and act as a "director" for several linked controllers.

It is important that only one controller in any mutually connected group act as a director.  Downloading
sequences to two separate controllers that are hooked up in a mutually connected group will have
undesired results, as the commands transmitted by the two will interfere with each other.  Similarly, it is
important not to also control sequences from your computer while you have a controller hooked up to it
acting in standalone mode, for the same reason.

Normally, the controller will execute the standalone sequence any time that it is powered on.  However,
some controllers have internal clocks that allow the standalone sequence to be scheduled to run during
a particular timeframe.

Note: The CTB08 controller does not have transmit capability in standalone mode.

To download a sequence to a controller to be used in standalone mode, take the following steps:
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Create the Sequence
Connect the Controller to the PC
Select the Comm Port
Select the Unit
Download the Sequence

You can also use this section of the Hardware Utility to choose when the sequence will run (for
controllers that support this), to remove the standalone sequence from a controller, and to test a
standalone sequence.

To get to the Standalone Sequence Downloader screen, make sure that you are in the LOR Control tab
of the Hardware Utility, and then click on the "Standalone" button.

The Standalone Sequence Downloader section of the Hardware Utility

Create the Sequence

Using the Sequencer, create an animation sequence.  Only animation sequences - not musical
sequences - can be downloaded for standalone mode.  When you create the sequence, associate it
with a preview that has the appropriate unit IDs and circuit IDs, as normal.

Some controllers have very little storage space for sequences.  Because size is a limiting factor,
you should consider the following tips to keep your sequence's size at a minimum:

Fade commands take up the most space.
The least space is used when all lights on a controller are at either 100% or 0% intensity.
When possible, place similar commands at the same time.  For example, if you turn one
circuit of a controller off and then, a tenth of a second later, turn another circuit on the same
controller off, that will take about twice as much space as would turning both of them off at the
same time.
Use loops whenever possible.
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Different types of controllers have different maximum sequence sizes; controllers such as the
CTB08 have little space and can handle only very simple animations.

Also, sequences to be used in standalone mode have some limitations:

You must download the playback file (.play.las) created by the Sequencer.
The sequence's preview should only contain props that are on a single network; unexpected
results may occur if you have more than one network listed in the preview.
The network must not be marked as "enhanced" in Network Preferences.
The sequence cannot contain motion effects.
Timings are only supported on tenth-of-a-second boundaries (for example, 1 second, 1.1
seconds, 1.2 seconds).  If any timings in the sequence are at some centisecond other than a
tenth-of-a-second boundary (for example, 1.15 seconds), they will be considered to be at the 
next tenth-of-a-second boundary.
Depending on the device type, between 1 and 10 loop levels may be supported.
Loop speed modification is not supported, and will be ignored.

Connect the Controller to the PC

Connect the unit to the computer, for example using an SC485 adaptor or a USB-RS485 adaptor. 
Make sure that the selector switches are correctly set for the type of cable used (units are shipped
ready to use data cables).  Plug the unit into an AC outlet, and turn the unit on.

Select the Comm Port

After you have connected the unit to the computer, select the comm port that the Hardware Utility
should use to communicate with the controller.

Select the Unit

After you have connected the unit to the PC and selected the comm port, select the unit ID of the
controller that you wish to use.  If you know the controller's unit ID, you can simply type it into the
dropdown box labelled "Select Unit".  If not, use the "Refresh" button, and the Hardware Utility will
scan your network for connected units.  You can then select it from the dropdown list.

NOTE: Scanning the network may take some time.  If you have set the unit IDs of your controllers to
low values, you can use the "Max Unit ID" section to speed up this scan drastically.  It is therefore a
good habit to assign your controllers unit IDs starting at 01, and increasing sequentially through 02,
03, and so on.

Selecting the unit to use

Download the Sequence

Choose the animation sequence you wish to download using the "Open" button in the "Select
Sequence" section, and then download it using the "DownLoad" button in the "Download Selected
Sequence" section:
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Selecting and downloading the sequence

If you do not see this in the Hardware Utility, make sure that you are on the LOR Control tab, and
click on the "Standalone" button near the bottom.

Scheduling the Sequence

Some Light-O-Rama controllers can schedule the downloaded sequence to run at certain times or in
certain conditions (those that cannot will run the sequence continually whenever powered on).  To
schedule when it will run, use the "Trigger Condition" section:

Scheduling the sequence

Select the condition you want to start the sequence, and click "Send Trigger info to Unit".

If you do not see this in the Hardware Utility, make sure that you are on the LOR Control tab, and
click on the "Standalone" button near the bottom.

Note: If you choose to use specific scheduled times, the clock on the controller is set to the current
time according to your computer.  Make sure that the time on your computer is correct.

Removing the Sequence

To remove a downloaded sequence from a standalone controller, use the "Delete" button in the
"Remove Sequence" section:
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Removing a sequence

Note: This does not actually remove the sequence from the controller; rather, it makes it so that the
controller will no longer play the sequence.  So, if you later decide to use the sequence again, you
can simply reschedule the sequence to run, rather than downloading the sequence again.

If you do not see this in the Hardware Utility, make sure that you are on the LOR Control tab, and
click on the "Standalone" button near the bottom.

Testing the Sequence

After downloading a sequence to a controller to be used in standalone mode, it is recommended that
you test the sequence, using the buttons in the "Test Sequence" section.  To start the sequence,
click "Sequence ON"; to stop it, click "Sequence OFF".

Note that the "Sequence OFF" button will stop the sequence even if it was started automatically (by
powering on or by schedule, as opposed to via the "Sequence ON" button).

Testing the sequence

If you do not see this in the Hardware Utility, make sure that you are on the LOR Control tab, and
click on the "Standalone" button near the bottom.

5.12.1.6 Firmware Updates

The Firmware Update section of the LOR Control tab of the Hardware Utility can be used to send new
firmware to Light-O-Rama controllers.  A controller's firmware has a similar purpose to the operating
system on your computer (such as Windows XP or Windows Vista): The operating system on your
computer is used to run other programs that you load on the computer, such as Light-O-Rama.  The
firmware on a Light-O-Rama controller is used to execute the commands to control the lights and run
standalone sequences.

From time to time, new versions of firmware will become available.  In general, unless the new version of
firmware has a new feature that you need to use, you should not update the firmware.

If you do wish to update the firmware of a controller, do so using the following steps:

Select the Unit
Select the Firmware File
Download the Firmware

If any problems are encountered, please see "Troubleshooting".

To get to the Firmware Update section of the Hardware Utility, make sure that you are in the LOR
Control tab, and click the "Firmware" button (near the bottom).
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The Firmware Update section of the Hardware Utility

Select the Unit

It is recommended that only one controller be connected to the computer when updating firmware. 
Units can have firmware updated when more than one is attached to the computer, but if you choose
to do this, make sure that "Selected unit listed above" is selected, and make sure that the proper
unit is selected in the "Select Unit to Configure.. Download.. Test" section (above the "Firmware"
section).

If you instead use the recommended method of having only a single controller attached to the PC
during a firmware update, choose "Only one unit is connected".

To update the firmware of a Light-O-Rama MP3 Player or a Light-O-Rama Wireless Unit, select the
matching entry in the "Select Unit" section.

Selecting the unit

Select the Firmware File

Use the "Open" button to select the firmware file that you wish to send to the controller.  The "Open"
button starts in your Light-O-Rama base directory; the firmware files are typically located in the
"Firmware" subdirectory.

Select the latest version of firmware for the unit being updated.  The names of the firmware files
correspond with the names of the controllers.
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Selecting the firmware file

Download the Firmware

Finally, start the download by pressing the "Download" button.  The progress bar will provide you
with an update.

If you encounter any problems, please see "Troubleshooting".

Starting the download

Troubleshooting

If the download does not start within 15 seconds of hitting the "Download" button, check that the unit
is powered and properly connected to the PC.  If all else fails, power the unit on and off after you
click the download button and the PC is attempting to start the download.

5.12.2 Light-O-Rama Wireless Devices

The LOR RF tab of the Light-O-Rama Hardware Utility can be used to configure Light-O-Rama wireless
devices (such as the Easy Light Linker).

When using this tab, make sure that only a single wireless device is in the daisy-chained network
hooked up to the PC.

For details, please see the following sections:

Frequency
Speed
Power Level
Stream Data
Get Current Configuration
Set Defaults
Update Configuration
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The LOR RF tab of the Hardware Utility

Frequency

Use this section to control the frequency used by the wireless device.  Note that the transmitter and
any receivers for it must be set to use the same frequency.  

You can also use this to set the frequencies of two different transmitters to different values, so that
they will not interfere with each other; these different transmitters can then be placed far apart from
each other, effectively increasing the range of your wireless network.

Finally, some other wireless source in your area may interfere with Light-O-Rama's wireless
communications at certain frequencies, so if you notice problems with the controllers hooked up to
your wireless devices, try changing the frequency that is used.

If you change this setting, make sure to click the Update Configuration button so that the change
will be sent to the wireless device currently hooked up to the PC.

Speed

Use this section to control the communications speed used by the devices.  The faster speed is
typically the better, allowing more frequent lighting effects, unless your controllers are separated
over large distances.  In that case, if you notice problems with the higher speed, try changing to the
lower speed.

Note that a transmitter and its receivers must use the same speed.

If you change this setting, make sure to click the Update Configuration button so that the change
will be sent to the wireless device currently hooked up to the PC.
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Power Level

If your transmitter and receivers are physically close to each other, using too much power might
cause unintended effects.  If you notice this, try setting a lower power level.

If you change this setting, make sure to click the Update Configuration button so that the change
will be sent to the wireless device currently hooked up to the PC.

Stream Data

This section continuously streams data.  This is mostly for internal testing purposes, and it is
unlikely that you will need to use this.

Get Current Configuration

Clicking this button will retrieve the settings (such as frequency) from the wireless device currently
hooked up to the PC, and display them in the "Current Device Parameters" section.

Set Defaults

Clicking this button will reset the settings (such as frequency) of the wireless device currently
hooked up to the PC back to their factory defaults.

Update Configuration

After you have changed the frequency, speed, or power level, click this button to send the changes
to the wireless device currently hooked up to the PC.

5.12.3 Digital IO Boards

Digital IO Boards are not supported in the S5 version.

5.12.4 X10 Controllers

X10 is not supported in the S5 verison.

5.12.5 Light Console

Clicking on the "Light Console" button of the Light-O-Rama Hardware Utility opens the Test Console. 
The Test Console can be used to test standard Light-O-Rama controllers, or to configure and test Light-
O-Rama iDMX-1000 DMX interface.  If you are trying to test RGB based devices, you may want to
instead use the Pixel Console.
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The Test Console of the Hardware Utility

Controller Type

Use this section (in the lower left) to choose whether to use a test a standard Light-O-Rama
controller or to configure and test a Light-O-Rama DMX interface.  In the latter case, you can choose
between the ability to send any of 101 different intensities, from 0 to 100 ("LOR %" mode), or the
ability to send any of 256 different intensities ("DMX" mode).

DMX Channel Mode

This section (in the lower right) is available only if the controller type is set to "iDMX-1000 - LOR %"
or "iDMX-1000 - DMX".  It allows you to choose how to map Light-O-Rama channels to DMX
channels.  

NOTE: Only "Virtual Controllers" is currently supported.  "Extended Circuit IDs" will be supported in
a future release.

In "Virtual Controllers" mode, the DMX interface is treated as sixteen separate Light-O-Rama
controllers each having its own unit ID and each with sixteen circuits, for a total of 256 channels. 
These 256 channels are each mapped to an individual DMX channel.

In "Extended Circuit IDs" mode (which is not currently supported), the DMX interface will be treated
as a single Light-O-Rama unit ID, but can individually address all 256 circuits (whereas currently a
single Light-O-Rama unit ID supports up to 16 circuits).

Select Unit ID
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Use this section to select the unit ID.  

If the controller type is set to "Standard Controller", or if the DMX channel mode is set to "Extended
Circuit IDs", both dropdown lists are enabled, with 0 through F available as the choices in each.  So,
for example, to use unit ID C7, select "C" from the first dropdown list, and "7" from the second.

If the DMX channel mode is set to "Virtual Controllers", only the first dropdown list is enabled.  The
DMX interface will use all sixteen unit IDs starting with the value selected there.  For example, to
use unit IDs 30 through 3F, select "3" in the first dropdown box.

Select Channel Group

A Light-O-Rama DMX interface can support up to 256 DMX channels simultaneously.  However, the 
intensity sliders at the top of the Test Console only show sixteen of them at once (plus the master
slider).  To select which sixteen are currently displayed, use the "Select Channel Group" slider with
the controller type set to iDMX-1000.

Set Intensities

The top portion of the Test Console shows sixteen sliders for the intensities of sixteen channels,
plus a master slider (on the left) which can be used to slide them all simultaneously.

Above each slider are the Light-O-Rama unit ID and circuit ID associated with that slider.  Also, if
the controller type is set to iDMX-1000, then above those is the corresponding DMX address.  These
values depend upon the selections made for the controller type, DMX channel mode, unit ID, and
channel group.

A common use of this is to determine the Light-O-Rama intensities to be used to produce various
effects on a DMX controller.  For example, a DMX controller may be able to turn on red, green, or
blue lights; each of these is done by sending the same circuit a different command value.  In Light-
O-Rama, these are represented as intensities.  The Light-O-Rama intensities and the corresponding
DMX values are displayed below each slider.

So, for example, you could use this portion of the Test Console to determine that your controller
turns on a blue light when sent a value of 94, which corresponds to a Light-O-Rama intensity of 37%
.  So, when building a sequence in the Sequencer, you can tell this DMX controller to turn on a blue
light by applying a Set Intensity effect for 37%.

Test Buttons

You can use the various buttons at the bottom of the Test Console to send lighting effect commands
to the controller.

5.12.6 Pixel Console

Clicking on the "Pixel Console" button of the Light-O-Rama Hardware Utility opens the Pixel Test
Console.  The Pixel Test Console is best used to test RGB Light-O-Rama controllers.  The labels above
each group of sliders show the physical pixel number, as well as the LOR channels in use.

The Pixel Console can be used to test DMX and E1.31 RGB devices as long as:
1. Your software is registered and your license level supports Native DMX Devices (Advanced or
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Higher)
2. The Comm Listener is running.  This will require that you have the LOR Control Panel loaded.
3. You have properly defined your DMX Universe in Network Preferences.

The Pixel Console can be used to test PixCon16 devices running in LOR mode as long as:
1. Your software is registered and your license level supports Enhanced LOR Networks (Pro)
2. The Comm Listener is running.  This will require that you have the LOR Control Panel loaded.
3. Only devices on the REGular network can be tested.
4. The REGular network must be defined to be running at 500K in Enhanced mode.
5. You did not allow the Hardware Utility to take control of the REGular port from the Listener on start

up.

The Pixel Test Console of the Hardware Utility

Set Intensities

The top portion of the pixel console shows up to twenty four sliders for the intensities of eight RGB
pixels, plus a master slider (on the left) which can be used to slide them all simultaneously.

Above each slider are the Physical Pixel Number and the Light-O-Rama circuit IDs, or DMX
Channels associated with that triplet.  The top number is the Pixel Number, the bottom three
numbers are the Circuit or Channel IDs.

Color Label

The colored label box under each group of 3 sliders shows an approximate representation of the
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color that will be output by the device.  NOTE:  colors on your monitor may not exactly match what
you would see on the actual device.  You should always reference what is actually output on the
physical device when selecting color values.  Clicking this box will bring up a color selection dialog
that will set the R G and B components automatically. The numbers shown in the box are the LOR
intensities of each of the sliders, or the DMX Channel values in R/G/B order.

Controller Type

Use this section (in the lower left) to choose whether to use a test a Light-O-Rama CMB24
controller, Cosmic Color Ribbon, Cosmic Color Bulb/Pixel device, a DMX universe, or network device
like the PixCon16 running on the REGular network in LOR Enhanced mode.  If your license does not
support native DMX the DMX and LOR Enh. options are not available.  If you license does not
support Enhanced LOR networks, the LOR Enh. option is not available,

Channel Mode

This section (in the lower right) is available only if the controller type is set to "Cosmic Color Bulb/
Pixel" or LOR Enhanced.  Set this to match the configuration of your Cosmic Color device or to No
Macro Channels (PixCon16).  The No Macro Channels option is only available if you have selected
the LOR Enh (Pixcon 16) controller type.

Please note that the Pixel Console does not know exactly what device(s) you have connected to
your Enhanced LOR network.  If you incorrectly set the channel mode, you may experience strange
behavior on your device.  For example, if you have a Cosmic Color device connected to your
Enhanced LOR network, but have specified No Macro Channels (Pixcon 16) channel mode, results
are going to be random once you pass channel 150.  Always ensure the channel mode matches the
device you are trying to test.

Select Unit ID/Select Universe

Use this section to select the unit ID.  When working with DMX devices, this changes to allow
selection of a DMX Universe.

Select Pixel Group

A Light-O-Rama RGB device can support up to 300 channels as 100 pixels, and DMX Universes can
support up to 510 channels as 170 pixels.  Due to screen space limitations, the Pixel Console can
only show sliders for 8 pixels at one time.  If your device supports more than 8 pixels, this selector
is active and allows you to set which group of pixels to control.

Zero Values when changing groups

When using the Select Pixel Group slider, the lights for the next selected group will be updated with
the values of the current sliders.  However, if you check this box, the sliders will all be set to 0 when
changing groups.  

Test Buttons

You can use the various buttons at the bottom of the Test Console to send lighting effect commands
to the controller.  Please remember that while the buttons may refer to 'Controller', Cosmic Color
Bulbs or Pixels that are in Dual Normal mode will only update the string the Unit ID corresponds to. 
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Using these buttons with an incorrect Channel Mode selected will produce unintended results.

5.13 ServoDog Utility

The Light-O-Rama ServoDog Utility can be used to configure the Light-O-Rama ServoDog, which
is a fourteen channel digital controller that can perform digital input, digital output, servo control
and PWM ("Pulse Width Modulation") dimming.

For details on how to use the ServoDog Utility, please refer to your ServoDog manual.  This can be
downloaded from the Light-O-Rama Support page.

The Light-O-Rama ServoDog Utility

5.14 Verifier

The Light-O-Rama Verifier can be used to check for certain types of problems with the way that Light-O-
Rama is configured on your machine, and with your schedule, shows, and sequences.

To use the Verifier, simply click its "Verify" button.  By default, this will cause it to check for issues in
your Light-O-Rama configuration, your schedule, shows that you have scheduled, and sequences in
those shows.  You can also tell it to "Verify a Single Show" or "Verify a Single Sequence"; note, though,
that two sequences which each pass "Verify a Single Sequence" without any problems might have
problems when used together in a single show, so it's always a good idea to do "Verify a Single Show"
and especially "Verify Entire Schedule" at least once before going live with your show.

As the Verifier is checking for issues, it will display what it is doing in its "Output Log" tab; when it is
complete, it will switch to its "Results" tab, showing a list of the issues that it has found:

http://www.lightorama.com/support.html
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The Verifier has found one error and seven warnings

Each result has a description, severity, and message number, and may have additional details.  There
are several "Details" columns, each of which may contain a piece of information specific to the detected
problem.  For example, in the above screenshot, several warning messages appear, all with message
number 28, meaning "Channel is completely off".  This message number's first "Details" column shows
the name of the sequence in which the problem was found and its second "Details" column shows the 
track containing the channel which is completely off.  Its third "Details" column (which cannot be seen in
the screenshot above, but which could be seen by scrolling to the right) displays the name of the
channel.

If you right-click on a particular result, a popup menu will appear:

The right-click popup menu for a result
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Clicking "Help on this result" simply opens the help file to the page for the result number in question.  

The two "ignore" options let you tell the Verifier that you are not interested in seeing this result in the
future - either it specifically ("Ignore this result") or all results with the same message number ("Ignore all
results with message number 28").

If you ignore a result (or all results with a certain message number), then whenever such results are
detected in the future, they will not count towards the number of errors or warnings which the Verifier
says it detected, and they will be displayed on the Verifier's "Ignored Results" tab instead of the
"Results" tab.  You can later decide to stop ignoring such results by going to that tab, right-clicking on a
result, and unchecking the ignore option that you had previously selected.

You can also save the list of results to a text file, by clicking the Verifier's "Save" button.  Only results
on the "Results" tab will be saved to the file; those on the "Ignored Results" will not be.

Please see the list of Verifier messages for details on the types of problems that the Verifier checks for.

5.14.1 List of Verifier Messages

The following messages can be generated by the Light-O-Rama Verifier.  For details on any given one,
please refer to its individual help page.

Message 1 (Info): No errors or warnings found
Message 2 (Warning): Verification cancelled
Message 3 (Error): Light-O-Rama is not fully installed
Message 4 (Error): No registry entry for application path
Message 5 (Error): Application directory does not exist
Message 6 (Warning): Verifier not running from LOR application path
Message 7 (Error): Application file does not exist
Message 8 (Error): Unlicensed LOR demo version used
Message 9 (Warning): Unsupported version of Windows Media Player
Message 10 (Error): No registry entry for user data path
Message 11 (Error): User data directory does not exist
Message 12 (Warning): No registry entry for non-media data path
Message 13 (Warning): Non-media data directory does not exist
Message 14 (Warning): No registry entry for media data path
Message 15 (Warning): Media data directory does not exist
Message 16 (Error): Application file has unexpected version number
Message 17 (Warning): Weekly schedule file does not exist
Message 18 (Warning): Yearly schedule file does not exist
Message 19 (Warning): Calendar scheduling not supported
Message 20 (Warning): No shows are scheduled
Message 21 (Error): Show file does not exist
Message 22 (Error): Error reading show file
Message 23 (Error): Sequence file does not exist
Message 24 (Error): Sequence file cannot be loaded
Message 25 (Warning): Show has no sequences
Message 26 (Error): Media file does not exist
Message 27 (Warning): Conflicting channel settings in sequence
Message 28 (Warning): Channel is completely off
Message 29 (Warning): Sequence is completely off
Message 30 (Warning): Channel is missing settings
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Message 31 (Warning): Channel uses undefined comm network
Message 32 (Warning): Channel in tracks of conflicting length
Message 33 (Warning): Musical file used in non-audio section of show
Message 34 (Warning): Subsequences not supported
Message 35 (Warning): Background sequences unsupported
Message 36 (Warning): Startup sequences unsupported
Message 37 (Warning): Shutdown sequences unsupported
Message 38 (Warning): Interactive triggers unsupported
Message 39 (Warning): Unsupported number of tracks
Message 40 (Warning): Shell commands unsupported
Message 41 (Warning): Shell command map file does not exist
Message 42 (Warning): Shell command not set
Message 43 (Warning): Channel conflict
Message 44 (Warning): Old MC-P compatibility enabled
Message 45 (Warning): Channel settings conflict in sequence/intensity file
Message 46 (Warning): Channel settings conflict in intensity file
Message 47 (Warning): Intensity file conflict
Message 48 (Warning): Channel/intensity file conflict
Message 49 (Warning): Intensity file uses undefined comm network
Message 50 (Warning): Intensity files not supported by license level
Message 51 (Warning): Use Compressed Sequences disabled
Message 52 (Warning): Show Player Memory Restarts disabled
Message 53 (Warning): Trigger uses undefined network
Message 54 (Warning): Trigger uses LOR Enhanced network

5.14.1.1 Verifier Messages 1-10

The following are some messages can be generated by the Light-O-Rama Verifier.  For details on any
given one, please refer to its individual help page.  To see all possible messages, please refer to the List
of Verifier Messages.

Message 1 (Info): No errors or warnings found
Message 2 (Warning): Verification cancelled
Message 3 (Error): Light-O-Rama is not fully installed
Message 4 (Error): No registry entry for application path
Message 5 (Error): Application directory does not exist
Message 6 (Warning): Verifier not running from LOR application path
Message 7 (Error): Application file does not exist
Message 8 (Error): Unlicensed LOR demo version used
Message 9 (Warning): Unsupported version of Windows Media Player
Message 10 (Error): No registry entry for user data path

5.14.1.1.1  1: No errors or w arnings found

Message Number: 1
Severity: Info
Summary: No errors or warnings found

If the LOR Verifier does not find any errors or warnings (other than those you have told it to ignore), it will
output this message.
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The LOR Verifier
List of Verifier Messages

5.14.1.1.2  2: Verif ication cancelled

Message Number: 2
Severity: Warning
Summary: Verification cancelled

If you hit the cancel button while the LOR Verifier is checking for problems, it will stop checking, display
any issues that it has found to that point, and additionally display this message to warn you that there
may be other issues that it would have found had it not been cancelled.

Note that it may not stop immediately when you hit the cancel button; it may finish its current check
first.

The LOR Verifier
List of Verifier Messages

5.14.1.1.3  3: Light-O-Rama is not installed

Message Number: 3
Severity: Error
Summary: Light-O-Rama is not fully installed

The installation of Light-O-Rama is not complete.  This could occur, for example, if the installation was
interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from your computer's
Windows registry.

If the problem is that the registry entries have been deleted, you can solve it by running the LORPost
utility, which is typically automatically run after installation.  This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

The LOR Verifier
List of Verifier Messages

5.14.1.1.4  4: No registry entry for application path

Message Number: 4
Severity: Error
Summary: No registry entry for application path

A required Light-O-Rama entry in the Windows registry cannot be found.  This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry.  You will not be able to use Light-O-Rama until this problem is
resolved.
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If the problem is that the registry entries have been deleted, you can solve it by running the LORPost
utility, which is typically automatically run after installation.  This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

The LOR Verifier
List of Verifier Messages

5.14.1.1.5  5: Application directory does not exist

Message Number: 5
Severity: Error
Summary: Application directory does not exist
Details: The name of the directory that is missing

The Windows registry says that the Light-O-Rama program files, such as the Sequencer and the
Hardware Utility, can be found in a certain directory, but that directory does not actually exist.  You will
not be able to use Light-O-Rama until this problem is resolved.

It is suggested to uninstall and reinstall Light-O-Rama.

The LOR Verifier
List of Verifier Messages

5.14.1.1.6  6: Verif ier not running from LOR application path

Message Number: 6
Severity: Warning
Summary: Verifier not running from LOR application path
Details #1: The name of the directory that LOR program files should be contained in
Details #2: The name of the directory that the Verifier is running from

The various Light-O-Rama program files, such as the Sequencer and the Hardware Utility, are expected
to be found in a certain Windows directory.  The Verifier itself is one such program.  However, the copy
of the Verifier that you are running is actually contained in a different directory.

This may not be a problem, for example if you intentionally copied the Verifier to a different directory and
ran it from there.  

However, it might indicate that you are using an old version of the Verifier from a previous installation,
and that old Verifier may not be completely compatible with the current installation.  Or, it might be
indicative of a deeper problem with the installation of Light-O-Rama.

It is suggested that you run the Verifier from the same directory where the Light-O-Rama program files
are installed.  If you are doing so, and still get this error, consider uninstalling and reinstalling Light-O-
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Rama.

The LOR Verifier
List of Verifier Messages

5.14.1.1.7  7: Application f ile does not exist

Message Number: 7
Severity: Error
Summary: Application file does not exist
Details: The expected directory and filename of the missing application file

One of the Light-O-Rama program files, such as the Sequencer or the Hardware Utility, cannot be found.

Depending upon exactly what is missing, your shows may still be able to play.  However, they may not,
and in any case, something is definitely wrong.

It is suggested that you uninstall and reinstall Light-O-Rama.

The LOR Verifier
List of Verifier Messages

5.14.1.1.8  8: Unlicensed LOR demo version used

Message Number: 8
Severity: Error
Summary: Unlicensed LOR demo version used

Your Light-O-Rama software has not been registered.  Until you register it, it will not actually control
your lights (and will have  other limitations as well).

This may have occurred for various reasons - for example, it simply may be that you have not yet
purchased a Light-O-Rama license.  If you do have a license, though, you may not have entered it on
this computer, or perhaps you have recently installed a new version of Light-O-Rama (in which case your
license may or may not be valid for this new version).  Or, perhaps your licensing information has been
deleted from the Windows registry, perhaps by a registry cleanup tool.

If you have not yet purchased a license, you can do so from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.

The LOR Verifier
List of Verifier Messages

5.14.1.1.9  9: Unsupported version of Window s Media Player

Message Number: 9
Severity: Warning
Summary: Unsupported version of Windows Media Player

http://lightorama.com/
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The version of Windows Media Player installed on this computer is older than the minimum version
required by Light-O-Rama, or, perhaps, Windows Media Player is not correctly installed.

You may still be able to use Light-O-Rama, but it will (at the very least) be severely limited - for
example, musical sequences will not play.  It is suggested that you install the latest version of Windows
Media Player.

The LOR Verifier
List of Verifier Messages

5.14.1.1.10  10: No registry entry for user data path

Message Number: 10
Severity: Error
Summary: No registry entry for user data path

A required Light-O-Rama entry in the Windows registry cannot be found.  This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry.

Your shows will not run successfully until this problem is resolved.

If the problem is that the registry entries have been deleted, you can solve it by running the LORPost
utility, which is typically automatically run after installation.  This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

The LOR Verifier
List of Verifier Messages

5.14.1.2 Verifier Messages 11-20

The following are some messages can be generated by the Light-O-Rama Verifier.  For details on any
given one, please refer to its individual help page.  To see all possible messages, please refer to the List
of Verifier Messages.

Message 11 (Error): User data directory does not exist
Message 12 (Warning): No registry entry for non-media data path
Message 13 (Warning): Non-media data directory does not exist
Message 14 (Warning): No registry entry for media data path
Message 15 (Warning): Media data directory does not exist
Message 16 (Error): Application file has unexpected version number
Message 17 (Warning): Weekly schedule file does not exist
Message 18 (Warning): Yearly schedule file does not exist
Message 19 (Warning): Calendar scheduling not supported
Message 20 (Warning): No shows are scheduled
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5.14.1.2.1  11: User data directory does not exist

Message Number: 11
Severity: Error
Summary: User data directory does not exist
Details: The name of the missing directory

The directory that Light-O-Rama expects to find Light-O-Rama data files in does not exist.  This could
occur, for example, if the installation was interrupted, or if a registry cleanup utility deleted certain Light-
O-Rama entries from your computer's Windows registry, or if the directory was deleted or renamed.

Your shows will not run successfully until this problem is resolved.

You may be able to solve this problem by running the LORPost utility, which is typically automatically
run after installation.  This utility can be found in the directory where you installed your Light-O-Rama
program files, which is typically (but not always) C:\Program Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

The LOR Verifier
List of Verifier Messages

5.14.1.2.2  12: No registry entry for non-media data path

Message Number: 12
Severity: Warning
Summary: No registry entry for non-media data path

A required Light-O-Rama entry in the Windows registry cannot be found.  This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not.  Even if the shows themselves do run, certain sequences in them may not.

If the problem is that the registry entries have been deleted, you can solve it by running the LORPost
utility, which is typically automatically run after installation.  This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

The LOR Verifier
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List of Verifier Messages

5.14.1.2.3  13: Non-media data directory does not exist

Message Number: 13
Severity: Warning
Summary: Non-media data directory does not exist
Details: The name of the missing directory

The directory that Light-O-Rama expects to find Light-O-Rama sequence files in does not exist.  This
could occur, for example, if the installation was interrupted, or if a registry cleanup utility deleted certain
Light-O-Rama entries from your computer's Windows registry, or if the directory was deleted or renamed.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not.  Even if the shows themselves do run, certain sequences in them may not.

You may be able to solve this problem by running the LORPost utility, which is typically automatically
run after installation.  This utility can be found in the directory where you installed your Light-O-Rama
program files, which is typically (but not always) C:\Program Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

The LOR Verifier
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5.14.1.2.4  14: No registry entry for media data path

Message Number: 14
Severity: Warning
Summary: No registry entry for media data path

A required Light-O-Rama entry in the Windows registry cannot be found.  This could occur, for example,
if the installation was interrupted, or if a registry cleanup utility deleted certain Light-O-Rama entries from
your computer's Windows registry.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not.  Even if the shows themselves do run, certain sequences in them may not.

If the problem is that the registry entries have been deleted, you can solve it by running the LORPost
utility, which is typically automatically run after installation.  This utility can be found in the directory
where you installed your Light-O-Rama program files, which is typically (but not always) C:\Program
Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.



The Light-O-Rama Software Package 583

© 2019 Light-O-Rama, Inc.

The LOR Verifier
List of Verifier Messages

5.14.1.2.5  15: Media data directory does not exist

Message Number: 15
Severity: Warning
Summary: Media data directory does not exist
Details: The name of the missing directory

The directory that Light-O-Rama expects to find audio and video files in does not exist.  This could
occur, for example, if the installation was interrupted, or if a registry cleanup utility deleted certain Light-
O-Rama entries from your computer's Windows registry, or if the directory was deleted or renamed.

Until this problem is resolved, it is possible that your shows will run successfully, but it is likely that they
will not.  Even if the shows themselves do run, certain sequences in them may not.

You may be able to solve this problem by running the LORPost utility, which is typically automatically
run after installation.  This utility can be found in the directory where you installed your Light-O-Rama
program files, which is typically (but not always) C:\Program Files\Light-O-Rama.

Note that the LORPost utility will ask where your Light-O-Rama data files should be stored.  If you
already have a "Sequences" directory, and would like to keep your sequences there by default, tell it the
directory one level above that directory.  For example, if your sequences are stored in C:\LOR
\Sequences, tell the LORPost utility to store your Light-O-Rama data files in C:\LOR.

Otherwise, try reinstalling Light-O-Rama, or uninstalling and then reinstalling.

The LOR Verifier
List of Verifier Messages

5.14.1.2.6  16: Application f ile has unexpected version number

Message Number: 16
Severity: Error
Summary: Application file has unexpected version number
Details #1: The name of the application file
Details #2: The expected version number of the application file
Details #3: The actual version number of the application file

A certain Light-O-Rama program file, such as the Sequencer or the Hardware Utility, has a version
number other than the one that the Verifier was expecting.

This may be because you are using an old version of the Verifier from a previous installation, and that old
Verifier may not be completely compatible with the current installation.  Or, it might be indicative of a
deeper problem with the installation of Light-O-Rama.

Make sure that you are running the copy of the Verifier that is in the same directory where your current
version of Light-O-Rama is installed.  If you are doing so, it is suggested that you uninstall and reinstall
Light-O-Rama.
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The LOR Verifier
List of Verifier Messages

5.14.1.2.7  17: Weekly schedule f ile does not exist

Message Number: 17
Severity: Warning
Summary: Weekly schedule file does not exist
Details: The name of the missing file

The file which is supposed to contain your weekly schedule does not exist.

If you do not intend to have any shows scheduled via the weekly schedule, this is not an issue; any
shows that you have scheduled via the calendar schedule should play as scheduled.  But if you do
intend to have shows scheduled via the weekly schedule, they will not be played until this problem is
resolved.

Perhaps the file was renamed out of the way, in which case you can rename it back to the expected
name.  Or, perhaps it was deleted; check your computer's Recycle Bin.  If neither of these is the
problem, then you will have to recreate your weekly schedule via the Schedule Editor or the Simple
Show Builder.

The LOR Verifier
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5.14.1.2.8  18: Yearly schedule f ile does not exist

Message Number: 18
Severity: Warning
Summary: Yearly schedule file does not exist
Details: The name of the missing file

The file which is supposed to contain your calendar schedule does not exist.

If you do not intend to have any shows scheduled via the calendar schedule, this is not an issue; any
shows that you have scheduled via the weekly schedule should play as scheduled.  But if you do intend
to have shows scheduled via the  calendar schedule, they will not be played until this problem is
resolved.

Perhaps the file was renamed out of the way, in which case you can rename it back to the expected
name.  Or, perhaps it was deleted; check your computer's Recycle Bin.  If neither of these is the
problem, then you will have to recreate your weekly schedule via the Schedule Editor or the Simple
Show Builder.

The LOR Verifier
List of Verifier Messages

5.14.1.2.9  19: Calendar scheduling not supported

Message Number: 19
Severity: Warning
Summary: Calendar scheduling not supported
Details #1: The date on which a show is scheduled via the calendar
Details #2: The name of the show



The Light-O-Rama Software Package 585

© 2019 Light-O-Rama, Inc.

A show is scheduled via the calendar schedule, but your license does not support calendar scheduling
(or you are using the unlicensed demo version of the software).  The show will not play at the scheduled
time.

If you already have a license, and have registered Light-O-Rama on this computer, then to get the show
to play, you can either upgrade to a higher level license which does support calendar scheduling, or else
remove the show from your calendar schedule and schedule it in your weekly schedule instead.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.

The LOR Verifier
List of Verifier Messages

5.14.1.2.10  20: No show s are scheduled

Message Number: 20
Severity: Warning
Summary: No shows are scheduled

You have no shows scheduled.  None of your shows will play until you schedule them, via the Schedule
Editor or the Simple Show Builder.

The LOR Verifier
List of Verifier Messages

5.14.1.3 Verifier Messages 21-30

The following are some messages can be generated by the Light-O-Rama Verifier.  For details on any
given one, please refer to its individual help page.  To see all possible messages, please refer to the List
of Verifier Messages.

Message 21 (Error): Show file does not exist
Message 22 (Error): Error reading show file
Message 23 (Error): Sequence file does not exist
Message 24 (Error): Sequence file cannot be loaded
Message 25 (Warning): Show has no sequences
Message 26 (Error): Media file does not exist
Message 27 (Warning): Conflicting channel settings in sequence
Message 28 (Warning): Channel is completely off
Message 29 (Warning): Sequence is completely off
Message 30 (Warning): Channel is missing settings

5.14.1.3.1  21: Show  file does not exist

Message Number: 21
Severity: Error
Summary: Show file does not exist

http://lightorama.com/
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Details: The name of the missing show file

You have a show scheduled, but the file that is supposed to contain that show does not exist.  The show
will not play until this problem is resolved.

If you do not want the show to play, this is not a problem, but you may want to remove it from your
schedule (using the Schedule Editor) so that this error message does not appear in the future.

If you do want the show to play, perhaps its file was renamed, or deleted.  If it was renamed, either
rename it back, or else use the Schedule Editor to point to the new name of the show file instead of the
old name.  If it was deleted, check your computer's Recycle Bin.

If these suggestions do not resolve the situation, you may have to recreate the show, using the Show
Editor.

The LOR Verifier
List of Verifier Messages

5.14.1.3.2  22: Error reading show  file

Message Number: 22
Severity: Error
Summary: Error reading show file
Details: The name of the show file

You have a show scheduled, but the show cannot be loaded.  For example, perhaps the show's file has
become corrupted.  The show will not play until this problem is resolved.

If you have any backups of the show file, check to see if they work.  Otherwise, you may have to
recreate the show, using the Show Editor.

The LOR Verifier
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5.14.1.3.3  23: Sequence f ile does not exist

Message Number: 23
Severity: Error
Summary: Sequence file does not exist
Details #1: The name of the missing sequence file
Details #2: The name of the show file that this sequence is referenced in

One of your scheduled shows refers to a sequence file that does not exist.  The sequence will not play
in the show until this problem is resolved.

If you do not want the sequence to play, this is not a problem, but you may want to remove it from the
show (using the Show Editor) so that this message does not appear in the future.

If you do want the sequence to play, perhaps its file was renamed (or placed in a different directory), or
deleted.  

If it was renamed (or placed in a different directory), you can either rename it back, or else use the Show
Editor to point to the new name instead of the old one.



The Light-O-Rama Software Package 587

© 2019 Light-O-Rama, Inc.

If it was deleted, check your computers Recycle Bin, or any backups that you may have.  Note that
whenever you change a sequence and save it (using the Sequencer), Light-O-Rama automatically saves
a backup copy of the file as it was before your changes, so you may be able to use that backup copy.  It
will be saved to the same directory as the original, with the file extension ".bak" appended to its name. 
For example, if your sequence is named "MySequence.las", the automatic backup will be named
"MySequence.las.bak".

If none of these suggestions help, you may have to recreate the sequence, using the Sequencer.

The LOR Verifier
List of Verifier Messages

5.14.1.3.4  24: Sequence f ile cannot be loaded

Message Number: 24
Severity: Error
Summary: Sequence file cannot be loaded
Details: The name of the file

One of your scheduled shows refers to a sequence file that cannot be loaded.  For example, perhaps the
sequence file has become corrupted.  The sequence will not play in the show until this problem is
resolved.

If you have any backups of the sequence file, check to see if they work.  Note that whenever you change
a sequence and save it (using the Sequencer), Light-O-Rama automatically saves a backup copy of the
file as it was before your changes, so you may be able to use that backup copy.  It will be saved to the
same directory as the original, with the file extension ".bak" appended to its name.  For example, if your
sequence is named "MySequence.las", the automatic backup will be named "MySequence.las.bak".

Otherwise, you may have to recreate the sequence, using the Sequencer.

The LOR Verifier
List of Verifier Messages

5.14.1.3.5  25: Show  has no sequences

Message Number: 25
Severity: Warning
Summary: Show has no sequences
Details: The name of the show file

One of your scheduled shows has no sequences in it.  This will not cause any problems - your other
scheduled shows should play fine - but there isn't much point to scheduling a show without sequences,
so this probably indicates a mistake.

If you want sequences to play in the scheduled show, use the Show Editor to add the sequences to the
show.  

If you do not want any sequences to play in the scheduled show, consider removing the show from your
schedule, using the Schedule Editor, so that this message does not appear in the future.
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The LOR Verifier
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5.14.1.3.6  26: Media f ile does not exist

Message Number: 26
Severity: Error
Summary: Media file does not exist
Details #1: The name of the missing media file
Details #2: The name of the sequence file that refers to the missing media file

One of your scheduled musical sequences refers to an audio file or video file that does not exist.  The
sequence will not play until this problem is resolved.

It is possible that the file has been renamed, placed in a different directory, or deleted.

If it has been renamed or placed in a different directory, you can either move it back to its original
location, or else use the Sequencer to modify the sequence so that it points to its new location.

If it has been deleted, check your computer's Recycle Bin, or for any backups that you may have of the
file.

The LOR Verifier
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5.14.1.3.7  27: Conflicting channel settings in sequence

Message Number: 27
Severity: Warning
Summary: Conflicting channel settings in sequence
Details #1: The name of the sequence having the conflict
Details #2: The track containing the first conflicting channel
Details #3: The name of the first conflicting channel
Details #4: The track containing the second conflicting channel
Details #5: The name of the second conflicting channel

One of your scheduled sequences contains two different channels that both are set up to control the
same physical string of lights - for example, they are both set up to control circuit 3 of Light-O-Rama unit
7 on the regular Light-O-Rama network.

Your sequence will play, but these two channels will fight for control over the lights hooked up to the
circuit, which may have make the lights behave in ways that you weren't expecting.

The cause of this may simply be that one of the two channels is set up with the wrong unit ID, circuit
number, network, or device type.  In this case, use the Sequencer to change the channel's settings
appropriately.

If you do intend both channels to control the same string of lights, the lights may or may not behave as
you expect.  The suggested way to do what you probably want is not to have two different channels with
the same settings, but to have a single channel that is contained in two different tracks:

Let's say that you have "Channel A" in the first track, and "Channel B" in the second track.  These
channels have the same physical settings as each other, but different effect events.  Then to change this
situation to the suggested way, use the Sequencer as follows:
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First, copy Channel A from the first track to the second track.

Next, merge the effect events from Channel B into Channel A, so that Channel A contains the effect
events from both channels.

Finally, delete Channel B.  

This will leave you with a single channel - Channel A - which is contained in both tracks, and which
contains all of the effect events that you wanted for its string of lights.  Having this single channel in two
tracks, instead of two different channels in the  two tracks, will make the lights behave as you probably
expect.

The LOR Verifier
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5.14.1.3.8  28: Channel is completely off

Message Number: 28
Severity: Warning
Summary: Channel is completely off
Details #1: The sequence containing the channel
Details #2: The track containing the channel
Details #3: The name of the channel

One of your scheduled sequences contains a channel which is completely off for its entire duration.

Consider removing the channel from the sequence, using the Sequencer.

The LOR Verifier
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5.14.1.3.9  29: Sequence is completely off

Message Number: 29
Severity: Warning
Summary: Sequence is completely off
Details: The name of the sequence file

One of your scheduled sequences has no lighting effects for any of its channels, except for having each
of them off for the sequence's entire duration.

This may be intentional - for example, you may have scheduled a musical sequence so that a song
plays while your lights are off.  Otherwise, consider adding effects to the sequence, or removing the
sequence from the show.

The LOR Verifier
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5.14.1.3.10  30: Channel is missing settings

Message Number: 30
Severity: Warning
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Summary: Channel is missing settings
Details #1: The name of the sequence file containing the channel
Details #2: The track containing the channel
Details #3: The name of the channel

One of your scheduled sequences has a channel which is missing a required part of its physical settings
- for example, perhaps it does not have a unit ID set.

This may be intentional - for example, perhaps you have a channel that shows the beat of a song, which
you intend to use to help build other channels rather than to actually control lights when your show
plays.  If not, though, use the Sequencer to set the channel's settings appropriately.

The LOR Verifier
List of Verifier Messages

5.14.1.4 Verifier Messages 31-40

The following are some messages can be generated by the Light-O-Rama Verifier.  For details on any
given one, please refer to its individual help page.  To see all possible messages, please refer to the List
of Verifier Messages.

Message 31 (Warning): Channel uses undefined comm network
Message 32 (Warning): Channel in tracks of conflicting length
Message 33 (Warning): Musical file used in non-audio section of show
Message 34 (Warning): Subsequences not supported
Message 35 (Warning): Background sequences unsupported
Message 36 (Warning): Startup sequences unsupported
Message 37 (Warning): Shutdown sequences unsupported
Message 38 (Warning): Interactive triggers unsupported
Message 39 (Warning): Unsupported number of tracks
Message 40 (Warning): Shell commands unsupported

5.14.1.4.1  31: Channel uses undefined comm netw ork

Message Number: 31
Severity: Warning
Summary: Channel uses undefined comm network
Details #1: The sequence that the channel is in
Details #2: The track that that the channel is in
Details #3: The name of the channel

One of your scheduled sequences contains a channel which is set up to use a network which does not
have a comm port defined for it.  The channel will not control lights until this issue is resolved.

The channel could be for a Light-O-Rama controller, which can be set up to use one of four different
networks.

It is possible that the channel's network (or device type) is simply set incorrectly.  For example, perhaps
a channel for a Light-O-Rama controller was accidentally set to use the Aux A network, whereas you
only have a comm port assigned to the Regular network.  Or perhaps a channel was accidentally set to
control a Dasher controller, whereas it was intended to control a Light-O-Rama controller.  In cases like
these, use the Sequencer to change the channel's settings in Prop Definition.

Another possibility is that you do intend to use the network that the channel has assigned to it, but that
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network is not set up to use any comm port on your computer.  In this case, use the Network
Preferences program to specify a comm port for the network to use.
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5.14.1.4.2  32: Channel in tracks of conflicting length

Message Number: 32
Severity: Warning
Summary: Channel in tracks of conflicting length
Details #1: The sequence that the channel is in
Details #2: The name of the channel
Details #3: A track that the channel is in
Details #4: Another track that the channel is in

One of your scheduled sequences contains a channel which is in two different tracks, but those tracks
are of different lengths.  For example, one track is a minute long, while the other is two minutes long.

This will likely cause the lights hooked up to that channel to behave in a way that you don't expect, as
different lighting effects from different parts of the same channel could be sent to the lights in an order
that you were not expecting.

Unless you have done this intentionally, and understand the way that your lights will behave because of
this, consider using the Sequencer to either remove the channel from one of the tracks or to change the
tracks to be of the same length.
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5.14.1.4.3  33: Musical f ile used in non-audio section of show

Message Number: 33
Severity: Warning
Summary: Musical file used in non-audio section of show
Details #1: The sequence file
Details #2: The show file that refers to the sequence
Details #3: The section of the show that refers to the sequence

One of your musical sequences is scheduled in a section of a show that does not support audio or
video.  For example, perhaps a musical sequence is contained in the Background section of the show. 
The sequence will play at its scheduled time, but will only control lights; it will not play audio or display
video.

Make sure that the sequence is in the section of the show that you intend it to be in.  If it is not, use the 
Show Editor to move it to the appropriate section.

If it is in the section that you intended, consider using an animation sequence instead, to avoid possible
confusion in the future. 

The LOR Verifier
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5.14.1.4.4  34: Subsequences not supported

Message Number: 34
Severity: Warning
Summary: Subsequences not supported
Details #1: The name of the subsequence
Details #2: The name of the parent sequence containing the subsequence
Details #3: The name of the channel in the parent sequence referencing the subsequence

One of your scheduled sequences contains a channel set up to be a subsequence, but your license
does not support subsequences (or you are using the unlicensed demo version of the software).  The
parent sequence will play at its scheduled time, but the subsequence will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get the
subsequence to play, you would have to upgrade to a higher license level which supports subsequences.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.
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5.14.1.4.5  35: Background sequences unsupported

Message Number: 35
Severity: Warning
Summary: Background sequences unsupported
Details: The name of the show file containing sequences in its Background section

One of your scheduled shows contains sequences in its Background section, but your license does not
support sequences in this section.  The show will play at its scheduled time, but sequences in this
section will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
sequences to play, you would have to either move them to a different section of the show, or else
upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.

The LOR Verifier
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5.14.1.4.6  36: Startup sequences unsupported

Message Number: 36
Severity: Warning
Summary: Startup sequences unsupported
Details: The name of the show file containing sequences in its Startup section

One of your scheduled shows contains sequences in its Startup section, but your license does not
support sequences in this section.  The show will play at its scheduled time, but sequences in this
section will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
sequences to play, you would have to either move them to a different section of the show, or else
upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.
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5.14.1.4.7  37: Shutdow n sequences unsupported

Message Number: 37
Severity: Warning
Summary: Shutdown sequences unsupported
Details: The name of the show file containing sequences in its Shutdown section

One of your scheduled shows contains sequences in its Shutdown section, but your license does not
support sequences in this section.  The show will play at its scheduled time, but sequences in this
section will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
sequences to play, you would have to either move them to a different section of the show, or else
upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.
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5.14.1.4.8  38: Interactive triggers unsupported

Message Number: 38
Severity: Warning
Summary: Interactive triggers unsupported
Details: The name of the show file using interactive triggers

One of your scheduled shows uses interactive triggers, either in an interactive group or as part of its
startup options, but your license does not support interactive triggers.  The show will play at its
scheduled time, but its interactive triggers will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
triggers to work, you would have to upgrade to a higher license level which supports subsequences.  If
your triggers are used for interactive groups, you could also move the sequences in them to a different
section of the show (but if so, they will play immediately, not upon being triggered).

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.
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5.14.1.4.9  39: Unsupported number of tracks

Message Number: 39
Severity: Warning
Summary: Unsupported number of tracks
Details #1: The name of the sequence using too many tracks
Details #2: The number of tracks the sequence uses
Details #3: The allowed number of tracks

One of your scheduled sequences uses more tracks than your license supports.  The sequence will play
at its scheduled time, but its excess tracks will not.

If you already have a license, and have registered Light-O-Rama on this computer, then to get these
tracks to play, you would have to upgrade to a higher license level which supports more tracks.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.

The LOR Verifier
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5.14.1.4.10  40: Shell commands unsupported

Message Number: 40
Severity: Warning
Summary: Shell commands unsupported
Details: The name of the sequence using a shell command

One of your scheduled sequences is set up to use a Windows shell command, but your license does
not support such commands.  The sequence will play at its scheduled time, but the command will not
be executed.

If you already have a license, and have registered Light-O-Rama on this computer, then to get the
command to execute, you would have to upgrade to a higher license level which supports this feature.

If you are using the unlicensed demo version, and you have not yet purchased a license, you can do so
from the Light-O-Rama website.

If you have already purchased one, try using it to register Light-O-Rama on this computer.  If this does
not work, perhaps you have already installed Light-O-Rama on the maximum number of computers
covered by your license, or perhaps your license is for an older version of Light-O-Rama than the one
that you are trying to run.
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5.14.1.5 Verifier Messages 41-50

The following are some messages can be generated by the Light-O-Rama Verifier.  For details on any
given one, please refer to its individual help page.  To see all possible messages, please refer to the List
of Verifier Messages.

Message 41 (Warning): Shell command map file does not exist
Message 42 (Warning): Shell command not set
Message 43 (Warning): Channel conflict
Message 44 (Warning): Old MC-P compatibility enabled
Message 45 (Warning): Channel settings conflict in sequence/intensity file
Message 46 (Warning): Channel settings conflict in intensity file
Message 47 (Warning): Intensity file conflict
Message 48 (Warning): Channel/intensity file conflict
Message 49 (Warning): Intensity file uses undefined comm network
Message 50 (Warning): Intensity files not supported by license level

5.14.1.5.1  41: Shell command map file does not exist

Message Number: 41
Severity: Warning
Summary: Shell command map file does not exist
Details: The expected name of the shell command map file

One of your scheduled sequences is set up to use a Windows shell command, but the command map
file that defines the commands to execute does not exist.  The sequence will play at its scheduled time,
but the command will not be executed.

http://lightorama.com/
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This could be because you created the sequence on one computer, and moved it to another computer to
play in your show, but did not move the command map file.  Light-O-Rama keeps these commands in
the command map file, rather than in the sequences themselves, due to security concerns.  Please see 
Sharing Sequences between Computers, and Security for details.

The LOR Verifier
List of Verifier Messages

5.14.1.5.2  42: Shell command not set

Message Number: 42
Severity: Warning
Summary: Shell command not set
Details: The name of the sequence file with the missing shell command

One of your scheduled sequences is set up to use a Windows shell command, but the command map
file does not list a command to be executed by that sequence.  The sequence will play at its scheduled
time, but no command will be executed.

This could be because you created the sequence on one computer, and moved it to another computer to
play in your show, but did not move the command map file.  Light-O-Rama keeps these commands in
the command map file, rather than in the sequences themselves, due to security concerns.  Please see 
Sharing Sequences between Computers, and Security for details.

The LOR Verifier
List of Verifier Messages

5.14.1.5.3  43: Channel conflict

Message Number: 43
Severity: Warning
Summary: Channel conflict
Details #1: The name of the show containing the channel conflict
Details #2: One of the sections of the show containing a sequence with the conflicting channel
Details #3: The sequence file in that section containing the conflicting channel
Details #4: The track in that sequence containing the conflicting channel
Details #5: The name of the conflicting channel in that track
Details #6: Another section of the show containing a sequence with the conflicting channel
Details #7: The sequence file in that section containing the conflicting channel
Details #8: The track in that sequence containing the conflicting channel
Details #9: The name of the conflicting channel in that track

One of your scheduled shows contains sequences which could possibly play at the same time, but
which each contain a  channel representing the same physical string of lights.  For example, perhaps
the show contains one sequence in its Background section, and another in its Musical section, which
each contain a channel for Light-O-Rama unit 3 circuit 7 on the regular network.  Since sequences in the
Background section can play at the same time as those in the Musical section, this is a conflict.

The show, and its sequences, will play at the appropriate times, but the two channels may fight for
control over the single string of lights that they are set up to use.  This may lead to those lights behaving
in a manner that you are not expecting.
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It is suggested that you use the Sequencer to check whether the channels are set up properly - for
example, perhaps the unit ID of one of the channels was mistakenly set to an incorrect value. 
Otherwise, consider removing the conflicting channel from one of the sequences, or moving one of the
sequences to a different section of the show, where it could not be played at the same time as the other
sequence.
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5.14.1.5.4  44: Old MC-P compatibility enabled

Message Number: 44
Severity: Warning
Summary: Old MC-P compatibility enabled
Details #1: The network on which old MC-P compatibility is enabled

One of your networks has old MC-P compatibility enabled.  This compatibility mode is required for
certain controllers, but they are rare (Light-O-Rama MC-P controllers purchased prior to November 15,
2003).  If you do not have any such controllers on this network, there is no reason to have this
compatibility mode enabled, and in fact it can cause significant overhead on the network, potentially
leading to lag in your lighting effects.  It is suggested to turn this compatibility mode off (unless you have
controllers that require it), which can be done through the Network Preferences program's "Misc" tab.
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5.14.1.5.5  45: Channel settings conflict in sequence/intensity f ile

Message Number: 45
Severity: Warning
Summary: Channel settings conflict in sequence/intensity file
Details #1: The sequence having the channel setting conflict
Details #2: The name of the track containing the channel having the settings conflict
Details #3: The name of the channel having the settings conflict
Details #4: The name of the intensity file having the channel settings conflict
Details #5: The range of addresses in the intensity file having the channel settings conflict

One of your sequences has a conflict between a channel defined in the sequence itself and an address
defined in an intensity file associated with the sequence.  For example, perhaps the sequence contains
a channel which is set up to control Light-O-Rama unit 25 circuit 3 on the Regular LOR network, and the
associated intensity file has a range of controlled addresses that includes that circuit - for example,
perhaps the intensity file controls circuits 1 through 7 on unit 25 on the Regular Light-O-Rama network. 
In such cases, both the channel and the intensity file will simultaneously attempt to control the same
physical circuit, and the resulting behavior of the lights is unlikely to be what you want or would expect.

To resolve this issue, change the channel and/or address range so that they no longer conflict with each
other.  Exactly how to do this depends upon the situation - for example, perhaps the conflict is due to a
typo made in the channel's settings (perhaps its unit number is incorrect), in which case change the
channel's settings.  Or perhaps the issue should be resolved by changing the address range in the
intensity file, or by deleting either the channel or the address range.

The LOR Verifier
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List of Verifier Messages

5.14.1.5.6  46: Channel settings conflict in intensity f ile

Message Number: 46
Severity: Warning
Summary: Channel settings conflict in intensity file
Details #1: The sequence having the channel setting conflict
Details #2: The name of the first intensity file having the channel settings conflict
Details #3: The first range of addresses having the channel settings conflict
Details #4: The name of the second intensity file having the channel settings conflict
Details #5: The second range of addresses having the channel settings conflict

One of your sequences has a conflict between two ranges of addresses controlled by its associated
intensity files.  For example, perhaps an intensity file is set up to control DMX universe 8 addresses 20
through 40, and also to control DMX universe 8 addresses 39 through 50.  In this example, addresses 39
and 40 are both set up to be controlled twice, and the resulting behavior on the lights for those two
addresses is unlikely to be what you would expect.

To resolve this issue, change the intensity file (or files) so that the address ranges do not overlap with
each other.
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5.14.1.5.7  47: Intensity File Conflict

Message Number: 47
Severity: Warning
Summary: Intensity file conflict
Details #1: The show with the conflict
Details #2: The section of the show containing the first sequence with the conflict
Details #3: The name of the first sequence with the conflict
Details #4: The name of the intensity file associated with the first sequence with the conflict
Details #5: The range of addresses for the first side of the conflict
Details #6: The section of the show containing the second sequence with the conflict
Details #7: The name of the second sequence with the conflict
Details #8: The name of the intensity file associated with the second sequence with the conflict
Details #9: The range of addresses for the second side of the conflict

One of your shows contains two separate sequences which could possibly play at the same time as
each other, and those two sequences each have associated intensity files which attempt to control
some of the same physical lights as each other.  For example, perhaps one intensity file attempts to
control LOR Regular network unit 10 circuits 8 through 12, and the other attempts to control LOR
Regular network unit 10 circuits 10 through 15.  In this case, both are attempting to control circuits 10,
11, and 12 on that unit.  If the two sequences actually do wind up playing at the same time as each
other, the resulting behavior on the lights attached to those circuits is unlikely to be what you would
expect.

How to resolve this issue depends upon the particulars of the situation.  For example, perhaps the
overlap is because of a typo in one of the intensity files' settings; perhaps "circuits 10 through 15" should
have been "circuits 13 through 15".  In this case, change the intensity file.  Another possibility is that
one of the sequences might not be in the correct section of the show -- for example perhaps it is in the 
Background section but should have been in the Animation section -- in which case the show file should
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be modified to correct it.
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5.14.1.5.8  48: Channel/intensity f ile conflict

Message Number: 48
Severity: Warning
Summary: Channel/intensity file conflict
Details #1: The show with the conflict
Details #2: The section of the show containing the conflicting channel
Details #3: The name of the sequence containing the conflicting channel
Details #4: The name of the track containing the conflicting channel
Details #5: The name of the conflicting channel
Details #6: The section of the show containing the conflicting intensity file
Details #7: The name of the sequence with the conflicting intensity file
Details #8: The name of the conflicting intensity file
Details #9: The range of addresses containing the conflict in the intensity file

One of your shows contains two separate sequences which could possibly play at the same time as
each other, and one of those sequences has a particular channel while the other has an intensity file
which attempts to control the same physical lights as that channel.  For example, perhaps one
sequence has a channel that is set up to control LOR Regular network unit 10 circuit 8, while the
intensity file attempts to control LOR Regular network unit 10 circuits 5 through 15.  In this case, both
are attempting to control circuit 8 on that unit.  If the two sequences actually do wind up playing at the
same time as each other, the resulting behavior on the lights attached to that circuit is unlikely to be
what you would expect.

How to resolve this issue depends upon the particulars of the situation.  For example, perhaps the
overlap is because of a typo in one of the intensity files' settings; perhaps "circuits 5 through 15" should
have been "circuits 13 through 15".  In this case, change the intensity file.  Or, similarly, perhaps the
channel's settings are mistaken, in which case those settings should be modified.  Another possibility is
that one of the sequences might not be in the correct section of the show -- for example perhaps it is in
the Background section but should have been in the Animation section -- in which case the show file
should be modified to correct it.
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5.14.1.5.9  49: Intensity f ile uses undefined comm netw ork

Message Number: 49
Severity: Warning
Summary: Intensity file uses undefined comm network
Details #1: The sequence whose intensity file uses the undefined comm network
Details #2: The intensity file using the undefined comm network
Details #3: The undefined comm network being used

One of your sequences uses an intensity file which attempts to control lights on a comm network that
has not been defined.  For example, perhaps it attempts to use the LOR Aux A network, but you have
not set up the LOR Aux A network to use any particular COM port.  In this case, your sequence will
play, but the lights that attempt to use the undefined network will not be controlled.
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How to fix this issue depends upon the particulars of the situation.  Perhaps the comm network used by
the intensity file is mistaken, in which case the intensity file should be modified to use the correct
network.  Or perhaps the correct comm network is being used, but that comm network has not been set
up via the Light-O-Rama Network Preferences program.
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5.14.1.5.10  50: Intensity f iles not supported by license level

Message Number: 50
Severity: Warning
Summary: Intensity files not supported by license level
Details #1: The sequence which is attempting to use an intensity file

One of your sequences uses an intensity file, but your license level does not support intensity files.  The
sequence will play, but any effects defined in the intensity file itself will not happen on your actual
physical lights.

This issue can be resolved by upgrading your Light-O-Rama license to a level that supports intensity
files.
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5.14.1.6 Verifier Messages 51-60

The following are some messages can be generated by the Light-O-Rama Verifier.  For details on any
given one, please refer to its individual help page.  To see all possible messages, please refer to the List
of Verifier Messages.

Message 51 (Warning): Use Compressed Sequences disabled
Message 52 (Warning): Show Player Memory Restarts disabled
Message 53 (Warning): Trigger uses undefined network
Message 54 (Warning): Trigger uses LOR Enhanced network

5.14.1.6.1  51: Use Compressed Sequences disabled

Message Number: 51
Severity: Warning
Summary: Use Compressed Sequences disabled

The LOR Control Panel option Use Compressed Sequences is disabled.  When enabled, this option
causes the Show Player to use compressed sequences instead of regular sequences.  Loading a
compressed sequence is significantly faster than loading a regular sequence, and the behavior of your
lights should be exactly the same no matter whether you use a compressed sequence or the sequence
that that compressed sequence was based on.  Thus, enabling this option has the benefit that it may
decrease loading delays in your show, with no drawback.

Unless you have a specific reason to believe that having this option enabled causes problems with your
show, it is recommended that you enable it.  You can do so via the LOR Control Panel's right-click
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popup menu.
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5.14.1.6.2  52: Show  Player Memory Restarts disabled

Message Number: 52
Severity: Warning
Summary: Show Player Memory Restarts disabled

The LOR Control Panel option Show Player Memory Restarts is disabled.  When enabled, this option
causes the Show Player to automatically shut down and restart in certain situations (not while your
show is playing), as a proactive measure to mitigate the effects of possible hypothetical memory leaks.

Unless you have a specific reason to believe that having this option enabled causes problems with your
show, it is recommended that you enable it.  You can do so via the LOR Control Panel's right-click
popup menu.
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5.14.1.6.3  53: Trigger uses undefined netw ork

Message Number: 53
Severity: Warning
Summary: Trigger uses undefined network
Details #1: The name of the show containing the trigger
Details #2: The name of the undefined network that the trigger uses
Details #3: The name of the trigger

One of your triggers (either a show startup trigger or an interactive group trigger) uses a network that is
not defined in Network Configuration.  The trigger will not function during your show.

There are at least two different reasons why this warning may occur, and how to resolve the issue
depends upon which one is the cause.  First, there may be a mistake in the settings of the trigger itself;
for example it may be set up to use network Aux B, whereas you intended it to use network Aux A.  In
this case, change the definition of the trigger (either in the show startup options or the interactive group,
depending upon what kind of trigger it is).  Second, the trigger may be set up to use the intended
network, but that network might mistakenly not have a comm port defined for it.  In this case, use the 
Network Configuration program to set the configuration of the network.
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5.14.1.6.4  54: Trigger uses LOR Enhanced netw ork

Message Number: 54
Severity: Warning
Summary: Trigger uses LOR Enhanced network
Details #1: The name of the show containing the trigger
Details #2: The name of the LOR Enhanced network that the trigger uses
Details #3: The name of the trigger
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One of your triggers (either a show startup trigger or an interactive group trigger) uses an LOR Enhanced
network.  Triggers are not supported on LOR Enhanced networks, and the trigger will not function during
your show.

There are at least two different reasons why this warning may occur, and how to resolve the issue
depends upon which one is the cause.  First, there may be a mistake in the settings of the trigger itself;
for example it may be set up to use the Enhanced network Aux B, whereas you intended it to use non-
enhanced network Aux A.  In this case, change the definition of the trigger (either in the show startup
options or the interactive group, depending upon what kind of trigger it is).  Second, the trigger may be
set up to use the intended network, but that network might mistakenly be marked as Enhanced.  In this
case, use the Network Configuration program to change the configuration of the network.
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5.15 Sequence Compressor

Compressed sequences are intended for use during shows, as they can be loaded much faster than
their associated sequences, yet contain all information necessary to play the sequence. The Show
Player will try to create compressed versions of the scheduled sequences (.PLAY.LMS files) when each
sequence is first played, but this can delay the start of the sequence by more than a minute for large
sequences (this delay only occurs the first time the sequence is played). To avoid this delay, you can
compress your sequences ahead of time using the Sequence Compressor program.

It can be used to compress all sequences in the entire schedule, or all sequences in a specified show,
or a single specified sequence.  Simply choose which of those you want to do (and, if appropriate,
choose the show or sequence), and click the "Compress" button.  The "Output Log" tab will show what
the Sequence Compressor is doing, as it does it.  When the Sequence Compressor finishes, it will open
a message box saying so, and the "Results" tab will contain a summary of what has been done.  The
summary will say, for example, how many (and which) sequences were compressed, and give details
about any errors or warnings that happened.  If desired, the "Save" button can be used to save both the
results summary and the output log to a file.

If some particular sequence already has an up-to-date compressed sequence available, the Sequence
Compressor will simply skip that sequence, unless the "Force compression even for sequences that are
already compressed" box is checked.

Please note that not all sequences can be compressed.  In particular, any sequence that contains a 
loop cannot be compressed, nor can any S4 sequence that contains two or more tracks with different
time lengths.  If such a sequence is encountered, the Sequence Compressor will issue a "warning"
about it. 

Compressed sequences have a .LCS file extension.
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The Light-O-Rama Sequence Compressor

5.16 Diagnostic

The Light-O-Rama Diagnostic tool can be used in troubleshooting.  It shows a snapshot of your Light-O-
Rama configuration, such as registry settings and the version numbers of the various Light-O-Rama
programs.

When the Light-O-Rama Diagnostic tool starts up, it may take several seconds before it displays your
configuration information.  During this time, it will tell you to please wait while Light-O-Rama gathers
information.

After the configuration information has been displayed, you can copy the results to the Windows
clipboard via the "Copy" button, or save them to a disk file via the "Save" button.  There is also an
"Advanced" button, which can be used to collect additional information that LOR Diagnostic does not
collect by default.
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The Light-O-Rama Diagnostic tool

5.17 Offline Registration Utility

The Offline Registration Utility is a program that you can use to help register the Light-O-Rama Software
Package on a computer which is not connected to the internet.  It must be run on another computer,
which is connected to the internet.  If you do not have another computer which is connected to the
internet, you can still register an offline computer by calling Light-O-Rama.

Please see the help file page "Registering Offline" for details.
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The Offline Registration Utility

5.18 Add-Ons

In addition to the standard programs that come with the Light-O-Rama software package, there is one
add-on program available:

Light-O-Rama Add-Ons
The Light-O-Rama Registry Wiper tool
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5.18.1 Registry Wiper

The Light-O-Rama Registry Wiper tool deletes your Light-O-Rama configuration from your computer's
registry.  This is for use in troubleshooting severe cases.

IMPORTANT: After running the Light-O-Rama Registry Wiper tool, your Light-O-Rama software will not
run.  You will need to reinstall Light-O-Rama.  Also, even after having reinstalled, you will have lost
certain preferences settings that you may have previously set.

The Registry Wiper tool is not a standard part of the Light-O-Rama software package.  It is available from
Light-O-Rama, for troubleshooting severe cases.

The Registry Wiper tool should not be used except in extreme situations.

The Light-O-Rama Registry Wiper tool

If you have previously registered your copy of Light-O-Rama, after selecting "Wipe", you may be
presented with a choice of whether to keep your licensing information (such as your license name and
license key) in the registry or not.  If you choose not to, your copy of Light-O-Rama will run in Demo
mode afterwards, until you re-register.  Note, though, that you will still be able to re-register using your
exact same licensing information.



Index 607

© 2019 Light-O-Rama, Inc.

Index
- A -
Add-Ons     605

Registry Wipe Utility     606

Animation Section (Show)     459

Animation Sequence     47

Loops     339

New Animation Dialog     102

Archived Props     67

Management     121

Audio Wizards     326

Beat Wizard     331

MIDI Wizard     337

Tapper Wizard     327

VU Wizard     334

- B -
Background Section (Show)     457

BSOFT Digital IO Cards     568

- C -
Cable    

Data     9

Phone     9

Calendar Schedule     477

Channel     50

Circuit IDs    

Light-O-Rama Controllers     76

Clipboards (Sequencer)     271

Comm Listener     531

Companion Unit     8

Compressed Sequences     66

Control Lights (Sequencer)     382

Preferences     138

Control Panel     84

Disable Shows Gracefully     93

Disable Shows Immediately     93

Enable Schedule     93

Hardware Utility Quicklaunch     92

Launch at Startup     95

Popup Menu     90

Schedule Editor Quicklaunch     92

Sequence Editor Quicklaunch     92

Show Editor Quicklaunch     92

Show On Demand     94

Shut Down Show On Demand     94

Simple Show Builder Quicklaunch     93

Status Window     86

Unload Light-O-Rama     95

Controllers     76

DMX     79

Light-O-Rama     76

PixCon16     79

Pixel Controllers     79

Convert traditional lights to RGB     69

- D -
Daisy Chain     8

Data Cable     9

Diagnostic Utility     603

Director Unit     9

Disable Shows Gracefully (Control Panel)     93

Disable Shows Immediately (Control Panel)     93

DMX     568, 570

Comm Listener     531

Controllers     79

- E -
Effects (Sequencer)     53

Add     249

Delete     262

Modify     259

Enable Schedule (Control Panel)     93

- F -
File Menu (Sequencer)     99

Close     102

Close All Files     102

Create Playback Files     101

Exit     102

Export as Protected     102

New     100

Open     100

Open Recent     101

Save     101



Light-O-Rama v5.2.4608

© 2019 Light-O-Rama, Inc.

File Menu (Sequencer)     99

Save A Copy     101

Save As     101

Firmware Updates     564

Fixed Timing Grids     64

Freeform Timing Grids     64

- G -
Getting Help     8

Getting Started     8

- H -
Hardware     76

Hardware Utility     531

Configuring Units     536

Digital IO Boards Tab     568

Downloading Sequences     560

Firmware Updates     564

LOR Control Tab     532

LOR MP3 Tab     545

LOR RF Tab     566

Selecting a Comm Port     533

Setting Unit IDs     534

Test Console     568, 570

Testing Units     556

X10 CM11A Tab     568

Help     8

- I -
Import Image (SuperStar)     412

Interactive Groups (Show)     465

Jukebox     467

Magic Toy     468

Soundboard     468

Interactive Section (Show)     461

- J -
Jukebox     467

- K -
Keyboard Shortcuts    

Custom Grid     207

Sequencer     389

- L -
Launch at Startup (Control Panel)     95

Light-O-Rama Controllers     76

Companion Unit     8

Configuring Units (Hardware Utility)     536

Director Unit     9

Downloading Sequences (Hardware Utility)     560

Firmware Updates (Hardware Utility)     564

Hardware Utility     532

PixCon16     79

Pixel Controllers     79

Setting Unit IDs (Hardware Utility)     534

Testing Units (Hardware Utility)     556

Light-O-Rama Network     77

List of Verifier Messages     575

Loops in Animation Sequences     62

Creating and modifying     339

LOR Control Tab (Hardware Utility)     532

LOR MP3 Tab (Hardware Utility)     545

LOR RF Tab (Hardware Utility)     566

- M -
Magic Toy     468

Menu Bar (Sequencer)     99

File Menu     99

Help Menu     145

Sequence Menu     110

Tools Menu     124

Window Menu     143

Motion Effect Generator     344

Bulkb Size     378

Effect Choice     345

Effect Slider     348

Favorites     376

Length     377

Mixing     352

Open     344

MP3 Directors    

Hardware Utility     545

Musical Section (Show)     460

Musical Sequence     48

New Musical Sequence Dialog     105



Index 609

© 2019 Light-O-Rama, Inc.

- N -
Network     77

Network Preferences     505

Advanced Mode     526

E131 Device List     506

IP Troubleshooter     508

PixCon16 Configuration     510

Simple Mode     519

Network Preferences Advanced Mode    

The DMX Tab     529

The LOR Tab     527

The X10/Dasher Tab     531

Network Preferences Simple Mode    

The DMX Tab     522

The LOR Tab     520

The X10/Dasher Tab     524

New Animation Dialog     102

New Musical Sequence Dialog     105

- P -
Phone Cable     9

Playback Files     101

Preferences (Sequencer)     126

Channel Effects     131

Cursor     137

Motion Effects     129

Playback     128

Preview     133

Save Copy     134

Start Up     138

Themes     138

Tooltips     126

Video     135

Zoom     142

Preview     42

Background Image Brightness     387

Management     148

Toolbar Menu     275

Preview Design     149

Channel Conflicts & Bulk Changes Tab     166

Copy Prop     211

Design Tab     152

Group Definition     208

Naming     212

Other Warnings Tab     172

Prop Definition     175

Statistics Tab     174

String Summary Tab     173

Prop     42

Archived     67

Archived Props Management     121

Custom Grid     203

Definition     175

Shapes     181

Protected Sequences     66

Creating     102

- R -
Registry Wipe Utility     606

RGB Aggregates     69

Management     122

Right-Click Context Menu (Sequencer)     281

Advanced Tools Sub-menu     307

Empty Areas (background) Sub-menu     289

Existing Effects (foreground) Sub-menu     293

Prompt For New Effect Sub-menu     286

Timing Marks Sub-menu     311

- S -
Schedule     71

Calendar Schedule     477

Schedule Editor     470

Weekly Schedule     476

Schedule Editor     470

Sequence     37

Animation Sequence     47

Channel     50

Compressed Sequences     66

Musical Sequence     48

Preview     42

Protected Sequences     66

Sequencer     96

Sharing     343

SuperStar Sequencer     392

Timing Grids     63

Windows Shell Commands     117

Sequence Compressor     602

Sequencer     96

About     147



Light-O-Rama v5.2.4610

© 2019 Light-O-Rama, Inc.

Sequencer     96

Add Effects     249

Archived Props Management     121

Audio Wizards     326

Background Image Brightness     387

Beat Channels     62

Beat Wizard     331

Change Colors     261

Change Intensity     261

Channel Background Color     133

Channel Buttons     219

Channel Effect Preferences     131

Clipboard Management     271

Clipboard Selection     263

Closing Sequences     102

Condensed Mode (grid)     225

Control Lights Window     382

Copy     266

Cursor Preferences     137

Cut     266

Delete Effects     262

File Menu     99

File References     116

Grid Rows     54

Grid View     230

Grid View Group     234

Grid View Menu     232

Help Menu     145

Intensity Range     246

Item List     219

Keyboard Shortcuts     389

Loops in Animation Sequences     339

Main Menu     99

MIDI Wizard     337

Modify Effects     259

Motion Effect Generator     344

Motion Effect Preferences     129

Motion Effect Rows     59

Motion Effects Window     381

Moving Windows     384

New Animation Dialog     102

New Musical Sequence Dialog     105

Nudge Tools     260

Paste     267

Paste Mode     263

Paste Special     267

Playback     317

Playback Preferences     128

Playback Window     378

Preferences     126

Preview     42

Preview Design     149

Preview Preferences     133

Preview Toolbar Menu     275

Previews Window     148

Prop Definition     175

Regular Channels (non-RGB)     55

Repeat     270

RGB Aggregates Management     122

RGB Channels     57

RGB Channels on Pixel Props     224

Right-Click Context Menu     281

Save Copy Preferences     134

Saving Changes     101

Scrolling     216

Selecting Cells     242

Sequence Information     116

Sequence Menu     110

Sequence Tab     214

Start Page     147

Start Up Preferences     138

Subsequences     61

Tapper Wizard     327

Themes     138

Time Format     70

Timing Grid Import     277

Timing Grid Toolbar Menu     276

Timing Marks     311

Toggle Tool     261

Toolbar     273

Tools Menu     124

Tooltip Preferences     126

Tooltips     339

Upgrading a Sequence     386

Video Preferences     135

View Fades As Ramps     132

VU Wizard     334

Waveform     320

Window Layout     384

Window Menu     143

Windows Shell Commands     117

Zoom Preferences     142

Zooming     218

ServoDog Utility     573

Shell Commands     117

Show     71



Index 611

© 2019 Light-O-Rama, Inc.

Show     71

Animation Section     459

Background Section     457

Immediate Background Startup     464

Immediate Startup     464

Interactive Groups     465

Interactive Section     461

Jukebox     467

Magic Toy     468

Musical Section     460

Show Editor     456

Show On Demand     94

Show Player     504

Shutdown Section     462

Simple Show Builder     498

Soundboard     468

Startup Options     463, 464

Startup Section     458

Triggered Startup     464

Show Editor     456

Show On Demand (Control Panel)     94

Show Player     504

Shut Down Show On Demand (Control Panel)     94

Shutdown Section (Show)     462

Simple Show Builder     498

Software     80

Add-Ons     605

Comm Listener     531

Control Panel     84

Diagnostic Utility     603

Hardware Utility     531

Network Preferences     505

Registry Wipe Utility     606

Schedule Editor     470

Sequence Compressor     602

Sequencer     96

ServoDog Utility     573

Show Editor     456

Show Player     504

Simple Show Builder     498

SuperStar Sequencer     392

Verifier     573

Soundboard     468

Standalone Mode     560

Startup Section (Show)     458

Status Window (Control Panel)     86

SuperStar    

ImportImage     412

SuperStar Sequencer     392

Animation     414

Archive Sequences     455

Clipboards     435

Commands     449

Custom Sequences     402

Fan     424

Image Action     409

Importing Timing Grid     449

Instant Sequences     396

Keyboard Accelerators     449

Layout Dialog Box     438

Morph     405

Overview     394

Pixels per Ribbon     436

Purchased Sequences     455

Scene     402

Select All     448

Select All Left     448

Select All Right     448

Shockwave     424

Smooth Effects     424

Spiral     424

Star Rays     438

Text     418

Thin Grid     438

Transfer Effects     434

Unit IDs, Hardware Utility     445

Unit IDs, SuperStar Sequencer     446

Welcome     393

Wide Grid     438

- T -
Time Format     70

Timing Grids     63

Editing     311

Fixed     64

Freeform     64

Toolbar Menu     276

Toolbar (Sequencer)     273

Preview Menu     275

Timing Grid Menu     276

- U -
Unit     11



Light-O-Rama v5.2.4612

© 2019 Light-O-Rama, Inc.

Unit IDs    

Light-O-Rama Controllers     76

Setting Unit IDs (Hardware Utility)     534

Unload Light-O-Rama (Control Panel)     95

- V -
Verifier     573

List of Verifier Messages     575

Video    

Display Video     130, 131, 133, 134, 136

Full Screen Mode     136

Preferences     135

- W -
Weekly Schedule     476

What's New     13

Window Menu (Sequencer)    

Float Current Window     144

Reset Window Layout     144

View Control Lights Window     144

View Motion Effects Window     144

View Playback Window     143

View Previews Window     144

View Start Page     143

Windows Shell Commands     117

Wireless Devices    

Hardware Utility     566

- X -
X10    

Hardware Utility     568

X10 CM11A Tab (Hardware Utility)     568


	Getting Started with Light-O-Rama
	What's New?
	Feature Comparison
	Light-O-Rama Concepts
	Sequences
	Previews
	Animation Sequences
	Musical Sequences
	Channels
	Effects
	Grid Rows
	Timings
	Compressed Sequences
	Protected Sequences
	Archived Props
	RGB Aggregates
	Time Format

	Shows
	Schedules
	File Locations
	Hardware
	Light-O-Rama Controllers
	Light-O-Rama Pixel Controllers
	Light-O-Rama PixCon16 Devices
	Native DMX Devices
	LED Pixel and Node Terminology


	The Light-O-Rama Software Package
	Registering Light-O-Rama
	Registering Offline

	Control Panel
	S5 Sequencer
	Menu Bar
	File Menu
	New Animation Sequence Dialog
	New Musical Sequence Dialog
	Quick Preview

	Sequence Menu
	Sequence Information Dialog
	File References Dialog
	Windows Shell Command Dialog
	Manage Archived Props Dialog
	Manage RGB Aggregates Dialog

	Tools Menu
	Sequencer Preferences
	Tooltip Preferences
	Playback Preferences
	Motion Effect Preferences
	Channel Effect Preferences
	Preview Preferences
	Save Copy Preferences
	Video Preferences
	Cursor Preferences
	Start Up Preferences

	Themes
	Zoom Preferences

	Window Menu
	Help Menu
	About


	Start Page
	Previews Window
	Preview Design
	Design Tab
	Channel Conflicts & Bulk Changes Tab
	Other Warnings Tab
	String Summary Tab
	Statistics Tab
	Prop Definition
	Prop Shapes
	Custom Grid

	Group Definition
	Copy Prop Dialog
	Naming Strategies

	Sequence Tab
	Scrolling & Zooming
	Item List
	Grid Views
	Grid View Menu
	Grid View Groups
	Motion Effect Rows Dialog
	Insert Props And Groups Dialog

	Selecting Cells
	Intensity Range
	Adding Effects
	Modifying Effects
	Deleting Effects
	Clipboards & Cut/Copy/Paste/Repeat
	Clipboard Management

	Toolbar
	Toolbar Preview Menu
	Toolbar Timing Grid Menu

	Right-Click Context Menu
	Right-Click Prompt For New Effect Sub-menu
	Right-Click Empty Areas (background) Sub-menu
	Right-Click Existing Effects (foreground) Sub-menu
	Right-Click Advanced Tools Sub-menu
	Right-Click Timing Mark Sub-menu

	Freeform Play Range
	Playback
	Audio Waveform
	Audio Wizards
	The Tapper Wizard
	The Beat Wizard
	The VU Wizard
	The MIDI File Wizard

	Tooltips
	Loops in Animation Sequences
	Sharing Sequences

	Motion Effect Generator
	Opening the Motion Effect Generator
	Creating an Effect
	Using the Effect Slider
	Mixing Two Effects
	Favorites
	Effect Length
	Bulb Size

	Playback Window
	Motion Effects Window
	Control Lights Window
	Customizing Window Layouts
	Upgrading Sequences
	Background Image Brightness
	Keyboard Shortcut Summary

	SuperStar Sequencer
	Welcome
	Overview
	Instant Sequences
	Custom Sequences
	Creating a Scene
	Creating a Morph
	Creating an Image Action
	Import Image
	Creating an Animation
	Creating Text
	Smooth Effects
	Auto Sequence Effect
	Auto Sequence Dialog Box
	Move or Scale Selected Effects
	Groups of Effects
	Select One or More Rows
	Transfer Effects from One Sequence to Another
	Load/Save Clipboard
	Change to 10 Pixels per Ribbon
	"Star Rays", "Wide Grid", and "Thin Grid"
	The Layout Dialog Box
	The Preferences Dialog Box
	Configure Controller Unit IDs Using the Light-O-Rama Hardware Utility
	Configure Controller Unit IDs in the SuperStar Sequencer
	Select All, Select All Left, and Select All Right
	Importing a Timing Grid and up to 3 Timing Channels

	Summary of Commands and Keyboard Accelerators
	Toolbar Summary
	Toolbar Buttons that have Keyboard Modifiers
	Timeline and Effect Object Selection
	Top Part of Color Controls
	Color Picker Dialog Box
	Bottom Part of Color Controls
	Sequencing Grid Commands for Scenes
	Selection Grid Commands for Morphs
	Sequencing Grid Commands for Smooth Effects (Shockwave, Spiral and Fan)
	Sequencing Grid Command for Images

	Purchased Sequences

	Show Editor
	Interactive Groups

	Schedule Editor
	The Weekly Schedule
	The Calendar Schedule

	LOR Hub
	Creating Shows and SD Cards
	Run from Your Computer
	Run from an MP3 Director
	Creating a new SD Card Show
	Editing an SD Card Show
	Advanced SD Card Wizard
	Throttle Parameters


	Applying and Using MotionPaks
	LOR Sequences
	LOR Hardware Props
	LOR MotionPaks
	Updating Sequences with MotionPaks


	Simple Show Builder
	Show Player
	Network Preferences
	Configuring LOR E131 Devices
	E131 Device List
	IP Troubleshooter

	PixCon16 Configuration
	Advanced Port Configuration


	Simple Mode
	The LOR Tab
	The DMX Tab
	The Misc Tab

	Advanced Mode
	Export/Import
	The LOR Tab
	The DMX Tab
	The Misc Tab


	Comm Listener
	Hardware Utility
	Light-O-Rama Controllers
	Selecting a Comm Port
	Setting Unit IDs
	Configuring Units
	Light-O-Rama MP3 Directors

	Testing Units
	Downloading Sequences
	Firmware Updates

	Light-O-Rama Wireless Devices
	Digital IO Boards
	X10 Controllers
	Light Console
	Pixel Console

	ServoDog Utility
	Verifier
	List of Verifier Messages
	Verifier Messages 1-10
	1: No errors or warnings found
	2: Verification cancelled
	3: Light-O-Rama is not installed
	4: No registry entry for application path
	5: Application directory does not exist
	6: Verifier not running from LOR application path
	7: Application file does not exist
	8: Unlicensed LOR demo version used
	9: Unsupported version of Windows Media Player
	10: No registry entry for user data path

	Verifier Messages 11-20
	11: User data directory does not exist
	12: No registry entry for non-media data path
	13: Non-media data directory does not exist
	14: No registry entry for media data path
	15: Media data directory does not exist
	16: Application file has unexpected version number
	17: Weekly schedule file does not exist
	18: Yearly schedule file does not exist
	19: Calendar scheduling not supported
	20: No shows are scheduled

	Verifier Messages 21-30
	21: Show file does not exist
	22: Error reading show file
	23: Sequence file does not exist
	24: Sequence file cannot be loaded
	25: Show has no sequences
	26: Media file does not exist
	27: Conflicting channel settings in sequence
	28: Channel is completely off
	29: Sequence is completely off
	30: Channel is missing settings

	Verifier Messages 31-40
	31: Channel uses undefined comm network
	32: Channel in tracks of conflicting length
	33: Musical file used in non-audio section of show
	34: Subsequences not supported
	35: Background sequences unsupported
	36: Startup sequences unsupported
	37: Shutdown sequences unsupported
	38: Interactive triggers unsupported
	39: Unsupported number of tracks
	40: Shell commands unsupported

	Verifier Messages 41-50
	41: Shell command map file does not exist
	42: Shell command not set
	43: Channel conflict
	44: Old MC-P compatibility enabled
	45: Channel settings conflict in sequence/intensity file
	46: Channel settings conflict in intensity file
	47: Intensity File Conflict
	48: Channel/intensity file conflict
	49: Intensity file uses undefined comm network
	50: Intensity files not supported by license level

	Verifier Messages 51-60
	51: Use Compressed Sequences disabled
	52: Show Player Memory Restarts disabled
	53: Trigger uses undefined network
	54: Trigger uses LOR Enhanced network



	Sequence Compressor
	Diagnostic
	Offline Registration Utility
	Add-Ons
	Registry Wiper



